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Concordance Desktop Release Notes

The CloudNine™ Concordance Desktop Release Notes provide information on the features
and improvements in each release.  

You can see a full listing of current and previous release notes on our Concordance
Desktop Release Notes site.
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Administration

Server Administration

Opening the Admin Console

The Admin Console is used to setup and maintain users, databases, user groups, matters,
clients, licenses, connections, scheduled jobs, and server based settings associated with
a Concordance Desktop server. To connect and perform administrative tasks on a
Concordance Desktop server, you must have:

· A user account/profile setup on the server to which you  need to connect

· An Administrator license available on the server for you to use

· The server's numeric IP address or the server's URL, such as cndt.myserver.com.

To access the Admin Console:

1. Run Concordance Desktop.

2. From the File menu, click Administration, then Admin Console. 

The Admin Console Log on displays. 
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3. Type your computer or network login ID in the Logon field.

When Concordance Desktop is installed on your computer or workstation, it creates
a user account using your computer login ID (or your network login ID, if on a Local
Area Network [LAN]) as your log on ID.

4. Type your Concordance Desktop password in the Password field, or type a new
password if this is the first time you are logging onto this server, or if you have had
your password reset. 

The first time you connect to a Concordance Desktop server, there is no password
registered for your account. The password that you type in the Password field
during your initial log on becomes your password for your user account/profile. 

Once you have entered a password on your first log on, you can continue to use
that same password or request a password reset, so that you can enter a new
password the next time you attempt to open a database, or the Admin Console.  

5. Type (or select if available) the server's numeric IP address or it's URL (such as
cndt.myserver.com) in the Host name field.

6. Type the Admin Console listening port number in the Port field.

10001 is the default listening port number, which can be adjusted later. For more
information about adjusting port settings, see Adjusting port settings.

7. Click the Connect button to connect to open the Admin Console.

Verifying connectivity - checklist

Reference the Connectivity Checklist for the Concordance Desktop server, to make sure
you have completed all necessary steps to ensure connectivity channels for servers,
databases, and users.

Connectivity Checklist:

Checklist: Concordance Desktop server Connectivity

Servers

Is Concordance Desktop installed on the machine you are using as the
Concordance Desktop server, and activated with a Server license?

Did you remember to set up a valid administrator account in Microsoft Windows?
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Checklist: Concordance Desktop server Connectivity

Did you set up your firewall ports?

Databases

Did you register existing 10.x databases in the Admin Console or place them in the
Registration Directory (DB Smart Path)?

Is the Yes option displayed in the Online field for the database (Admin Console,
Management tab, Databases)? 

Did you associate your Concordance Desktop databases to the client and matter
that applies for each database?

*Clients are for organizational purposes only.

Did you setup all database administrators in the Admin Console?

Users/User Groups

Have you setup user groups and associated them with matters that are associated
databases?

Do you have users associated to a database in the Concordance Desktop Admin
Console?

Did you save a .fyi file for each database that remote Concordance Desktop users
need to access?

Does each user have a valid ID and password in the Admin Console, and does it
match what is used for authentication?

Manage Licenses

Adding new license keys

Before you can add user license keys to the Concordance Desktop server, you need to
contact Concordance Desktop Sales to request the licenses your organization will need.
CloudNine sends an e-mail containing the applicable license keys. Once you have the
licenses keys, you can add them to the Concordance Desktop server from the Admin
Console.

To add a new license key:
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1. Contact Concordance Desktop Sales at Sales@cloudnine.com to request an FYI
Reviewer license.

In the license request, please include the following:

· Your organization’s server name

· Number of seats needed

· Length of time needed per seat

When your seat request is approved, CloudNine will send an e-mail containing the
license keys.

2. Once you receive the license keys, Log onto the Admin Console on the
Concordance Desktop server where you need to add the license keys.

3. Click the Licenses tab.

4. Copy the license key from the e-mail (CTRL+C) and paste it (CTRL+V) into the
Enter a new license key here field.

5. Click the Activate button to enable the license for this server.

6. Repeat steps 4 and 5 for each license key you need to add. 

When the seats are activated, the license count at the top of the tab is updated,
and the license key is added to the license key list on the Licenses tab. Seats are
valid during the date range you specified in the e-mail.

When you enter the license key, ensure that you include the semi-colon at the
end, and that there are no extra spaces at the front or end of the entry, otherwise
you will receive an error stating that it is an invalid or duplicate license.

Removing license keys

To remove a license key:

1. Open the Admin Console on the server where you need to delete the license key. 

2. Click the Licenses tab.

3. In the license key list, click the license key you want to remove.

4. You are asked to confirm the deletion, click Yes.

5. Click the Remove button.
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The license key is removed from the list of license keys, indicating that it has been
removed from the server. 

Setting up license notifications

Concordance Desktop administrators can receive e-mail notifications when a license is
about to expire, providing their user account includes their email address. Notification
options can be set from the Admin Console Licenses tab. Concordance Desktop ASPs may
also want to use e-mail notifications to alert clients of any upcoming license expiration.

License expiration occurs at midnight on the last date of the licensing period. If licenses
do expire for users, they will not be able to access any databases until you reactivate the
licenses. 
 

You must have an email client installed on the server in order to send notifications.

To set options for license expiration notifications:

1. From the Admin Console, click the Licenses tab.

2. Click the Notification options button.

Clicking the Notification options button opens the Notification options dialog box.

3. Select the Notify administrators prior to license expiration check box to receive
an e-mail alert when a license is about to expire.

4. In the Begin notifying administrators day(s) prior to expiration field, type the
number of days prior to the expiration date that a notification email will start being
sent out for an expiring license.

5. To have an e-mail notification sent out every day once the notification begins,
select the Remind administrators once a day check box. 

6. Click OK to save your settings.
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For an administrator to receive e-mail notifications, their e-mail address must be
added to the E-mail field in their user account. 

For more information about administrators and setting up e-mail notifications, see
Adding administrator accounts to the server.

Manage Users

About user setup & management

User accounts for all users must be added to the Concordance Desktop server in order to have
access to the databases created, migrated to, and registered on that Concordance Desktop
server. As users are added to the server, they are automatically added to a group named "All
Users." The "All Users" group, that includes the user name, field rights and menu access
settings of every user added to the server, is automatically applied to a matter named "All User
Groups." As databases are created, migrated to, or registered on the Concordance Desktop
server, they too are automatically associated with the "All User Groups" matter. It is this set of
associations to the "All User Groups" matter that makes it possible for every user to have
access to every database on the Concordance Desktop server.

Users can be added to the server using any of the following methods:

· One user at a time, under the Management tab in the Admin Console. 
This method is used when Concordance Desktop is used for user authentication.

· Inserting of multiple users from Active Directory or another external domain. 
This method is used when Active Directory or another external domain is used for user
authentication.

· Users assigned to a Concordance 10.x database that is migrated or registered on the
Concordance Desktop server. 
During the migration or registration of a Concordance 10.x database, users who were
assigned to the database, are carried over and automatically added to the Concordance
Desktop server. 

Methods for adding and managing users 

There are several methods you can use for adding and managing users on a Concordance
Desktop server; you can use Concordance Desktop  authentication, Active Directory or another
external domain authentication, or by migrating or registering a Concordance 10.x database
with Concordance Desktop. How users are added, and how you maintain those users moving
forward, depends on the method selected for adding them. The selected method also
determines the users' database access rights defaults. 

Concordance Desktop authentication:

Users who are added one at a time in the Admin Console automatically receive full rights to
all databases. Though user field rights and menu access can be changed in a user's user
account. Any restrictions set in a user's user account are applied to all databases associated
with the "All User Groups" matter, with the exception of any migrated or registered
Concordance 10.x databases that the user may have been assigned. In a migrated or
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registered Concordance 10.x database, the user's rights assigned to that database in
Concordance are carried over and applied only to that database, in Concordance Desktop.

Active Directory or another external domain:

Users who are added from an external domain automatically receive full rights to all
databases. Just like users who are added one at a time in the Admin Console, user field
rights and menu access can be changed in a user's user account in the Admin Console. Any
restrictions set in a user's user account are applied to all databases associated with the "All
User Groups" matter, with the exception of any migrated or registered Concordance 10.x
databases that the user may have been assigned. In a migrated or registered Concordance
10.x database, the user's rights assigned to that database in Concordance are carried over
and applied only to that database, in Concordance Desktop. 

 Migrating or registering a Concordance 10.x database:

Users who are added to the server during the registration of a migrated Concordance 10.x
database receive full rights to all Concordance Desktop databases. However, whatever
rights were assigned to them in the Concordance 10.x database, are carried forward and
applied for that database only. As with users added by the other methods, these users
automatically receive full rights to all other databases. And their rights in those other
databases can be changed in the Admin Console. However, in order to change their rights
on the migrated/registered Concordance 10.x database, you need to user the User
Management feature. The User Management feature lets you set rights on a database by
database basis. For more information about the User Management feature, see Restricting
user access on databases.

Most firms will find that the user access they grant in the Admin Console is sufficient for
all databases on the server. However, if your firm requires that specific users be restricted
on one or more databases, you can setup each user's general access settings in the
Admin Console that will be applied to all databases, and then set user restrictions for the
specific database(s) using the User Management feature. For more information about the
User Management feature, see Restricting user access on databases. 

Consider matching user IDs to a reviewer’s Windows or network ID. You can also
reference your staff’s Windows profiles to review what permissions should be granted
to different reviewers.

About user logon names and passwords

Users of Concordance Desktop are not asked for log on credentials until they actually
attempt to open a database. It is only during this attempt that their installation of
Concordance Desktop can determine which Concordance Desktop server they need to
access the database from. This holds true for administrators as well when they attempt
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to access the Admin console or create a new database. However, administrators are
also asked for the server name and port on their log on screen. 

The user name and password a user must use when opening a database, is based on
the method used to add and authenticate users on the Concordance Desktop server. 

When Concordance Desktop is used for user authentication:  Users are authenticated
by their user account on the Concordance Desktop server. Whatever user name their
user account is setup with, that is the name they need to use when they open a
database on a Concordance Desktop server. Passwords cannot be changed by an
administrator on the Concordance Desktop server, but they can be reset so that users
are prompted to enter a new password the next time they attempt to open a
database. 

When an external domain is used for user authentication:  Users are authenticated by
the network. Whatever user name and password is setup for them on the network,
those same credentials must be used to open a database on a Concordance Desktop
server. If using an external domain add and authentication users, the user's network
password must be set to "Never expire." 

When users are added by migrating or registering a Concordance 10.x database:  Users
are authenticated by whichever method (Concordance Desktop or external domain) is
used to authenticate the users. Their user names, as set in the database, are carried
over and added to the Concordance Desktop server. If Concordance Desktop is the
authentication method, they use their Concordance Desktop user name, and are asked
to create a password on their first attempt to open a database. If an external domain is
used for authentication, they use their network user name and password when they
attempt to open a database. 

For more information about resetting passwords, see Resetting a user's password.

Before user setup

Before you set up users in Concordance Desktop, please consider the following tips: 

General user setup tips

· User passwords are encrypted with the SHA-1 standard in the .sec files

· Concordance Desktop does not support special characters such as %, & #, etc.,  in
user, user group, database, matter, and client names.

· Concordance Desktop does not support user names, passwords, or database names
containing characters in Unicode, such as Chinese or Japanese characters.
Currently, only user names, passwords, or database names containing single-byte
characters are supported, such as English characters.

· Distinct user IDs and passwords need to be the same across all databases the users
need access to on the Concordance Desktop server. This includes all databases
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created in Concordance Desktop and all Concordance 10.x databases that have
been migrated to Concordance Desktop. 

· Best practice is to ensure there is at least one user who is setup as a Supervisor,
with full rights. Since most users at a firm perform several different tasks, this is the
default for all users, unless a user's rights are changed in the Admin Console, or in a
specific database using the User Management feature

· Concordance Desktop captures a user’s network log on and compares it with the
user list from the Admin Console and if applicable, with the restrictions in database
user management settings. If a match is found, then the user receives the
corresponding rights. If a match is not found, the user receives the default user
rights (all rights to all databases).

· Deleting the Default user in Concordance Desktop is optional, but suggested. 

User setup limitations

· User IDs – 22-character maximum, not case sensitive, spaces allowed, special
character such as %, &, #, etc. are not allowed in user IDs

· Passwords – 24-character maximum, case sensitive, created on first access,
slashes, and other special characters, such as %, &, #, etc., are not allowed in
passwords

· Blank user names are not allowed in Concordance Desktop

Active Directory authentication user setup tips

· First set up users in Microsoft Active Directory before adding them to the
Concordance Desktop server. 

· The spelling of the user name must be the same as the user name in the Active
Directory.

· Passwords in Active Directory must be set to never expire, for all Concordance
Desktop users.

User setup tips for restricting user access rights in a databases

· Consider setting up a user group for each user type (administrators, project
manager, CCSA, database administrator, etc.), that require the same access to all
databases, and then drag and drop each user to their respective user group. When
you need to assign the users with new database, you create a matter, and drag the
specific user group(s) and database to the matter. This assigns the database and
the user group(s) to the same matter, allow those users to access that database. 

· By default, all users are granted full rights to fields and access to all menus when
they are added to the server. 

· When you add a new field to a database, by default all users are granted full access
rights to that field. If you want to restrict access to the field you need to modify
the field access rights for each applicable user whom you want to restrict.
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· If you intend to set the same restrictions for a user, or multiple users, across
several databases, you can create a template (role template) .csv file. You create
the .csv file by 'exporting' the user restrictions from one database and 'importing'
them into another database. The same user  restrictions can be imported to several
other databases. When you export to a .csv file, both the field rights and menu
access rights are saved to the .csv file. 

· It is best practice to always export a copy of your user management settings each
time you update them so you have a current backup copy to reference. Be sure
your supervisor or secondary database administrator has access to this file in case
of an emergency. 

Recommended database menu restrictions

If you are using the User Management feature to restrict user rights in a database,
we recommend that you restrict the following menu rights from all users except the
applicable database administrators and supervisors:

· File > Index

· File > Reindex

· File > Administration

· File > Begin Program

· File > Edit Program

· Edit > Delete and Undelete

It is best to adhere to these guidelines when setting restrictions on users in
Concordance Desktop databases, to ensure consistency in how user settings are
applied.

If you restrict a user's access to Edit > Validation, that user will not be able to
access list files. 

Optional field restrictions

Even if user management is not applied to a database, you can apply read-only
rights to database fields in the Data Entry Attributes screen. Any field marked as
read-only in this box applies to all database users and also overrides field rights
applied in the User Management screen.

For more information about the Data Entry Attributes screen, see Setting data
validation.

User management guidelines for concatenated databases
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Setting up user management for concatenated databases includes the following
guidelines:

· Field rights and menu access settings can be set up in each database if you need
to apply restrictions for users of that database. Setting up these settings in a
concatenated database set only affects the primary database.

· The user name and password must be the same for all databases in the
concatenated set.

· When the user name and password in the primary database does not exist in a
secondary database, and security is enabled, the concatenated database will not
open. The user will receive a message that they do not have access rights to the
specific database.

· When a secondary database has security enabled and the primary database does
not have security enabled, the user is prompted for the user name and password
when using the secondary database. The user name and password entered
becomes the user name and password for the concatenated database set.

For detailed instructions on setting up Concordance Desktop database access
restrictions, see Restricting user access on databases.

User Authentication Setup

We recommend that before you set up users and apply Field and Menu permissions, that
you pre-plan the following items noted in the Setting Up User Authentication Checklist.

· If you are using external authentication, you want to set up your users first in the
Microsoft Active Directory and then import the users into the Administration Console
when registering databases on a Concordance Desktop server.

· If you are not using authentication, we recommend that you set up users in the
Concordance Desktop Admin Console. This will allow each user to have access to all
databases on that server or added to that server, unless you restrict user access
using the User Management feature. 

Setting Up User Authentication Checklist

Checklist: Setting Up User Authentication

Pre-Planning for User Setup

Have you determined if external authentication will be implemented?

Do you have a method of assigning and tracking user IDs to help manage
individual user accounts?
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Checklist: Setting Up User Authentication

Have you implemented a process for adding users to the Concordance Desktop
server? 

Are these processes known to other administrators who are responsible for setting
up users and managing databases?

Did you implement a folder template to store your databases and associated files?

Admin Console User Setup

Did you add additional administrator user accounts, and set full menu and field
access rights? 

Did you include an email address for each administrator who needs to receive
watchdog and other notifications from the server?

Did you set up e-mail options and watchdog services under the Settings tab? 

(All notifications will be sent to all administrators who have an e-mail address
included in their user account/profile.)

For databases migrated to Concordance Desktop using the DB Smart Path
directory:  Did you verify that all users associated with the database, now have
user accounts in the Admin Console under the Management tab?

Did you associate your Concordance Desktop databases to the client and/or matter
that applies for each database?

Note: Clients are for organizational purposes only.

Did you add additional contact information for each user, in the Admin Console
under the Management tab, in the event that the user or main contact for a case
needs to be contacted?

User Management Setup for Restricting User Rights in One or More
Databases
* Only if you are restricting one or more user's rights in one or more
databases.

Did you set the administrator credentials for the applicable databases in the User
Management dialog box in Concordance Desktop, and did you give them full access
to all fields and menu items? (Optional) 

This should be done only if you are using the User Management feature to restrict
user field rights and menu access on a per user per database basis. 

Have you planned and designed user roles with pre-defined database field and
menu settings based on the types of administrators and users that are accessing
databases? (This is only applicable if you are going to setup user restrictions on a
database by database basis.)



Concordance Desktop 24

Checklist: Setting Up User Authentication

Have you created user role templates on which to base the same restrictions for
one or more users across multiple databases? 

Did you verify field rights and menu access as designed in user templates and
customize per user, as needed?

Did you export a backup copy of the .csv file for reference, and save it to a
specified location in the folder template? 

Note: You can import the .csv file into other Concordance Desktop databases to
save time with user restriction set up.

Authentication Options

When using Concordance Desktop, you have two primary user authentication options: 

· External - Concordance Desktop relies on an external source to validate users.

· Internal -  Concordance Desktop determines whether a user has access to a
database or to view matters.

Using External Authentication

When using Concordance Desktop with Microsoft Active Directory, Microsoft Windows
NT or PDC (Primary Domain Controller) to authenticate users, a two-fold verification
takes place. The user is first authenticated with one of the following: Active Directory,
Windows NT or PDC. If the person is a valid user, they are then authenticated in the
Concordance Desktop Admin Console and have permissions based on the user rights
applied.

To use this method of user verification, the login IDs in Concordance Desktop must be
identical to the login IDs used in the directory service on the network. User passwords
must be set to "never expire" on the network.

To add outside users to the Concordance Desktop server when using this type of
authentication, the user must be added to the directory service on the network. For
security purposes, they can be assigned no rights at the network level – but they need
to be listed in the network directory for the authentication to take place. In the
Concordance Desktop Admin Console, users can be added and granted the appropriate
rights they need for the case. The same rules apply with regard to matching log on IDs
in both the Active Directory and Concordance Desktop Admin Console.

For more information about authentication types, see Setting authentication types. 

Authentication Type Considerations
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The Concordance Desktop server supports a variety of authenticators that determine
what source grants or denies users from accessing resources and the hosted
databases. Please read the following sections before you adjust settings for
authentication types.

Supported Authentication Types

Internal Types Description

Concordance
Desktop

Concordance Desktop handles authentication. A valid user ID and
password is required to connect.

External Types Description

External by Domain Authentication by NT Domain Controller (non-Active Directory)

External by NT
Server

Authentication by stand-alone server (Member server)

External by Active
Directory LDAP

Authentication by Lightweight Directory Access Protocol (Microsoft
Active Directory)

If you are using external authentication, you must still use Concordance Desktop
security.

Concordance Desktop

This authentication method verifies user credentials set in the Concordance Desktop
Admin Console. Concordance Desktop gives users their designated field and menu
access. Users who are not verified by the Concordance Desktop settings are refused
access by the Concordance Desktop server.

External by Domain

Domain passwords take precedence over Concordance Desktop passwords:

· If a user name or password is not recognized by the domain controller, then the
user is refused access by the Concordance Desktop server.

· If the user is verified by the domain controller, then the user is given access to
all Concordance Desktop databases where Concordance Desktop rights allow
access for that log on, regardless of the Concordance Desktop password.

The External by Domain setting typically requires use of several ports: 137 TCP, 138
UDP, 139 TCP, and 445 TCP. Please ensure that your firewall is not blocking these
ports.
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You can verify user credentials through your Windows NT Primary Domain
Controller (PDC) or Backup Domain Controller (BDC).

External by NT Server

This authentication method verifies user credentials through your Windows NT
Primary Domain Controller (PDC) or Backup Domain Controller (BDC), specified by the
Internet or IP address. This method has the same restrictions and features as
described above for the External by Domain method.

If you enter an IP address and the server's IP address changes, the Concordance
Desktop server will not be able to communicate with the credential server until the
address is manually updated.

Port addresses typically required by this method include 137 TCP, 138 UDP, 139 TCP,
and 445 TCP. Please ensure that your firewall is not blocking these ports.

External by Active Directory

Microsoft Active Directory passwords take precedence over Concordance Desktop
passwords.

This authentication method requires a Microsoft Active Directory compatible
credentials server. User credentials are verified and used as described above for the
External by Domain method.

If you enter an IP address and the server's IP address changes, the Concordance
Desktop server will not be able to communicate with the credential server until the
address is manually updated.

Firewall ports that need to be open for Active Directory include 389 (LDAP), 636
(secure LDAP), and NetBIOS ports for the change password feature.

When authenticating users against an Active Directory server in a domain other
than where the Concordance Desktop server is located, make sure that the
Concordance Desktop server is running on Windows Server 2008 R2, Windows
Server 2012, or Windows Server 2012 R2.

Concordance Desktop ASPs will want to set up a separate domain for their clients
and then set up user accounts with passwords set to never expire. Firms and
organizations hosting their own data can use their existing domain and user
accounts.
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When using external authentication, it is necessary that user IDs and passwords in a
Concordance Desktop database are identical to those used in the Active Directory.
To do this, you will need to create organization units (OU) in the Active Directory
specifically for Concordance Desktop server users and set passwords to never expire
so that you are not updating passwords in both the Active Directory and
Concordance Desktop databases if passwords expire.

For more information about setting up users in Active Directory, please refer to
Microsoft's help system. 

Managing users between Active Directory and Concordance Desktop can be an easy task
when there are clear, written instructions on how to add, update, and remove users.
Always ensure that the administrators are using the same methodologies and there is
documentation in a shared location for new administrators and for reference.

Managing Users 

Application Tasks Include

Active Directory Domain Users

Resetting user passwords

Editing Users

Concordance Desktop Admin Console - Management Tab - Users

Modifying user Concordance Desktop server access
settings

Resetting lost passwords for individual users

Exporting user account files in User Management for
reference files or to import into another database
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Adding/modifying users

User accounts for all users must be added to the Concordance Desktop server in order to have
access to the databases created, migrated to, and registered on that Concordance Desktop
server. As users are added to the server, they are automatically added to a group named "All
Users." The "All Users" group, that includes the user name of every user and their field rights
and menu access settings, is automatically applied to a matter named "All User Groups." As
databases are created, migrated to, or registered on the Concordance Desktop server, they
too are automatically associated with the "All User Groups" matter. It is this association that
allows all users to access all databases on the Concordance Desktop server. 

User accounts are added to the Concordance Desktop server in any one of three ways:

· Manually adding each user's user account in the Admin Console - Management tab,
under Users

· Migrating and registering a Concordance 10.x database on the Concordance Desktop
server

· Adding user accounts from an external domain, such as Active Directory

When adding users through the Admin Console, by default, full rights to fields (read and
write) and full menu access (all menus in each database) are granted to the user.
However, these defaults can be changed if you need to restrict the user's field rights and
menu access rights across all databases. See Restricting user access on databases for
more details.  

When adding users by registering a migrated Concordance 10.x database, user accounts
and rights to the migrated database are carried over from the Concordance 10.x database
and applied to that database in Concordance Desktop. However, for all other databases
on the server, field rights and menu access defaults are used. Therefore, users added
through migration may have restricted rights, while all other users on the Concordance
Desktop server still have full rights to the migrated database. If you need to restrict user
rights on these migrated databases, you can do so from the User Management screen.
See Restricting user access on databases for more details.  

When adding users through an external domain (such as Active Directory), as with users
manually added in the Admin Console,  the default of full rights to fields (read and write)
and full menu access (all menus in each database) are granted to each user. These
defaults can be changed if you need to restrict a user's field rights and menu access
across all databases. See Restricting user access on databases for more details. 

It is important to note that no matter how users are added to the Concordance Desktop
server, if you need to setup restrictions for a user across all databases, you need to do
so in the user's user account in the Admin Console immediately after their user account
appears in the Admin Console. This is the only way in which to ensure that the restrictions
you setup will be applied to all databases on the Concordance Desktop server. If you
setup restrictions later on, the new settings will only apply to all databases added to the
server from that point forward. 

Concordance Desktop does not support user names, passwords, or database names
containing characters in Unicode, such as Chinese or Japanese characters. Currently,
it only supports user names, passwords, or database names containing single-byte
characters, such as English characters. 
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Concordance Desktop does not support the use of special characters such as %, &,
#, etc. in user names, user group names, matter names, client names, or database
names. Characters in Unicode are also not supported in user names, password, and
databases. 

When adding users, the user name cannot be greater than 22 characters in length.

To add users when using Concordance Desktop authentication:

When using Concordance Desktop as your authentication type, you add users to the
server one at a time in the Users list, from the Management tab in the Admin Console. 

You must be an administrator on the Concordance Desktop server where you need to
add users, as only Administrators can open the Admin Console. 

To add a user to the server:

1. Log onto the server where the user account needs to be added. 

This can be done by either:

· Logging into the computer/server that has been registered as the Concordance
Desktop server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer/server

2. Run Concordance Desktop on the server computer.  

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your administrator Logon name and Password. 

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.

Th Admin Console opens.

7. Click the Management tab.
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8. Right-click on the Users folder and click on New user, to open a box in which to
type the new user name.

9. Type the user name and press Enter to display the fields for setting up a user.  
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The 'User name' field automatically populates with the user name you entered in
step 3.

The 'Description' field is used to indicate how the user was added to the server. If
this user was added along with other users from a server list, or from the migration
of a Concordance 10.x database, that information is displayed in the this area. 

The 'Last login' field indicates the last time the user had logged into the server.
Because you are just setting up this user account, "(never)" is displayed in this
field.

Adding the user's contact information is optional, and what you enter should be
based on your organization’s user account guidelines.

10. After adding the user, if you want to add contact information, click on their name in
the Users list, to open the user account pane for their account.

11. In the First name field, type the user's first name. 

12. In the Last name field, type the user's last name.

13. In the Company field, type the company/firm name.

14. (Optional) In the Phone field, type the user's phone number. 
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15. In the Email field, type the user's e-mail address if they are to receive e-mail
notifications.

By adding an e-mail account, the administrator is notified when a license is about to
expire, if you have setup the license notification options under the Licenses tab.
The notification is sent to all Administrators who have an E-mail address in their
user account.

E-mail notifications need to route through an existing SMTP server and Port
(the standard default port is 25). The SMTP options can be setup on the
Settings tab in the Admin Console. See Setting up SMTP options for more
details.

 

Ensure that the Concordance Desktop server and SMTP server have IP trust
between them. For instance, the anti-spamming rules must accept emails from
the servers.

16. Click the License Type down-arrow and select Administrator, to setup this
account as an administrative user.

17. Click the Field Rights down-arrow and select Read and Write, to ensure this
account has full rights when working with databases.

· Read and Write: Read/write access to fields. This level of access for all fields is
required for anyone who will be performing maintenance functions such as
indexing, packing, or a database modify. If the user does not have full access to
the fields, Concordance Desktop does not either.

· Read only: Ability to search, browse, and print fields. User with this access
cannot edit or otherwise modify read-only fields. Commands such as Global edit
and Load will not display fields which have read-only access. These fields are
displayed in Edit view, but only for reference or to copy text to the clipboard.

18. Click the Menu Type down-arrow and select the preset you want to apply for the
user. 

· Supervisor: User has access to all menus and menu commands. 

· Administrator: User has access to all menus and menu commands except the
Modify, User Management, and Zap menu commands. 

· Editor: User does not have access to the menu commands restricted in the
Administrator preset, and does not have access to the following menu commands:
New, Reindex, Index, Pack, Begin program, Edit program, and the menu
commands for data validation. Though Editors can still search and edit, perform a
global edit, load and unload data, and run reports. 

· Researcher: User does not have access to the menu commands restricted in the
Administrator and Editor presets, and cannot edit or append, load, overlay, import
data, perform global edits, or unload a copy of the database's structure.

· No Access: User does not have access to any menus or menu commands. User
can only open and exit the database.
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19. Click the Synchronize now button (at the top of the Admin Console pane) to
synchronize the new user account with the databases on this Concordance Desktop
server.

To add users when using external domain authentication:

Domain users can only be added to the Concordance Desktop server when External by
domain, External by NT Server, or External by Active Directory LDAP is selected as the
authentication type on the Settings tab in the  Admin Console. When any one of these
authentication types are selected, the 'Insert domain user' option is available when you
right-click on the Users folder under the Management tab. 

You must be an administrator on the Concordance Desktop server where you need to
add domain users, as only Administrators can open the Admin Console. 

User passwords cannot be changed when using an external authentication method.

To add/insert users from the selected domain:

1. Log onto the Concordance Desktop server where the users need to be added. 

This can be done by either:

· Logging into the computer/server that has been registered as the Concordance
Desktop server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer/server

2. Run Concordance Desktop on the server computer.  

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your administrator Logon name and Password. 

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.

The Admin Console opens.

7. Click the Management tab.

8. Right-click on the Users folder and click on Insert domain user, to open a box in
which to type the new user name.

· If this is the first time you have accessed the domain user list, you are asked for
your domain user name and password. Type them in the appropriate fields and
click Submit to continue. 
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The Domain user import dialog box opens. 

· If this is not the first time you have accessed the domain user list, the Domain
user import dialog box opens. If you have been logged into the server and Admin
Console prior to clicking on Insert domain user, you are not asked to provide your
domain user name and password. 

9. Click the domain user you want to insert, and click the Insert button.

To select multiple users at once, use SHIFT+click or CTRL+click and then click the
Insert button.

Adding user contact information is optional, and what you enter should be based on
your organization’s user account guidelines.

10. After inserting a domain user, if you want to add contact information, click a user's
name in the Users list, to open the user account pane for their account.

11. In the First name field, type the user's first name.

12. In the Last name field, type the user's last name.
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13. In the Company field, type the user's company name.

14. In the Phone field, type the user's phone number.

15. In the E-mail field, type the user's e-mail address if they are to received email
notifications. Usually, the email address is only added for administrators. 

By adding an e-mail account, if the user is an administrator, they are notified when
a license is about to expire, if you have setup the license notification options under
the Licenses tab. The notification is sent to all Administrators who have an E-mail
address in their user account.

E-mail notifications need to route through an existing SMTP server and Port
(the standard default port is 25). The SMTP options can be setup on the
Settings tab in the Admin Console. 

 

Ensure that the Concordance Desktop server and SMTP server have IP trust
between them. For instance, the anti-spamming rules must accept emails from
the servers.

16. Click the License Type down-arrow and select the license type this user is to use
on this Concordance Desktop server.

Available License Types are:

Administrator:  This license is to be used for those users who require access to
the Admin Console and all administrator features for this Concordance Desktop
server. This includes database administration. 

Full Reviewer:  This license is to be used for those users who require the ability to
search and view documents in their near native format (PDF format) and apply
notations, redact text, etc. to those PDF copies. 

Data Reviewer:  This license is to be used for those users who require the ability
to search and view documents in text format only. 

17. Click the Field Rights down-arrow and select whether the user should have Read
and Write or Read Only rights, to all the databases on the Concordance Desktop
server. 

18. Click the Menu Type down-arrow and select the preset you want to apply for the
user. 

· Supervisor: User has access to all menus and menu commands. 

· Administrator: User has access to all menus and menu commands except the
Modify, User Management, and Zap menu commands. 

· Editor: User does not have access to the menu commands restricted in the
Administrator preset, and does not have access to the following menu commands:
New, Reindex, Index, Pack, Begin program, Edit program, and the menu
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commands for data validation. Though Editors can still search and edit, perform a
global edit, load and unload data, and run reports. 

· Researcher: User does not have access to the menu commands restricted in the
Administrator and Editor presets, and cannot edit or append, load, overlay, import
data, perform global edits, or unload a copy of the database's structure.

· No Access: User does not have access to any menus or menu commands. User
can only open and exit the database.

19. Click the Synchronize now button (at the top of the Admin Console pane) to
synchronize the settings with all the databases on this Concordance Desktop
server. 

To modify a user's field rights and menu access settings

If you need to change a user's field rights and menu access settings across all
databases, you can make the changes in the Admin Console under the Management
tab, by following the instructions below. However, if you need to change a user's field
rights and menu access settings on a specific database, you must open the database in
Concordance Desktop and make the changes in the User Management screen instead.
For more information about changing field rights and menu access at the database
level, see Restricting user rights to databases.

Modifying a user's field rights and menu access settings across all databases:

1. Log onto the server where the user account needs to be added. 

This can be done by either:

· Logging into the actual computer/server that has been registered as the
Concordance Desktop server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer/server

2. Run Concordance Desktop on the server. 

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your administrator Logon name and Password.

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.  The Admin Console opens.

7. Click the Management tab.

8. Double-click on the Users folder to display the list of users on the Concordance
Desktop server. 
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9. Locate and click on the user you need to change, to display the user account pane
for the user.  

10. Click the Field Rights down-arrow and select whether the user should have Read
and Write or Read Only rights, to all the databases on the Concordance Desktop
server. 

If a user has been added to the server from the migration of a Concordance 10.x
database, their rights on that database cannot be overridden with this setting. Instead,
you need to make the changes at the database level, from the User Management
screen. See Restricting user rights to databases for details. 

11. Click the Synchronize now button (at the top of the Admin Console pane) to synchronize
the settings with all the databases on this Concordance Desktop server.

Administrator Accounts

Administrators are added to a Concordance Server through the Admin Console
Management tab, just like all other users. And like other users, there is some setup that
must be done on the Concordance Server, before an administrator can log onto the
server.

· A  user account/profile must already be setup for them on the Concordance Desktop
server, with the "Administrator" License Type assigned to their user account. 

· An Administrator license must be available on that server for them to be able to
connect as an Administrator on that server. If no Administrator license is available,
Concordance Desktop automatically grants access, but at the next access level down,
providing there is an available license at that level for them to acquire.

· Concordance Desktop must be installed on the computer they are using to connect to
the server. 

When you add administrators, take into account each of their roles and schedules for
managing server processes and ongoing maintenance tasks. 

If you intend to restrict databases field rights and menu access, we recommend that you
grant full rights for the supervisor of each database in the under User Management
feature. This ensures that the supervisor is not accidentally locked out of the database
they need to manage. 

To add a new administrator account to the server:

You must be an administrator on the Concordance Desktop server in order to log onto
the server and open the Admin Console. 

1. Log onto the server where the administrator account needs to be removed. 
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This can be done by either:

· Logging into the computer that has been registered as the Concordance Desktop
server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer

2. Run Concordance Desktop on the server computer.  

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your Logon name and Password.

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.

7. Click the Management tab.

8. Right-click on the Users folder and click on New user, to open a box in which to
type the new user name.

9. Type the administrator's user name and press Enter to display the fields for setting
up a user.  

The 'User name' field automatically populates with the user name you entered in
step 3.

The 'Description' field is used to indicate how the user was added to the server. If
this user was added along with other users from a server list, that information is
displayed in the this area. 

The 'Last login' field indicates the last time the user had logged into the server.
Because you are just setting up this user account, "(never)" is displayed in this
field.

10. In the First name field, type the user's first name. 

11. In the Last name field, type the user's last name.

12. In the Company field, type the company/firm name.

13. (Optional) In the Phone field, type the user's phone number. 

14. In the Email field, type the user's e-mail address if they are to receive e-mail
notifications.

By adding an e-mail account, the administrator is notified when a license is about to
expire, if you have setup the license notification options under the Licenses tab.
The notification is sent to all Administrators who have an E-mail address in their
user account.
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E-mail notifications need to route through an existing SMTP server and Port
(the standard default port is 25). The SMTP options can be setup on the
Settings tab in the Admin Console. See Setting up SMTP options for more
details.

 

Ensure that the Concordance Desktop server and SMTP server have IP trust
between them. For instance, the anti-spamming rules must accept emails from
the servers.

15. Click the License Type down-arrow and select Administrator, to setup this
account as an administrative user.

16. Click the Field Rights down-arrow and select Read and Write, to ensure this
account has full rights when working with databases.

· Read and Write: Read/write access to fields. This level of access for all fields is
required for anyone who will be performing maintenance functions such as
indexing, packing, or a database modify. If the user does not have full access to
the fields, Concordance Desktop does not either.

· Read only: Ability to search, browse, and print fields. User with this access
cannot edit or otherwise modify read-only fields. Commands such as Global edit
and Load will not display fields which have read-only access. These fields are
displayed in Edit view, but only for reference or to copy text to the clipboard.

17. Click the Menu Type down-arrow and select either Supervisor or Administrator. 

· Supervisor: Access to all menus and menu commands. 

· Administrator: Access to all menus and menu commands except the Modify, User
Management, and Zap menu commands. 

18. Click the Synchronize now button (at the top of the Admin Console pane) to save
the new user account. 

Administrator accounts are deleted in the same manner as any other user account on the
Concordance Desktop server. 

The current administrator account cannot be deleted while it is active. To remove the
current administrator account, log off of the Concordance Desktop Admin Console and
log on as another administrator.

To delete an administrator account:
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1. Log onto the server where the administrator account needs to be removed. 

This can be done by either:

· Logging into the computer that has been registered as the Concordance Desktop
server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer

2. Run Concordance Desktop on the server computer.  

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your Logon name and Password.

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.

7. Click the Management tab.

8. Double-click the Users folder to display the list of users.

9. Right-click on the administrator user you need to delete, and click Delete user.

The following message displays:

10. Click Yes to delete the administrator account.

Deleting users

Users can be manually deleted from the Concordance Desktop Admin Console. When you
delete the user, it removes their user account from the Concordance Desktop server,
preventing them from being able to open any of the databases on the Concordance
Desktop server. 
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To delete a user from a Concordance Desktop server:

You must be an administrator on the Concordance Desktop server where you need to
add users, as only Administrators can open the Admin Console. 

To delete a user on a Concordance Desktop server:

1. Log onto the server where the user account needs to be added.

This can be done by either:

· Logging into the computer that has been registered as the Concordance Desktop
server

· Using Windows Desktop Remote to log into the physical Concordance Desktop
server computer

2. Run Concordance Desktop on the server computer.  

3. From the File menu, click Administration, and then Admin Console. 

4. Enter your administrator Logon name and Password. 

5. Enter the Concordance Desktop server Host name and the Port number (usually
10001) to use for accessing the Admin Console. 

6. Click Connect.

7. Click the Management tab.

8. Double-click on the Users folder to open the list of user accounts on the server.

9. Right-click on the user name of the user you need to delete and click Delete user.

10. You are asked to confirm the deletion, click Yes.

11. Click the Synchronize now button to remove the user's association with all
databases on the server that are associated with the "All User Groups" matter .

To remove a user's access to a specific database:

Access to a database is controlled by the association of the database and a user group
with a specific matter. Therefore, when you need to remove a user's access from a
database, you actually have to remove the user from the user group associated with
the matter to which the database is associated. 

First, determine the user group associated with the matter to which the database is
associated. Once you know the user group, follow the steps below. 

1. Open and log onto the Admin Console.
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2. Click the Management tab.

3. Double-click on the User group folder to display the list of user groups. 

4.  Double-click on the user group that is associated with the matter to which the
database is associated. 

5. Right-click on the user name of the user to be removed and select Remove user
from usergroup.

6. Click the Synchronize now button to synchronize the change with the database.

Resetting a user's password

If a user has forgotten a password, an administrator user can reset their password,
provided the administrator is assigned as an administrator on the Concordance Desktop
server where the user needs to have their password reset. The password reset feature
does not allow the administrator to create a new password for the user, instead it
removes the old password. The next time the user attempts to open a database on the
server, they are asked to create their new password. This process ensures the integrity of
the user's password.  

If you are using external authentication, such as Microsoft Active Directory, user
passwords cannot be reset from the Concordance Desktop Admin Console. User
passwords can only be reset in the Admin Console if Concordance Desktop is the
authentication type.

If you reset an administrator's password, make sure that you tell them they must
open a database, as opposed to the Admin Console, in order to reset their password.
Administrators cannot reset their passwords from the Admin Console log on. 

To reset a user's password:

1. From the File menu click Administration, and then Admin Console, to open the
Admin Console. 

2. Log onto the server where the user needs their password reset. 

3. Click the Management tab.

4. Double-click the Users folder to expand the list of users.

5. Locate and click on the user ID of the user whose password needs to be reset. 
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6. In the user account pane on the right, click Reset Password.

You are asked if you want to reset the user's password.

In the New password and Confirm new password field, type the new user password.

7. Click Yes.

8. Click the Synchronize now button to synchronize the change with all databases on
the server to which the user has access. 

This resets the user's password to be blank. 

The next time the user attempts to open a database on this server, the New
password screen opens. 

Automatically refreshing the users and connections lists

The Auto refresh on button under the Admin Console Management tab allows you to view
who is currently connected to the Concordance Desktop server. For example, when a user
logs on to the server and opens a database, their name displays in bold in the Users folder
on the Management tab. 

The Auto refresh on button under the Admin Console Connections tab also allows you to
view who is currently connected to the Concordance Desktop server, but the Connections
tab displays more details about each user's connection. 

To ensure that the user list and/or connections list is always refreshed, you can turn on
the auto refresh feature. 

To turn auto refresh on/off:

The Auto refresh on button works like a toggle switch to turn on and off the feature.
To turn it on or off for either the User list or the Connections list, click on the
associated tab, and then do one of the following:

· To toggle auto refresh on, click the Auto refresh off button so that it shows "Auto
refresh on." 
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· To toggle auto refresh off, click the Auto refresh on button so that it shows "Auto
refresh off."

There may be a slight delay before the automatic refresh begins. If you to see an
immediate refresh, you can use the Refresh button.

Using the Refresh button to immediately refresh

To immediately refresh a list under the Management tab in the Admin Console:

· Click on the Refresh button at the top of the tree navigation pane. 

Auto refresh does not need to be turned on for the refresh button to do an immediate
refresh, as the refresh button and the Auto refresh on/off toggle work independent of
one another. 

Disabling and re-enabling user accounts

Individual user accounts can be disabled if you need to temporarily prevent a user from
opening databases on a particular Concordance Desktop server. Disabling a user account
does not remove the user from the server, nor does it prevent them from opening
databases on any other Concordance Desktop server where they have a user account. It
simply prevents them from opening any of the databases registered on the server where
their account has been disabled.

To disable a user account:

1. Open the Admin Console on the Concordance Server where the user account
needs to be disabled. 

2. Click the Management tab.

3. Double-click the Users folder to display the list of user accounts on the server.

4. Click on the name of a user to open their user account pane. 

5. Click on the License Type down-arrow and select Disabled from the list. 

The next time the user attempts to open a database on this Concordance Desktop
server, they will not be able to log onto the server. 

 To re-enable a user account:
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1. Open the Admin Console on the Concordance Server where the user account
needs to be re-enabled. 

2. Click the Management tab.

3. Double-click the Users folder to display the list of user accounts on the server.

4. Click on the name of a user to open their user account pane. 

5. Click on the License Type down-arrow and select the license type you need to
assign to them. 

The next time the user attempts to open a database on this Concordance Desktop
server, they will be granted access to the server and the database. 

Limiting user access to a database

When a database is created, all users are automatically assigned to the database through
the "All User Groups" matter, and granted whatever rights are defined in their user
accounts. If you have a database to which you need to restrict access to only a specific
group of users, you can do so by using the associations between matters, databases and
user groups. There are several steps involved when you first setup the associations, but
once it is done, adding and removing users becomes a very simple and manageable task.

If you need to set restricted field rights and menu access for specific users on a specific
database, you can use the following steps to associate the users with the database
through a matter, and then use the User Management feature to set the specific field
rights and menu restrictions for those users in the database. For more details on the User
Management feature, see Restricting user field rights and menu access on databases.

To limit user access to a specific database:

Step 1:  Create a matter

1. Open the Admin Console on the Concordance Desktop server where the
database is registered. 

See Accessing the administration console for instructions on opening the Admin
Console.

2. Click the Management tab. 

3. Right-click on the Matters folder and select New matter.

An empty field appears.
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4. Type a short name for the matter in the field and press Enter. 

The matter information appears in the right-hand pane, where the Name field displays
the name you just entered.

5. Type a longer title or description for the matter in the Description field and
press Enter. 

The matter is now created. 

Next you need to associate the database with the new matter. 

Step 2:  Associate the database with the matter

To associate the database on which you need to limit user access, with the matter
you just created, use a simply drag and drop action.

1. Double-click on the Databases folder to display the list of databases on the
server.

2. Press and hold down the left mouse button on top of the database. 

3. Drag the mouse until it is on top of the matter you just created, then release the
button to drop the database onto the matter. 

The database is now associated with the matter. 

Next you need to create a user group that you can associate to the matter.

Step 3:  Create a user group

To create a user group:

1. Right-click on the User Groups folder and select New usergroup. 

An empty field appears.

2. Type a name for the user group in the field and press Enter. 

3. Type a more descriptive name or description of the user group in the Description
field in the right-hand pane. 

The user group is now created. 

Next you need to assign the user group to the matter associated with the database
in which you want to limit user access.  
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Step 4:  Assign users to the user group

1. If not already visible, double-click on the User Groups folder to display the list of
user groups. 

2. Double-click on the Users folder to display the list of users. 

3. In the Users list, press and hold the mouse button down on a user name.

To select multiple users at once, use CTRL+click or SHIFT+click to select the
names. 

Once they are all highlighted, release the CTRL or SHIFT key - the user names
should remain highlighted. Place the mouse anywhere over the list of highlighted
names and then press down and hold the left mouse button.

4. Drag the mouse until it is on top of the user group you just created, then release
the button to drop the database onto the user group.

This action assigns the selected user(s) to the user group. 

5. Repeat steps 3 and 4 to assign more users to the user group.

6. When finished, click the Synchronize now button. 

The users who need access to the database are now assigned to the new user
group. 

 Next you need to to associate this user group with the same matter with which you
associated the database. 

Step 5:  Associate the user group with the matter

1. Double-click on the Matters folder to display the list of matters.

2. If not already displayed, double-click on the User Groups folder to display the
list of user groups. 

3. Press and hold down the left mouse button on top of the user group to which you
just assigned the users. 

4. Drag the mouse until it is on top of the matter to which the database is
associated, then release the button to drop the user group onto the matter. 

The user group is now associated with the matter. All users in the group will have
access to any databases associated with this same matter. 

The final step is to remove the database from the "All User Groups" matter.
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Step 6:  Remove the database from the "All User Groups" matter

The final step of the process is to remove the database from the "All User Groups"
matter so that all other users on the Concordance Desktop server no longer have
access to the database. 

1. Double-click on the Matters folder to display the list of matters. 

2. Double-click on the "All User Groups" matter to display the list of databases and
user groups associated with it. 

3. Locate the database for which you just created the new matter and user group.

4. Right-click on the database and select Remove Database from matter.

5. You are asked to confirm the removal, click Yes. 

Once the matter, database, and user group are all setup and associated under the
matter, making changes going forward involves only a simple drag and drop action to
add users and a right-click on the user names in the user group to remove users. 

Restricting user field rights and menu access on databases

Users receive access to databases through a specific matter named "All User Groups" to
which all databases and all users are automatically associated. When a user account is
setup, it is automatically added to a specific group named "All Users." The "All Users"group
is automatically assigned to the "All User Groups" matter. Likewise, as a database is
created, it is automatically assigned to the "All User Groups" matter.  It is this assignment
of the databases and the "All Users" group to the "All User Groups" matter that allows all
users to have access to all databases on the Concordance Desktop server. 

In similar fashion, initial field rights and menu access settings to all databases are
controlled through the settings in each user's user account displayed in the Admin
Console. The only exception is when user accounts are added through the migration of a
Concordance 10.x database to Concordance Desktop. 

To further explain:

When adding users through the Admin Console, by default, full rights to fields (read and
write) and full menu access (all menus in each database) are granted to the user.
However, these defaults can be changed if you need to restrict the user's field rights and
menu access rights across all databases. See Restricting user access on databases for
more details.  

When adding users by registering a migrated Concordance 10.x database, user accounts
and rights to the migrated database are carried over from the Concordance 10.x database
and applied to that database in Concordance Desktop. However, for all other databases
on the server, field rights and menu access defaults are used. Therefore, users added
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through migration may have restricted rights, while all other users on the Concordance
Desktop server still have full rights to the migrated database. If you need to restrict user
rights on these migrated databases, you can do so from the User Management screen.
See Restricting user access on databases for more details.  

When adding users through an external domain (such as Active Directory), as with users
manually added in the Admin Console,  the default of full rights to fields (read and write)
and full menu access (all menus in each database) are granted to each user. These
defaults can be changed if you need to restrict a user's field rights and menu access
across all databases. See Restricting user access on databases for more details. 

It is important to note that no matter how users are added to the Concordance Desktop
server, if you need to setup restrictions for a user across all databases, you need to do
so in the user's user account in the Admin Console immediately after their user account
appears in the Admin Console. This is the only way in which to ensure that the restrictions
you setup will be applied to all databases on the Concordance Desktop server. If you
setup restrictions later on, the new settings will only apply to all databases added to the
server from that point forward. 

If you have a need to restrict a user's field rights and menu access settings for a specific
database, you do so from the User Management dialog box in Concordance Desktop. 

If you need to setup the same restricted field and menu access rights to one or more
users across multiple databases, but not all databases, you can setup the restrictions
for each user in one database, and they export the settings to a role template (.csv
file) and import those same user restrictions to those same users on other databases.

When you make changes to user settings in the User Management screen, and the
user currently has the database open on their desktop, the changes are not applied
until the database is closed and reopened by that user. 

To restrict a user's field rights and menu access across all databases:

In  each user's account, you can quickly restrict database field rights and menu
access, which is then applied to all databases when you synchronize the changes with
the databases. The one exception is if the user ID is listed in a Concordance 10.x
database that has been migrated to Concordance Desktop; in which case, the field
rights and menu access settings for that user in that database override whatever
settings are selected in the user's account in the Admin Console.  

To set a user's Field Rights & Menu Type restrictions across all databases, you
must change the default settings when the user is first added to the Concordance
Desktop server. If you change a user's settings later on, the new settings will only
take affect on databases added to the server from that point forward. 
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To set user restrictions for a user across all databases on the Concordance Desktop
server:

1. In Concordance Desktop, click on the Workspace tab to ensure that your focus is
not on a database.

2. From the File menu, click Administration, and then Admin Console.

3. Log onto the server where you need to restrict the user's rights. 

4. Click the Management tab. 

5. Double-click the Users folder. 

6. Click on the user ID of the user for whom you need to apply access restrictions. 

7. Click the Field Rights down-arrow and select whether the user should be able to
read and write to all fields in all databases or just read access. 

8. Click the Menu Type down-arrow and select the user Preset you want to apply for
this user across all databases. 

Menu Type Presets

Menu access rights for each Preset:

Supervisor: User has access to all menus and menu commands. 

Administrator:  User has access to all menus and menu commands except the
Modify, User Management, and Zap menu commands. 

Editor: User does not have access to the menu commands restricted in the
Administrator preset, and does not have access to the following
menu commands: New, Reindex, Index, Pack, Begin program, Edit
program, and the menu commands for data validation. Though
Editors can still search and edit, perform a global edit, load and
unload data, and run reports.

Researcher: User does not have access to the menu commands restricted in the
Administrator and Editor presets, and cannot edit or append, load,
overlay, import data, perform global edits, or unload a copy of the
database's structure.

No Access: User does not have access to any menus or menu commands. User
can only open and exit the database.

9. Repeat steps 6 through 8 for each user you need to set restrictions on. 

10. Click the Synchronize now button to apply the restrictions. 

These restrictions are applied to all databases, except for those in which the user
was added to a Concordance 10.x database that has been migrated to Concordance
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Desktop. In this case, the settings assigned in the database are carried over and
override the settings from the user account in the Admin Console. 

To restrict a user's field rights and menu access on a specific database:

When you make changes to user settings in the User Management dialog box, the
changes are not applied until the database is closed and reopened by the user
whose settings were changed. 

1. In Concordance Desktop, open the database in which you need to set user
restrictions. 

2. From the File menu, click Administration, and then User Management. 

The User Management screen opens. 

3. Click on the user name of the user for whom you need to set restrictions. 

4. To set or modify field rights, click the Field rights tab.

· In the Field list, select the fields to apply or remove field rights. To select
multiple fields, use CTRL+click or SHIFT+click. 

By default, the Full access check box is selected for all fields when you add a
user to the Concordance Desktop server.  

Field right presets

Full access:  Gives users both read/write access to a field. This level of access
for all fields is required for anyone who will be performing
maintenance functions such as, indexing, packing, or a database
modify. If the user does not have full access to the fields,
Concordance Desktop does not either.  

Read only: Gives users the ability to search, browse, and print the field. They
may not edit or otherwise modify read-only fields. Commands such
as Global edit and Load do not display fields which have read-only
access. These fields are displayed in Edit view, but only for
reference or to copy text to the clipboard. 

The Read-only setting for fields in the Data Entry Attributes
dialog box takes precedence over the read-only setting for
fields on the Field rights tab in the User Management dialog
box. 
For example, if the Read only check box is selected for the
OCR1 field in the Data Entry Attributes dialog box, and the
Full access check box is selected for the OCR1 field on the
Field rights tab in the User Management dialog box, the OCR1
field will be read-only for the user in the Edit view. 
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For more information about the Data Entry Attributes dialog
box, see Setting data validation. 

Write only: Give very limited access. Users with write-only field access can
load data into fields using Load, and assign values to them
through the programming language, but they are not able to view
or search these fields. The Edit view does not display write-only
fields and therefore, they cannot be edited. The searches are
post-processed to remove any references to hits in these fields.
The searches may also run slower. 

No rights: Denies all access to the field. Users are not able to search for data
in these fields. Searches are post-processed to remove any
references to hits in these fields. The searches may run slower
and the results may not contain the same count as a search with
read-only field access.

5. To set or change menu access rights, click the Menu access tab, click one of the
menu access preset buttons, and/or manually define the menu and menu command
access for the user in the menu tree. 

By default, new users have full access to all menus and menu commands on the
Menu access tab. 

You can manually select the menu access permissions for each menu, select one of
the menu access presets, or select a preset and then manually customize the menu
permissions for the individual user.

Menu access presets

Menu access rights for each Preset:

Supervisor: User has access to all menus and menu commands. 

Administrator:  User has access to all menus and menu commands except the
Modify, User Management, and Zap menu commands. 

Editor: User does not have access to the menu commands restricted in the
Administrator preset, and does not have access to the following
menu commands: New, Reindex, Index, Pack, Begin program, Edit
program, and the menu commands for data validation. Though
Editors can still search and edit, perform a global edit, load and
unload data, and run reports.

Researcher: User does not have access to the menu commands restricted in the
Administrator and Editor presets, and cannot edit or append, load,
overlay, import data, perform global edits, or unload a copy of the
database's structure.

No Access: User does not have access to any menus or menu commands. User
can only open and exit the database.
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· When a menu or menu command check box is checked, the user has access
to this menu or menu command. 

· When a menu check box is checked but the check box is gray, the user has
access to the menu, but does not have access to some of the menu
command on the menu. 

· When a menu or menu command check box is  not checked (blank), the user
does not have access, and cannot view the menu or menu command in
Concordance Desktop. 

6. Click the Apply button to save the user settings. 

7. Repeat the steps for each user you need to restrict. 

If you are setting up user database restrictions for a new database, and want to
import restricted user settings, including users, from another database, be sure to
import the user management settings before manually defining any restrictions in the
User Management screen.  

When you import user restrictions from a .csv file, the file overwrites all existing
settings previously defined in the User Management screen or in the Admin Console,
for the selected database only. 

Whenever you add or rename a field in the database, by default, full field access
rights are granted to all users. Therefore, if you have renamed a field to which some
users were assigned specific restrictions, you will need to reset those restriction for
those users. If you have created a new field that some users should have limited or
no rights in, you will need to set those user restrictions.

As users are added to the Concordance Desktop server, they are granted administrative
rights across all databases, unless you change their License Type and Menu Type settings
in the Admin Console. Administrative users have access to additional menu options that
other user types cannot access. These additional menu options are described below under
the Administrator default menus section. 

Administrator default menus

Database administrator only - menu commands when focus is on a database tab:

On the File menu, you can access the following Administration commands:

· Admin Console (Server and license management, and user, database, user
group, matter, and client setup and maintenance at the Concordance Desktop
server level)

· Added menu items (Adding custom menus at the database level)

· User Management (Field rights and Menu access at the database level)
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· Pack > Database

· Pack > Dictionary

· Zap

· Imagebase Management (Rename media paths/folder, rename or delete media
keys, export imagebse to OPT format, calculate or update document page count)

· Remove Kashida Characters

· Bulk Field Format Reset

· Concatenate > Edit Concatenation (Add databases to a concatenated set, or
create a concatenated set by adding databases to the currently opened
database. Remove one or more databases from a concatenated set.

· Concatenate > Clear Concatenation (Remove a concatenated set)

Administrator-only menu commands when focus is on the Workspace tab:

On the File menu, you can access the following Administration commands:

· Admin Console (Server and license management, and user, database, user
group, matter, and client setup and maintenance at the Concordance Desktop
server level)

Optional Field and Menu restrictions

There are two options you can implement to prevent users from accessing fields and
menus.

Restricting Field Access

Even if user management is not applied to a database, you can apply read-only
rights to fields in the Data Entry Attributes dialog box. Any field marked as read-only
in this box applies to all database users and also overrides field rights applied in the
user management console.

For more information about the Data Entry Attributes dialog box, see Setting data
validation.

User restriction guidelines for concatenated databases

Setting up user restrictions for concatenated databases includes the following
guidelines:

· User restrictions need to be set up in each database. Setting them in a
concatenated database set only affects the primary database.

· The user name and password must be the same for all databases in the
concatenated set.
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· When the user name and password in the primary database does not exist in a
secondary database, the concatenated database will not open. The user will receive
a message that they do not have access rights to the specific database.

· When a secondary database has user restrictions and the primary database does
not have, the user is prompted for their user name and password when using the
secondary database. The user name and password entered becomes the user name
and password for the concatenated database set.

To export user management settings:

You can export the user management settings from a Concordance Desktop database
and import them into another Concordance Desktop database. When you export
Concordance Desktop user management settings, you are exporting all of the user
access settings, including users, that are defined for the database in the User
Management dialog box. The exported settings can be used to set up a database
template with your user access specifications.

It is best practice to always export a copy of your user access settings each time
you update them so you have a current backup copy to reference. Be sure your
supervisor or secondary database administrator has access to this file in case of
an emergency.

 

1. On the File menu, click Administration, and then User Management.

The User Management dialog box opens.

2. In the Field rights tab, click the Export button.

The Save As dialog box opens.

3. Navigate to where you want to save the exported user access settings file, type
the name of the file in the File name field, make sure that Comma separated file
(*.csv) is selected in the Save as type field, and click Save.

It is best practice to store this file in a separate, secure folder on your network.

Hre is an example of exported user access settings file in a spreadsheet:
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7. Click OK to close the User Management dialog box.

To import user management settings:

You can import the user management settings from one Concordance Desktop database
into another Concordance Desktop database. When you import Concordance Desktop
user management settings, you are importing all of the user access settings, including
users, that were defined  for the database in the User Management dialog box.

The import requires at least one commonly named field between the .csv file and the
database to which the file is being imported. Before importing a .csv file exported from
another Concordance Desktop database, make sure that there is at least one commonly
named field. For example, the user access settings for the DOCTITLE field are exported
to the user management settings .csv file, and the .csv file is being imported into a
database also containing a field named DOCTITLE.

If you are setting up user management, and want to import the user access
settings, including users, from another database, be sure to import the user
access settings before manually defining any user access settings on users in the
database. 

When you import a user management settings CSV file, the file overwrites all
existing user access settings defined in the User Management dialog box. 

1. On the File menu, click Administration, and then User Management.

The User Management dialog box opens.

2. On the Field rights tab, click the Import button.

An Open dialog box opens.

6. Browse to and click the .csv file containing the user management settings you want
to import and click the Open button. 

The user access settings from the file are imported into the database. If there were
any existing user access settings defined in the User Management dialog box, they
are overwritten by the user access settings defined the .csv file during the import. 

7. Click OK to close the User Management dialog box.

Managing User Sessions

From the Connections tab in the Concordance Desktop Admin Console, you can monitor
and manage user activity and time allotments for user sessions. 



Administration 57

The Connections tab displays all users currently connected to the Concordance Desktop
server. Each user’s current status is displayed, along with what database is being
accessed, the start time and duration of the connection, the remaining time before their
allotment expires, the IP address being used, the type of software being used for the
connection (CN = Concordance Desktop), the version of that software, and the type of
license their account is using on the server.  Most users' status displays as idle while they
are logged on.

You can also use the Connections tab to send broadcast messages and disconnect users,
including administrators.

Select the Server side tab to administer user sessions. Select the Administration side tab
to administer the administrator user sessions.

You can define the user connection options for the Concordance Desktop server on the
Connections tab in the Admin Console.
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To set user connection options:

1. Open the Admin Console on the Concordance Desktop server where you need to
set/change user connection options.

2. On the Connections tab, do one of the following:

· Click the Server side tab to set the user connection options for the Concordance
Desktop server.

· Click the Administration side tab to set the user connection options for the
Admin Console.

3. Click the Options button to open the Connection options dialog box.

The Refresh rate field determines how often, in seconds, the user connection list
refreshes on the Connections tab. The Refresh rate field defaults to 3 seconds.

4. In the Refresh rate field, type or scroll to how often you want the list to be
refreshed.

The Idle session timeout field determines how long, in minutes, a session can be idle
before the Concordance Desktop Admin Console automatically closes the session
connection and disconnects the user. The Idle session timeout field defaults to 480
minutes. To disable time-outs, set the Idle session timeout field to 0 minutes.

The Idle session timeout can also be set on the Settings tab in the Concordance
Desktop Admin Console. For more information. see Adjusting time-outs.

5. In the Idle session timeout field, type or scroll to how long a user session can be
idle before the session times out. 

6. Make sure that the Auto refresh button is toggled to on. 

When the Auto refresh function is turned on, user connections list on the
Connections tab will automatically refresh at the rate you specified in the
Connection options dialog box.
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User sessions expire when the software sits idle for the time specified on the Connections
tab. You can manually extend a user session back to the default time-out period, or enter
a zero to disable time-outs.

For more information about defining the default time-out period and disabling time-outs,
see Setting user connection options.

If a user time-out period expires, the Admin Console automatically alerts the server with
an announcement. Users who are logged in, but not actively working in a database, may
risk losing editing updates if you manually kill their session when their user session expires.

For more information about disconnecting users, including soft and hard kills, see
Disconnecting user sessions. 

You can extend user time-outs for users on the server and performing administration tasks
on the Connections tab in the Concordance Desktop Admin Console.

To manually extend user time-outs:

1. On the Connections tab, do one of the following:

· Click the Server side tab to extend a users session on the server.

· Click the Administration side tab to extend a users session in the Admin Console.

2. In the user listing, click the applicable user connections.

To select multiple connections, use SHIFT+click or CTRL+click.

3. Click the Extend button.

Clicking the Extend button resets the session time-out to number of minutes
entered in the Idle session timeout field in the Connection options dialog box, and
updates the time-out minutes displayed in the Expiration column. 

The Idle session timeout can also be set on the Settings tab in the Concordance
Desktop Admin Console. For more information. see Adjusting time-outs.

To alert users that you need to perform administrative tasks and that they need to exit
the application, you can send a broadcast message notifying them of the task and how
much time they have before it occurs. If a user does not respond to the notice, you then
have the option to disconnect them.

You can send broadcast messages to users on the Concordance Desktop server from the
Connections tab in the Admin Console.
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To send a broadcast message:

1. On the Connections tab, do one of the following:

· Click the Server side tab to broadcast a message to users on the Concordance
Desktop server. 

· Click the Administration side tab to broadcast a message to users on the
Concordance Desktop Admin Console server.

2. In the user listing, click the applicable user connections.

To select multiple connections, use SHIFT+click or CTRL+click.

3. Click the Broadcast button to open the Message Broadcast dialog box.

 

4. In Caption field, type a description for the notification.

The Caption field defaults to Concordance Desktop Notification. 

5. In the Body field, type the message you want to broadcast.

6. In the Type field, select the type of message you are broadcasting: 

· Informative 

· Warning 

· Urgent 

7. Click the Send button to broadcast the message to the selected user connections.

The selected users immediately receive a message prompt onscreen with the
content of your message.
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If a user does not respond to a broadcast message to exit the system or you have a need
for users to exit the system immediately, you can manually disconnect them.

You can disconnect user sessions on the server and to the Admin Console from the
Connections tab in the Admin Console.

For more information about time-out settings on the Settings tab, see Adjusting time-
outs. 

If you disconnect a user when they are in the process of clicking on the File menu,
the user will not receive the message that their connection has been terminated.  

To disconnect user sessions:

1. On the Connections tab, do one of the following:

· Click the Server side tab to disconnect user sessions on the server.

· Click the Administration side tab to disconnect user sessions in the Admin
Console. 

2. In the user listing, click the applicable user connections.

To select multiple connections, use SHIFT+click or CTRL+click.

3. Click the  Kill button. 

4. You are asked to confirm that you want to disconnect the user's session, click Yes.
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Clients, Matters and User Groups

In Concordance Desktop, a matter is the focal point for associating users with a database.
 Matters are used to organize and maintain associations between databases and users on
the server.  First you create a matter and associate the database with that matter. Next
you create a "user group" and assign all the users who need to access the database, to
that user group. Last, you associate that user group with the matter with which you have
already associated the database. It is the use of these associations that allows those
users to access that database. Management of user access becomes easier, as
maintaining access is as simple as adding or removing users in the user group. Each user
group can also be associated with multiple matters, allowing the same users access to
different databases simply by adding the user group to a matter that is associated with a
different database.

Concordance Desktop, has an automated association that allows all users to have access
to all databases on a Concordance Desktop server, for those firms in which all users need
access to all databases. This automated association method is the default in Concordance
Desktop. Here's how this automated association works:

· When a database is created on, migrated to, or registered with the Concordance
Desktop server, that database is automatically associated with a special matter named
"All User Groups." 

· When users are added to the Concordance Desktop server, their user account is
automatically added to a special "All Users" user group, which is also automatically
associated with the "All User Groups" special matter. 

It is this association process that allows ALL users with user accounts setup on a
Concordance Desktop server to have access to ALL databases.

The default behavior may be modified by selecting a different user group as the default
user group for all members. 

Clients have a different use. They are used solely for containing all matters that relate to
a single client. For example, if you have multiple matters (cases) that apply to the same
client, you may want to organize those matters under a single "client" name to make it
easier to find all matters associated with that client. 

All these associations are managed from a tree view on the Management tab in the Admin
Console. The tree displays a listing of all Clients, Matters, Databases, User Groups and
Users. From the tree you can visually verify each of the associations. In addition, the tree
view lets you easily manage the databases, users, user groups, matters and clients
directly from the folders in the tree.

· Clients - From the Clients folder you can add, remove, and modify clients, and
associate multiple matters with a client. 

· Matters - From the Matters folder you can add, remove, and modify matters, and
associate databases and user groups.

· Databases - From the Databases folder you can register and unregister databases,
enable databases for FYI Reviewer, and create shortcut (.FYI) files for Concordance
Desktop users. 

· User groups - From the User groups folder you can add, modify and delete user
groups, and assign users to each user group. 
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· Users - From the Users folder you can add, modify, and delete users, insert and
remove domain users, reset passwords for users, and disable user accounts. 

Setting Up Clients, Matters, and Databases Checklist

We recommend that you set up clients and/or matters prior to creating user groups and
registering databases in the Admin Console. This way you can easily associate
databases and user groups with those clients and/or matter. Reference the following
checklist to ensure that you have completed the necessary phases of planning and
implementing clients and/or matters, databases, and user groups.

Checklist: Setting Up Clients and Matters

Pre-planning

Have you created a list for all clients and/or matters, databases, user groups and
users that you need to manage and what matters apply to each of them?

Have you created a list of what databases are associated with each client and/or
matter?

Are you going to migrate/register databases individually or automatically (using the
DB Smart Path folder) for each client and matter?

Will you allow all users to be added to the All Users Group and the all matters to be
added to the All Users Group matter?  If not, have you established a default user
group and modified the Setting in the administration console?

Setup

Did you set up all clients and/or matters and user groups?

Did you already add all users to the Concordance Desktop server?

Did you add users to each of the user groups?

Registering Databases

Did you specify a database administrator?

Did you associate each database with a client and/or matter?

Publishing Databases

Did you remember to save a Database Shortcut (.fyi) file for licensed Concordance
Desktop users to access databases from remote locations?

Did you set up e-mail templates to distribute Database Shortcut (.fyi) files?
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Managing clients

Client folders can be used to keep track of multiple matters. Adding clients is one way to
organize your matters for the clients for whom you host data or for the clients your
organization represents.  Clients are displayed in alphabetical order and can easily be
added or removed, as needed.

Once clients are added, you can drag-and-drop matters to clients or in version 1.07+
click on a client and use the selection box to associate matters with them. 

 

To add a client

1. From the Admin Console, click the Management tab. 

2. Right-click on the Clients folder and select New client.

An empty folder appears.

3. Type a short name for the client in the field and press Enter. 

The client information appears in the right-hand pane, where the Name field displays the
name you just entered.

4. Select the new client.  The client information expands and allows you to type a
longer title or description for the client in the Description field and press Enter. 

The client is now created. 

To delete a client

1. From the Admin Console, click the Management tab.

2. Expand the Clients folder on the left.. 

3. Right-click on the client name that you need to delete, and select Delete client.

4. You are asked to confirm the deletion, click Yes. 

The client is removed from the Clients folder and all associated matters are
disassociated with the client. The matters are not removed, only the association
between the matters and the client are removed. If you need to recreate the client,
you will need to associate the matters with the client again. 

To associate a matter with a client
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In version 1.07+, Matters can be associated with Clients using the drag and drop
method or by selecting the desired matter(s) and adding them to the client.  

1. From the Admin Console, click the Management tab. 

2. Expand Clients and select the desired client with which to associate a matter by
either using the drag and drop method or selecting matters for association. 

Selecting matters for client association in version 1.07+.

Selecting the column header Matter for either Available Matters or Client Matters

will sort the matters in ascending  or descending  order.

3.  After sorting the matters to find your desired matter, do one of the following:

· Select the Matter from the Available Matters column and select Add Matter. 

· Select the Matter from the Available Matters column by clicking the left mouse
button twice. 

4.  The added matter will be removed from the Available Matters column and added
to the Client Matters column. 

Available Matters - lists all Matters registered on the server.
Client Matters - lists all Matters currently added to the selected client.  

If there are more entries in either column (Available User Groups or Matter User
Groups) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes.

To associate a matter with a client using drag and drop

3.  Double-click on the Matters folder to display the list of matters.

4.  Press and hold down the left mouse button on top of the matter you want to
associate with a client. 

5.  Drag the mouse until it is on top of the client, then release the button to drop
the database onto the matter. 

The matter is now associated with the client. 

To see the changes reflect on the menu tree select Refresh .   After adding
all desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and databases.

Removing Matters from a client

To remove matters from the client.  The matters are not deleted, only the
association between the matters and the client is removed.
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Select the client to which you need to remove matters. 

Do one of the following:

· In version 1.07+, select the Matter from the Client Matters column and select
Remove Matter. 

· In version 1.07+, select the Matter from the Client Matters column by clicking the
left mouse button twice. 

· Expand the client to review the associated matters then right click on the matter.
 Select Remove matter from Client.

The selected matter will be removed from the Client Matters Column and added to
the Available Matters column. 

Available Matters - lists all Matters registered on the server.
Client Matters - lists all Matters currently added to the selected client.  

If there are more entries in either column (Available User Groups or Matter User
Groups) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes. 

To see the changes reflect on the menu tree select Refresh .   After adding
all desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and databases.

Managing matters

Matters are used for organizing client cases. Adding matters also helps you manage
databases by topic or case. However, the most important purpose of a matter is to create
an association between a database and the users that need to open that database. In
order for users to access a database on the Concordance Desktop server, both the
database and the users (via a user group), must be associated with a matter. 

We recommend that you outline and create matters so that you can keep track of multiple
databases and the user groups that require access to them. Folders display in alphabetical
order and can easily be added or removed, as needed.

Once matters are added to the Concordance Desktop server, you can associate
databases and user groups to the matters, which will allow the users, assigned to the
associated user group, to open the associated database(s).  

To add a new matter

1. From the Admin Console, click the Management tab. 
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2. Right-click on the Matters folder and select New matter.

An empty field appears.

3. Type a short name for the matter in the field and press Enter. 

4.   Double click the newly created matter and the matter information appears in the

right-hand pane, where the Name field displays the name you just entered.  Type a
longer title or description for the matter in the Description field and press Enter. 

You can  now associate a database and user group to the matter, so that the users in
the user group have the ability to open the database. 

To delete a matter

1. From the Admin Console, click the Management tab.

2. Expand the Matters folder on the left to display the list of matters.

3. Right-click the matter you want to delete and select Delete matter. 

4. You are asked to confirm the deletion, click Yes. 

Deleting a matter removes it from the Concordance Desktop server and any associated
clients. Once you delete a matter, if you need to recreate the matter, you need to
associate the matter to the applicable clients, databases, and user groups again.

Deleting a matter from the Matters folder, removes the matter from the Concordance
Desktop server and any associated client, databases, and user groups. When a matter
is removed from a client in the Clients folder, the matter is only deleted from the
selected client. The associated database(s) and user group(s) are not affected.  

If you delete the "All User Groups" matter, it prevents ALL users from accessing
ALL databases on the Concordance Desktop server. For this reason, we
recommend that you do not delete this matter and user group unless you plan to
create a matter and user group for every database on the server, and then
associate the appropriate databases and user groups with the various matters. 

To associate a database with a matter

1. From the Admin Console, click the Management tab. 

2. Expand Matters and select the desired matter with which to associate a database
then either use the drag and drop method or database selection. 

Selecting databases for matter association.
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Selecting the column header Database for either Available Databases or Matter

Databases will sort the databases in ascending  or descending
 order.

In version 1.07+, databases can be associated with matters by selecting the desired
database(s), and adding them to the matter.  

3.  Select the Databases tab to change from the User Groups selection screen.

4.  After sorting the databases to find your desired database, do one of the
following:

· Select the database from the Available Databases column and select Add. 

· Select the database from the Available Databases column by clicking the left
mouse button twice. 

5.  The added database will be removed from the Available Databases column and
added to the Matter Databases column. 

Available Databases - lists all databases registered on the server.
Matter Databases - lists all databases currently added to the selected matter.  

If there are more entries in either column (Available Databases or Matter
Databases) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes.

Drag and drop database association method.

1. Double-click on the Databases folder to display the list of databases on the
server.

2. Press and hold down the left mouse button on top of the database you want to
associate with a matter. 

3. Drag the mouse until it is on top of the matter, then release the button to drop
the database onto the matter. 

The database is now associated with the matter. 

To see the changes reflect on the menu tree select Refresh .   After adding all
desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and databases.

To Insert a database in a matter

1. From the Admin Console, click the Management tab. 

2. Expand Matters and select the desired matter with which to add a database.
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3. Right click and select Insert database.

4. A new folder is created.  

5. Type the database name and hit Enter.

6. A new window opens for browsing to the database that you would like to add.

7. Browse out to the database.dcb and select Open. 

8. The database will be added to the server and the matter.

To remove a database from a matter

To remove databases from the matter.  The databases are not deleted, only the
association between the database and the matter is removed.

Select the matter to which you need to remove database. 

Do one of the following:

· In version 1.07+, select the database from the Matter Databases column and select
Remove. 

· In version 1.07+, select the database from the Matter Databases column by clicking
the left mouse button twice. 

· Expand the matter to review the associated databases then right click on the
database.  Select Remove Database from matter.

The selected database will be removed from the Matter Databases Column and added
to the Available Databases column. 

Available Databases - lists all databases registered on the server.
Matter Databases - lists all databases currently added to the selected matter.  

If there are more entries in either column (Available Databases or Matter
Databases) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes.

To see the changes reflect on the menu tree select Refresh .   After adding all
desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and databases.

To associate a user group with a matter

1. From the Admin Console, click the Management tab. 

2. Double-click on the Matters folder to display the list of matters.
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3. Select the desired matter with which to associate a user group then either use the
drag and drop method or database selection. 

Selecting user groups for matter association

Selecting the column header Usergroup for either Available User Groups or

Matter User Groups will sort the databases in ascending  or

descending  order.

In version 1.07+, user groups can be associated with Matters by selecting the
desired user group(s), and adding them to the matter. 

4.  Select the User Groups tab to change from the Databases selection screen. 

5.  After sorting the user groups to find your desired user group, do one of the
following:

· Select the user group from the Available User Groups column then select Add. 

· Select the user group from the Available User Groups column by clicking the left
mouse button twice. 

6.  The added user group will be removed from the Available User Groups Column
and added to the Matter User Groups column. 

Available User Groups - lists all User Groups registered on the server.
Matter User Groups - lists all User Groups currently added to the selected
matter.  

If there are more entries in either column (Available User Groups or Matter User
Groups) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes. 

Drag and drop user group association method.

4.  If not already displayed, double-click on the User Groups folder to display the
list of user groups. 

5.  Press and hold down the left mouse button on top of the user group. 

6.  Drag the mouse until it is on top of the matter, then release the button to drop
the user group onto the matter. 

The user group is now associated with the matter. All users in the group will have
access to any databases associated with this same matter. 

To see the changes reflect on the menu tree select Refresh .   After adding all
desired user groups to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and user groups.
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To remove a user group from a matter

To remove user groups from the matter.  The user groups are not deleted, only the
association between the user group and the matter is removed.

Select the matter to which you need to remove user group. 

Do one of the following:

· In version 1.07+, select the user group from the Matter User Groups column and
select Remove. 

· In version 1.07+, select the user group from the Matter User Groups column by
clicking the left mouse button twice. 

· Expand the matter to review the associated user group(s) then right click on the user
group.  Select Remove Usergroup from matter.

The selected user group will be removed from the Matter User Groups Column and
added to the Available User Groups column. 

Available User Groups - lists all user groups registered on the server.
Matter User Groups - lists all user groups currently added to the selected matter.  

If there are more entries in either column (Available User Groups or Matter User
Groups) than can be displayed at once, then a scroll bar will be displayed for
scrolling purposes.

To see the changes reflect on the menu tree select Refresh .   After adding all
desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and user groups.

Managing user groups

User groups are used to group users together who require access to the same
database(s). User groups are required if you want to grant user access to a database, as
users cannot be added to a database, nor to a matter to which the database is
associated. 

The user group can be associated with a matter to which a database is associated,
allowing the users of the user group to open that database. See Managing matters for
more information.

To add a user group
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1. From the Admin Console, click the Management tab. 

2. Right-click on the User Groups folder and select New usergroup. 

An empty folder appears.

3. Type a name for the user group in the field and press Enter. 

The user group is now created. 

Next you need to assign the users to the user group.  

To delete a user group

Deleting a user group removes it from the Concordance Desktop server and removes
any associations it has to any matters. Once you delete a user group, if you need to
recreate it, you need to associate it with at least one matter to allow users of the
group to open any database that is associated with that matter.

1. From the Admin Console, click the Management tab.

2. Expand the User Groups folder on the left to display the list of matters.

3. Right-click the user group you want to delete and select Delete usergroup. 

4. You are asked to confirm the deletion, click Yes. 

If you delete the "All Users" user group or remove it from the "All User Groups"
matter, it prevents ALL users from accessing ALL databases on the Concordance
Desktop server. For this reason, we recommend that you do not delete this matter
and user group unless you plan to create a matter and user group for every
database on the server, and then associate the appropriate databases and user
groups with the various matters. 

To assign users to a user group

1. If not already visible, double-click on the User Groups folder to display the list of
user groups. 

2. Select the newly created User Group.  You can type a more descriptive name or
description of the user group in the Description field in the right-hand pane. 

3. Add a user or users to the User Group by either using the drag and drop method or
user selection. 

To add users by user selection

Selecting the column header User for either Available Users or User Group User

will sort the users in ascending  or descending  order.  The
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users can also be sorted by email address using the column header eMail in

ascending  or descending  order.

In version 1.07+, users can be associated with User Groups by selecting the desired
user(s), and adding them to the user group.  

4.  After sorting the users to find your desired user, do one of the following:

· Select the user from the Available Users column and select Add. 

· Select the user from the Available Users column by clicking the left mouse button
twice. 

5.  The added user will be removed from the Available Users column and added to the
User Group Users column. 

Available users - lists all users registered on the server.
User Group Users - lists all users currently added to the selected user group.  

If there are more entries in either column (Available Users or User Group Users)
than can be displayed at once, then a scroll bar will be displayed for scrolling
purposes.

To add users by drag and drop

1. Double-click on the Users folder to display the list of users. 

2. In the Users list, press and hold the mouse button down on a user name.

To select multiple users at once, use CTRL+click or SHIFT+click to select the
names.

Once they are all highlighted, release the CTRL or SHIFT key - the user names
should remain highlighted. Place the mouse anywhere over the list of highlighted
names and then press down and hold the left mouse button.

3. Drag the mouse until it is on top of the user group you just created, then release
the button to drop the database onto the user group.

This action assigns the selected user(s) to the user group. 

4. Repeat steps 3 and 4 to assign more users to the user group.

To see the changes reflect on the menu tree select Refresh .   After adding all
desired databases to the matters, select Synchronize now  from the
Management tool bar to update the changes in the matters and databases.
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Monitoring Server Status

About monitoring server status

The overall status of the server can be monitored from the Server tab in the Admin
Console. You can also stop and start the server, and set server options from the Server
tab.

The Server tab allows you to instantly view the following:

· Current CPU load percentage

· Amount of memory being used

· Number of users currently logged on to the server

· Amount of server traffic (received and transmitted in bites per second)

· Amount of disk memory being used by processes

Each bar graph displays color indicating how resources are currently being used. Green in
a bar graph indicates resources used by the server itself. Blue in a bar graph indicates
overall resources used by the operating system. The lower portion of the Server tab
displays the usage for the past 24 hours, with the latest information on the far right.
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Click on a bar graph to change it to a line graph and toggle to change the graph
views.

Starting and stopping a server

You can start and stop a Concordance Desktop server from the Server tab in the Admin
Console. 

Before stopping a server, we strongly advise sending a broadcast message to any
users with live connections, as stopping the server closes all their connections and
they lose any work done in databases. For more information about broadcast
messages, see Sending broadcast messages.

 

If you stop the server from the Server tab of the Admin Console, you must click the
Start button to restart the watchdog services. They will not restart automatically.

If you manually stop the Server and Admin services from Windows Task Manager,
when you restart the services (from Windows Task Manager), always start the Server
(Concordance Server) service before starting the Admin (Concordance Admin Server)
service. 

 

To stop the server:

1. Log onto the Admin Console on the Concordance Desktop server you need to
stop. 

2. On the Server tab, click the Stop button. 

3. You are asked to confirm the stop, click Yes.

To start the server:

1. Log onto the Admin Console on the Concordance Desktop server you need to
stop. 

2. On the Server tab, click the Start button. 

The server starts. 

If you manually stop the services through Windows Task Manager, always start the
Server service (Concordance Server) before starting the Administration Console
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service (Concordance Admin Server).

Setting the refresh rate

You can adjust the refresh rate for a Concordance Desktop server status graphs on the
Server tab in the Admin Console, allowing you to control the number of seconds between
updates.

To refresh the graphs on the Server tab:

1. Log onto the Admin Console on the Concordance Desktop server where you want
to set the refresh rate. 

2. Click the Server tab. 

3. Click the Options button to open the Server options dialog box.

The Automatic refresh check box determines whether the graphs on the Server tab
are automatically refreshed. The Automatic refresh field determines how often, in
seconds, the status graphs refresh on the Server tab. The Automatic refresh field
defaults to 3 seconds.

4. Select the Automatic refresh check box, and type or scroll to how often you want
the graphs to be refreshed.

5. Click OK to save the settings.
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Setting watchdog services

In the event that a Concordance Desktop server stops for any reason, you can set
watchdog services to automatically restart the server and admin console services. When
the watchdog services are enabled, the watchdog service can send an e-mail alert to the
Concordance Desktop administrator when it restarts services.

We recommend that you enable both the Concordance Desktop server and Admin Console
watchdog services. You can enable and disable watchdog services on the Server tab in
the Concordance Desktop Admin Console. By default, the watchdog services are enabled
for both servers. 

For more information about setting up watchdog e-mail messages, see Adding
administration accounts to the server. 

 

If you stop the services from the Server tab of the Admin Console, you must click the
Start button in the Admin Console Server tab to restart the services. They will not
restart automatically.

 

To enable watchdog restart services:

1. On the Server tab, click the Options button to open the Server options dialog
box.

2. Select the CNServer check box to enable the server watchdog service.

3. Select the CNSAdmin check box to enable the Admin Server watchdog service.

If you need to disable the watchdog services, clear the check box for the applicable
server.

4. Click OK to save the settings.
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Applying Advanced Server Settings

About applying advanced server settings

You can adjust server settings, including memory cache usage, indexing performance
limitations, and server port addresses, for the both the Concordance Desktop Admin
Console Server on the Settings tab. ..

Before making any changes to the server settings, we recommend you read all topics
in this module. Adjustments to the server settings can affect user access and server
performance.

 

Server settings include:

· Server listening port address

· Session idle and shutdown time-outs

· Indexing

· Email notifications

· SMTP options

· Registration directory

· Snapshot path
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· Authentication type selection

Admin Console settings include:

· Server port address

· Idle session and disconnected time-outs

At the bottom of the tab, you can click the Apply button to save all changes made
since the last time they were saved, and you can click the Revert button to undo all
changes made since the last time they were saved.

Adjusting port settings

Ports for users and administrators are set during the activation of a Server license on a
Concordance Desktop installation. Typically, default settings are accepted during
installation and are later adjusted as needed on the Settings tab. You can, however,
select any port your network needs.

Port defaults include:

· Port 443 - is used by the Concordance Desktop server to connect with registered
databases. This default port is selected because it’s commonly left open for use with
SSL connections.

· Port 10001 - is used by the Concordance Desktop Admin Console to manage the
Concordance Desktop server. This default port is selected because it’s not commonly
used and unlikely to conflict with other services.

To lookup the host name (computer name), open a command prompt, type
ipconfig /all, and press Enter. 

If you change the default ports for the Admin Console, you need to stop and then
restart the Concordance Admin Server service from the Windows 'Services' window,
for the change to take affect. To get to the Services window in Windows 7 click
Start > Control Panel. In the Control Panel window click the Administrative Tools link.
From Administrative Tools, double-click on the Services icon in the right pane. 

Considerations for changing the port address:

· Port address changes are immediate

· Send a broadcast announcement to affected users before modifying the port address

· Will not log out currently connected users until services are restarted

· Will invalidate any previously distributed shortcut ( .fyi) files for Concordance Desktop
users. The shortcut .fyi) file needs to be recreated and redistributed to users.
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To modify the Concordance Desktop server port address:

1. Before changing the server's port address, send a broadcast message to inform
users of the port change and that the server will be restarted for this process.
Inform users they need to save their work and exit the application.

For more information about broadcast messages, see Sending broadcast messages.

2. Log onto the Admin Console on the Concordance Desktop server where you need
to change the port address.

3. Click the Settings tab.

4. In the Server Settings section, click the port number in the Listening port row,
and type or scroll to the new port number.

5. Click Apply to save your settings.

6. Click Yes to confirm the change.

7. Stop and restart the server.

To restart the server

Click the Server tab. 

Click the Stop button at the top of the Server pane.

You are asked to confirm the stop, click Yes. The server is stopped. Now you
need to start the server.

Click the Start button. The server restarts. 

For more information, see Starting and stopping a server

When you change the server port address, all users are disconnected when the
server is restarted. The users receive a message stating that their server
connection was dropped. 

8. Remind users to enter the new port number the next time they attempt to open a
database on the server. 

9. For Concordance Desktop shortcut (.fyi) file users, create and distribute a new
shortcut (.fyi) file. 

The previously distributed shortcut ( .fyi) file references the old port address, so the file
can no longer be opened in Concordance Desktop. For more information about creating
and distributing shortcut (.fyi) files, see Creating shortcut (.fyi) files and Distributing the
shortcut (.fyi) file to users.

To change the Admin Console port address:
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1. Before changing the Admin Console port address, send a broadcast message to
inform users of the port change and that the server will be restarted for this
process. Inform users they need to save their work and exit the application.

For more information about broadcast messages, see Sending broadcast messages.

2. Click the Settings tab.

3. In the Administration Console Server Settings section, click the port number in
the Listening port row, and type or scroll to the new port number.

4. Click Apply to save your settings.

5. Click Yes to confirm the change.

6. Stop and restart the Concordance Desktop server.

For more information on stopping and restarting the server, see Starting and
stopping the Concordance Desktop server. 

When the Admin Console port address is changed and you restart the server, all
server users and any administrator user connections, except for the one you are
using, will be disconnected.

7. Remind users to enter the new port number in the Port field on the Connect tab in the

Concordance Desktop Admin Console the next time they log on. 

Adjusting time-outs

On the Server tab, you can adjust the following time-out settings:

Idle session

The Idle session timeout feature allows you to set the number of minutes the
Concordance Desktop server and/or Admin Console allows a session to sit idle before
closing the connection and disconnecting the user. When a user's connection status on
the Connections tab in the Concordance Desktop Admin Console displays as Idle, the
user is typically editing or reviewing records in Concordance Desktop .FYI, or working in
the Concordance Desktop Admin Console.

The Idle session time-out feature can be set on the Settings and Connections tabs in
the Concordance Desktop Admin Console. For more information about modifying the
setting on the Connections tab, see Setting user connection options.

The idle session timeout does not apply when a user is running a production or
print job associated with the Concordance Viewer so that these jobs are allowed
to run to completion.
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Shutdown

You can adjust the number of seconds the Concordance Desktop server waits before
ending a session in FYI Reviewer or Concordance Desktop .FYI by changing the
Shutdown timeout (in seconds) setting on the Settings tab. Sessions are ended when
Concordance Desktop server services are stopped/restarted on the Server tab or when
an individual user session is disconnected on the Connections tab. When a user’s
session ends, Concordance Desktop server first attempts a soft kill, which sends a
message to the server requesting it to close all files, save data, and end the user's
session. Soft kills do not save data currently being edited by the client.

If a time-out occurs while a user is performing a long-term process, such as
packing, indexing, or running a CPL, possible database corruption may occur.

Disconnect

You can adjust the number of seconds the Concordance Desktop server waits before
disconnecting users' connections to the Concordance Desktop Admin Console by
changing the Disconnected timeout (in seconds) setting on the Settings tab. Sessions
are ended when Concordance Desktop server services are stopped/restarted on the
Server tab or when an individual user session is disconnected on the Connections tab.
When a user’s session ends, Concordance Desktop server first attempts a soft kill,
which sends a message to the server requesting it to close all files, save data, and end
the user's session. Soft kills do not save data currently being edited by the client.

If a time-out occurs while a user is performing a long-term process, such as
packing, indexing, or running a CPL, possible database corruption may occur.

For more information about starting and stopping the Concordance Desktop server, see
Starting and stopping Concordance Desktop server.

For more information about broadcast messages and disconnecting sessions, see Sending
broadcast messages and  Disconnecting user sessions.

To modify the idle session time-out setting on the Server tab:

1. Click the Settings tab.

2. Do any of the following:

· To modify the time-out for the Concordance Desktop server, in the Server
Settings section, click the time-out minutes in the Idle session timeout (in
minutes) row, and type or scroll to the number of minutes a user session can be
idle before the session times out. 
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· To modify the time-out for the FYI Administration Console Server, in the
Administration Console Server Settings section, click the time-out minutes in
the Idle session timeout (in minutes) row, and type or scroll to the number of
minutes a user session can be idle before the session times out.

The Idle session timeout (in minutes) setting defaults to 480 minutes. To disable
time-outs, set the Idle session timeout (in minutes) field to 0 minutes.

3. Click Apply to save your settings.

To modify the shutdown time-out setting:

1. Click the Settings tab.

2. In the Server Settings section, click the time-out seconds in the Shutdown
timeout (in seconds) row, and type or scroll to the number of seconds
Concordance Desktop server waits before ending a session in FYI Reviewer or
Concordance Desktop .FYI. 

The Shutdown timeout (in seconds) setting defaults to 30 seconds. We recommend
a shutdown of 4 minutes (240 seconds) for FYI Reviewer users, allowing them to
save their work and exit the application.

3. Click Apply to save your settings.

To modify the disconnected time-out setting:

1. Click the Settings tab.

2. In the Administration Console Server Settings section, click the time-out
seconds in the Disconnected timeout (in seconds) row, and type or scroll to the
number of seconds Concordance Desktop server waits before disconnecting users'
connections to the Concordance Desktop Admin Console.

The Disconnected timeout (in seconds) setting defaults to 0 seconds. When
Disconnected timeout (in seconds) is set to 0, the setting is disabled. We
recommend a shutdown of at least 30 seconds for Concordance Desktop Admin
Console users. One second is the minimum accepted value.

3. Click Apply to save your settings.

Adjusting indexing settings

Indexing settings affect performance and capacity. We recommend that you read the
entire topic before making any changes.

In the Admin Console under the Settings tab, you can adjust the amount of memory the
server uses for indexing. Indexing cache memory is only used during the indexing and
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reindexing process, then the memory is released back to the operating system when
indexing is complete.

Large memory allocations index databases faster. However, it is important to consider how
many clients or users will index or reindex a database at the same time. Do not over-
commit memory to indexing instances.

To calculate the indexing cache:

We recommend you leave at least 512 MB of RAM free and allow the rest to be used by
indexing when needed. To calculate the indexing cache, take the amount of memory
you have available, subtract 512 MB, and divide the remainder by the number of users
you will allow to index at one time. Use that number for the Indexing cache (MB)
setting. 

Set the maximum number of users allowed to index concurrently in the Maximum
indexing instances setting. Indexing is processor intensive. We recommend that you
allow only one indexing process per processor, reserving the additional processor for
general purposes. Count each Xeon or Pentium HT processor as two processors. For
instance, if you have dual Xeon server with 2GB of RAM, you could set the Maximum
indexing instances setting to 3 and the Indexing cache setting to 512 MB. If you want
to allocate more memory to the index cache for faster performance, then lower the
number of indexing instances to avoid over-committing memory.

To modify the indexing cache and instances:

1. Click the Settings tab.

2. In the Server Settings section under Indexing settings, click the megabytes in
the Indexing cache (MB) row, and type or scroll to the indexing cache that you
calculated in megabytes. 

3. The Indexing cache (MB) setting defaults to 128 MB.

The Maximum indexing instances setting controls the number of simultaneous
indexing processes allowed. The number of  instances entered for this setting should
be low to ensure processing is done on the server.

4. In the Maximum indexing instances row, click the number and instances, and
type or scroll to the new number of instances.

5. Click Apply to save your settings.

If two users are concurrently indexing, the allocated indexing cache is per user. For
example, if the Indexing cache (MB) is set to 679 MB, both users are allocated 679
MB of cache.
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Adjusting dictionary cache settings

The Dictionary cache (MB) setting controls the amount of memory the dictionary cache
uses to process list files. We recommend a dictionary cache setting of 32 MB for the
Concordance Desktop server. A server allocation smaller than 32 MB can cause contention
between client sessions. 

Dictionary Cache is used to process list files including:

· Database dictionary

· Database key file

· Stopword files

· Files for spell checking

· Miscellaneous .LST files

· Security files

· Password files

 

To modify the dictionary cache size:

1. Click the Settings tab.

2. In the Server Settings section under Indexing settings, click the megabytes in
the Dictionary cache (MB) row, and type or scroll to the dictionary cache size you
want to use in megabytes.

The Dictionary cache (MB) setting defaults to 32 MB.

3. Click Apply to save your settings.

Setting up email notifications

As the administrator of the Concordance Desktop server, you may want to be notified via
email when there are issues concerning the Concordance Desktop server. In order to
receive notification, you need to setup your email address, and the issues for which you
would like to receive email notifications.
 

You need to also setup SMTP Options in order for the notification to be sent. In
addition, you must have an email client installed on the server in order to send
notifications.
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To setup email notification:

1. Open the Admin Console.

2. Click the Setting tab.

3. Double-click on Email Notifications to expand it.

4. Type your email address, or whatever address you want notification to be sent, in
the Email field. 

To receive specific types of notifications, you need to set the notification to Yes. 

5. Click on the field of the type of notification you want to receive, and then click
Yes.

6. Repeat step 5 for each notification you want to receive. 

7. Ensure that No is selected for those notifications that you do not want to receive. 

You must now setup your SMTP Options so that the notification can be sent from the
server. 

Setting up SMTP options

In order for the Concordance Desktop server to send out notifications to administrators
and users, you need to have an SMTP client (email client) setup on the server, and you
need to define the SMTP Options in the Concordance Desktop Admin Console, so that the
Concordance server can send the notifications via email.  

 

You must have an email client installed on the server in order to send notifications.

If you are an administrator and would like to receive notifications (Watchdog notifications)
when specific issues arise with the Concordance server, you also need to  setup your
email address and types of notifications.

To setup the SMTP Options:

1. Open the Admin Console.

2. Click the Settings tab. 

3. Double-click on SMTP Options to expand it. 

4. Type your SMTP server name in the SMTP Server field.
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5. Type the port number your SMTP Server uses into the SMTP Server Port field.

6. In the Author Of E-mail field, type the name of the person whose name you want
to appear in the signature of the email message.

7. In the Reply To E-mail, type the email address of the person whose name you
want to appear in the FROM box. 

Usually this will be the email address of the person whose name you entered above. 

Changing the default Registration Directory

The Registration Directory is a special directory you can designate in the Admin Console,
that allows you to automatically migrate and register existing Concordance 10.x SQLite
databases on the Concordance Desktop server. When you place a folder, that contains all
the files for a Concordance 10.x SQLite database, into the designated  "Registration
Directory," the database is automatically migrated and registered on the Concordance
Desktop server when Concordance Desktop is run on that server. The "Registration
Directory" can be any directory on the server computer, even a directory that contains all
your current Concordance 10.x SQLite databases. Only one Registration Directory can be
designated per Concordance Desktop server. By default, a directory is already setup for
you named DB Smart Path, but you can the default to any directory you want to use. The
default directory is located in the server computer's ProgramData folder (usually C:
\ProgramData\CloudNine\Concordance Desktop\DB Smart Path). If you decide to keep the
default directory, you will need to move your database folders into the DB Smart Path
default directory to have the database migrated and automatically registered on the
Concordance Desktop server. See Migrating databases for instructions on moving
database folders to the Registration Directory.

We recommend that you setup the Registration Directory at the server's root, or as
close to the root folder as possible, as there is a path and file name limitation that if
exceeded, can prevent users from being able to open files in the viewer.

Only one Registration Directory can be designated per Concordance Desktop server.

To change the default Registration Directory:

1. Open the Admin Console. 

2. Click the Settings tab.

3. Double-click on Registration Directory to expand it. 

4. Click in the field to display the Browse (ellipses) button.
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The Select the DB Smart Path (Registration Directory) window opens.

5. Navigate to the location of the directory that you want to setup as the automatic
database migration and registration directory.

6. Click on the directory name to select it. This action places the name in the File
name field. 

Before clicking OK, please ensure that the directory path and folder name for the
Registration Directory does not include special characters such as %, &, #, etc.,
as special characters are not supported.  

7. Click OK.

Setting the snapshot path

The Snapshot path setting is the directory location where you want .snp files to be stored
on the Concordance Desktop server. We recommend this setting always be on the
database server’s C:\ drive.

With the Snapshot path setting enabled for users, each time a user exits the application,
a snapshot of the session is automatically taken. Snapshot files allow users to restart a
session from where they left off.

Users can also save snapshots of their session at any time. A shortcut file is saved on
their local computer and the snapshot file is saved on the Concordance Desktop
server, as specified in the Snapshot path setting. Snapshots can only be restored in
the original database.

For more information about snapshots in Concordance Desktop, see Saving and restoring
snapshots  in the Using Concordance Desktop module.

Ensure that the snapshot path is no longer than 256 characters. This includes
whatever name is given to a snapshot, so make sure you account for snapshot file
names.

To set up the snapshot path:

1. Click the Settings tab.

2. In the Server Settings section, click the snapshot directory in the Snapshot path
row.
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3. Click the ellipsis (...) button to open the Select a folder that will contain the
Snapshot files dialog box. 

4. Navigate to and select the folder where you want to store the snapshot .snp files,
and then click OK.

This location should be on the Concordance Desktop server's C:\ drive. 

Clicking OK adds the directory path to the Snapshot path row.

5. Click Apply to save your settings.

6. Check the snapshot directory occasionally to delete old and unused snapshot files.

 You can also schedule a job on the Jobs tab to automatically delete old
snapshots. For more information about scheduling jobs, see Adding and managing
jobs.

 

Setting the authentication type

Although there are four options in the Authentication type list, these can be divided into
two categories: Concordance Desktop security and external authentication through
Microsoft Windows (depending on your version of Microsoft Windows Server). In choosing
external authentication, you gain the use of policies, including but not limited to password
expiration, renewal, and format.

When the authentication type is external to Concordance Desktop, such as Microsoft
Active Directory, the Concordance Desktop server uses the external authentication logon
name to determine the user's Concordance Desktop database rights, field rights, and menu
security. If the user's external authentication logon name is not added to the
Concordance Desktop database, the user will not have access to the database.

Dual authentication, authenticating users against more than one server, can only be
set for a maximum of two Active Directory LDAP servers.  The Auxiliary authentication
server setting is not available for the External by Domain or External by NT Server
options.

When authenticating users against an Active Directory server in a domain other than
where FYI Sever is located, make sure that the Concordance Desktop server is
running on Windows Server 2008 R2.

If a database administrator account is specified on the Management tab in the
Concordance Desktop Admin Console, the Concordance Desktop server then copies the
users from Concordance Desktop and adds them to the Concordance Desktop Admin
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Console for that specific database. This allows you to use external security to set
password policies, including expiration, renewal, and format.

Before changing the authentication type to an external method, check the
Concordance Desktop databases and add user names and rights as needed.

For more information about authentication types, see About setting up user security.

To set the authentication type to Concordance Desktop:

1. Click the Settings tab.

2. In the Server Settings section, click the authentication type in the
Authentication type row.

3. Click the arrow to open the authentication type list, and click Concordance
Desktop.

When Concordance Desktop is selected, Concordance Desktop server uses the a
Concordance Desktop database's .sec file to authenticate users.

4. Click Apply to save your settings.

5. Remember to adjust port settings as specified for each authentication type, and
update IP addresses if they change.

To set the authentication type to External by domain:

1. Click the Settings tab.

2. In the Server Settings section, click the authentication type in the
Authentication type row.

3. Click the arrow to open the authentication type list, and click External by domain.

When External by domain is selected, Concordance Desktop server allows for user
authentication against an NT domain controller without an Active Directory.

4. Click in the Authentication server row below External by domain, and type the
authentication server name, such as a company or work group name (.com or IP
address entries are not acceptable).

5. Click Apply to save your settings.

6. Remember to adjust port settings as specified for each authentication type, and
update IP addresses if they change.
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External by domain authentication typically requires use of several ports: 137 TCP,
138 UDP, 139 TCP, and 445 TCP. Ensure that your firewall is not blocking these
ports.

To set the authentication type to External by NT Server:

1. Click the Settings tab.

2. In the Server Settings section, click the authentication type in the
Authentication type row.

3. Click the arrow to open the authentication type list, and click External by NT
Server.

When External by NT Server is selected, Concordance Desktop server allows for
user authentication against a stand alone server (member server).

A member server is a server that meets all of the following requirements:

· The server is running a Microsoft Windows 2008 R2 Server operating system

· The server is part of a domain

· The server is not a domain controller 

4. Click in the Authentication server row below External by NT Server, and type
the authentication server name, such as mypdc.company.com or an IP address.

5. Click Apply to save your settings.

6. Remember to adjust port settings as specified for each authentication type, and
update IP addresses if they change.

The port addresses typically required by External by NT Server authentication
include: 137 TCP, 138 UDP, 139 TCP, and 445 TCP. Ensure that your firewall is not
blocking these ports.

To set the authentication type to External by Active Directory LDAP:

1. Click the Settings tab.

2. In the Server Settings section, click the authentication type in the
Authentication type row.

3. Click the arrow to open the authentication type list, and click External by Active
Directory LDAP.

When External by Active Directory LDAP is selected, Concordance Desktop server
uses Microsoft Windows Active Directory to authenticate users.
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4. Click in the Authentication server row below External by Active Directory LDAP,
and type the authentication server name or an IP address.

5. (Optional) Click in the Auxiliary authentication server row to set a second
authentication server, and type the authentication server name or an IP address. 

When authenticating against an internal and an external domain, make sure
that the same username does not appear in both domains.

6. Click Apply to save your settings.

7. Remember to adjust port settings as specified for each authentication type, and
update IP addresses if they change.

The firewall ports that need to be open for Active Directory include: 389 (LDAP,)
636 (secure LDAP,) and NetBIOS ports for the change password feature.

If both the LDAP and Auxiliary server options are set, both server names are
displayed when using the Insert Domain Users option for the Users tab in the
Concordance Desktop Admin Console.

Selecting a matter for new database registration

In Concordance Desktop, matters are used for organizing client cases and serve as the
focal point for associating users with registered databases. In order for users to access a
database on the Concordance Desktop server, both the database and the users (via a
user group), must be associated with a matter. 

With Concordance Desktop, we have also created an automated association that allows all
users to have access to all databases on a Concordance Desktop server, for those firms in
which all users need access to all databases. This automated association method is the
default in Concordance Desktop, since most firms using the product prefer to allow all their
users access to all of the databases. 

You can change the  default matter for new database registration in the admin console to
prevent newly registered matters from being automatically accessible by all users.

To choose a different default matter for new database registration:

1. Click the Settings tab.

2. In the Database Administration Settings section, click the Selected Matter for
new database registration row.
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3. Click the arrow to open the list of available matters.

Matters must be created prior to selecting them from the list. For more information
about creating matters, see Creating Matters.

4. Select the desired matter.

5. Click Apply to save your settings.

Authenticating Admin Console Users

The option to authenticate users that are logging into the Admin Console is now built into
Concordance Desktop. When the option is set to NO, administrators will be able to log into
the Admin Console from the Concordance Desktop Server without using a password. When
the option is set to YES, administrators accessing the admin console from the
Concordance Desktop server will be required to enter a password when logging into the
Admin Console.

To set the Admin Console authentication on the server:

1.Click the Settings tab.

2. In the Administration Console Server Settings section, click the authentication
option in the Authenticate admin console users on server row.   

3. Click the arrow to open the authentication options, and select one of the following:

YES - Administrators are required to enter a password when logging into the
Concordance Desktop Admin Console.

NO - Administrators are not required to enter a password when logging into the
Concordance Desktop Admin Console.

4. Click Apply to save your settings.

The option defaults to 'No' when Concordance Desktop is installed.

Enabling access control audit logs

This setting enables audit logging for Concordance Desktop Administrators that will include
timestamps, username and action taken.
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To Enable Access Control Auditing

1.  Click the Settings tab.

2.  In the Administration Console Server Settings section, select Yes or No to enable Access
control logging.

3.  By default, the Audit log is saved in this location: C:
\ProgramData\CloudNine\Concordance Desktop\Working Path. Click the ellipsis (…)
button to navigate to a different location of your choice.

4.  For the Number of days to start a new log file option, use the arrows to choose
between 1 and 1000 days.

5.  Click Apply to save your settings.

Scheduling Jobs

About scheduling jobs

Common administrative tasks can be managed on the Jobs tab. New jobs can be added to
run automatically at scheduled intervals and existing jobs can be removed, disabled,
edited, and run manually. Setting up these actions in advance allows you complete control
in managing your schedule and ongoing maintenance tasks, freeing your time for other
needs.

Scheduled job activities can be automatically updated on the Jobs tab as changes are
recorded by the server. On the Jobs tab, use the Auto refresh feature to automatically
update jobs displayed, or click the Refresh button to manually update the listing. 

You can also schedule jobs to run using Windows Task Scheduler to save server
resources and manage load balancing.

Job processing uses server RAM. To monitor any memory drain when certain jobs are
running, check the Memory bar graph in the Server tab.

Too much processing on the Concordance Desktop server can bring the server down.
Watchdog services will restart the server but user sessions will be shutdown. Each
user needs to log back on to regain access.
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From the Jobs tab you can schedule the following tasks:

· Reindexing of one or all databases

· Indexing of one or all databases

· Packing of one or all databases

· Packing of one or all dictionaries

· Deleting old snapshot .snp files saved on the server

Snapshot .snp files store users search history and can be large. Review these files
periodically, and delete any that have not been accessed within an established timeframe,
such as 30 days. For more information about snapshots, see Setting the snapshot path.

Adding and managing jobs

Automate your administrative tasks on the Jobs tab where they can be set to run at
scheduled intervals, as needed. Once scheduled, you can easily edit, disable, or remove a
job whenever necessary. You can also manually start any scheduled job, if you need it to
run immediately.
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The Maintenance job is a built-in job that comes with the server and performs basic
server maintenance. It cannot be removed from the Job list.

To add a new job:

1. On the Jobs tab, click the Add button.

Clicking the Add button opens the Name dialog box.

2. In the Name field, type the job name.

3. In the Description field, type the job description.

4. Click Next to open Actions dialog box.
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5. In the Available actions list, click the action you want to include in the job.

6. If the job is not for all databases, in the Database field, click the database you
want the action run on.

If you are deleting old snapshots, in the Days prior field, type the number of days
that a snapshot file remains unaccessed, before it is automatically deleted. 

7. Click the Add button to add the action to the Selected actions (in order) list.

The job performs each action in the order the actions are displayed in the Selected
actions (in order) list. To change the order of actions in the list, click the action
you want to move, and click the Move up or Move down button to modify the
action order.

8. If your job contains multiple actions, and you want the job to continue running the
other actions if an action in the job fails, select the Continue running all actions
if action(s) fail check box. 

9. Click Next to open the Frequency dialog box.
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10. Define the job frequency settings, and click Finish.

Remember to send broadcast announcements to users prior to scheduled tasks for
tasks that will affect their access to the server. For more information, see Sending
broadcast messages.

To manually run a job:

1. On the Jobs tab, click the job you want to run.

2. Click the Run button . 

To manually cancel a job:

1. On the Jobs tab, click the currently running job that you want to cancel.

2. Click the Cancel button . 

To edit a job:
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1. On the Jobs tab, click the job you want to edit.

2. Click the Edit button to open the Name tab in the Edit job dialog box.

You can change the name or description of the job on the Name tab.

3. To modify job actions or the order in which the actions run, click the Actions tab.

4. To change the time, date or frequency of a job, click the Frequency tab.

5. When you are finished editing the job, click OK to save your changes.

To disable a job:

1. On the Jobs tab, click the job you want to disable.

2. Click the Disable button.

Clicking the Disable button disables the job and moves the job to the Inactive jobs
list on the Jobs tab. 

To enable an inactive job, click the job and click the Enable button.

To delete a job:

1. On the Jobs tab, click the job you want to delete.

2. Click the Remove button to permanently delete the job.

Troubleshooting jobs

If you created a job for deleting old snapshots, but old snapshots are not being deleted,
the Microsoft Windows registry setting for the Last Access file attribute may be disabled
on the machine hosting the server. 

By default, the Last Access file attribute is disabled for NTFS-based operating systems,
such as Microsoft Windows Vista, to improve the NTFS (NT File System) performance.
When the Last Access file attribute is disabled, the Delete old snapshots action will not
run for a job on the Concordance Desktop server. 

Before enabling the Last Access attribute, refer to Microsoft Windows documentation
to determine whether you should activate the Last Access attribute, and consult
with your Network Administrator before changing the Last Access attribute setting.
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To determine whether the Last Access file attribute is disabled:

1. On the Start menu, click Run to open the Run dialog box. 

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt. 

3. Type fsutil behavior query disablelastaccess and then press Enter.

When disablelastaccess = 0, the Last Access attribute is enabled. 

When disablelastaccess = 1, the Last Access attribute is disabled.

To enable the Last Access file attribute:

1. On the Start menu, click Run to open the Run dialog box. 

2. Type cmd in the Open field and click OK to open the cmd.exe command prompt. 

3. Type fsutil behavior set disablelastaccess 0 and then press Enter.

4. Restart the computer.

You must restart the computer for the change to take effect.

Indexing and reindexing considerations

Indexing will not occur if a user is logged into a database. The system will not kick a user
out, but rather reassign the scheduled task to run at the next interval. We recommend
that you ensure all users have exited the system and take the database offline before
indexing is scheduled to occur.

Reindexing affects users differently than indexing. If the reindexing process starts when a
user is still logged into a database, they can remain logged in. Users who wish to continue
working while the database is being reindexed may find that the searching speed slows
during this timeframe.

Using Windows Scheduled Tasks

You can automate administrative tasks using the Microsoft Windows Scheduled Tasks with
CPLs. These tasks need to be scheduled with the Concordance Desktop.exe file and
modified to include the designated CPL you want to run.
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For more information about CPLs, see About the Concordance Desktop Programming
Language Reference in the Concordance Desktop Programming Language module.

Please refer to Microsoft's instructions on how to add a scheduled task. 

Managing Logs

About managing logs

The Log tab displays server activities recorded by the Admin Console Server and the
server. Activities include user log on and off time, administrative jobs such as database
packing and indexing, and detected errors.

Server activities are automatically saved as text files in the server's Working Path folder.
These log files can be read by text editor programs and imported into a spreadsheet or
database for future analysis. The log files can also be reloaded back into the Concordance
Desktop Admin Console for review. 

The default directory for the Working Path folder is C:\Users\All
Users\LexisNexis\Concordance Desktop (Windows 7 and above)
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From the Log tab you can: 

· Select the Server tab to view activities and major errors

· Select the Administration Console tab to view console activities and major errors

· Open and review log files

· Save activities as text files to the server for future analysis

· Customize server log options (Options button) for maximum log lines, refresh rate,
retention, and start new settings

· Customize server and admin console logs (Customize button) to include or exclude
specific information

· Clear log activities

We recommend you start a new log every seven days. Remember to also set the
option for the Admin Console Server as well, perhaps for every 30 days.

Viewing activities

The server activities are listed on the Log tab for both the Admin Console Server and the
server. Select either side tab to view server activities.

Concordance Desktop Server Activities

The Log listing has six columns of server information as outlined in the Concordance
Desktop server Activities table:

Server Activities

Log Tab Columns Description

Type A single letter indicating the message type:

· O – Open

· C – Close

· X – Exit (log off)

· L – Log on

· S – Server Start

· T – Server Terminate (shut down)

· I – Information

· E – Error
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Server Activities

Log Tab Columns Description

· W – Warning

· ! – Severe error

Session ID A unique session ID assigned when logging on

IP The user’s IP address

User The user’s logon name

Date/Time The date and time of the log entry

Description A description of the action

To refresh the Log tab:

The server activities list on the Log tab can be automatically updated as changes are
recorded by the server:

· To automatically refresh the activities displayed on the Log tab, make sure that the
Auto refresh button is toggled to on. 

When the Auto refresh function is turned on, the server activities list on the Log
tab will automatically refresh at the rate specified in the Server log options dialog
box.

· To manually refresh the activities displayed on the Log tab, on the Log tab, click
the Refresh button. 

When the Auto refresh feature is turned on, the Log tab does not need to be
manually refreshed.

Setting server log options

Server log options are defined on the Server log options dialog box. We recommend you
start a new log every seven days. Remember to also set the option for the Admin Console
as well, perhaps for every 30 days.

 

To set the server log options:
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1. Click the Log tab.

2. Do one of the following:

· To set the server log options for the server, click the Server side tab.

· To set the server log options for the Admin Console, click the Administration
Console side tab.

3. Click the Options button to open the Server log options dialog box.

 

The Maximum log lines to view field controls the maximum number of lines displayed
on the Log tab. The default setting is 1000 lines. For slow client connections, set
this option to a low number to maintain reasonable performance.

If you want to view all information that occurs on a given day, you may need to
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increase the number of lines in the Maximum log lines to view field to ensure that
lines are not overwritten when the maximum number of lines is reached.

4. In the Maximum log lines to view field, type or scroll to the maximum number of
lines to include in the log file.

The Refresh rate field controls how often the server activities are updated on the
Log tab. Changes are sent to the Log tab when they are available. The default
setting is 1 second. Slower connections can benefit from a longer interval.

5. In the Refresh rate field, type or scroll to how often, in seconds, the server
activities list refreshes on the Log tab.

The Start a new log file every field controls how often a log file is created. By
default, a new log file is started or rotated, every day. Therefore, each log file
contains entries from one day. To include entries from more than one day, increase
the number of days for this option. 

We recommend creating a new log file for the Concordance Desktop server every
seven days, and creating a new log file for the FYI Administration Console Server
every 30 days.

6. In the Start a new log file every field, type or scroll to how often, in days, you
want to start a new log file.

The Previous logs to retain field controls the maximum number of log files to retain.
Log files over this limit are deleted.  The setting defaults to 7 days. To retain all log
files, type 0 in the Previous logs to retain field.

7. In the Previous logs to retain field, type or scroll to how many logs to retain on
the server.

8. Click OK to save the settings.

Customizing logs

A customize log feature has been added to Concordance Desktop that allows you to
select specific data to gather and include in the logs, that can provide more detailed 
information for troubleshooting. In addition to the ability to log more data, this feature
also provides easy access to those logs directly from the Admin Console, simplifying the
act of locating the logs for troubleshooting.

In order to use the customize logs feature, you must run Concordance Desktop as
Administrator (Windows Administrator). 

To include or exclude additional data to be logged:
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1. Run Concordance Desktop as Administrator.

To do this:

a. Right-click the Concordance Desktop icon on the desktop and select Run
as administrator. 

b. When the User Account Control window opens, click Yes.

c. If you are presented with a Concordance Desktop Logon box, enter the logon
information for the server, then click Connect. If not, ignore this step. 

Concordance Desktop opens to the Workspace.

2. Log onto the Admin Console.

3. Click the Log tab.

4. Click Customize. 

An Extended Logging Options box opens.
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In this box you can select to include specific base and extended logging options. By
default, all options are excluded from logging.

5. Click on an option to display its description at the bottom of the box.

For more detailed descriptions about logs see the Log descriptions topic. 

6. To include an option, click on the down-arrow for the option and select Yes. 

7. To exclude an option, click on the down-arrow for the option and select No. 

8. Click OK. 

9. A confirmation box opens, stating that you will need to stop and restart the
Concordance Desktop and servers, click OK. 
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Refer to Starting and stopping a server  for further details. 

Sometimes you may need to access the folders where the server and client logs are
located, so that you can view more detailed logged information, or to send a log file to
Support for troubleshooting. While this can be accomplished using Windows Explorer, it
is often difficult or cumbersome to locate and open the correct folder. To make
locating and opening the folder an easy task, Concordance Desktop provides quick,
easy access to the folders from the Extended Logging Options box. See Opening log
files for details on how to access the folders. 

Opening log files

Log files for the Concordance Desktop Server and the Admin Console are automatically
saved in the Working Path folder on the Concordance Desktop server. Working Path Log
files are retained for the number of days specified in the 'Previous logs to retain' field in
the Server log and Administration server log options dialog boxes. In the Admin Console,
you can either open a server or Admin Console server log file by using the Open button, or
from a button in the Customize pane. 

Concordance Desktop Client Log files are automatically saved in a Concordance Desktop
folder found under each users AppData, Local, CLoudNine directory. 

You must run Concordance Desktop as Administrator in order to access the Customize
dialog box. To do this, right-click on the Concordance Desktop icon on the server
desktop and select Run as administrator. 

 

The default directory for the Working Path folder is C:
\ProgramData\CloudNine\Concordance Desktop\Working Path (Windows 7).

To open a Server or Admin Console server log file using the Open button:

1. In the Admin Console, click the Log tab.

2. Click the Open button.

 The Open log file box opens.
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3. Click the log file you want to open, and click OK.

Clicking OK opens the log file on the Custom side tab on the Log tab. The Custom
side tab is only visible on the Log tab when a retained log file is opened.

Sometimes you may need to access the folders where the server and client logs are
located, so that you can view more detailed logged information, or to send a log file to
Support for troubleshooting. While this can be accomplished using Windows Explorer, it
is often difficult or cumbersome to locate and open the correct folder. To make
locating and opening the folder an easy task, Concordance Desktop provides quick,
easy access to the folders from the Extended Logging Options box.

To easily find and open the Server Logs folder:

1. Run Concordance Desktop as Administrator. 

To run Concordance Desktop as Administrator:

There may be times when you need to run the Concordance Desktop software as
a Windows administrator. For example, to activate a Concordance Desktop server
license on a computer, or to select additional data to be logged in the log files for
troubleshooting purposes. 

For your convenience, here are the steps on how to do this:

1. Right-click the Concordance Desktop icon on the desktop and select Run
as administrator. 

2. When the User Account Control window opens, click Yes.

3. If you are presented with a Concordance Desktop Logon box, enter the logon
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information for the server, then click Connect. If not, ignore this step. 

2. Log onto the Admin Console.

3. Click the Log tab.

4. Click Customize. 

An Extended Logging Options box opens.

5. Click the Open Server Logs Folder button.

 A Windows Explorer window opens to the folder where the logs are saved. 

6. To open a log for viewing, double-click on the log name. 
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7. When finished viewing the log, click the Windows Close button to exit the window. 

8. You are returned to the Extended Logging Options box. 

9. Click OK to close the Extended Logging Options box. 

To easily find and open the Client Logs folder:

1. Run Concordance Desktop as Administrator. 

2. Log onto the Admin Console.

3. Click the Log tab.

4. Click Customize. 

An Extended Logging Options box opens.
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5. Click the Open Server Logs Folder button.

6.  A Windows Explorer window opens to the folder where the logs are saved. 

7. To open a log for viewing, double-click on the log name. 

8. When finished viewing the log, click the Windows Close button to exit the window. 

You are returned to the Extended Logging Options box. 

9. Click OK to close the Extended Logging Options box. 
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Saving log file activities

The server activities displayed in the Log tab can be saved to a file. These log files are
formatted as tab delimited text files and can be imported into spreadsheets and
databases. They can also be saved as other file types for further analysis. All log files are
saved in the server's Working Path folder. 

The default directory for the Working Path folder is :
\ProgramData\LexisNexis\Concordance Desktop\Working Path (Windows 7).

To save all activities displayed on the Log tab:

1. Click the Log tab.

2. Do one of the following:

· To save the server log activities for the server, click the Server side tab.

· To save the server log activities for the FYI Administration Console Server, click
the Administration Console side tab.

3. Click Save to open the Save As dialog box.

You can also right-click any activities and click Save to open the Save As dialog
box.  By default, the .log files are saved to the Working Path folder. 

4. In the File name field, type the log file name.

5. Click Save. 

To save selected activities displayed on the Log tab:

1. Click the Log tab.

2. Do one of the following:

· To save the server log activities for the server, click the Server side tab.

· To save the server log activities for the FYI Administration Console Server, click
the Administration Console side tab.

3. Select the activities you want to save. 

To select multiple activities, use SHIFT+click or CTRL+click.

4. Right-click a selected activity and click Save selection to open the Save As dialog
box.

5. Click Save to open the Save As dialog box.

By default, the .log files are saved to the Working Path folder. 



Concordance Desktop 114

6. In the File name field, type the log file name.

7. Click Save.

To copy selected activities to the clipboard:

1. Click the Log tab.

2. Do one of the following:

· To copy the server log activities for the server, click the Server side tab.

· To copy the server log activities for the FYI Administration Console Server, click
the Administration Console side tab.

3. Select the activities you want to copy. 

To select multiple activities, use SHIFT+click or CTRL+click.

4. Right-click a selected activity and click Copy to clipboard.

5. Paste the activities to another program.

Deleting log files

In the Concordance Desktop Admin Console you can delete all log files in the Working Path
folder from the Server log options dialog box. If you want to delete individual log files, you
will need to manually delete the log files from the Working Path folder in Microsoft
Windows Explorer.

To delete all log files from the Working Path folder:

1. Click the Log tab.

2. Do one of the following:

· To delete the logs for the Server, click the Server side tab.

· To delete the logs for the Administration Console, click the Administration
Console side tab.

3. Click the Options button to open the Server log options dialog box.

4. Click the Clear all logs button.

5. Click Yes when asked Are you sure you want to remove all previous log files?.
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6. Click OK.

All .log files are deleted from the Working Path folder and the server log activities on
the selected side tab are cleared from the Log tab.

Log descriptions

Below are the logs available from Concordance Desktop and their respective descriptions.

Basic logging

Server logs

Log Name Location Description
Extended
Logging

Concordance
Server.log

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

This is the tab
separated database
output for the "logging"
tab in the Admin
Console. It is less
complete and detailed 

Limited
effect

Concordance Server
- YYYY-MM-DD.log

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Saved copy of
'Concordance
Server.log' for the day
listed in the file name. 

Limited
effect

CNServer.YYYYMM.lo
g

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

* Required when
escalating issues*

Logs the action taken
by the server. For
example, removal of
DCB's, Job
indexing/reindexing,
packing etc., license
information/authenticat
ion, Ports, number of
users allowed to
connect to server (per
proc limit) - all for the
month listed in the file
name.  

See
Extended
logging
table

ServerCPU YYYY-MM-
DD.txt

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Internal data format for
the Admin Console.
This is now the charts
get their data. 

No effect
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Server logs

Log Name Location Description
Extended
Logging

OverallCPU YYYYY-MM-
DD.txt

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Internal data format for
the Admin Console.
This is now the charts
get their data. 

No effect

Server Memory YYYY-
MM-DD.txt

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Internal data format for
the Admin Console.
This is now the charts
get their data. 

No effect

OverallMemory YYYY-
MM-DD.txt

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Internal data format for
the Admin Console.
This is now the charts
get their data. 

No effect

Admin logs

Log Name Location Description
Extended
Logging

Concordance Admin
Server.log

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

This is the tab
separated data output
for the "logging" tab in
the Admin Console. It
is a less complete and
less detailed version of
the
CNSAdmin.YYYYMM.log
for the Admin Console.

Limited
effect

Concordance Admin
Server - YYYY-MM-
DD.log

C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

Saved copy of
"Concordance Admin
Server.log" for the day
in the day listed in the
file name.

CNSAdmin.YYYYMM.log C:
\ProgramData\LexisNexis\
Concordance
Desktop\Working Path

* Required when
escalating issue *

Logs/captures the
settings in the Admin
Console for the month
listed in the file name.

See
Extended
logging
table
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Import logs

Log Name Location Description
Extende
d
Logging

DATImportLog_MM_DD
_YYYY_HH_MM_SS.log

DatabaseLocation\logs Logs the initial import
of documents. (aka:
the first load at db
creation)

Name depends on the
type of database
created (initial load)

No effect

EdocImportLog_MM_D
D_YYYY_HH_MM_SS.lo
g

DatabaseLocation\logs Logs the initial import
of documents. (aka:
the first load at db
creation)               

Name depends on the
type of database
created (initial load)

No effect

EmailImportLog_MM_D
D_YYYY_HH_MM_SS.lo
g

DatabaseLocation\logs Logs the initial import
of documents. (aka:
the first load at db
creation)               

Name depends on the
type of database
created (initial load)

No effect

ImportLog_MM_DD_YY
YY_HH_MM_SS.log

DatabaseLocation\logs Logs the append
import of documents
into the database.

No effect

NAMEOFDATABASE
YYYY-MM.LOG

DatabaseLocation\logs Logs all log on/off
activity to the database
for that month.

No effect

OverlayLog_MM_DD_Y
YYY_HH_MM_SS.log

DatabaseLocation\logs Logs the Overlay
import of information
into the database.

No effect
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Miscellaneous logs

Log Name Location Description
Extende
d
Logging

Concordance
Desktop.YYYMM.log

C:
\Users\"Username"\AppDa
ta\Local\LexisNexis\Conco
rdance Desktop

* Required when
escalating issues *

Logs all actions
executed by the EXE
for the month listed in
the file name. 

See
Extended
logging
table

ImageBaseManageme
nt.log

C:
\Users\"Username"\AppDa
ta\Local\LexisNexis\Conco
rdance Desktop

Each module has its
own individual log file,
as .NET programs do
not share a log file.

No effect

CDV.log C:
\Users\"Username"\AppDa
ta\Local\LexisNexis\Conco
rdance Desktop

Each module has its
own individual log file,
as .NET programs do
not share a log file.

No effect

ProductionModule.log C:
\Users\"Username"\AppDa
ta\Local\LexisNexis\Conco
rdance Desktop

Each module has its
own individual log file,
as .NET programs do
not share a log file.

No effect

PrintingModule.log C:
\Users\"Username"\AppDa
ta\Local\LexisNexis\Conco
rdance Desktop

Each module has its
own individual log file,
as .NET programs do
not share a log file.

No effect

Extended logging

Logging options enable extended information prior to and after an error, that may
help to diagnose unusual things.

Log Option Basic Description When you would use it

Admin Console
Management

Enables logging for actions in
the Admin Console that alter
definitions such as, editing the
name of a database. 

Licensing Actions such as, adding a license
or verifying if a license is valid or

When licenses that appear to be
valid are not registering. 
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Log Option Basic Description When you would use it

expired, are logged with this
options. Advanced diagnostics
are available when Low Level is
enabled as well. 

Tagging Tag errors (note that at this
time, tag operations are not
heavily logged).

Server
Commands

Shows the CNServer command
diagnostics for all messages
being sent to the server. This
can become quite noisy, but may
be required for some
diagnostics.

When you want to verify that
command traffic is happening.

Connections Shows details of connections to
the server, and actions upon
those connections. Advanced
diagnostics are available when
Low Level is enabled as well. 

Enable when extra information is
needed, regarding needed  when
a client successfully connected and
disconnected. This information can
help diagnose things that aren't
errors, by tracking when the client
signed on and left, and the extra
information about their
connection. 

Networking The details of lower level
network protocols and traffic are
exposed with this option.
Advanced diagnostics are
available when Low Level is
enabled as well. 

When you need to review network
traffic, like packet sends and
socket ports, showing extra
information around the traffic. 

Low Level Enables extended logging of
more data than the Base
Options. For example, with
Licensing enabled the log
displays messages about a
license registered. However,
with Low Level enabled, the log
also shows debug information
that is used to diagnose even
more details. 

Enable this when development
needs detailed logs. This expands
and affects many of the other
options. Some options require this
option to be enabled in order to
log detailed information, while
others provide details without
having to have this option
enabled. 

SQL Internal Query Engine states
and operations such as, when
you have a failure to insert a
record for a user. Most of these
only show up in the log if Love
Level is also enabled. 

If there are problems where things
are not getting inserted or
queried, enabling this may help
diagnose the SQL statements. This
may be useful when unexpected
data, for example, a user name
with a Unicode character may have
issues inserting. 
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Log Option Basic Description When you would use it

Databases Actions that happen on a
database (DCB) such  as,
creation or registration. Most of
these only show up in the log if
Low Level is also enabled. 

Problems with opening databases
or related.

Unicode Files Shows extended information
during the reading of Unicode
files, helpful when diagnosing
why a text file doesn't read
correctly in some situations. 

When trying to figure out if a file is
Unicode, and if so, what type. This
log data will  diagnose the path of
that. For example, if you convert
an OPT to Unicode, when the
database is opened for any
operation, that  information about
the file will be logged.

Profile Extends information during
reading of profile data such as,
a home directory from the user's
profile. 

Backing Up Concordance Server

About backups and data recovery

For information about backing up SQL Server and other supporting products, refer to your
organization’s internal guidelines or source documentation.

Please read all the topics in the Backing Up Concordance Desktop server topic to ensure
that you are not missing any relevant information. If regular backups are not scheduled,
you can possibly risk losing data. 

Backups for the Concordance Desktop server include the following:

· FYI.db file

· Concordance Desktop databases

· User Management settings (under each database folder)

· Tags

· List files, queries, and other supporting files

Most FYI ASPs and large firms and organizations should already have backup and data
retrieval planning outlined and implemented, as well as disaster recovery protocols.
Determining backup schedules for the Concordance Desktop server depends on the number
of databases and users you have to manage. If you have numerous users accessing
databases and running tasks, you may want to consider scheduling backups twice daily. If
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you only have a few databases with a handful of users accessing them, you may be able
to set backup schedules to once a week.

Do not perform live backups if you are using backup software that locks files, even
briefly. This has been known to cause read/write functions to the database files to
fail, and can cause file synchronization or corruption issues. Check with your IT group
and/or backup solution provider to verify that no file locking occurs before scheduling
any backups on the Concordance Desktop server and Concordance Desktop files that
are in use. 

Be aware that anti-virus, firewall, and backup software can often interfere with
network traffic and the locking of files, and in effect could cause Concordance
Desktop software to crash.

Backing up FYI.db files

The FYI.db file holds all settings for the Concordance Desktop Admin Console, links to the
database, and includes the database name. As a standard practice, you can always
export a copy of your database to make a backup. You can also create a backup copy of
the FYI.db file by stop and restarting the Concordance Desktop server services in the
Concordance Desktop Admin Console.

If your FYI.db is corrupted and irretrievable, you will lose the following:

· User settings: must re-enter all users and re-apply user permissions

· Client, matter, user groups and database structure: must rebuild folders and organize
databases per matters

We recommend that you regularly make backup copies of the FYI.db file if administrators
are performing tasks in the Concordance Desktop Admin Console that affects information
you want stored in the FYI.db file, such as registering and removing databases, managing
logs, setting up network maps.

Back-Up Considerations:

· We encourage you to back up your primary databases every night. 

· If you have secondary databases that are not accessed as much, consider backing
them up on a weekly basis.

· If you are performing full nightly backups, you need to take your databases offline. You
can conduct incremental backups.

· Remember to make time for backup copies of your Snapshot files so they can be
restored for reviewers; backing up this file can be a time consuming task given that
some .SNP files reach terabyte size
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Always back-up your FYI.db files before performing any updates to any products or
services that run on the server that hosts the Concordance Desktop server. Do not
use live backups as it may corrupt your databases.

Do not copy and paste the .dcb file because Windows could corrupt it.

To back up the FYI.db file:

1. In the Admin Console, click the Server tab.

2. Click the Stop button to stop the Concordance Desktop server services. 

3. To recover the file, locate the directory folder where Concordance Desktop is
installed.

The default location is C:\Users\All Users\LexisNexis\Concordance Desktop. The last
10 nightly backups are automatically stored in this directory.

Here is an example of what a backup file name may look like: f68f7096-a85e-49be-
823b-b48fd0617137.db

4. Select the latest version of the .db file for the date and time when services were
stopped and rename the file or move it to a different directory location.

5. Rename the file to FYI.db.

6. In the Concordance Desktop Admin Console, on the Server tab, click the Start
button to restart the Concordance Desktop server services. 

When you restart the services, it relinks to the new FYI.db file. Every time you
restart services, the server looks for a FYI.db file in the install directory.

Backing up authentication files

For the Concordance Desktop Admin Console, you will also want to ensure that you back
up copies of the Admin Authentication.dcb file. This file is a Concordance Desktop
database that contains no data, but retains all administrative settings except passwords.
You will want to ensure that at least one administrator has access to this file.

If you find yourself without a backup copy or with a corrupt file, contact Concordance
Desktop Technical Support for assistance.
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Backing up registry settings

The Concordance Desktop server holds all root registry settings for Concordance Desktop
server. The registry settings are stored in the following directory in the Microsoft Registry
Editor:

· HKEY_CURRENT_USER\Software\LexisNexis\Concordance Desktop 

· HKEY_LOCAL_MACHINE\Software\Wow6432Node\LexisNexis\Concordance Desktop

To make a backup copy of your registry settings, do one of the following:

· In the Registry Editor, right-click the Concordance Desktop folder, and click
Export.

· In the Registry Editor, click the Concordance Desktop  folder, and on the File
menu, click Export. 

Disaster recovery protocols

Protecting your organization’s data in the event of a natural or man-made disaster is
essential to ensuring that data retrieval occurs in a timely fashion with limited impacts for
conducting business. We recommend that you have data recovery protocols in place at an
offsite location. Many vendors have data hosted and archival environments with a variety
of services to choose from.

With Concordance Desktop server, you may want to keep an inactive copy as a failover
means of ensuring access to your data. Internally, you will want to mirror hard drives on
your servers and may want redundancy for the SQL Server.

Concordance Desktop server components to mirror:

· The Concordance Desktop server directory by default, it is located in the following
directory:

C:\Program Files (x86)\LexisNexis\Concordance Desktop (Windows 7)

· The Concordance Desktop server application directory is located in the following
directory:

C:\Users\All Users\LexisNexis\Concordance Desktop (Windows 7)

The Concordance Desktop server application directory includes the necessary fyi.db
file, which maintains a list of registered databases, users, user groups and other
essential information.

· The services settings for both servers.

The services settings are located in the Services Control Panel (Start > Control Panel
> Administrative Tools > Services). These settings include the system user name and
password used to access network shares.
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Data recovery and retrieval

Protecting your organization’s data in the event of a natural or man-made disaster is
essential to ensuring that data retrieval occurs in a timely fashion with limited impacts for
conducting business. We recommend that you have data recovery protocols in place at an
offsite location. Many vendors have data hosted and archival environments with a variety
of services to choose from.

Things to consider for data recovery and retrieval:

· Manual backups that are scheduled on a regular basis that store data in a secure,
offsite location in a controlled environment

· Incremental secure backups or data mirroring/clustering

· Backup rotation storage of files and databases

· Environments that include comprehensive, around-the-clock network/server monitoring
of network traffic with industry-leading technologies for intrusion and protection
detection

· Environments that implement 24-hour surveillance requiring with an infrastructure that
imposes keycard, fingerprint, and/or retina scan access

· Environments that operate on full redundancy, in addition to stand-alone power
generation, and can support heavy transactional processing

· Vault storage specifically designed for long-term data storage with additional services
for online viewing access

Database Administration

Supporting Reviewers

Supporting reviewers

As an administrator, your job is to support the document review team by providing the
best database structure and maintenance for document review, on a case-by-case basis.
The more you can learn and understand from a reviewer’s perspective and the needs of
each particular case, the easier your job becomes in providing proper support.

This topic covers the administrative information and activities that you will need to
perform to support reviewers in searching, saving queries, sorting, and tallying.

How to Support Reviewers:

Searching
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Administrators should understand basic searching concepts used in Concordance
Desktop, including how to differentiate between full-text and relational clauses, and
how to use search operators and wildcards. Understanding these concepts helps you
troubleshoot questions or problems reviewers may have when learning to use
Concordance Desktop.

Searching Overview:

· Full-text searching uses the .dct and .ivt files

· Full-text searching is very fast, highlights hits in red, searches multiple fields

· Relational searching searches the entire database each time

· Relational searching uses different operators, searches one field, runs slower, and
does not provide keyword highlights

Tips to Increase Search Processing Speed:

· Reviewers can speed up relational searching by placing a full-text search clause
before the relational clause to cut down the amount of data Concordance Desktop
must read in real time

· Check the Key box on fields to improve relational search processing speed 

· Locate empty or not empty paragraph fields (empty: fieldname = “”, not empty:
fieldname = *)

· Search for punctuation with relational searching (OCR co %) or globally replace
punctuation with a%a, then reindex and run a full-text search

Tips for Assisting Reviewers:

· Verify that reviewers are not running relational searches on paragraph fields

· Verify that reviewers are placing a full-text search clause before the relational
clause to cut down search processing time

· Verify that search syntax is correct

· Verify the search terms are included in the dictionary

· Verify that the field is indexed for full-text searching

· Reindex the database to ensure all updates are available to reviewers

Creating a Synonyms List

Creating a synonyms list for your database increases your reviewers search capabilities
by locating results for words that have similar meanings or alternative names.
Synonyms can be based off of words already entered in your database dictionary,
creating a permanent link between them, or other search terms in Concordance
Desktop. You can also create synonyms from the fuzzy words list, to include homonyms
or words that look like and sound like those already in your dictionary and synonyms
listings. Fuzzy words provide a 65% character match on search terms, but fuzzy
searches can miss words longer than the search term.

Synonyms are stored in the .syn file and fuzzy words are stored in the .fzy file. Both
files are located in the same directory folder as the primary database.
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If your reviewers are receiving over-inclusive results or search time is getting
bogged down, this is one area you can check for shaving off processing time. You
can easily edit the list later, if need be.

For more information about creating a synonyms list, see Creating a synonyms list. 

Saving queries

Reviewers can save their search history by saving a query file from a current
Concordance Desktop session. By doing so, they can later restore those same searches
to create new complex searches and/or capture query results on database updates.
Saved query files can also be executed on different databases if the field names used in
the searches match. Please note that restored query files will update internal search
number references in the Review view.

As an administrator you may need to help reviewers save or modify query files, and
clear their search history from the database. Searches are saved in a .qry file and are
editable text files containing only the search string.

Search Query Options:

· Use the Save all Queries command on the Search menu to save all searches in the
current query session to a .qry query file.

· Use the Execute Saved Queries command on the Search menu to relaunch a
previous query saved to a .qry file, and capture any new and/or edited data since
the initial search was run.

· Use the Clear Search History command on the Search menu to delete the search
history when you index, reindex, or pack the database.

Modifying query files

Query files are text files that contain only the search string. These files can be opened
and edited in any text editor program, such as Notepad, TextPad or UltraEdit.
Reviewers may want to modify a saved query file to write new complex search queries
and then run the edited query file on a database. However, as an administrator, you will
typically review these files in order to delete unnecessary queries that you do not need
to store or rerun later.

To modify a query file:

1. Locate the query (.qry) file you want to modify.

2. Right-click and open with any text editor program you want to use to modify the
file.

If the text editor program is not listed, click Choose Program to locate the text
editor program. 

3. In the text editor program, make the applicable edits and save your changes.
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Saving search results

In the Review view, you can print your search results or save them to an ASCII text file
by right-clicking your mouse in the center of the view. If you save your search results
to a text file from the Review view, the search terms and search results information
saved to the text file can be used as a backup of search results in a report format in
case a reviewer needs to prove what search criteria was used during an e-discovery.

Clearing searches

Clearing reviewers’ search history allows you to erase all searches from a current
Concordance Desktop work session without reopening a database, and it allows users
to start the new search session without looking at the results of previous searches.

To clear search history, on the Search menu click Clear Search History. The user’s
search results in the Review view will be erased and reset except for the All query used
to locate all records in the database.

We recommend that you save a user’s searches to a .qry file before clearing them
from Concordance Desktop. Once you have cleared a user’s search history, there
is no Undo function to retrieve this information.

Tallying records

Tally is a great sorting tool for a quick record count and for quality assurance checks.
You can search on a unique value within a field and also print a list of these results.

Tally is also useful to organize documents in preparation for printing reports. The Tally
feature is only accessible by right-clicking on a field in the Table view and clicking Tally.

Customizing table layouts
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The document listing in the Table view can be customized by viewer preference or for
viewing particular query results. Each user can create one private table layout per
database that is not viewable by other users, except the database administrators.
Private layouts are identified by the user ID in the layout name.

All layouts, except for private layouts, are made public to all users in the database and
stored in the .layout file. We recommend that you implement custom table layout
guidelines for your organization, because too many table layouts may result in a
cluttered layout menu tree. A database's .layout file can be used and copied to other
databases, which is useful when working with concatenated database sets. If you are
experiencing problems with users creating too many layouts, you can set up a group of
standard layouts and make them read-only. Any layout customizations that users may
want can be done using their private layouts.

For more information about layouts, see  Using table layouts.

Saving snapshots

Snapshots are a point-in-time picture of a user’s work history and helps them track and
preserve their search history and search results. Saved snapshots can be restored to
see what the contents of a database were on a particular day and what search results
were found at that moment in time. Snapshots only store historical data, such as
searches, the last record selection, and the last sort performed during a user’s
Concordance Desktop session.

When a saved snapshot file is restored, Concordance Desktop automatically opens the
databases associated with the file, with all queries and sorts preserved.

Users may also choose to have the auto-restore feature turned on, which is a feature
similar to saving a snapshot. An Auto-restore snapshot file contains that last record
selection and last record viewed at the end of a Concordance Desktop session, so
when users next access Concordance Desktop they can resume reviewing where they
last left off. Unlike manually saved snapshot .snp files, the Auto-restore file is
overwritten each time the user logs out of Concordance Desktop.

Snapshot Overview:

· Snapshots are saved as non-editable .snp files and can only be restored on original
databases

· Auto-restore will not work if a user does not have Microsoft Windows permissions

· Sometimes Auto-restore will not work if the most recently used (MRU) feature is
disabled

If reviewers make a practice of saving snapshots at the end of every work session,
we recommend that you periodically review and delete outdated or unnecessary
.snp files due to their large file size on a hard drive or network.

For more information about saving snapshots, see Saving and restoring snapshots.

Sorting records
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The results of any search are sorted in the order in which documents are added to the
database, and typical sorting only affects current search results. Administrators,
however, have the means to permanently apply a sort order to a database.

Reviewers may want to have documents permanently sorted in a database
chronologically, or by author, type, or other field, to help speed up their review. We
recommend that you only accommodate this request under special circumstances due
to the time involved in managing these extra files and databases.

Sorting Overview:

· The default sort order of all queries is the record creation or load order of the
documents when they were added to the database (accession number)

· Sorting can be done on up to 16 fields at one time with a maximum character limit of
1,000

· Sorting of paragraph fields is done on the first 60 characters only and uses the
longest value in the field up to 60

· Sort order is temporary and only applies to the current query 

· Speed up sorting by selecting the Key check box for database fields in the Modify
dialog box.

For more information about sorting records and field data, see Sorting documents.

Permanently sorting database files

You can permanently sort databases using two methods:

· Export the database

· Replicate the database

To permanently sort a database, sort the records in the database the way you want
them to be permanently sorted, then export or replicate the database to a new
database to replace the original database.

To permanently sort a database:

1. Back up the original database.

For more information see backing up databases. 

2. In Concordance Desktop, open the database you want to permanently sort.

3. Sort the database.

For detailed steps on sorting a database, see Sorting documents.

To permanently sort a database you can either export or replicate the database.

Exporting a database does not export the database's security settings.
Replicating a database preserves the database's security settings.
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4. To export the database, on the Documents menu, point to Export, and click As
a Concordance Desktop database.

The accession number is reassigned in your new database to match the import
order.

For detailed steps on exporting a database, see Exporting databases.

Once you have named the database with its new sort order, you can start using
your new database. You will need to delete or archive your old database.

About Databases

About Concordance Desktop databases

We recommend preparing and outlining your database field structure in advance. This may
involve discussions with a lead attorney and key people involved in the case. Making
changes to the database structure once data has been loaded has a high potential for
database corruption, so careful preparation helps minimize the need for changes later.

Use the database checklist to assist you when you first begin creating and indexing
databases to ensure that you understand each step of the process and don't forget to
verify critical data.

Making changes to your database template is the number one way to corrupt your
database. It is important to prepare and outline your field structure in advance to
avoid changes after data has been loaded.

Database Capacities

The Database Capacities table lists the capacities for each of the database elements.

Database Capacities

Database Capacity

Number of documents 500,000

Concatenated databases 128

Document size 3 billion characters

Fields 250
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Database Capacities

Database Capacity

Characters per field 12 million

Database .ivt file 6 gigabytes

Database dictionary 6 gigabytes

Database file path name 199 characters in length

Database Checklist

Checklist: Database

Data Review

Do you know how many documents or gigabytes (GB) of data have been received?

Are your files converted to types that are recognized by Concordance Desktop?

Do you understand Concordance Desktop field structure and how it affects
importing data?

Review Load Files

Have you reviewed the contents of the data volume you are about to load?

Have you reviewed your data load file for acceptable delimiters and date formats?

Do you have fields set in place for data that you are importing?

Have you verified that the bates number for the first record to be loaded does not
overlap with the last bates number used in the existing collection? If it does
overlap, a correction should be requested from the source prior to loading.

Did you receive an image load file along with your images? If not, you can create
one.

Did you adjust the directory path of your image load files, if need be?

Have you verified that your alias in the image load file matches the Image field in
the Concordance Desktop database?
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Checklist: Database

Have you reviewed how your OCR has been formatted, named and organized? Do
you know which CPL to use for import if the OCR was not included in the .dat file?

Importing a .pst file requires that a user profile is set up for each user in Microsoft
Outlook. Have you completed this process?

Database Structure

Did you create a database template that includes administrative fields?

Did you select an image key field for your images?

Did you validate the EDITTRAIL and CREATEDATE fields?

Did you index all fields needed for full-text searching?

Did you create additional miscellaneous fields?

CPLs

Did you verify supported CPLs for your current Concordance Desktop version by
reviewing the ...\ProgramData\LexisNexis\Concordance Desktop\CPL folder, or
Concordance Desktop Scripts Help topic? 

Case Review

Have you reviewed case records to understand what types of files you are
importing?

Did you review case records to plan your field structure?

Do you understand what types of reports you may be generating for maintenance
and to support reviewers?

Do you understand the file and media requirements for print productions, especially
for opposing counsel?

Ongoing Maintenance

Have you outlined maintenance processes and schedules that affect your new
databases?
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About Concordance Desktop database files

When you create a database, you import the initial load files to populate the database
with records. These initial files can be either PST files, electronic documents, or delimited
text files prepared by a vendor (or other party), and can be imported as you create the
new Concordance Desktop database. Concordance Desktop provides a Creation Wizard to
help you create and import the documents all together. 

· You can import the following types of files:

· Delimited text file

· Native files

· Electronic documents

· E-mails and attachments

· Transcripts

· Concordance Desktop databases

Each Concordance Desktop database uses several files during operation. Only four are
absolutely required to open and use a database. The four mandatory files are the
database control block (.dcb), the numeric, date, and text file (.ndx), the text file (.txt),
and the user management file (.sec). All of the other files can be recreated without
damaging the integrity of the data. At a minimum, these four files should be backed up for
archival purposes.

For more information see backing up databases. 

A B-tree file uses a tree data structure to provide fast search results. The tree data
structure minimizes the number of times the database is accessed when searching for
a record, resulting in faster searches.

The .TRK file in Concordance Desktop uses SQLite. SQLite is an embedded relational
database engine, which brings more stability to the functions of the .TRK file.
Because SQLite is an embedded database, SQLite does not increase the required
maintenance and administration of Concordance Desktop.

Concordance database files

Concordance Desktop Database Files

Name  File Description Usage File Type

.cat Concatenation Stores a list of concatenated databases Text file

.cib Imagebase Stores association between media keys
and native and image files including
markup history 

SQLite file



Concordance Desktop 134

Concordance Desktop Database Files

Name  File Description Usage File Type

.cpl CPL script Store Concordance Desktop
Programming Language (CPL) scripts

Script file

.cpt CPL script Stores compiled versions of CPL script Script file

.csv User management Stores field and menu access for all users
(when exported by user)

Text file

.dat Delimited text Contains metadata and sometimes OCR
for document records

Text file

.dcb Data control block Database definition, including fields,
document count, and other settings

.dct Dictionary All unique words in the database, in
alphabetical order 

This is not a plain text file, it cannot be
read or edited by a text editor or word
processor

B-tree file

.fmt Print settings Saves print settings for reports
generated using the standard print
feature

User generated file

.fyi Concordance
Desktop
Concordance
Desktop server
database

A link file that opens a database on a
remote Concordance Desktop server

Text file

.fzy Fuzzy search
dictionary

The fuzzy search dictionary contains
homonyms for words in the search
dictionary

This file is created and updated by
indexing and reindexing

B-tree file

.gat Back Up A tag backup file that stores tagging
information. Generated by running the
TagSaver.cpl

.ini Configuration
settings

Stores various configuration settings Text file

.ivt Inverted text Used with the dictionary during searches
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Concordance Desktop Database Files

Name  File Description Usage File Type

.key Key fields Field storage for fast relational searching B-tree file

.layout Table layout Stores the defined table layouts B-tree file

.sortlayo
ut

Sorting layout Stores the defined sorting layouts for the
current database

.editlayo
ut

Editing layout Stores the defined editing layouts for the
current database

.lst Word lists Contains predefined values that can be
selected from a list when editing fields

When a list is assigned to a specific field,
it's called an Authority List

B-tree file

.ndx Numeric, date, and
text fields

Stores data for the fixed length field
types: Numeric, Date, and Text

.opf Print settings A Concordance Desktop Image print file
that stores print settings for print jobs
generated by Concordance Desktop
Image (Opticon)

User generated

.qry Query Stores search query strings

.sec User management
control

Stores user management settings B-tree file

.snp Snapshot Stores search history and auto-restore
settings

.stp Stopwords Contains the noise words that are
ignored during database indexing

B-tree file

.syn Synonyms Stores the user defined synonyms B-tree file

.tex Text Full text paragraph field storage Text file

.trk Transaction tracking Relational SQLite file structure that
stores tags and tag histories, security
(field and menu access for all users) and
replication data

SQLite file
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Concordance Desktop Database Files

Name  File Description Usage File Type

.xrl Markup Stores the current state of markups and
placeholders

Temporary files

Concordance Desktop creates and uses temporary files, which are automatically erased
when you leave the program. However, temporary files are not erased if there is a
power outage or other problem which causes an irregular program termination.
Concordance Desktop places the files in the system's temporary directory as defined by
the Windows TEMP environment variable. The two most common functions that create
temporary files are indexing and reindexing.

When indexing a database, two temporary files are saved in the local computer's temp
directory. Both files begin with the prefix C- and end with the .tmp extension. These
files represent the temporary .dct and .ivt files. They are not initially saved on the
network server since network latency would severely decrease performance. When
indexing is complete, the resulting .dct and .ivt files are copied to the Concordance
Desktop server.

When reindexing a database, the same temporary files are saved in the local computer's
temp directory. In addition, a temporary dictionary file with a .dcb file extension is
saved in the local computer's database directory. This file contains information from the
newly created records. Near the end of the reindexing process, this dictionary file is
merged with the main dictionary file on the network server.

For more information about indexing and reindexing, see Indexing Databases. 

Managing data files

Files can be received from a client, data processing vendor, or third party. When receiving
data, you should always review all files on the disk, prior to loading the data, to ensure
they have the proper formats for Concordance Desktop.

Load files or delimited text files are the files used to construct your Concordance Desktop
database. These files typically have extensions ending in .dat, .csv, or .txt. Each file
contains record metadata, but some may also include body text. We recommend having
your OCR separated into individual text files so they can be imported separately. 
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As an administrator, you should always make a practice of opening and reviewing your
delimited text files when you receive them, as the files are not always prepared perfectly
and may need to be modified.

When reviewing your data load files, always check for the following:

· Field names – each line of metadata is one record, check each header column to
verify data

· Delimiters – unique characters that appear in the delimited text file and do not exist
in your actual data

· Date format – date fields are an 8-character maximum with slashes. If dates include
slashes, you can import any format. If slashes are not used, then you must use the
universal date format of YYYYMMDD or the mm-dd-yyyy date format with dashes.

· Carriage return – a final carriage return ensures that the last record will load into the
database.

Concordance Desktop Delimiters

Comma Field break indicator, default is ? (ASCII 20), customizable, avoid characters in
data

Quote Keeps text together, default is þ (ACSII 254) and is only required around fields
that have text and spaces, customizable, avoid characters in data

New Line Manual line break and text wraps within a field, default is ® (ASCII 174),
customizable, avoid characters in data

New Record Starts a new record, final carriage return loads the last record, cannot be
changed, industry standard

Delimiters are customizable for an organization's internal database design, but many
organizations ask vendors to use Concordance Desktop default delimiters. If your case
records contain the registered trademark symbol, you may want to consider changing
the ® to another symbol in the load file.

About fields

Before you begin your database construction, it’s important to understand the types of
data you will receive, and how that information can be categorized into the data format of
Concordance Desktop fields. 

Concordance Data Field Types
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There are two basic field categories available in the Concordance Desktop system:
defined length fixed fields and variable length paragraphs. The full-text paragraph fields
are the most flexible and most commonly used type in a Concordance Desktop
database.

Fixed fields are always a pre-defined length and contain numbers, dates, or short
amounts of text. Documents in a Concordance Desktop database can be sorted by the
contents of both fixed fields and free-text paragraph fields, but fixed length fields sort
much faster. Data in fixed fields is typically searched using relational comparison search
operators such as =, >, and <, however fixed fields can be fully indexed and searched
using full-text techniques as well.

Fixed length fields have unique applications when compared to full-text paragraphs.
While paragraph fields are flexible and variable in size, they do not sort quickly or
search easily by comparison.

· Fixed-length fields sort the fastest.

· Fixed fields display faster in Table view than Paragraphs. This is useful in long
document databases.

· Relational searches for dates and numbers work best when they are stored in Date
and Numeric fields.

· Numeric and date math using the Report Writer or using Concordance’s programming
language work best with Date and Numeric fields.

Use the following table as a reference when you review your data.

Concordance Desktop Data Field Types

Data Type Capacity Type Notes

Date 8 bytes Fixed Just for dates, keyed by default

Numeric 1-20 digits Variable Currency, zero-filled, comma, keyed by
default

Text 1-60 characters Variable Alphanumeric, keyed by default

Paragraph 12 million
characters

Fixed Alphanumeric, indexed by default,
allows rich-text format

If you want a field to be full-text searchable, make it a 'Paragraph' type. Reviewers
using the Browse view will then understand that fields with an = sign are for
relational searches and fields with a : sign are full-text searchable.

Understanding field structure and applying properties



Administration 139

Concordance Desktop does not have a pre-defined field structure and there are no
required fields. However, preliminary planning in how you construct fields and apply
properties to each is essential.

Concordance’s field profile includes:

· No predefined structure, no required fields

· Maximum of 250 fields per database

· Field Name maximum of 12 characters, including:

o Letters

o Numbers at middle or end

o Underscoring in the middle only

· Field names are stored in capital letters

· Field names save when the data type is selected

Media (image) key field names with Unicode characters are not supported.

Concordance Field Properties:

Concordance Desktop Field Properties

Image
(Concordance Desktop
Image Only)

Indicates which field contains the image key or alias, only
selected once per database and is usually the BEGNO field.

Media 
(Concordance Desktop
Viewer Only)

Indicates the field that contains the media key or alias, only
selected once per database and is usually the BEGNO field.

Key Speeds sorting and relational searching (adds values to
database .key file), keying everything dilutes the value.

Accession Copies UUID in system table into visible field, good for sorting by
load order, great for tracking gaps

System Field cannot be seen by users, Concordance Desktop creates
these for replication/synchronization information

Indexed Enables full-text searching (adds values to .ivt and .dct files)

Guidelines for Creating Fields:

Guidelines for Creating Fields

Bates Numbering A unique serial number used to identify a record. When setting up the
numbering system, think of the longest number you might need given
your case record load. Designate a length that is large enough so
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Guidelines for Creating Fields

data does not truncate. Choose text as the field’s properties in case
you need an alphanumeric system implemented.

Media field 
(Image field)

Select the Media (Image) Key setting to indicate the media key or alias
field.  You can click the View image (camera) button to launch and link
the imagebase files with the corresponding Concordance Desktop
database records. Only make this selection once per database for a
unique field, this is generally the BEGNO field.

Keyed fields Select the Key setting to improve sorting and relational searching
speed.

Indexing Indexing puts data into the dictionary and index. You can index any
data type. Paragraph fields are indexed by default. Full-text searching
only works on indexed fields. Avoid indexing unique values, serial,
Bates numbers, and dates to optimize the full-text searching speed.
Use relational searching for non-indexed fields.

OCR2 field This field is created as an overflow field for OCR1, just in case the 12
million character limit for OCR1 is exceeded. This field name must have
the same alpha prefix as the primary field and the numeric suffix must
be a consistent width and start at 1. Fields must be entered in order
by suffix. 

Punctuation Your customizable Punctuation list designates what punctuation you
can use for full-text searches, as long as the characters are embedded
between alphanumeric characters and are within quotes. You only
need to set punctuation once for each database.

Dictionaries/Inde
xes

Big dictionary and index files slow search processing. Do not bloat
these files with unnecessary entries; build stopword lists to exclude
them.

Field Validation Some fields require additional attributes for tracking purposes, like
EDITTRAIL and CREATIONDATE date fields. These attributes can be set
in the Modify window, and must be added before importing load files in
order to capture the information.

Table view Field column width in Table view is determined in the Types setting in
the Modify dialog box. The default column width is the field length
identified in the Data Types table, and as set in field properties. And
by default, paragraph fields aren’t included in Table view to keep
display speed optimal. You can customize Table view to include
paragraph fields at any time.

Additional fields and naming conventions

Use the following table as a reference when planning your database field structure. You
may find that adopting the use of these fields is beneficial to your administrative
functions or provides alternative naming conventions for fields previously mentioned.
Use this table to brainstorm other fields that make sense to your organization’s
processes and use of Concordance Desktop.
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Additional Administrative Fields and Alternative Naming Conventions

Field Type Settings

Serial Numbers Text Can be used to link to image files if BEGNO is
not used.

May have many serial #s during the life of a
database, usually matched with the .tif file
name as the first field in the database.

BEGBATES

BEGDOC

STARTPAGE

Text Alternative field names for BEGNO.

ENDBATES

ENDDOC

ENDPAGE

Text Alternative field names for ENDNO.

DOCNO Text Document number, an alternative to using
serial numbers key to the page, more common
in e-documents that are not .tif files.

BEGATTACH Paragraph Used to denote attachment range.

ENDATTACH Paragraph Used to denote attachment range.

INCLUDES Text Holds Bates or control numbers of all pages
inside the document, facilitates searching for
middle page .tif files.

PARAGRAPH Paragraph Alternative name for DOCTYPE field.

Document metadata
fields

Paragraph Also called bibliographic metadata fields. 

Typically includes author, recipient, custodian,
dates (sent, received filed, etc.), subject, title,
etc. Generally this information is visible on the
face of the document.

System metadata fields Paragraph Typically includes information captured
automatically by the computer like last access
date, modification date, and print date. 

This information may not appear on the face of
the document.

TEXT1

TEXT2

Paragraph Alternative naming convention for document-
level text fields like OCR1, OCR2, OCR3.



Concordance Desktop 142

Additional Administrative Fields and Alternative Naming Conventions

Field Type Settings

If these fields are named with the same alpha
prefix (TEXT for example) and have numeric
suffixes that start with 1, are the same numeric
length, and are in order ascending by suffix, the
import process overflows additional text into
subsequent fields, as needed.

BODY, TEXT or MESSAGE Paragraph Naming conventions for e-documents that are
not OCR scanned, fields names are usually with
numeric suffixes.

ATTACHMENT or
FILEPATH

Paragraph Customarily used to hold a clickable hyperlink to
the native document in electronic format. If this
field contains a file path or web address,
running the CreateHyperlinks.cpl converts it to
a hyperlink.

DOCCOND Paragraph Holds notes about the document condition, like
Marginalia.

PRIVCALL Paragraph Holds the reason a document or redacted
sections are marked as privileged, like
Attorney-Client, Priest-Penitent, Medical, etc.

MENTIONS Paragraph Keywords included in the document.

LOADDATE Date Alternative name for CREATEDATE field.

Used to record the date the record was
created, date data type.

AUDITTRAIL Paragraph Alternative name for EDITTRAIL field.

Records the date, time zone, computer session
ID, and user name any time a record is changed
in Edit mode, and paragraph data type. 

DISCSOURCE or
SOURCE

Text Used for entering the name of the disk the data
is loaded from or physical media it is delivered
on, includes disk number, case number, client
number, name of person who loaded it, etc.

Administrative fields
with different data
types

Paragraph or
Date

Consider creating ADMIN1PARA, ADMIN1TEXT,
ADMIN1DATE, etc. to hold specific types of data.

Template for
administrative fields

(not
applicable)

Consider creating this template. 
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Additional Administrative Fields and Alternative Naming Conventions

Field Type Settings

Each time you make a new database, you can
insert fields above them to accommodate data. 

To create a template: on the Documents menu,
 point to Export, and then click Structure. 
Locate and save the existing database
structure in the Templates folder that is located
in the same folder as the Concordance Desktop
.EXE file.

REVIEWEDBY Paragraph Alternative name for REVIEWSTATUS.

Name of the attorney who reviewed the file.

TAGSATPROD Paragraph Alternative name for PRODTAGS1.

Tags as they existed for production.

Configure visibility of Empty fields

You can configure a database such that empty fields are not visible in the field listing.
Empty fields are those that contain no values. Hiding unused fields can help to improve
the readability of database records for end users. Showing empty fields is generally a
preference for Concordance Desktop administrators, who typically want to have all
database fields visible whether they contain data or not.

Database with empty fields hidden
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Database with empty fields shown

By default empty fields are not visible. This means that when you create a new
database but before you import data, no fields are visible since none of the fields
contain any data. After you import data, any field that does not contain data is not
visible. 

To show empty database fields:

1. Open the Concordance Desktop database you want to view.

2. From the Tools menu, click Empties.  A check mark next to the Empties
command indicates that empty fields are visible.

If you have the option to view empties enabled, you may still see fields with no
data on individual records. This situation occurs if data exists in that field for any
other record in the case.

To hide empty database fields:

1. Open the Concordance Desktop database you want to view.

2. From the Tools menu, click Empties to remove the check mark next to the
command and hide the empty fields from view.

About punctuation

When indexing a database, Concordance Desktop uses several rules to determine what is
a word and what is not. One of the rules is that a word ends when it encounters any
character that is not a number or a letter. For instance, the space character would
indicate that one word is ending and another is beginning. Some characters, like the
decimal point and the comma in numbers or the slash in dates, do not indicate the end of
a word. They are called embedded punctuation and are a part of the word.
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The set of embedded punctuation recognized by Concordance Desktop during the indexing
process is determined by what you enter in the Punctuation field. By default, Concordance
Desktop recognizes the period (.), comma (,), forward slash (/), and the apostrophe ('). It
does not include the hyphen. These characters are only considered part of a word if they
are both preceded and followed by a letter or a number.

Changes to the punctuation list are kept with the database. Use any non-alphanumeric
character except the space. For example, add @ if you want to search for e-mail
addresses. Up to 10 punctuation characters can be entered. Changing the embedded
punctuation in the Punctuation field does not update the dictionary. Index the database
after modifying the Punctuation field to update the dictionary files.

Basic database fields

To help you plan and create your databases, we have created a list of the standard

Concordance Desktop database fields, including administrative fields:

Basic database fields

Field
Name

Field Description Possible
Values/Examples

Load
File

Email &
Attachm
ents

E-
Docs

CNDCN
A unique identifier
assigned to each
record.

0000001

ATTACHME
NT

Populates a list of the
parent document and
its attachments.

Ex: ABC0002;ABC0003

CONVERSI
NDEX

E-mail thread
identification.

Ex:
01C72AC4CB0FC3953C5FA
8E149389B522EFF595EF9
FB

FROM
Author of the e-mail
message.

TO
Main recipient(s) of the
e-mail message.

CC
Recipient(s) of "Carbon
Copies" of the e-mail
message.

BCC
Recipient(s) of "Blind
Carbon Copies" of the
e-mail message.
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Field
Name

Field Description Possible
Values/Examples

Load
File

Email &
Attachm
ents

E-
Docs

TITLE

Title field value
extracted from the
metadata of the native
file.

SUBJECT
Subject of the e-mail
message.

Ex: FW: Concordance
Desktop

FILENAME

Original filename of
native file. Contains
subject of e-mail
message for e-mail
records.

Ex(1): Estimates.xls

Ex(2): FW: Monday
Meeting

AUTHOR
Author field value
pulled from metadata
of the native file.

COMPANY
Name of the company
that created the
document.

CATEGORY
Category field value
pulled from metadata
of the native file.

Ex. Software

KEYWORD
S

Keywords extracted
from the metadata of
the native file.

PRODUCER
The name of the PDF
producer.

CREATOR
The software that
created the document.

COMMENT
S

Comments field value
pulled from the
metadata of the native
file.

FILEPATH

Contains a clickable
hyperlink to the native
document in electronic
format.

SOURCE
The original folder path
or pst path that the file
was saved in.

FILEEXT
File extension of native
file.

Ex. DOC

FOLDER
The original folder the
file was saved in.
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Field
Name

Field Description Possible
Values/Examples

Load
File

Email &
Attachm
ents

E-
Docs

DATE
The date the original
file was created.

TIME
The time the email
message was received.

GMT_DATE
Email received date in
GMT.

GMT_TIME
Email received time in
GMT.

MODDATE
Last day the file was
modified.

CREATION
DATE

The day the document
was created.

PRINTDATE
Last day the document
was printed.

BEGATTAC
H

Displays BegDoc# of
parent record.

EX: ABC0001

ENDATTAC
H

EndDoc# of last
attached document in
family.

EX: ABC0003

ATTACHRA
NGE

Stores BegDoc# of
parent record and
EndDoc# of last
attachment record,
separated by a
hyphen. Populated for
all records in the family
(parent and
attachment(s)).

Ex: ABC0001 - ABC0003

BEGNO
Displays page ID of
first page in a
document.

ENDNO
Displays page ID of
last page in a
document. 

TEXT01
Contains document
level text.

TEXT02
Overflow field for
document level text.

TEXT03
Overflow field for
document level text.

TEXT04
Overflow field for
document level text.
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Field
Name

Field Description Possible
Values/Examples

Load
File

Email &
Attachm
ents

E-
Docs

TEXT05
Overflow field for
document level text.

EDITDATE
Last day the document
was edited in
Concordance Desktop.

CREATEDD
ATE

The date the document
was added to
Concordance Desktop.

HEADER
Contents of the header
in an e-mail message.

METADATA

A collection that
represents all of the
built-in document
properties.

MESSAGEI
D

Outlook identification
number.

81F3CC6EBB6FD01191780
0805FC17836072FDBF2@P
ANTHERS.RBVDNR.COM

MESSAGEI
NDEX

The index of the
message file in the
database.

ENTRYID
Unique identifier of e-
mails in mail stores.

Ex:
1322C3C03649D44186257
11400748A13

PARENT_D
OCID

Parent ID of the
document's family.

BEGPRODN
O

Captures the
beginning production
number.

ENDPRODN
O

Captures the ending
production number.

Basic administrative fields

Basic Administrative Fields

Field Type Settings

ACCESSID  Numeric 20, 0, Accession, Use to track delete documents

Generates a record load order number.
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Basic Administrative Fields

Field Type Settings

CREATEDATE Date Set properties using the Validation command on the
Edit menu, normally not keyed or indexed

EDITTRAIL Paragraph Set properties using the Validation command on the
Edit menu, includes YYYYMMDD, time, time zone,
[session # -- assession #] per user

PRODBEG1 Text Captures beginning Bates #s for first production.
Using number suffixes avoids having to rename
fields later for additional productions.

PRODEND1 Text Captures ending Bates #s for first production.
Using number suffixes avoids having to rename
fields later for additional productions.

PRODNOTES1,

PRODNOTES2 

Paragraph Enter pertinent information here about the person
who ordered the production, add this on every
single record in a production set.

PRODDATE1 Date Enter the production date here with global edit or
AppendTextToField.cpl.

PRODTAGS1 Paragraph Used to capture tags as they existed at the time of
production using the Tag To Field command, Tools >
Manage Tags/Issues.

TAGS Paragraph Used to hold the names of checked tags generated
by the Tag To Field command, Tools > Manage
Tags/Issues.

TAGINFO Paragraph Used to hold activity generated by the Tag
History&Store It.cpl.

CUSTODIAN Paragraph Original owner of the data.

REVIEWSTATUS Paragraph Name of person who reviewed the file.

ATTYNOTES Paragraph Used to hold attorney notes.

ADMIN1, ADMIN2,

ADMIN3, ADMIN4 

Paragraph Extra fields to hold data generated later for any
reason, make several of them.

When you make a new field, you must run a full
index so these fields save valuable time.

Make some paragraph and some for dates.
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Reviewing load files

Load files or delimited text files typically have extensions ending in .dat, .csv, or .txt.
Each file contains record metadata, but some may also include document-level text,
sometimes referred to as OCR text. 

Though Concordance Desktop can import OCR text that is contained in a load file
(DAT file), it is best practice, and our recommendation that your OCR text be
separated into individual text files and imported using an OPT file to reference the
location of each OCR text file.

As an administrator, always make it a best practice to open and review delimited text files
when you receive them, as the files are not always prepared perfectly and may need to
be modified.

To review a load file:

1. Open the load file in any text editor program.

Delimited text files can be opened with any text editor program, such as Notepad.
We recommend using an advanced text editor program like TextPad® or
UltraEdit®.

2. Review the load file for the following elements:

· The file must be a text-based format with an extension of .dat or .csv.

· If there is not a header row containing field names, open the associated .tif file
for the first record and match the data in the record to the data in the .tif file.

· Note the delimiters used in the file. Concordance Desktop can handle any
standard text delimiters. 

· Note the date format used in the file. Concordance Desktop can load dates
containing slashes in any order with either 2- or 4-digit years, with a maximum of
8 digits. The only date formats Concordance Desktop can load without slashes is
the universal date format of YYYYMMDD and the mm-dd-yyyy date format with
dashes.

· Check the final line number for your last record to note the number of records
expected to be added to the database. Subtract header row if the Skip first line
option is checked during import.

· Is there a carriage return at the end of the record? If not, add a carriage return
at the end of the record. Concordance Desktop will not load the last record if the
carriage return at the end of the record is missing.

Concordance Desktop database field names do not support special characters. 
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Therefore, make sure that the header row does not contain any special characters
(i.e. #, $, etc).  Special characters will prevent the wizard from creating the fields
properly.

Load files that include OCR text

If the OCR text is included in the load file (DAT file), Concordance Desktop provides a check
box you can select, that will enable the import process to read the text from the load file and
write it to the OCR designated field in the database records. It is recommended that before
creating a database with a load file that includes OCR text, you ensure that there is a
designated OCR field for each OCR text entry. 

Note that an OCR field can contain up to 12 million characters. As the import process reaches
the 12 million character limit, the text is overflowed into the next OCR field. If one does not
exist in the database, the import process creates the field. At that point, a '1' is added to the
original OCR field (OCR1), and the second OCR field is named the same as the original OCR
field, but with a '2' added to the end of the field name (OCR2). The database then have two
OCR fields; OCR1 and OCR2 (or TEXT1, TEXT2). All characters following the 12 millionth
character are placed into the second OCR field (OCR2) of the records. If the character limit is
reached a second time, the import process creates a third and final OCR field, naming it the
same as the other two, and adding a number 3 to the field name (OCR3). All characters
following the 24 millionth character are placed into the third OCR field (OCR3).

As you create a new database from a load file that contains the OCR text (document-
level text), during the import process the OCR text (document-level text) is imported
into each corresponding record and placed in the specific OCR field, usually named OCR,
TEXT, or something similar. When the document-level text exceeds the capacity of that
OCR field (capacity is 12 million characters), Concordance Desktop will automatically
overflow the text into the next available field, regardless if that field is setup for the
OCR text or not. In order to prevent the overflow text from filling a field not designed
for that text, you need to ensure that there are multiple OCR fields to contain the
document-level text (ex., OCR1, OCR2, OCR3, etc.), and that after the 12 million
characters has been reached, the OCR field for the next character starts with the next
incremented OCR field name. . With OCR text that is external to the load file, this isn't a
problem, as you can create additional OCR fields using the Customize feature in the
import process. However, when the OCR text is included in the load file, the field name
is included with each line of textwhen the document-level text reaches the 12 million
character limit, you need to ensure that the next character begins 

When your OCR (document-level text) is included in the delimited text file, the process
is the same, except that on the field in the delimited text file that contains the
document level text. This field is usually named OCR, but may be named TEXT or
something similar. During the import process, the field needs to be identified so that the
document-level text can be copied into each record. When checking the delimited text
file, you need to keep in mind that should the total of all the document-level text ,
Concordance Desktop automatically overflows the text into the next available field. For
this reason, there needs to be a defined 2, 3, etc. extension of the OCR field for this
character overflow (example: OCR2, OCR3, OCR4), and the document-level text in the
delimited file needs to be broken up after every set of 12 million characters and the
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OCR field incremented so the next character set begins in the next OCR field.  What
this means is you will need to change the field name every 12 million characters, by
incrementing the additional number by 1. For example, at the first 12,000,001 (12 million
+ 1) character you will need to split the text between two lines and ensure that the
12,000,001 characters gets placed into a 

When your OCR is placed into individual document-level text files, the text is imported
into each corresponding record based on fields you create in the database to contain
that text. The fields can be created during the import process by using the Customize
feature. you have to create fields (usually OCR1, OCR2, OCR3, etc.) during the import
process to contain the document-level text (OCR) from the individual text files. This is
done by using the Customize feature in the Load File window.  

About Creating Databases

When you create a database, Concordance Desktop imports the initial load files to
populate the database with records. These initial files can be either PST files, electronic
documents, or delimited text files prepared by a vendor (or other party), and can be
imported directly into the new Concordance Desktop database. Concordance Desktop
provides an Import Wizard to help you create the database. 

After a database is created, additional files can be added directly to the database by
dragging and dropping the files onto that database in Concordance Desktop. Though there
are a few exceptions  in which dragging and dropping is not supported. The exceptions,
along with more information about dragging and dropping can be found in the About adding
extra files to a database topic. 

When creating a new database, if you cancel at any time during the import process,
it corrupts the new database. If you wish to create the new database again, you
have to delete the corrupted database, and then start the create process from the
beginning.

About delimiter characters

Delimiters are unique characters that appear in the delimited text file and do not exist in
your actual data. The delimiters are used to determine where fields break, to encase fields
that have text with spaces, to indicate the start of a new line, and to indicate the start
of a new record.  
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Delimiters are customizable for an organization's internal database design, but many
organizations ask vendors to use Concordance Desktop default delimiters. If your case
records contain the registered trademark symbol, you may want to consider changing
the ® to another symbol in the load file.

The following four columns represent the available delimiter characters. For each delimiter,
the displayed symbol is on the left and the decimal equivalent is in parenthesis on the
right. If the source program you are importing from uses a different font, it can change
the symbolic representation of the delimiters. If this happens, match the delimiter
characters with the decimal equivalents instead of relying on the displayed symbol. Using
the decimal equivalents will always result in a correct delimiter match.
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About OCR

Optical Character Recognition (OCR) is the process of scanning native files and processing
them into readable text files. During the Concordance Desktop database creation and
import process, these readable text files (often called OCR or OCR'ed text), are written to
a designated field in the database records. The incorporation of this readable text in the
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database records provides the ability to index and search document-level data in
Concordance Desktop.  Documents that are not processed through OCR scanning will
often contain characters that are not supported by Concordance Desktop, and therefore
may provide unreadable results when viewed in Concordance Desktop.

For those instances where the native document files have not been OCR'ed (scanned into
readable text), you can select to have Concordance Desktop OCR them during the import
process. This option may be optimal for smaller databases, but probably not for very large
ones, as it increases the import processing time. Files that have not been OCR'ed can still
be imported/added to a database, but the native data is imported "as is," meaning that
some of the data may be unreadable, and therefore not indexed or searchable in
Concordance Desktop, and not viewable in the viewer. If this is the case, there is an
option in Concordance Desktop that allows you to 'optimize' the native file(s) so that the
text is readable, can be indexed, and is searchable in Concordance Desktop, and the
document(s) viewable in the viewer.

For those instances where the native document files have been OCR'ed, Concordance
Desktop provides a few options for adding the OCR'ed text to the records in the database:

· OCR'ed text files with an OPT - If you have OCR'ed text files in one or more folders
and an OPT file referencing each of those files, you can select to have Concordance
Desktop read the OPT file to find the text files and write the text to the corresponding
records as referenced in the OPT file. Concordance Desktop will not attempt to OCR
the files, it will simply read the text and write it to the associated records. This option
helps to minimize import processing time, as the OCR process is not run.

· OCR'ed text files without an OPT - If you have OCR'ed text files but no OPT file
referencing the location of the text files, you can select to have Concordance Desktop
find the files based on a folder where the files are located. This option is usually
selected in conjunction with the option to have the import process create an OPT file
in the Load File window.  Concordance Desktop will not attempt to OCR the files, it will
simply find the files and write the OCR'ed text to the corresponding records in the
database. This option helps to minimize import processing time, as the OCR process is
not run.

· OCR'ed text included in the load file - If the OCR'ed text is included in the load file (DAT
file), Concordance Desktop provides a check box you can select which will enable the import
process to read the text from the load file and write it to the OCR designated field in the
database records. Concordance Desktop will not attempt to OCR the files, it will simply
read the text and write it to the associated records. This option helps to minimize
import processing time, as the OCR process is not run.

· OCR Path is included in the load file - If the DAT file references an OCR path, the new
import option allows you to import document level text.  The OCR path needs to be edited
to reflect the directory where the text is located or edited to reflect a relative path. When
using the relative path in the DAT file, the edited copy of the DAT file must be in the
same directory as your text folders.

   Example of a full text path:  

   C:\Cowco_Data\OCR\Vol001\ABC0001.TXT

   Example of a relative text path:  

   .\Vol001\ABC0001.txt

About the OCR field
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Before creating a database with a load file, we recommend that you ensure there is at least
one designated OCR field in the database. Note that an OCR field can contain up to 12 million
characters. As the import process reaches the 12 million character limit, the text is overflowed
into the next OCR field. If another OCR field is not included in the database, the import process
creates the field and labels it with the same name, and adds a number (example: OCR2). For
each additional OCR field needed, the number is incremented by one (OCR2, OCR3). Only two
additional fields can be automatically created by the import process (OCR2 and OCR3). If
more fields are required, you will need to add them using the Customize feature in the
Load File window.

Preparation for database creation

Before creating a load file database:

· Make sure that an OCR field (i.e., OCR, TEXT, TXT, etc.) exists in the load file - if not,
use the Customize feature in the Load File window to add it. 

OCR fields can be named anything, as long as you reference the correct name when
selecting the OCR field in the Load File window, so the OCR'ed text appears in the
correct field in the database records.

· Make sure that all OCR fields are setup as 'Paragraph' type fields, to ensure that the
data can be indexed and searched

· Make sure the file path pointing the text files are accurate to ensure 

Before adding documents to an existing load file database:

· Make sure that the OCR fields in the corresponding Concordance Desktop database are
setup properly (i.e., OCR1, OCR2, OCR3, etc.)

· Make sure that there are enough OCR fields to support all the text - each OCR field
can hold a maximum of 12 million characters

· Make sure that the OCR fields are setup as 'Paragraph' type fields to ensure that the
data is indexed and searchable

· Make sure that you have read/write access to the OCR fields if you are adding
documents to an existing load file database

Tips and Tricks for Importing OCR Files

If your OCR files aren’t importing properly, check the following:

· Verify file names and extensions

· Consider using a renaming utility software or use a DOS batch file (.BAT extension)
if the file names do not match the key

· Check your .LOG file to verify whether each OCR file successfully loaded

Your OCR text files can reside in the same directory as the image files. They do not
need to be separated. You will need to import your OCR for each volume where it
resides.
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About native imagebase load files

For the discovery process, it is common practice to pre-process documents, by converting
them to image files for review. However, it is often more desirable to review certain
documents in PDF format so they appear just as they do in their native format.
Concordance Desktop provides an "Optimize" feature that allows you to create PDFs of
one document, a query of documents, or all documents in a database. While the viewer
provides access to both the PDF file copies and the images, thus speeding up the review
process.

When PDF copies of the files are available, the viewer opens the PDF copy of the native
document including images, layout and more. The PDF can be reviewed, redacted, and
marked-up for production. These PDFs are referred to as "optimized" PDFs, because they
allow for any type of document to be viewed in the viewer.

When importing native documents into Concordance Desktop for viewing in the viewer, the
database must contain a valid media (image) key and file path field. The media (image)
key field is used to link the Concordance Desktop database with the viewer. In the
database records, the FILEPATH field stores the path to the native document.

Concordance Desktop imagebase load file formatting

A load file (.opt, .log, .txt) format is a delimited ASCII file containing all information
necessary to insert links into the imagebase. The load file consists of seven delimited
entries. Reference the following table and examples when formatting images.

Image Load Files

Format Description

ALIAS Should match your media (image) key from the Concordance
Desktop database. Concordance Desktop stores this key in order
to reference the image.  Media keys are case-sensitive.

VOLUME Name of the volume where the documents and image reside,
typically the volume name of a CD or DVD server.

PATH Full path and file name (and extension) of the image.

DOC_BREAK Enter a Y to denote whether this image marks the beginning of a
document.

PAGES Number of pages associated with the document or image

Character Description

Y First page of a document
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Image Load Files

Format Description

Comma (,) Indicates a page break or pages

Example: viewer format for single-page files

00010002,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010002.tif,Y,,,1

00010003,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010003.jpg,Y,,,1

00010004,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010004.gif,Y,,,1

00010005,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010005.tif,Y,,,

00010006,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010006.tif,Y,,,

Example: viewer Format for Multiple-Page files

00010036,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010036.pdf,Y,,,1

00010065,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010065.tif,Y,,,2

00010067,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010067.doc,Y,,,3

00010070,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010070.pdf,Y,,,1

00010071,NROTEK001,C:\MY_DATABASES\NROTEK001\001\00010071.pdf,Y,,,1

A load file does not necessarily need the volume name, but still needs the
parameter for the volume name (the commas). The format is
Imagekey/Alias,Volume Name,Pathname,Doc Break,Folder Break, Box Break, Page
Count 

Example format with the VOL name:  
0000001,NROTEK001,D:\VOLO001\001\0000001.tif,Y,,,1 

Example format without the VOL name:  
0000001,,D:\VOLO001\001\0000001.tif,Y,,,1

A document or image media key and file path cannot contain a comma (,) when
loading documents and images for the viewer. The comma is used as a delimiter in
the exported OPT file.

Unique identifier (Media Key)
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Your load file format’s alias (media key) should match your image key from the
Concordance Desktop database. Concordance Desktop stores this key in order to
reference the image.

The alias in your load file matches the database field that has the Image check box
selected on the Modify dialog box for the database in Concordance Desktop. For
more information about the Image check box, see About fields. Note that this
check box should only be checked when you have an imagebase. If you want to
import a database that does not have an imagebase, then you need to ensure that
the Image Key check box is not checked, prior to starting the import.

The viewer will not load documents and images if the media (image) key contains
over 1000 characters.

A document or image media key and file path cannot contain a comma (,) when
loading documents and images for the viewer.  The comma is used as a delimiter in
the exported OPT file.

About e-documents

There are several file and electronic document formats that are supported for creating and
adding to an e-documents database, but there are some that may not be supported. For
formats that are not supported, the files are still added to the database as an excluded
file, but the contents is not imported. When working with e-document files, you’ll need to
adhere to any forensic data processes as outlined by your organization or recommended
for e-discovery processing.

Concordance Desktop supports the following E-Document file types for creating and
adding documents to an E-Documents database:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text

*.pcx PC Paintbrush bitmap

*.csv Comma-Separated Values

*.cal, *.cals Facsimile
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*.pdf Adobe Portable Document Format

*.doc, *.dot, *.docx Microsoft Word 

*.ppt, *.pps, *.pptx, *.pptm Microsoft PowerPoint®

*.xls, *.xlsx, *.xlw, *.xlt Microsoft Excel®

*.msg Microsoft Outlook 2010 or later Message File

*.eml Microsoft Outlook Express Message File

*.txt ASCII Text

*.rtf Rich Text Format

*.html, *.htm Web/HTML

*.pab Microsoft Outlook Personal Address Book

*.wps Microsoft Works

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop. For more information,
please see the Microsoft website.

Concordance Desktop integrates with CloudNine™ LAW as well as a few other products, so

you can import and export data to and from other industry software applications. 

CloudNine™ LAW can be used to extract text content and metadata from electronic files in

native file format, and scans and exports data directly into databases. 

For more information about other product integrations, see Welcome.

Creating Databases

Creating a new database from load files

When creating a database, Concordance Desktop uses a wizard type interface that walks
you through each step of the database creation process. The Database Creation Wizard
for load files uses the header row of a delimited text file, an existing Concordance Desktop
database structure, or a setting file that was saved from an existing database, to create
the fields and import the data.  

Keep the following in mind when creating a database from load files:

· Field names longer than 12 characters will be automatically truncated.

· Single-page OCR text files are grouped together into a single database record and
separated in the specified OCR field using page tags (i.e. ***00010002***).

· Only one OPT file can be loaded. If you have more than one OPT file, you can "drag
and drop" each additional OPT onto the database, after the database has been
created. See the Adding extra OPT files to a database topic. 
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· Make sure that OCR fields (i.e., OCR1, OCR2, OCR3, etc.) exist in the load file - if not,
use the Customize feature in the Load File window to add them.

These fields can be named anything (example; TEXT1, TEXT2, etc.). As long as you
reference the correct name when selecting the OCR field in the Load File window, the
OCR'ed text will appear in the correct field in the database records.

· Make sure that there are enough OCR fields to support all the text in the OCR'ed text
files - each OCR field can hold a maximum of 12 million characters

· If you add OCR fields using the Customize feature, make sure that you set them up as
'Paragraph' type fields so that the data can be indexed and searched.

Only files with a .DAT or .CSV file extensions can be loaded. If you have a .TXT, or
.ASC file, you must rename the file extension to either .DAT or .CSV prior to loading
the file.

The format and delimiters used in the load file help determine the options you select to
create the new database. For example, if the load files were created using Concordance
Desktop, than the format and delimiters should be the same Concordance Desktop
standards, meaning, that the default settings in the Load File window can be used.
However, if the load files were created using a different application such as Microsoft
Excel, or they are simple comma delimited, or text files, the formatting, delimiters and date
format are probably not set to the Concordance Desktop standards. For these files, you
will need to customize the settings in the Load File window. 

Additional factors to consider when creating a new database are:

· Do you want the Concordance Desktop import process to OCR the native document
files? (See the About OCR topic for more information)

· Do you want the Concordance Desktop import process to create near-native PDFs of
each native file for better viewing in the viewer? 

By default, the above two processes are not run, thus minimizing the time required to
create the database. However, you can select to run these processes during the import.
Please note that if not run during the import, you can run the processes later on one,
several, or all of the files in the database, using the Optimize feature. For more information
about the Optimize feature, please see the Optimizing documents to PDF topic.

Based on the above information, you  can choose to use default settings, or customized
settings, when creating a new database from load files. Below is a summary of what needs
to be considered for each:

· Use the Create a new database using load files and Concordance Desktop default
settings instructions to create the new database if:

§ The format, delimiters, and date format in the load file all match the Concordance
Desktop standards, and your load file (DAT or CSV) already has a one or more
fields (usually named OCR, TEXT, or something similar) designated for OCR data
(document-level text) 

OR

§ Your load file contains OCR data (document-level text), the format, delimiters, and
date format in the load file all match the Concordance Desktop standards, and the
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fields defined for the do not want to the import process to create PDF files from
the native files.

· Use the Create a new database from load files using customized settings instructions
to create the new database if any of the following are true:

§ The load file does not contain the same standard format, delimiters, and/or date
format as those in Concordance Desktop

§ You have an OPT file that references the OCR text files, and your load file does not
contain fields for holding OCR data

§ Your DAT file does not contain fields for holding the OCR data (OCR fields are
required for the input of the text files into the database records)

§ You need to add fields that don't currently exist in the load file, for example fields
to attorney comments, or administrator comments

§ Your load file is a DAT that contains OCR data, but the format, delimiters, and date
format in the load file do not match the Concordance Desktop standards

§ You want to include beginning and ending attachment fields

§ If you need to make any setting changes to accommodate what is included in the
load file

§ You would like to add a previously defined Tag List to the new database

Create a new database using load files and Concordance Desktop default settings:

1. Review the load files you are importing into the database, see Reviewing load files.

2. In Concordance Desktop, on the File menu, click New.
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3. Select the viewer for the new database.  The "new" Concordance Viewer is
recommended.

4. In the New Database Wizard dialog box, click the Load Files button.

Load File opens in a new window to configure your load file import settings.
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If you know the exact path where you want to save the new database:
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· In the Database Name field, type the path where you want to save the
database, along with a name for the database.

If there isn't a folder previously created for the new database, it is
recommended to create a new folder.  Name the new folder according to your
database.  Double click the newly created folder to open it. 

If you do not know the exact path where you want to save the new database:

a. Click the Browse button next to the Enter Database Name field.

b. Select the location where you want to save the new database.

It is recommended that each database be created in its own unique folder.
 Name the new folder according to your database.  Double click the newly
created folder to open it. 

c. In the File name field at the bottom of the window, type a name for the
database you are creating. 

d. Click Save. 

You are returned to the Load File window where the Enter Database Name
field is populated with the information you entered in the Create Database
window.

4. Click the Browse button next to the Select DAT file field. 

5. Locate and select the DAT file, and then click Open.

6. To preview the records prior to loading the file:

a. Click the Preview button to open the Preview window.
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The Preview window displays all fields in which there is data, along with a few of the
records in the load file. 

b. To turn on the visibility of empty fields, check the Include Empties check box. 

When checked, empty fields are displayed in the preview, along with the
populated fields.

c. When finished viewing the records, click OK to close the Preview window. 

7. If you need to alter the format and delimiter settings, stop here and go to the
Create a new database from load files using custom settings section for detailed
instructions. 

List of settings you can change when selecting to customize: 

· Load Field Names From:  Location from which to load Field Names. You can
select to load Field Names from the DAT file you are loading, from a
Template/Structure file, from a previously defined Settings File, or define a
new set by manually creating all field names.

· Select the delimited format to import or select custom values:  You can
change the delimiter settings to match the settings in the load file, should
they differ from the standard Concordance Desktop delimiters. 

· Select the date format for importing date fields:  You can change the
date format, if the format in the load file differs from the standard yyyymmdd
used in Concordance Desktop.

· Load Tag List:  You can load a set of Tags from a saved Tag List file so that
those tags are available in the new database.

· Field Names:  You can add or modify field names. 
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· Change the order in which fields display in the database. 

· Show System fields:  You can select to include the display of system fields
in the database.

· Skip first line: You can select to skip the first line in the DAT load file. 

· Import rich text: You can select to import rich text formatting when
importing a text file. 

· Set Attachment Fields:  You can select the field to store the attachment
range data, or select the beginning attachment number and ending
attachment number fields. 

8. Select the path and File name of the load file to use for creating the database.

9. Click Open. 

You are returned to the Load File window where the Select DAT File field is
populated with the information you entered in the Open window. 

10. Do one of the following:

If you have an OPT file to load, select it.

a. Click the Browse button next to the Select OPT File field. 

b. Locate and select the .opt file you want to load.

c. Click Open.

You are returned to the Load File window where the Select OPT File field is
populated with the selection you just made

If you do not have an OPT file to load, you need to create one.

a. Click the Create button next to the Select OPT File field. 
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b. Click the ellipse button and select the location where you want to store the
OPT file. 

We suggest that you enter a folder and sub-folder that is located in the same
directory as the database .DCB file, and name the .OPT file the same as the .DCB
file, but with a .OPT extension. Alternatively, you can open Windows Explorer,
locate and open the folder where the native files are, and then drag and drop the
native files into the large box below the OPT file.

c. Open a Windows Explorer window.

d. Locate and open the folder where the native (.tif, .ppt, .doc, etc.) files are located.
 

e. Drag and drop the native files into the large box below the OPT file.

f. Click OK.

You are returned to the Load File where the Select OPT file is populated with the
OPT file location you just entered.

11. Select Pre-append path.  In the Pre-append dialog box the UNC path upto the
image path in the .opt or browse out to the folder containing the image folder.

What is a pre-appended path?

For example, the path in the .opt is: Images\0001\T000001.tif

The folder structure where the data was copied is: \
\uncpath\Matter001\Vol001\Images\0001\T000001.tif

Select Pre-append path and add \\uncpath\Matter001\Vol001\ in the Pre-
append dialog box or browse to \\uncpath\Matter001\ and select Vol001.
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The UNC path is added before the image path in the .opt during import.

Pre-append path assists the administrator in appending the path without
having to change the structure of the .opt.

12. Click the Key down-arrow and select the name of the field used to identify the
beginning of new records. 

An example would be BEGNO. 

13. If OCR text is included in the load file, check the OCR contained in load file check
box, otherwise leave the check box blank.

14. Click the OCR arrow and select the name of the field to contain the OCR text in the
record.

Some examples are TEXT1 or OCR1

The wizard can import both single or multi-page text files. 

      (Optional) Click the Customize Image/OCR button if you want to change the
default OCR method. This option is not available when you check the 'OCR
contained in load file' check box, as the OCR'ed text already exists.

The Customize Image/OCR dialog box opens.

Options are:

· Use CN Desktop OCR - Use this option if you want Concordance Desktop to OCR
all the files regardless of any existing OCR'ed text files. By default, Concordance
Desktop does not OCR the text files.
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· Use OPT Files to load Text Files - Use this option if you want Concordance
Desktop to load the document-level text from files existing in designated folders
that are referenced in the OPT file. Concordance Desktop does not OCR the
document-level text, it simply takes the text from the text files and loads it into
the associated records. This option can help save processing time.

· Use OCR Text Files - Use this option if you have text files that have already

been OCR'ed and you want Concordance Desktop to use those OCR'ed text files.

As with the Use OPT Files to load Text Files option, Concordance Desktop will not

do any OCRing of the text, it will simply load the text from the text files into the

associated records. This option can help save processing time. When this option is

selected, you also need to click the Browse button to locate and select the text

files.

· Use Field Containing File Path to load Text Files - Use this option if you want

Concordance Desktop to load the document level text from an OCR path referenced in

the DAT file. This new import option allows you to import document level text if

your DAT file references an OCR path. The OCR path needs to be edited to reflect

the directory where the text is located or edited to reflect a relative path. Save

the edited copy of the DAT file to the same directory as your text folders.

If the file path pointing to your text files is not accurate the text will not be imported.

15. If you want Concordance Desktop to create optimized PDFs of the native files
during the import process, check the Process to PDF. 

By default, Do not process to PDF is checked, which helps to reduce processing
time. When Process to PDF is checked, rendering of supported native file types is
done on the fly as they are viewed in the viewer. Unsupported files types however,
cannot be viewed in the viewer until they are optimized. For more information about
optimizing, please see the Optimizing documents to PDF topic.

16. Click Import to start the import of the load files you have selected.

17.  A status bar is displayed showing the import record currently in process during the
load file import process.

18. If one or more files did not import properly, a dialog box displays telling you to see
the log file. Click OK.

19. In the DAT Database dialog box:

· If all files imported properly (i.e., you did not see a dialog box stating one or more
files imported properly) , click the Open button to open the database in
Concordance Desktop. 

· If any files did not import properly, click the View Log button to check the log for
any files that did not import properly. 

Create a new database from load files using customized settings
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You can customize to the settings for the database so that they match the settings in
the load file you are importing. 

1. Review the load files you are importing into the database, see Reviewing load files.

2. In Concordance Desktop, on the File menu, click New.

3. In the New Database Wizard dialog box, click the Load Files button.
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If you know the exact path where you want to save the new database:
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· In the Database Name field, type the path where you want to save the
database, along with a name for the database.

If there isn't a folder previously created for the new database, it is
recommended to create a new folder.  Name the new folder according to your
database.  Double click the newly created folder to open it.

If you do not know the exact path where you want to save the new database:

a. Click the Browse button next to the Enter Database Name field.

b. Select the location where you want to save the new database.

If there isn't a folder previously created for the new database, it is
recommended to create a new folder.  Name the new folder according to your
database.  Double click the newly created folder to open it.

c. In the File name field at the bottom of the window, type a name for the
database you are creating. 

The Concordance Desktop server does not support Unicode characters (such
as Chinese or Japanese characters) in database names. Currently, only single-
byte characters (such as English characters) are supported. 

d. Click Save. 

You are returned to the Load File window where the Enter Database Name
field is populated with the information you entered in the Create Database
window.

4. Click the Browse button next to the Select DAT file field. 

5. Locate and select the DAT file, and then click Open.

6. To view a display of a few records prior to loading the file:

a. Click the Preview button to open the Preview window.
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The Preview window displays all fields in which there is data, along with a few
records in the load file so you can ensure that the expected meta data for each field
is correct.

a. To turn on the visibility of empty fields, check the Include Empties check box. 

When checked, fields containing no meta data are displayed in the preview,
along with those fields containing meta data.

b. When finished viewing the records, click OK to close the Preview window. 

7. Click the Customize button to open the Choose Delimiter window.

8. Use the Load Field Names From pane to define the database structure.
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In the Load Field Names From section, do one of the following:

· Select DAT File to load the database field names from the DAT file header row you
are importing.  The field type settings are automatically set to Paragraph.

· Select Template/Structure to import the field names and types from a template or
existing database structure.   In the Load Database Structure dialog box, click the
Browse button to locate and select the template/database you want to load.

· Select Settings File to import the field names and field type settings from a
specified Field Properties File (.TXT), click the Browse button to locate and select
the Field Properties file.

The Field Properties file is a text file that can be exported using the Save to
File option in the Modify dialog box (File > Modify).  The properties file lists
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the field names and type settings for the database structure.

Concordance Desktop requires that each field name be unique; therefore, if
the imported settings file and/or DAT file contain duplicate fields, the
duplicate field names are appended with a suffix of 01 up to the maximum
number of characters allowed for field length.

· Select None (Enter Field Names Manually) to manually enter all field names to
include in the database.

9. Define delimiter formats.

The delimiter format defaults to the Concordance Desktop delimiters. If you are
exporting and importing documents within the Concordance Desktop system, then
you won't need to change these default values. However, if the load file uses a
different format (i.e., comma delimited, tab delimited or a custom delimited format)
you need to change the delimited format to match that which is in the file you are
loading.



Administration 177

Concordance default delimiters

Concordance Desktop Default Delimiters

Delimiter Character Function Numeric Value

Format A selection of predefined delimiter
formats. 

Comma The field delimiter separates one field
from the other.

20
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Concordance Desktop Default Delimiters

Delimiter Character Function Numeric Value

Quote The text qualifier encloses text to
differentiate it from field delimiters
which may appear in the data.

254

Newline Substitute carriage return. Some
programs use this character to
designate multi-level fields or fields-
within-fields. Concordance Desktop
replaces all carriage returns or
carriage return linefeed combinations
with the newline code within the
data of a field. The record itself is
still terminated with a real carriage
return and a line feed.

174

To select a predefined format:

a. Click the Format down-arrow.

b. In the menu that appears, select the format that matches the format of the load
file. 

c. Make any other format changes necessary.

To select a custom format:

a. Click the Format down-arrow.

b. In the menu that appears, select Custom.

c. To modify the Comma, Quote, or Newline delimiter settings, click on the
associated down-arrow and select the format that matches the format in the load
file. 

10. Define the date format used in the load file.

a. In the Select the date format for importing date fields field, click the down-arrow. 

b. Select the date format that matches the date format in the load file. 

11. Optional: Import a Tag List.

a. In the Load Tag List pane, click the Browse button.
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b. In the Open window, locate and select the directory containing the tag list you
want to include. 

c. Click the Open button.

Tags and tag folders do not support Unicode characters. Only ASCII
(values 032-126) characters are allowed. If a tag name or tag folder
name contains an invalid character, you are prompted to make
corrections.  For more information about creating a Tag list, see Importing
and Exporting Tags.

12. Click the Next button.

13. Define the database field names and type properties

If you selected to import the field names from a DAT file, the field names are
created from the header row of the DAT file and the type property for each
field is set to Paragraph by default.  

If you selected to import the field names from a DAT file, the field names are
created from the header row of the DAT file and the type property for each
field is set to Paragraph by default.  

Make sure that the database fields you are creating match the fields in the
header row of the corresponding delimited text file you are using to import
the field data.

a. In the Modify dialog box, review the Field Name list and modify the Type settings for
each database field as needed.



Concordance Desktop 180

Field names must begin with an alphabetic character. Only alphanumeric
characters and the underscore character are allowed in the field name. The
maximum number of characters for a field name is twelve.

The order the fields are listed, is the order the fields appear in Concordance
Desktop. 

If you are creating database fields using an existing database template or
structure, or a settings file, make sure that the database fields you are
defining match the fields in the header row of the corresponding delimited
text file you will be using to import the field data. 

If you accidentally click the OK button or press ENTER while entering fields in
the Modify window, the window clsoes.  To reopen it, click the Back button
and then click the Next button.

To create a text field:

1. In the Type field, click Text.

2. In the Length field, type the number of characters allowed in the field
value. 
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Text fields can have from 1 to 60 characters. Fixed length text fields
should be used for numeric values that are not used mathematically,
such as telephone numbers, social security numbers, and other serial
numbers.

Sorting is alphanumeric.  The numbers 1 and 1000 sort before 9 and
999. Use zeros for any numeric values or serial numbers stored in text
fields so that they sort correctly, 0009 before 1000.

The field length value, affects the column width and how the field
name appears in the Table View.  The larger the number the wider the
column. Values smaller than 20 cause the field name to appear
truncated.

To create a numeric field:

1. In the Type field, click Numeric.

2. In the Length field, type the number of characters allowed in the field
value. 

Numeric fields can have up to 20 characters, including the decimal
place. The number you type in the Length field defines the total length
of the number including the decimal place and all digits following the
decimal place. 

The field length value, affects the column width and how the field
name appears in the Table View.  The larger the number the wider the
column. Values smaller than 20 cause the field name to appear
truncated.

3. In the Places field, type the number of decimal places for the numeric
field. 

For example, the number 1234.56 would have a field length of seven
and a places value of two. 

Negative numbers use an extra place for the negative sign.

4. In the Format field, choose one of the following numeric field formats:

· Plain

· Comma

· Currency
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· Zero Filled

The Format field determines how numeric fields are displayed and
printed in Concordance Desktop.

To create a date field:

In the Type list, select the date format:

· Date MMDDYYYY (month-day-year)

· Date YYYYMMDD (year-month-day)

· Date DDMMYYYY (day-month-year)

The date field format you choose is the date format that is displayed in
Concordance Desktop.

You need to use the date format selected in the Type field when
searching for dates and entering dates during data entry.

Concordance Desktop sorts date fields correctly, regardless of the date
format you choose in the Type field.

To create a paragraph field:

In the Type field, click Paragraph.

Paragraphs fields can have up to 12 million characters. Even though
paragraph fields are variable in length, Concordance Desktop only sorts
paragraph fields by the first 60 characters in the first line of text.  

b. For each field, select the check boxes for the properties that apply.

Image (Media) check box

An image/media field is used to link Concordance Desktop with the viewer.
The Image check box needs to be selected for only one of the database's
fields. It is best practice to select the Image check box for the BEGNO field or
it's equivalent. This box should only be checked if you select to produce near
native PDFs

When you view a document associated with a record in Concordance
Desktop, the corresponding media/image is displayed in the viewer. 

Key check box

Selecting the Key check box makes the field a key field. Any field can be a
key field, but most often fixed-length fields and date, numeric, and text fields
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that you need to search are designated as key fields. Key fields perform a
function similar to indexing, but they do not require reindexing. When fields
are designated as key fields, Concordance Desktop creates a database .key
file, which is used in searching key fields.

Full-text paragraph fields are usually made into key fields for only one reason,
which is to quickly locate empty paragraph fields. 

For example, the search author = "", where AUTHOR is full-text paragraph
field, would normally perform slowly, but it will work quickly when the AUTHOR
field is a key field. To locate records where this field is not empty use the
search author > "". Note that there are no spaces between the quotes.

So, why not make all fields key fields? The key field file takes up room. The
more key fields your database has, the more room it will take up. Typically,
full-text paragraph fields are not searched using comparison operators.
Making full-text paragraph fields key fields is of marginal benefit and adds
administrative overhead to the database management system. Also, if you
have fixed-length fields that you do not need to search, it is best practice
not to designate those fields as key fields.

Accession check box

Accession numbers are unique serial numbers internally assigned to each
record in Concordance Desktop version 6.x or later databases. Accession
numbers are stored with each record and are managed entirely by the
database software. They stay with the document as long as the document
stays in the database, even if other records are deleted around it. Accession
numbers cannot be edited or modified in any way, but they can be viewed. 

The Accession check box only needs to be selected for one of the database's
fields. To create accession numbers, create an accession field by adding a
numeric field to your database and selecting the Accession check box. It is
best practice to select the Accession check box for the ACCESSID field or it's
equivalent. The internal accession number for each record will be displayed in
the accession field you create.

System check box

System fields are created by Concordance Desktop. Concordance Desktop
automatically selects the System check box for system fields, which are hidden
fields with no read or write end-user privileges. System fields are used for
internal system administration features such as replication. Under normal
circumstances, system fields should never be indexed, added, deleted or
modified by users.

Indexed check box
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A field must be indexed to use Concordance’s full-text search capabilities.
Indexing places every word in the field into a dictionary for fast retrieval.
Concordance Desktop automatically selects the Indexed check box when you
create a paragraph field. You need to manually select the Indexed check box if
you want to index other field types.

You can change the Indexed check box setting at any time, however changing
the setting will not update the dictionary. Index the database after modifying
the Indexed check box setting to update the dictionary files.

c. To add additional fields to the database, click the New button and define the
field name and type settings.

d. To remove fields from the database, select the field you want to delete, and
then click the Delete button.

e. Review the punctuation in the Punctuation field and add any other punctuation
that is integral to your searches, such as :;-@$.

f. The Punctuation field defaults to the following punctuation: '.,/. The punctuation list
is used in full-text searching, see About Punctuation.

g. To save these field settings so you can use them as a template, click the Save
to File button, locate where you want to save the template file, give it a file
name and then click Save. The file must be saved in Text (.txt) format.

14. When finished defining the database field names and type properties, click OK. 

An Import Wizard - Fields window opens.
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15. Select database fields to import.

By default, all of the database fields are added to the Selected fields list for the
import. In the Fields dialog box, you can also set up the fields associated with
document attachments (Optional).  The attachment fields can be set up or changed
any time after the database is created.  For more information, see Defining
preferences.

a. To only select some of the fields for the import, click the double arrow (<<)
button to move all the fields to the Available fields list.
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b. In the Available fields list, select the fields you want to include in the import,
and click the right arrow (>) button to add the fields to the Selected fields
list. 

c. Once you have added the applicable fields to the Selected fields list, use the
Up and Down buttons to make the field order match the field order of your
delimited text file.

The field order in the Selected fields list, must match the field order of your
delimited text file.  If you created the database fields using a DAT file and
haven't made any modifications to the field names, the fields are listed in the
same order in which they appear in the DAT file.  However, it is recommended to
open the DAT file to verify the fields are correct.

Print a one-page copy of your delimited text file so you can reference your
header row while determining the field order during the import.

If the field structure that you enter in Selected fields list does not match the
field structure of your delimited text files, the data won’t transfer into
Concordance Desktop properly.

16. To display system fields in the database, select the Show system fields check
box.

System fields are fields used by Concordance Desktop to administer database functions,
such as replication. They are generally not visible, but you can display and import them if
you select the Show system fields check box.

17. To prevent Concordance Desktop from creating a record for your field name row,
select the Skip first line check box.

The first line of a data file sometimes contains the field names used in creating the
database, with each field name taking the place of the data for that record. When you
select the Skip first line check box, Concordance Desktop ignores that line of data during
the import.

18. If you are loading from a text file that includes Rich Text, and you want to include
that Rich Text formatting, check the Import rich text check box.

This option is only available when you are loading/importing a text file that includes
Rich Text formatting.

19. To setup the attachment fields, in the Set Attachment Fields section, do any of the
following:

· To set a field to a range of attachments, select the Attach Range option, and
then select the field to store the attachment range data. 
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· To set up the beginning and ending attachment fields, select the Fields option,
and then from the Beg Attach and End Attach lists select the beginning
attachment number and ending attachment number fields.

When using the Find Attachments feature, it is best practice to setup the
fields as paragraph type fields to increase the performance and make sure to
index/reindex the database. For more information about the Find Attachments
command, see Finding attachments.

20. When finished, click OK.

You are returned to the Load File window. 

21. Select or create an OPT file.

If you have an OPT file to load, select it.

a. Click the Browse button next to the Select OPT File field. 

b. Locate and select the .opt file you want to load.

c. Click Open.
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You are returned to the Load File window where the Select OPT File field is
populated with the selection you just made.
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If you do not have an OPT file to load, create one.

a. Click the Create button next to the Select OPT File field. 

b. Click the ellipse button and select the location where you want to store the
OPT file. 

We suggest that you enter a folder and sub-folder that is located in the same
directory as the This should be in a sub-folder as your DAT file,and have the same
name as.  Alternatively, you  can open Windows Explorer, locate and open the
folder where the image files are, and then drag and drop the image files into the
large box below the OPT file

c. Open a Windows Explorer window.

d. Locate and open the folder where the image (.TIF) files are located.  

e. Drag and drag the image files into the large box below the OPT file.

f. Click OK.

You are returned to the Load File where the Select OPT file is populated with the
OPT file location you just entered.

22. Select Pre-append path.  In the Pre-append dialog box the UNC path upto the
image path in the .opt or browse out to the folder containing the image folder.

What is a pre-appended path?

For example, the path in the .opt is: Images\0001\T000001.tif

The folder structure where the data was copied is: \
\uncpath\Matter001\Vol001\Images\0001\T000001.tif
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Select Pre-append path and add \\uncpath\Matter001\Vol001\ in the Pre-
append dialog box or browse to \\uncpath\Matter001\ and select Vol001.

The UNC path is added before the image path in the .opt during import.

Pre-append path assists the administrator in appending the path without
having to change the structure of the .opt.

23. Click on the Key down-arrow and select the name of the field used to identify the
beginning of new records. 

An example would be BEGNO. 

23. Click on the OCR down-arrow and select the name of the field to contain the
document-level text of each record.  

Some examples are TEXT1 or OCR1

The wizard can import both single or multi-page OCR text files.  To import the
files correctly, make sure that all the text files are located within the same
directory.

24. (Optional) Click the Customize Image/OCR button if you want to change the
default OCR method. 

The Customize OCR dialog box opens.

Options are:

· Use CN Desktop OCR - Use this option if you want Concordance Desktop to OCR
all the files regardless of any existing OCR'ed text files. By default, Concordance
Desktop does not OCR the text files.
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· Use OPT Files to load Text Files - Use this option if you want Concordance
Desktop to load the document-level text from files existing in designated folders
that are referenced in the OPT file. Concordance Desktop does not OCR the
document-level text, it simply takes the text from the text files and loads it into
the associated records. This option can help save processing time.

· Use OCR Text Files - Use this option if you have text files that have already
been OCR'ed and you want Concordance Desktop to use those OCR'ed text files.
As with the Use OPT Files to load Text Files option, Concordance Desktop will not
do any OCRing of the text, it will simply use load the text from the text files into
the associated records. This option can help save processing time. When this
option is selected, you also need to click the Browse button to locate and select
the text files.

· Use Field Containing File Path to load Text Files - Use this option to import
document-level text files if the DAT file references an OCR path. The OCR path
needs to be edited to reflect the directory where the text files are located or
edited to reflect a relative path. When using the relative path in the DAT file, the
edited copy of the DAT file must be in the same directory as your text folders.

If the file path pointing to your text files is not accurate the text will not be imported.

25.  If you want Concordance Desktop to create optimized PDFs of the native files
during the import process, check the Process to PDF. 

If the load file contains other file types than .tif or .pdf, then Process to PDF
needs to be enabled for viewing those files.

By default, Do not process to PDF is checked, which helps to reduce processing
time. When Process to PDF is checked, rendering of supported native file types is
done on the fly as they are viewed in the viewer. Unsupported files types however,
cannot be viewed in the viewer until they are optimized. For more information about
optimizing, please see the Optimizing documents to PDF topic.

26. Click Import to start the import of the load files you have selected.

27.  A status bar is displayed showing the import record currently in process during the
load file import process.

28. If one or more files did not import properly, a dialog box displays telling you to see
the log file. Click OK.

29. In the DAT Database dialog box:

· If all files imported properly (i.e., you did not see a dialog box stating one or more
files imported properly) , click the Open button to open the database in
Concordance Desktop. 

· If any files did not import properly, click the View Log button to check the log for
any files that did not import properly. 
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Creating a new e-documents database

Concordance Desktop is able to create a database using a variety of native files (e-
documents), including text, Adobe Acrobat PDF, and Microsoft Word, PowerPoint, and
Excel files. 

When creating a database, Concordance Desktop automatically processes and normalizes
the documents during import. The Concordance Desktop E-documents engine OCRs all the
native files (e-documents) and generates a .PDF near-native version of the document for
viewing in Concordance Desktop Viewer. The PDF near-native files are stored in the
database folder in a separate Near Natives folder and a copy of the native file is stored in
a Natives folder. Documents are imported alpha-numerically. The Temp folder contains the
.txt formatted files for the OCR text that was extracted from the document and is cleared
when the import process is complete.

Concordance Desktop database folder structure

To create an E-documents database:

1. On the File menu, click New.

2. In the New Database Creation Wizard window, choose the viewer for the new
database, and click the E-documents button.

The Create E-Documents Database window opens.
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3. Select the location of the e-document files by either:

·   Selecting the folder from the folder list:

a. In the Select document location list, expand the folders.

b. Navigate to the location where the documents you want to import are
located.

c. Click on the folder name you want to select. 

d. Click the Add button.

· Entering the full path of the folder:

a. In the Add Path field, type the full path to the folder in which the files are
located. 

b. Click the Add button.

4. Repeat step three for each set of documents you want to import into the database.

5. To include files from any sub-directories within the folder, select the Include
subdirectories check box.
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6. Select the location where you want to create the database.

a. In the Select database location field, click the Browse button.

It is recommended that each database be created in its own unique folder.

b. Navigate to the location where you want to save the new database.

c. In the File name field, type a name for the new database.

The Concordance Desktop server does not support Unicode characters (such
as Chinese or Japanese characters)  in database names. Currently, only
single-byte characters (such as English characters) are supported. 

d. Click Open.

7. To customize the import settings:
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a. Click the Customize button, and then do any of the following:

· To use an existing database template

1. Click the Choose Database Template Browse button. 

2. Locate the database template to use. 

3. Click Open.

· To change the document numbering defaults

1. Click on the Auto number documents arrow to open that section, if it is not
already open. 

2. In the Starting Number field, enter the number you want to begin with for
numbering the documents. The default is 0000001.
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Make sure to precede the starting number with enough zeros to cover the
total number of records being imported. For example, if you are importing a
DAT file that includes includes 999 records and you want to start numbering
with 1, enter 001 as the starting number. If the file includes 550,500 records
and you want to start the numbering with 1, enter 000001. 

3. Optional:  In the Prefix field, type the prefix you want to use in front of the
numbers. 

· To add Bates Stamping to the documents

1. Click the Bates Stamp arrow to open that section, if it is not already
open. 

2. To enable Bates stamping, click on the Bates stamp documents field. A
down-arrow appears at the end of the field.

3. Click the down-arrow and select Yes. 

The default is No, do not put Bates Stamps on the documents. 

After you select Yes, two other fields appear under the Bates Stamp section.

4. Optional:  In the Bates prefix field, enter the prefix you want to use in
front of the Bates Stamp number.

You cannot currently use Unicode characters in the Bates stamp prefix
field. Doing so will not display the character correctly.

5. In the Bates starting number field, enter the beginning Bates Stamp number
you want to use.

· Specify whether to copy the original native files and store them

You can specify whether to copy the original native files and store the copies in a
Native Files folder with the database.

1. Click on the Native file arrow to open that section, if it is not already
open. 

2. Click on the Copy original files field to select it. 

3. Click the down-arrow and select Yes or No. The default is Yes. 

· Yes indicates that you want to copy the original files and store them in
a Native Files folder with the database.

· No indicates that you do not want to copy and store the original files.  

· To change imported data (document metadata) mapping to Concordance
fields 

1. Click on the Field mapping arrow to open that section, if it is not already
open.
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2. Click on a field that you want to change, to select it.

3. Click on the down-arrow and select the imported data type.

When importing E-Documents, Concordance Desktop createsa unique document
ID and captures metadata where possible, including author, creation date, and
last modified date. Concordance Desktop also captures the metadata present in
formatting such as font changes, bolding, underlining and highlighting. Each of
the fields in the Field mapping section are automatically set to the default
Concordance Desktop field mappings. 

Ensure that the documents import properly, the Document Text field must be
set to the first OCR paragraph field with an alpha prefix and numeric suffix.
For example, if you have TEXT01, TEXT02, and TEXT03, you must set the
OCR paragraph field to TEXT01. Do not set the OCR field to any other type of
paragraph field, as the text will not be imported. 

The CREATEDATE and EDITDATE fields should not be set to <none>. 

b. When finished customizing, click OK. 

You are returned to the Create E-Documents Database window.

8. Click the Import button.

9. If one or more files did not import properly, a dialog box displays telling you to see
the log file. Click OK.

10. In the E-Document Database dialog box:

· If all files imported properly (i.e., you did not see a dialog box stating one or more
files imported properly) , click the Open button to open the database in
Concordance Desktop. 

· If any files did not import properly, click the View Log button to check the log for
any files that did not import properly. 

After the import is complete, it is recommended that you review the import log to
verify document import success and failure messages.

Creating a new e-mail and attachments database

When creating an Email and Attachments database, Concordance Desktop uses a
Database Creation Wizard to walk you through each step of the database creation
process.  Using the wizard, Concordance Desktop imports one or more .pst formatted files.
When importing multiple .pst files, a new database is created for each .pst, and all
database are automatically concatenated. 
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Concordance Desktop provides you with an E-mail and Attachments template, but you
may also create your own. The E-mail and Attachments template includes typical
metadata fields from Outlook and takes care of the field mapping for you. The template
also allows you to create and modify fields as needed.

If you need to export your e-mail from Concordance Desktop back to a .pst file, then
consider using CloudNine's LAW software for processing before importing to
Concordance Desktop.

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop. 

To create an E-mail database:

The second step is to create a database  and import the e-mail and attachment files.

1. In Concordance Desktop, on the File menu, click New.  A logon dialog box opens. 

2. Enter your logon name and password, and then click Connect.

3. In the New Database Creation Wizard window, choose the viewer for the new
database, and click the E-mail and Attachments button.

The Create E-Mail Database window opens.
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4. Select the location of the .pst files by either:

· Selecting a .pst from the folder list:

a. In the Select document location list, expand the folders.

b. Browse to the location where the .pst file you want to import is located.

c. Click on the .pst file to select it. 

d. Click the Add button.

e. To add more .pst files, repeat the steps for each file. 

· Entering the full path and .pst file name:

a. In the Add Path field, type the full path to the .pst file, including the .pst file
name. 

b. Click the Add button.

c. To add more .pst files, repeat the steps for each one. 

5. Repeat step 3 for each .pst file you want to add to the import. 
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6. Select the location where you want to create the database.

a. In the Select database location field, click the Browse button.

b. Navigate to the location where you want to save the new database.

c. In the File name field, type a name for the new database.

The Concordance Desktop server does not support Unicode characters (such as
Chinese or Japanese characters) in database names. Currently, only single-byte
characters (such as English characters) are supported. 

d. Click Open.

7. To customize the import settings:
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a. Click the Customize button, and then do any of the following:

· To use an existing database template

1. Click the Choose Database Template Browse button. 

2. Locate the database template to use. 

3. Click Open.

· To change the document numbering defaults

1. Click on the Auto number documents arrow to open that section, if it is not
already open. 

2. In the Starting Number field, enter the number you want to begin with for
numbering the documents. The default is 0000001.

Make sure to precede the starting number with enough zeros to cover the
total number of records being imported. For example, if you are importing a
DAT file that includes includes 999 records and you want to start numbering
with 1, enter 001 as the starting number. If the file includes 550,500 records
and you want to start the numbering with 1, enter 000001. 

3. Optional:  In the Prefix field, type the prefix you want to use in front of the
numbers. 

· To add Bates Stamping to the documents

1. Click the Bates Stamp arrow to open that section, if it is not already
open. 

2. To enable Bates stamping, click on the Bates stamp documents field. A
down-arrow appears at the end of the field.

3. Click the down-arrow and select Yes. 

The default is No, do not put Bates Stamps on the documents. 

After you select Yes, two other fields appear under the Bates Stamp section.

4. Optional:  In the Bates prefix field, enter the prefix you want to use in
front of the Bates Stamp number.

You cannot currently use Unicode characters in the Bates stamp prefix.
The Unicode character will not display correctly.

5. In the Bates starting number field, enter the beginning Bates Stamp number
you want to use.

· Specify whether to display the full path of attachments

You can specify whether to display the full path of e-mail attachments. 
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1. Click on the Path Display arrow to open that section, if it is not already
open. 

2. Click on the Display Full Path of Attachments field to select it. 

3. Click the down-arrow and select Yes or No. The default is Yes. 

· Yes indicates that you want to display the full path of attachments.

· No indicates that you do not want to display the full path of
attachments.  

· Specify whether to allow duplicate e-mails

Most e-mails have a unique message identifier called the message-id. This entry is
stored in the MESSAGEID field. Before importing a message, the Import e-mail
wizard checks to see if any previously imported e-mails have the same message-
id. If the wizard finds another record with this message-id, it does not import the
message. 

You can specify whether to allow duplicate E-mails to be included in the
database. 

1. Click on the Duplicate Handling arrow to open that section, if it is not
already open. 

2. Click on the Do not allow duplicate E-mails field to select it. 

3. Click the down-arrow and select Yes or No. The default is Yes. 

· Yes indicates that you do not want to allow duplicate E-mails to be
included in the database.

· No indicates that you want to allow duplicate E-mails to be included in
the database. 

To change imported data (document metadata) mapping to Concordance fields 

1. Click on the Field mapping arrow to open that section, if it is not already
open.

2. Click on a field that you want to change, to select it.

3. Click on the down-arrow and select the imported data type.

When importing .pst files, Concordance Desktop captures metadata when
possible. Concordance Desktop also captures the metadata present in formatting
such as font changes, bolding, underlining and highlighting. Each of the fields in
the Field mapping section are automatically set to the default Concordance
Desktop field mappings. 

To ensure that the documents import properly, the Document Text field must
be set to the first OCR paragraph field with an alpha prefix and numeric suffix.
For example, if you have TEXT01, TEXT02, and TEXT03, you must set the
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OCR paragraph field to TEXT01. Do not set the OCR field to any other type of
paragraph field. 

b. When finished customizing, click OK. 

You are returned to the Create E-Mail Database window.

8. Click the Import button.

9. If one or more files did not import properly, a dialog box displays telling you to see
the log file. Click OK.

10. In the E-Document Database dialog box:

· If all files imported properly (i.e., you did not see a dialog box stating one or more
files imported properly) , click the Open button to open the database in
Concordance Desktop. 

· If any files did not import properly, click the View Log button to check the log for
any files that did not import properly. 

To verify the imported files:

Once you have created the email database, it is best practice to verify that the files
imported correctly. After verification, you also need to index the database.

1. In Concordance Desktop, open the Browse view.

2. In the Browse view, verify that the e-mail messages you imported display properly.

3. If you have not already indexed the database, run a full index now.

For more information about indexing and reindexing databases, see Indexing and
reindexing updates.

If you receive the following message, Dictionary file exists, overwrite?, click Yes.

Creating/updating a transcripts database

Transcripts are the easiest files to load, but you must load the files into a database
created from the Transcript database template. The template is hard-coded with a CPL
script that enables line numbering and does the work for you. You can import plain text
transcripts, depositions, and West LiveNote portable transcript (.ptf) and portable case
format (.pcf) files.

Transcript Import Guidelines
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· The transcript database must be created from the Concordance Desktop Transcript
template

· The maximum size for an imported transcript file is 11 MB

· On average, transcripts have 24-25 lines per double-spaced page

To create a transcript database

1. On the File menu, click New.

You are asked to log onto the Concordance Desktop server where you want to
create the Transcripts database.  

Note that you must either be logged into the physical server itself, or using
Windows Remote Desktop to log into the server. You can only create databases
when on the actual server computer itself. 

Note also that you must be a Concordance Desktop administrator on the server you
are logging on to. 

2. Type you Logon and Password for the specific Concordance Desktop server. 

3. Type the Host name or IP address of the server and the Port you need to use to
connect to it. 

4. Click Connect. The New Database Creation Wizard dialog box opens.

5. Select the viewer for the new database and click the Transcript button.

6. Navigate to where you want to save the transcripts .dcb database file. 

A dialog box opens allow you to select the location for the new database, and a file
name. 

7. Optional: Create a new folder for the database files.

8. Type the database file name in the File name field, and click Open.

The Concordance Desktop server does not support Unicode characters (such as
Chinese or Japanese characters)  in database names. Currently, only single-byte
characters (such as English characters) are supported. 

A Load Transcripts dialog box opens.

9. In the Properties section, review the information Concordance Desktop has
extracted from each of the transcripts you are importing.

10. Navigate to where the transcript files are located. 

To view the transcript information for each transcript, click the transcript file name
in the File column.

11. Make any necessary edits in the Properties section and click Save.
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You can edit or add information in the Name, Date, Time, or Comments fields for
each transcript before you save it. Use the preview pane at the bottom of the
dialog box to locate information needed for those fields. 

If you do not want to review the extracted transcript properties for each of the
imported transcripts, and just want to save the extracted transcript properties as
they are, select the Save all with default settings check box and click Save.

Clicking Save completes the transcript import. 

12. To import additional transcript files, click the Load button.

13. To close the Load transcripts dialog box, click Done. 

To import PTF or PCF transcript files:

1. On the Documents menu, point to Import, and click Transcripts.

The Transcipts menu command is only enabled when the current database was
created using the Transcripts template.

Clicking Transcripts opens the Load transcripts dialog box.

2. Locate and open the .pcf transcript files you want to import.

Clicking Open opens the Load transcripts dialog box and automatically loads the
transcript files into the transcript database.

The process for importing .pcf transcript files is slightly different than importing TXT
or .ptf transcript filess. Because .pcf files contain multiple transcripts, you are not
able to edit and save individual transcripts within a file. Therefore, the step to edit
and save the transcript metadata information is skipped in import process.

3. To import additional transcript files, click the Load button.

4. To close the Load transcripts dialog box, click Done.

To verify the imported files:

Once you have imported your transcript messages, it is best practice to verify the files
imported correctly. After verification, you need to reindex or index the database.

1. In Concordance Desktop, open the Browse view.

2. In the Browse view, verify that the transcript messages you imported display
properly.
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3. If you have already indexed the database, reindex the database. Otherwise, run a
full index.

For more information about indexing and reindexing databases, see Indexing and
reindexing updates.

If you get a message prompt stating, Dictionary file exists, overwrite?, click Yes.

About Migrating Databases

Database migration preparation

Concordance databases that you want to open in Concordance Desktop need to first be
migrated to Concordance Desktop. Before migrating however, there may be some
additional preparation involved, based on the version of Concordance with which the
database was built, as well as some other factors.  

· Concordance databases created with Concordance versions 8.x or 9.x must first be
converted to Concordance 10.x databases, before they can be migrated to
Concordance Desktop databases. 

· Only Concordance 8.x and 9.x databases can be converted to Concordance 10.x. If
your database was built with an earlier version of Concordance, it cannot be converted
to Concordance 10.x, and cannot be migrated to Concordance Desktop. 

· If using Concordance Image, prior to converting a Concordance 8.x or 9.x  database to
10.x, the imagebase must be converted from a version 4.0 imagebase to a version 5.0
imagebase in Concordance Image. 

· Additional factors in determining how a database should be prepared for migration to
Concordance Desktop:

· The version of Concordance used to create the database

· Whether Concordance Image was used to view native files

· Whether Concordance Desktop Viewer was used to view near native files

· Whether the database has been moved

· Whether the native files (only if using Concordance Image) have been moved

· Whether the near native files (only if using Concordance Desktop Viewer) have been
moved

Only Concordance version 10.x SQLite databases can be migrated to the Concordance
Desktop database format. Therefore, all databases created with Concordance 8.x or
9.x need to first be converted to version 10.x SQLite databases before attempting to
migrate them to Concordance Desktop. 

Prior to converting a Concordance 8.x or 9.x version database to 10.x, you must
convert the imagebase in Concordance Image from a version 4.0 imagebase to a
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version 5.0 imagebase. Only after this is done can you proceed with converting the
database to Concordance version 10.x.

The migration is permanent and there is no process to convert a database back to a
Concordance database. Therefore, we recommend that you make backup copies of
the databases before migrating them to Concordance Desktop.

Do you plan on moving a database you want to migrate?

Concordance 10.x database (other than a 10.21 E-Documents database)

If you plan to migrate a Concordance 10.x database to Concordance Desktop, and also
plan to move it to another server, drive, or folder, please follow the steps below, in the
order they appear. 

1. Move the database to its new location.

2. Open the database in Concordance 10.x. Doing this ensures that the notes DCB is
properly linked to the parent DCB. 

3. If the native files have been moved, edit the native file path (see Updating hyperlinks
file path), and then recreate the hyperlinks in the records using the CreateHyperlinks
CPL.

4. Re-index the database and test the hyperlinks to ensure they work. 

5. Refer to the factors in the table below that apply to a Concordance 10.x database
(other than a 10.21 E-Documents database).

Concordance 10.21 E-Documents database

If you plan to migrate a Concordance 10.21 E-Documents database, and also plan to move
it to another server, drive, or folder, please follow the steps below in the order they
appear.

1. Move the database to its new location.

2. Open the database in Concordance 10.21. Doing this ensures that the notes DCB is
properly linked to the parent DCB. 

3. If the native files have been moved, edit the native file path (see Updating hyperlinks
file path), and recreate the hyperlinks in the records (see the CreateHyperlinks CPL
topic).

4. Refer to the factors in the table below that apply to a Concordance 10.21 E-
Documents database.

Database preparation checklist

Below is a checklist that provides the various preparations, based on the various factors
listed above. 
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Database factor Preparation

Concordance 7.x or
below database

YES: The database cannot be migrated to Concordance Desktop.

NO:  Continue to next factor.

Concordance 8.x or 9.x 
database

YES: Are you using Concordance Image?

Yes: If using Concordance Image 4.0 (formerly Opticon), the
imagebase must be converted to Concordance Image
version 5.0, prior to converting the database to
Concordance 10.x.

Is the imagebase currently a Concordance 5.0 imagebase?

Yes: Convert the database to a Concordance 10.x
database. 
See Converting databases on the Concordance Answer
Center.

No: Convert the imagebase to Concordance Image from
version 4.0 to 5.0 first, then convert the database to
Concordance 10.x. 
See Converting imagebases and Converting databases
on the Concordance Answer Center.

 No: Concordance Image is not being used. There is no
imagebase to convert. 
You are ready to convert the database to Concordance
10.x. 
See Converting databases on the Concordance Answer
Center.

NOTE: Once the database has been converted to
Concordance, 10.x, go to the Concordance 10.x (other
than E-Documents) database factor below.

NO: It is not a Concordance 8.x or 9.x database. Continue to the
next factor.

Concordance 10.x
(other than a 10.21 E-
Documents) database

If the database is a Concordance 10.x database, other than a 10.21
E-Documents database, then follow this set of preparations.

YES: Are you using Concordance Image?

Yes: If the database folder contains a [database
name].DIR file and a [database name].VOL file, it indicates
that Concordance Image was used for the imagebase.

Do you want to maintain your redactions and notes when
you migrate the database to Concordance Desktop?

Yes: Use the Redline Migration Utility to migrate the
database to Concordance Desktop.

CAUTION: When using the Redline Migration Utility
to migrate a 10.x database to Concordance
Desktop, all data from the database moves over,
but only redactions and notes are moved over
from the imagebase.
NOTE: If you plan to move the database to another
server, drive, or folder, move the database first, and
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Database factor Preparation

then open it in Concordance 10.x to reset the link
between the DCB and the Notes DCB. Once these two
steps are finished, you can migrate the database.  

No: There is no need to run the Redlines Migration
utility. The database is ready for migration to
Concordance Desktop. 

NOTE: If you plan to move the database to another
server, drive, or folder, move the database first, then
open it in Concordance 10.x to reset the link between
the DCB and the Notes DCB, and then migrate the
database.

No: Are you using Concordance Desktop Viewer?

Yes: If using Concordance Desktop Viewer, you can
use any of the methods in the Migrating databases
to Concordance Desktop topic, to migrate the
database to Concordance Desktop.

CAUTION: When migrating a 10.x database to
Concordance Desktop, all data from the database
moves over, but markups (redactions, notes,
etc.)are not moved over. Markups will need to
be either burned in prior to migration, or
reentered through Concordance Desktop after
migration. Please note that burned in markups
cannot be edited, they are permanent.

No: The database can be migrated, providing the
database has not been moved. If the location of the
database has changed since you last opened it in
Concordance 10.x, please see the note above.

NO: The database is not a Concordance 10.x database (other than
an 10.21 E-Documents database). Continue to the next factor.

Concordance 10.21 E-
Documents database

If the database is a Concordance 10.21 E-Documents database,
there are two final determining factors that need to be addressed;
whether the database was built with the old e-documents engine or
with the new e-documents engine. The new e-documents engine
creates databases that are completely compatible with
Concordance Desktop, however, the old e-documents database
engine does not.

YES: Does the database folder contain a [database name].CIB file
and a Near Natives folder?

Yes: This indicates that the database was built with the
new 10.21 E-Documents engine, which is completely
compatible with Concordance Desktop. The database is
ready to be migrated. 

NOTE: When migrating a 10.21 E-Documents database
that was built with the new E-Documents engine, all
data is moved over, and markups (redactions, notes,
etc.) are also moved over. Markups will need to be
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Database factor Preparation

reentered through Concordance Desktop after the
database has been migrated.

No: The database was created with the old E-Documents
database engine. 

CAUTION: When migrating a 10.21 E-Documents
database that was built with the old E-Documents
engine, all data is moved over, but markups
(redactions, notes, etc.) are not moved over. Markups
will need to be reentered through Concordance Desktop
after the database has been migrated. 

NOTE: If you plan to move the database to another server,
drive, or folder, move the database first, and then open it in
Concordance 10.x to reset the link between the DCB and the
Notes DCB. Once these two steps are finished, you can migrate
the database.

NO: Return to the factor above that applies to the database version
and type.

Migrating databases to Concordance Desktop

Migration of a 10.x database can be an easy process if the files have been properly
prepared. Before attempting to migrate a database from Concordance to Concordance
Desktop, please review the information in the Database migration preparation topic. Doing
so will help to mitigate issues that could arise when attempting to migrate Concordance
databases to Concordance Desktop. 

When a database is ready to be migrated, the migration can be completed using any one
of the following methods: 

· Placing a folder, that contains all the files for the Concordance 10.x SQLite database, in
the Registration Directory for automatic migration. Ensure that you do not place the
folder inside another folder that contains a database. There can be only one database
per folder, and each folder can reside under the Registration Directory. 

· Registering a Concordance 10.x SQLite database with the Concordance Desktop server.
See Registering/unregistering a database in the Answer Center or the Installation Guide
for more information.

· Selecting File > Open in Concordance Desktop and selecting a Concordance 10.x SQLite
database

· Double-clicking on a Concordance 10.x database on the Concordance Desktop server
computer. This method will not work, if Concordance 8.x or 9.x is currently installed on
the same server computer as Concordance Desktop.
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· Concordance Image ONLY: If Concordance Image was used for the imagebase in
Concordance 10.x, and you need to retain redactions and notes in the database, the
Redlines Migration Utility should be used to migrate the database. Using any of the other
four methods will not retain the redactions and notes.

Concordance Desktop provides the ability to convert version 10.x load file databases
without near native conversion, thereby decreasing the time needed to migrate the
databases.

If you plan to migrate an existing Concordance 10.x database to Concordance
Desktop, but also want to move it to another server or folder, first move the
database to its new location, then open it in Concordance 10.x. Doing so ensures
that the notes DCB is properly linked to the parent DCB. Next, ensure that the image
and native file links are updated in Concordance 10.x and that they are working
properly. Once these steps are done, you can migrate the Concordance 10.x
database to Concordance Desktop. 

If you plan to migrate a Concordance 10.x database to Concordance Desktop, and
also plan to move it to another server, drive, or folder, please follow do the following
in the order they appear. 

1) Move the database to its new location. Note that there can be only one database
per folder. The folder can reside within another folder, but not within another
database's folder. 
2) Open the database in Concordance 10.x. Doing this ensures that the notes DCB is
properly linked to the parent DCB. 
3) Migrate the database to Concordance Desktop. 

Placing a database folder in the Registration Directory for automatic migration

When you place a Concordance 10.x SQLite database folder (the folder containing all
the files for the database) into the directory that has been designated as the
"Registration Directory" in the Admin Console, Settings tab, the database is
automatically migrated and registered on the Concordance Desktop server. A
Registration Directory can be any directory on the server computer, even one that
contains all your current Concordance 10.x SQLite databases in their respective folders.
Only one Registration Directory can be designated per Concordance Desktop server.
The default directory is named "DB Smart Path" and is located in the server computer's
ProgramData directory (usually C:\ProgramData\LexisNexis\Concordance Desktop\DB
Smart Path). See Changing the default Registration Directory for more information on
how to designate a different directory as the Registration Directory. 

To copy a database folder to the Registration Directory:

1. Before migrating a database, make a backup of all the files in the database.
(Backup the whole folder, including all sub-folders.)

2. Open Windows Explorer and navigate to the your Registration Directory folder.
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Th default Registration Directory folder is named "DB Smart Path" found in the ..
\ProgramData\LexisNexis\Concordance Desktop\ folder on the Concordance
Desktop server computer. 

3. Open another Windows Explorer window, and navigate to to the location of a
folder containing a Concordance 10.x SQLite database that you want to migrate
to Concordance Desktop. 

4. Copy the whole database folder and paste it into the Registration Directory
folder. 

The next time you open Concordance Desktop, any databases the application
finds in the Registration Directory will automatically be migrated and registered
with the Concordance Desktop server. 

To ensure that a database has been migrated successfully, you can check its
status in the Databases list in the Admin Console, under the Management tab. If
the migration failed, you can check the log file for more information.

Migrating a database through registration

1. Before migrating a database, make a backup of all the files in the database. (Backup
the whole folder, including all sub-folders.)

2. On the File menu, click Administration and then Admin Console.

3. Log onto the server where you want to register the database. 

You must be a Concordance Desktop administrator on the selected server in order
to register a database.

4. Click on the Management tab.

5. Right-click on the Databases folder, and then click Register database.

6. In the field that appears, type the name of the database you want to register, and
press Enter. 

An Open dialog box opens.

7. Locate and open the folder where the database is located.

8. Click on the database DCB file to select it. 

9. Click Open.

A dialog box opens stating that the database has been queued for imagebase
migration. Or, depending on the database type, you may be asked if you are ready
to migrate the database. 
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After the migration and registration processes are finished, the Databases pane
opens on the right. The database you just registered displays at the bottom of the
list. If the imagebase is being migrated, the status of the database will show
"Converting" until the process finishes. This process may take a while, depending on
the number of files in the database.

If the selected database is a Concordance Desktop database, after the registration
process is finished, the Databases pane opens on the right. The database can be
found at the bottom of the list. 

The Status column indicates whether or not migration for the Concordance 10.x
database was successful. If successful, the Status column displays "Online", of not
successful, it displays "Conversion failed" or "Registration failed." More information
about failures can be found in the server log file. 

If Auto refresh is turned on (Auto refresh on), the database name appears under
the Databases folder, after auto refresh runs.

Selecting File > Open to migrate a Concordance 10.x database

1. Before migrating a database, make a backup of all the files in the database. (Backup
the whole folder, including all sub-folders.)

2. Open Concordance Desktop on the Concordance Desktop server.

3. From the File menu click Open. 

4. Navigate to the location of a Concordance version 10.x SQLite Concordance
database that you want to migrate.

A dialog box opens notifying you that the database is not compatible with
Concordance Desktop, and that the imagebase need to be updated. database must
be migrated to Concordance Desktop before it can be opened.

5. Click Yes. 

The migration in progress dialog box opens. When the migration finishes, the
database opens in Concordance Desktop. 

Double-clicking a database to migrate it

Double-clicking on a Concordance 10.x SQLite database on the Concordance Desktop
server computer. Concordance Desktop prompts you to migrate the database. Please
note that if you still have Concordance version 9.x or 8.x installed on the same
server/computer as the Concordance Desktop installation, this method will not work, as
the database will be opened in Concordance instead of Concordance Desktop.
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1. Before migrating a database, make a backup of all the files in the database. (Backup
the whole folder, including all sub-folders.)

2. Open Windows Explorer and navigate to the folder containing the files for the
database you want to migrate. 

3. Double-click on the database DCB file.

A dialog box opens stating that the database is not compatible, and asks if you
want to update the imagebase.

4. Click Yes. 

A migration in progress dialog box opens. When the migration finishes, the database
opens in Concordance Desktop. 

To ensure the database has been migrated, registered, and indexed

1. From the File menu, click Administration, and then Admin Console, to open the
Administration Console. 

2. Click the Management tab. 

3. Click on the Databases folder to display the list of databases on the server and their
statuses. 

The database you just migrated displays at the bottom of the list displayed in the right
side pane. 

If after migrating, there are documents that do not display correctly or at all in the
Concordance Desktop viewer, you can optimize those documents so that they do
display correctly. See the Optimizing documents to PDF topic for more information. 

How do I know a database migration was successful?

If the answer to the questions below are 'yes', then your database has migrated
successfully. 

· Are the images visible in the Concordance Desktop viewer?

If no, the most likely cause is that the location of the images has changed. You will
need to update the links to the images. See Renaming file paths and folders

· Are you able to launch the natives from the hyperlinks in the records?

If no, the most likely cause is that the links to the native files were not updated. You
will need to first update the links (see Renaming file paths and folders), and then run
the CreateHyperlinks CPL (see CreateHyperlinks) to create new hyperlinks in the
records. 
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Optimizing documents to PDF

Optimization is a process in which a native file is reprocessed to a PDF file, for more
optimized viewing in the viewer. You can run optimization on a single document, a query,
or all documents in a database. Optimization is most useful for the reprocessing of native
file types that are not supported by the "on-the-fly" processing that occurs when you
open a document in the viewer. A good example would be an HTML file, which is a file type
not supported by the on-the-fly processor. In order to view an HTML file, the file needs to
be reprocessed to PDF format. Once this optimization is done, the PDF can then be viewed
in the viewer. 

In some instances, the optimization may not be able to optimize a file, for example, when
a file has become corrupt. When this occurs, the optimization process tags the file with an
"Import Errors" tag. After optimization has completed, you can run a query on the Import
Errors tag to find out what, if any, documents could not be optimized. You can then check
the log file to find out why those files could not be optimized.

When you optimize a document that has already been OCR'ed, any notes, issues, and
issue tags in the OCR field of that document's record is removed. Notes, issues, and
issue tag if fields other than the OCR field are not removed.

To optimize a single document:

1. In either Browse or Table view, select the document you want to optimize.

2. From the File menu, select Administration, then Optimize, and then Optimize Current
Document.

A dialog opens stating that you will lose markups and notes associated with the OCR
fields, and asks if you want to continue.

3. Click Yes.

The document conversion process runs. When it completes, the document-level text
displays in the OCR field of the record, and the PDF copy of the native file can be viewed
in the viewer.

4. Click on the  Camera button to view the PDF copy of the document in the viewer. 

To optimize a query:
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You can use a query to locate specific documents, and then run the optimization on
the results of the query. 

1. Run a query to gather the documents you need to optimize.

2. From the File menu, select Administration, then Optimize, and then Optimize Current
Query.

A dialog opens stating that you will lose markups and notes associated with the OCR
fields, and asks if you want to continue.

3. Click Yes.

The document conversion process runs. When it completes, the document-level text
displays in the OCR field of the record, and the PDF copies of the native files can be
viewed in the viewer.

4. Click on the  Camera button to view the PDF copies of the documents in the viewer.

To optimize all documents:

1. Open the database.

2. From the File menu, select Administration, then Optimize, and then Optimize
Entire Database.

 A dialog opens stating that you will lose markups and notes associated with the OCR
fields, and asks if you want to continue.

3. Click Yes. 

4. Click on the  Camera button to view the PDF copies of the documents in the
viewer. 

About Adding More Files to Databases

Typically, all data for a specific case is not processed or received at the same time.
Subsequent data may arrive on an ongoing basis. Therefore, after a new database is
created with its initial set of files, additional files can be added directly to the database
using one of two methods, depending on the database. The first method is a simple
Windows drag and drop action. This drag and drop functionality is available for all new
databases created in Concordance Desktop, and for all migrated Concordance 10.21 E-
Document databases. All other types of Concordance 10.21 databases that have been
migrated to Concordance Desktop cannot support the drag and drop functionality. In
addition, any databases that have been converted from a prior version of Concordance to
Concordance 10.x, and then migrated to Concordance Desktop, as well as all Transcript
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databases, are unable to support the drag and drop functionality. To add files to these
types of databases, you use the "Import" feature in Concordance Desktop. 

Databases created in Concordance Desktop cannot be added or appended to a
migrated Concordance database, nor can they be concatenated with a migrated
database. 

About adding files using drag and drop

The drag and drop method is used for appending updates or adding files to existing
databases that were created in Concordance Desktop, and for existing Concordance 10.21
E-Document databases that have been migrated to Concordance Desktop. 

The follow table shows what types of files can be appended to each type of database.

Drag and Drop Append Chart

File Type
Load File
Database

E-
Document
Database

E-mail
Database

DAT or CSV X X

OPT X

E-document (DOC, PDF, XLS,
etc.)

X X

PST X

MSG X* X* X

EML X* X* X

DCB X X X

*Does not process attachments. 

There are some limitations of which you need to be aware: 

· Concordance Desktop Load File, Concordance Desktop E-Document databases, and
migrated Concordance 10.21 E-Documents databases are the only databases that allow
dropping (importing) of all types of electronic files (pdf, doc, ppt, image files, etc.),
including msg and eml files. However, when msg or eml files are dropped (imported),
attachments are not processed.  

· Only email msg, eml, and PST files can be dropped onto a Concordance Desktop E-mail
database. 
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· Both the email and attachment(s) (if any) are appended when you drag and drop a .msg
or .eml file onto an E-mail database.

· DCB files can be dropped on any type of database. 

· OCR files are no longer necessary for Load File databases. Instead, the OCR process is
automatically run during the import, where a PDF copy is generated for each native file.
This does not mean that you cannot include the OCR files. You still have the option to
add them, and when you do, most often it results in a decrease of processing time.

When you drop an e-mail msg or eml file onto an existing Concordance Desktop E-
Documents or E-Mail database, or migrated Concordance 10.21 E-Documents database,
the import process appends the file as the last record(s) in that database, At the same
time, the import process creates a PDF of the native file for viewing in the viewer.  If the
file is dropped on a database that is part of an existing concatenated (CAT) database set,
then the file is appended to the end of the last database in the CAT set. Dropping an OPT
file onto an existing database results in the same action - the files are appended to the
end of the database, or the end of the last database in a CAT set. When you drop a DAT,
DCB, or PST file onto an existing database, a new database is created from the dropped
file, and that new database is automatically concatenated with the database on which it
was dropped. The existing database becomes the "primary" database of the CAT set. 

When you drag and drop a DAT or DCB onto a Concordance Desktop DAT database, a new
DAT database is created and automatically concatenated with the existing DAT database.
At the same time, the import process creates a PDF of the native files for viewing in the
viewer. When you drag and drop an OPT file onto a Concordance Desktop DAT database,
the files are appended to the end of that existing DAT database, and again, PDFs of the
native files are automatically created. 

About adding files with the Import feature

The import feature must be used for updating existing records or adding new files to
Concordance 10.x Load File (DAT) or E-Mail databases that have been migrated to
Concordance Desktop. It is also used when you need to append files to a DAT database
that has been migrated from Concordance 10.x. To append files to databases created in
Concordance Desktop, you must use the drag and drop method. 

Do not use the import process if you are importing replacement data into a database
created in Concordance Desktop, or into a Concordance 10.x E-Document database
that was migrated to Concordance Desktop. Instead, use the Drag and drop method
to add the replacement data.

About adding files to Concatenated databases

When you add an additional file to a concatenated database, the file is appended as the
last record to the very last database in the concatenated set.

Databases that are automatically concatenated either by a drag and drop, or by the
import process when creating a new database with multiple record sets, should not be
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removed from the CAT set. Removing a database from an automated CAT set can
cause the record numbering in the CAT database to be sequentially inconsistent.

When adding files to a concatenated database set, always open the primary database
and drop the files onto it. Also, never attempt to open any of the other databases in
the set, as doing so can cause database corruption. To identify the other database in
the set, look for the database name with -001, -002, etc. appended to the name.
These are the other databases in the set. The primary database displays just the
database name, without any added numbers.

Concatenated sets can be easily identified by how they appear in both the Admin Console
and in Windows Explorer. 

Concatenated database set views

   

A concatenated set in the Admin Console 

A concatenated set in Windows Explorer

Best Practices for successfully adding files

Regardless if you are dragging and dropping or importing, when adding additional files to a
database, we recommend creating a duplicate database structure first, and then adding
the new files to the duplicate. This step allows for further quality control before changing
your main database. The final step is using the drag and drop functionality, or the Import
feature to append and replace your new records by matching records using a common
unique field.

When importing new data, consider the following:

· Run a test load by importing new data into an exported database or database
structure

· Note the last record number on the status bar prior to importing the secondary
database with the new data

· Reindex the database prior to loading the new data. After the data is loaded, on the
Search menu, click Search for Edited Documents, to query only the records that you
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just loaded for verification of the number of records that needed to be loaded or to
isolate the records that need to be deleted if loaded improperly.

· Decide whether to load data into a secondary database structure and then
concatenate it with the primary database

To find recently updated documents, on the Search menu, click Search for edited
documents. Reindex prior to importing the updated records so the search query only
includes changes made to the database by the matching import.

To create a duplicate database:

After reviewing the delimited text files, you need to create a copy of the database you
want to add the additional text files. You will duplicate the database by exporting the
database's structure.

To create a duplicate database:

1. In Concordance Desktop, open the database you want to copy. 

2. On the Documents menu, point to Export, and click Structure.

3. Clicking Structure opens the Copy Structure dialog box.

4. Navigate to where you want to save the duplicate database, type the name of the
database file in the File name field, and click Save.

Adding Files to Concordance Desktop DBs

Concordance Desktop is able to import a variety of electronic documents (eDocuments),
including text, Adobe Acrobat PDF, Microsoft Word, PowerPoint, Excel, and Outlook or
Outlook Express message files into an existing eDocuments database.  

Electronic documents require that source file software, like Microsoft Office and Adobe
Acrobat, are pre-installed on your network in order to extract the data from the file and
import it into your Concordance Desktop database.

Concordance Desktop, however, does not allow importing of data from any zipped,
encrypted, .exe, or system files. The files are imported but not the data contained with
the file.  You’ll need to adhere to any forensic data processes as outlined by your
organization or recommended for e-discovery processing.

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop.  For more information,
please see the Microsoft website.
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When using the Record Divider option, imported Microsoft Excel files that contain more
than one sheet and viewed in the Concordance Desktop viewer will display only the
first sheet for the database record.  No view is available for the other sheets
associated with the record.

Adding documents to an existing E-Documents database is made easy using a simple file
drag-and-drop operation. Concordance Desktop automatically processing the documents,
assigning document IDs, reading document metadata, extracting text, and appending the
records to the database. 

Any file or electronic document format not supported will be added to the database as an
excluded file, but the contents will not be imported.  You’ll need to adhere to any forensic
data processes as outlined by your organization or recommended for e-discovery
processing.

Supported e-document file types

Concordance Desktop supports the following E-Document file types for creating and
adding documents to an E-Documents database:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text

*.pcx PC Paintbrush bitmap

*.csv Comma-Separated Values

*.cal, *.cals Facsimile

*.pdf Adobe Portable Document Format

*.doc, *.dot, *.docx Microsoft Word 

*.ppt, *.pps, *.pptx, *.pptm Microsoft PowerPoint®

*.xls, *.xlsx, *.xlw, *.xlt Microsoft Excel®

*.msg Microsoft Outlook 2010 or later Message File

*.eml Microsoft Outlook Express

*.txt ASCII Text

*.rtf Rich Text Format

*.html, *.htm Web/HTML (Only supported in e-document
databases.)

*.pab Microsoft Outlook Personal Address Book
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*.wps Microsoft Works

When importing records using a DAT file, ensure that the carriage return delimiter is
set to something other than "new line" (value 013). If the new line delimiter value 013
is set, change that delimiter in the DAT file before attempting to import the file. 

To add documents to a Concordance Desktop e-documents database:

1. In Concordance Desktop, open the database to which you want to add additional
records.

2. Open Windows Explorer and locate the folder that contains the documents you want
to add to the database.

3. In the Windows Explorer folder, select the file(s) to add.

To select multiple files, use SHIFT+click or CNTRL+click.

4. Drag the file(s) to the database open in the Concordance Desktop workspace.

5. If dragging a DAT file, a Dat File Drop Operation box opens. Click Append. 

6. When asked if you are sure you want to add files to the current database, click
Yes.

The Import E-Documents progress dialog box opens. 

7. In the Browse view, verify that each E-document you added displays properly.

8. If the database has already been indexed, reindex it. Otherwise, run a full index.

For more information about indexing and reindexing databases, see Indexing and
reindexing updates.

9. If you receive the following message, Dictionary file exists, overwrite?, click Yes.

When adding documents to a database that is part of a concatenated set, the
imported documents are appended to the end of the last database in the
concatenated set.

When adding additional e-mails and attachments into a Concordance Desktop database, it
is best to add them to an E-mail database because they contain unique internet account
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type coding for the author and recipients, including a parent and child structure that
needs to be preserved, and attachments that need to be retained. All of these
components are critical metadata that can easily be altered, spoiling original records and
damaging critical information regarding who knew what and when. Once damaged, this
information is nearly impossible to restore and is irretrievable after the documents have
been added to the database.

Concordance Desktop provides an E-mail database wizard, which includes typical
metadata fields from Outlook and takes care of the field mapping for you. The import
wizard automatically establishes parent-child relationships with the e-mail messages and
their attachments. This provides efficient and comprehensive searching and saves time in
document loading. The wizard also lets you create and modify fields as needed.  For more
information about creating an E-mail database, see Creating an E-mail and attachments
database.

When adding e-mail .msg or .eml files to a Concordance Desktop concatenated
database, the e-mails are appended to the last database in the concatenated set.
When adding an e-mail .pst file, a new e-mail database is created from the .pst file
and the databases are automatically concatenated (CAT). The database onto which
the .pst file was dropped becomes the primary database in the CAT set.

Drag and drop is not supported for databases that have been migrated from
Concordance 10.x, and for DAT and Transcript 10.x migrated databases, Following
the steps found under Importing extra e-mail & attachments to a Concordance 10.x
E-mail database for adding e-mails and attachments to these migrated databases.

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop.  For more information,
please see the Microsoft website.

If you need to export your e-mail from Concordance Desktop back to a .pst file,
consider using Discover the Wave’s Trident Pro software.

To add a PST file to a Concordance Desktop  e-mail database:

When dropping multiple PST files onto an e-mail database, drop only one PST file
at a time, and reindex the primary database prior to dropping the next PST file. 

1. In Concordance Desktop, open the database to which you want to add the PST file.

2. Open a Windows Explorer window and navigate the location of the PST file. 

3. Drag the PST file from the Windows Explorer window and drop it onto the E-mail
database open in the Concordance Desktop window. 

4. You are asked if you are sure you want to add the files to the database, click Yes.
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The Import Email and Attachments progress dialog box opens. 

5. When the import finishes, check to ensure that the e-mail messages and
attachments, if applicable, were added and that they can be viewed in the viewer.  

To add e-mail & attachments to a Concordance Desktop database:

E-mail is imported into a Concordance Desktop database using the drag and drop
method. During the import, the Import e-mail wizard automatically establishes parent-
child relationships with the e-mail messages and their attachments. This provides
efficient and comprehensive searching and saves time in document loading.

When adding e-mail .msg or .eml files to a Concordance Desktop concatenated
database, the e-mails are appended to the last database in the concatenated set.
When adding an e-mail .pst file, a new e-mail database is created from the .pst file
and the databases are automatically concatenated (CAT). The database onto
which the .pst file was dropped becomes the primary database in the CAT set.

1. In Concordance, open the E-mail database into which you want to import additional
documents.  

2. Open a Windows Explorer window and navigate to the location of the file(s) you
want to append to the database.

3. Select the file(s) you want to add.

To select multiple files, use SHIFT+click or CNTRL+click.

4. Drag the files and drop them onto the database you have open in Concordance
Desktop.

A dialog box opens asking if you are sure you want to add files to the current
database.

5. Click Yes. 

The Import Email and Attachments progress dialog box opens.

6. When the import finishes, check to ensure that the e-mail (and attachment if
applicable) was added to the database and that it can be viewed in the viewer. For
multiple e-mails or attachments, we recommend you check each one. 

To verify the added files:

Once you have imported your e-mail messages, it is best practice to verify that the
files imported correctly. After verification, you need to reindex or index the database.

1. In Concordance Desktop, open the Browse view.

2. In the Browse view, verify that the e-mail messages you imported display properly.
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3. If you have already indexed the database, reindex the database. Otherwise, run a
full index.

For more information about indexing and reindexing databases, see Indexing and
reindexing updates.

If you receive the following message, Dictionary file exists, overwrite?, click Yes.

In Concordance Desktop, you can drag and drop a DAT, CSV, DCB, MSG, or EML file onto a
Concordance Desktop Load File (DAT) database to add the files to the existing database.
To use the drag and drop functionality, you must either log onto the Concordance Desktop
server/computer where the database you want to add to resides, or use Windows Remote
Desktop to log onto that server/computer. 

If you need to update records that already exist in a Load File (DAT) database, you
need to use the' Import' feature instead. For more information on the Import feature
see, Importing updates to an existing database.

When importing records using a DAT file, ensure that the carriage return delimiter is
set to something other than "new line" (code 013). If the new line delimiter is set,
change the delimiter in the DAT file before attempting to import the file. 

Drag and drop is not supported for DAT databases that have been migrated from
Concordance 10.x. To add additional files to a migrated DAT database, you must use
the 'Import' feature. See Importing updates to a migrated DAT database for more
information. 

Before importing delimited text files into Concordance Desktop, be sure to review the
Managing data files topic.

As an administrator, you should always make a practice of opening and reviewing your
delimited text files when you receive them, as the files are not always prepared perfectly
and may need to be modified.

Adding delimited text files

Following are the steps for adding delimited text files. 

Step 1:  Review and edit delimited text files

Review the delimited text file, and make any necessary corrections.



Concordance Desktop 226

To review and edit a delimited text file:

1. Open the delimited text file in any text editor program.

Example of a delimited text file opened in UltraEdit:

2. Review the delimited text file for the following elements:

· The file must be a text-based format with an extension of .dat, .csv, .txt, .rtf, or
any normal text file extension.

· If there is no a header row containing field names, open the associated .tif file for
the first record and match the data in the record to the data in the .tif file.

· Note the delimiter used in the file. Concordance Desktop can handle any standard
text delimiters. 

· Note the date format used in the file. Concordance Desktop can load dates
containing slashes in any order with either 2- or 4-digit years, with a maximum of
8 digits. The only date formats Concordance Desktop can load without slashes is
the universal date format of YYYYMMDD and the mm-dd-yyyy date format with
dashes.

· Is there a carriage return at the end of the record? If not, add a carriage return
at the end of the record. Concordance Desktop will not load the last record if the
carriage return at the end of the record is missing.

3. Make the necessary edits, if applicable.

4. Save the file.

5. Either print a copy of this file or leave the text editor program open so you can
reference the field order when importing the files.
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After reviewing the delimited text files and prior to continuing with step 2, we
recommend that you create a duplicate of the database to which you want to add the
additional files. This protects the original database, should any issues arise during the
importing of the additional files. You can duplicate the database by exporting it to a
Concordance Desktop database. See Exporting databases for more details.

Step 2:  Drag and drop the delimited text files onto the Concordance Desktop DAT database

Before you drag and drop the delimited text files, review them to ensure that the data
contains valid formats - those that are supported by Concordance Desktop databases.

When dropping a file onto a database, you must first open that database in
Concordance Desktop and ensure that it is open in either Browse or Table mode on the
Concordance Desktop workspace. Whatever database is currently open and has focus
is the database to which the file will be appended. If no database is open, the drag and
drop action will fail.

1.  Open the Concordance Desktop application on the server where the database you
need to add to is registered.

2.  Open the database to which you need to add the DAT file, using one of the following
methods:

· From the File menu click Open. Locate and select the database, then click Open.

· If the database is displayed in the Databases 'Recent' list, click on the database
name to open it.

3.  Open a Windows Explorer window and navigate to the location of the delimited text files
you need to add to the database you just opened in Concordance Desktop.

4.  Click and drag the DAT file from the Windows Explorer window and drop it onto the
database displayed in the workspace pane of Concordance Desktop. 

5.  Do one of the following:

Append by Concatenation

When dropping a DAT file onto an existing DAT database, the import process creates a
new database with the same name plus an appended numerical extension (example;
DBNAME-001). Concordance Desktop then concatenates the new DB with the existing,
and the existing becomes the primary database for that CAT set. As you drop more DAT
files onto the primary database, each is named after the primary database and the
appended extension is incremented by 1 (-002, -003, etc.).

a.   Click Append by Concatenation.
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The following dialog box opens.

b.   Click Yes to continue.

The load file dialog box opens.
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The Enter Database Name field is populated with the name of the database you have
open in Concordance Desktop. You cannot change this name. 

The Select DAT file field displays the path and file name of the file you just dropped
onto the DAT database. If you accidentally selected the wrong DAT file, you can click
the Browse button to find and select the correct DAT file.
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c.   If you need to alter the format and delimiter settings, stop here and go to the Create
a new database from load files using custom settings section for detailed instructions.

List of settings you can change when selecting to customize:

· Load Field Names From: Location from which to load Field Names. You can select
to load Field Names from the DAT file you are loading, from a Template/Structure
file, from a previously defined Settings File, or define a new set by manually
creating all field names.

· Select the delimited format to import or select custom values:  You can change
the delimiter settings to match the settings in the load file, should they differ from
the standard Concordance Desktop delimiters. 

· Select the date format for importing date fields:  You can change the date
format, if the format in the load file differs from the standard yyyymmdd used in
Concordance Desktop.

· Load Tag List:  You can load a set of Tags from a saved Tag List file so that those
tags are available in the new database.

· Field Names:  You can add or modify field names.

· Change the order in which fields display in the database.

· Show System Fields:  You can select to include the display of system fields in
the database.

· Skip first line:  The first line will usually list the fields in the DAT file and should not
be imported as a record in the database.

· Import rich text:  You can select to import rich text formatting when importing a
text file. 
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· See Attachment Fields:  You can select the email/attachment range field or the
beginning and ending attachment number fields.  Making either of these selections
allows Concordance Desktop to identify the email and attachment family members.

d.  Click OK.

You are returned to the Load File window where the Select DAT File field is populated
with the information you entered in the Open window.

Append Direct

When importing new records using a DAT file, ensure that any new fields that are not
currently in the existing database are added before you begin the append process by
selecting File and then Modify. Additional OCR fields will not have to be added in the
database.

a.   Click Append Direct.

The following dialog box opens.
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b.   Click Yes to continue.

The load file dialog box opens.



Administration 233

The Enter Database Name field is populated with the name of the database you have
open in Concordance Desktop. You cannot change this name. 

The Select DAT file field displays the path and file name of the file you just dropped
onto the DAT database. If you accidentally selected the wrong DAT file, you can click
the Browse button to find and select the correct DAT file.
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c.   If you need to alter the format and delimiter settings, stop here and go to the Create
a new database from load files using custom settings section for detailed instructions.

List of settings you can change when selecting to customize:

· Load Field Names From: Location from which to load Field Names. You can select
to load Field Names from the DAT file you are loading, from a Template/Structure
file, from a previously defined Settings File, or define a new set by manually
creating all field names.

· Select the delimited format to import or select custom values:  You can change
the delimiter settings to match the settings in the load file, should they differ from
the standard Concordance Desktop delimiters. 

· Select the date format for importing date fields:  You can change the date
format, if the format in the load file differs from the standard yyyymmdd used in
Concordance Desktop.

· Load Tag List:  You can load a set of Tags from a saved Tag List file so that those
tags are available in the new database.

· Field Names:  You can add or modify field names.

· Change the order in which fields display in the database.

· Show System Fields:  You can select to include the display of system fields in
the database.

· Skip first line:  The first line will usually list the fields in the DAT file and should not
be imported as a record in the database.

· Import rich text:  You can select to import rich text formatting when importing a
text file. 
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· See Attachment Fields:  You can select the email/attachment range field or the
beginning and ending attachment number fields.  Making either of these selections
allows Concordance Desktop to identify the email and attachment family members.

d.  Click OK.

You are returned to the Load File window where the Select DAT File field is populated
with the information you entered in the Open window.

6.  To preview the records prior to loading the file:

a.   Click the Preview button to open the Preview window.

The preview window displays all fields in which there is data, along with a few
records in the load file.

b.   To turn on the visibility of empty fields, check the Include Empties check box.

When checked, empty fields are displayed in the preview, along with the populated
fields.

c.   When finished viewing the records, click OK to to close the Preview window.

7.  Do one of the following:

If you have an OPT file to load, select it:

a. Click the Browse button next to the Select OPT File field.
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b. Locate and select the .OPT file you want to load.

c. Click Open.

You are returned to the Load File window where the Select OPT File field is
populated with the selection you just made.

If you do not have an OPT file to load, you can create one:

Typically, the vendor who processed your documents supplies you with a
corresponding load file (.opt, .log, or .txt) along with your documents and images. If
you do not receive the OPT file, you can create one to use.

a. Click the Create button next to the Select OPT File field.
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b. Click the ellipse button and select the location where you want to store the OPT
file.

We suggest that you enter a folder and sub-folder that is located in the same
directory as the This should be in a sub-folder as your DAT file,and have the same
name as.  Alternatively, you  can open Windows Explorer, locate and open the folder
where the image files are, and then drag and drop the image files into the large box
below the OPT file.

c. Open a Windows Explorer window.

d. Locate and open the folder where the image (.TIF) files are located.

e. Drag and drag the image files into the large box below the OPT file.

f. Click OK.

You are returned to the Load File where the Select OPT file is populated with the OPT
file location you just entered.

8.  Click on the Key down-arrow and select the name of the field used to identify the
beginning of new records.

An example would be BEGNO. 

9.  If OCR text is included in the load file, check the OCR contained in load file check
box, otherwise leave the check box blank. 
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10.  Click on the OCR arrow and select the name of the field to contain the OCR text in
the record.  

Some examples are TEXT1 or OCR1

The wizard can import both single or multi-page OCR text files.

11.  (Optional) Click the Customize Image/OCR button if you want to change the
default OCR method. This option is not available when you check the 'OCR
contained in load file' check box, as the OCR'ed text already exists.

The Customize Image/OCR dialog box opens.

Options are:

· Use CN Desktop OCR - Use this option if you want Concordance Desktop to OCR
all the files regardless of any existing OCR'ed text files. By default, Concordance
Desktop does not OCR the text files.

· Use OPT Files to load Text Files - Use this option if you want Concordance
Desktop to load the document-level text from files existing in designated folders
that are referenced in the OPT file. Concordance Desktop does not OCR the
document-level text, it simply takes the text from the text files and loads it into
the associated records. 

· Use OCR Text Files - Use this option if you have text files that have already
been OCR'ed and you want Concordance Desktop to use those OCR'ed files. As
with the Use OPT Files to load Text Files option, Concordance Desktop will not do
any OCRing of the text, it will simply load the text from the text files into the
associated records. This option casn help save processing time. When this option
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is selected, you also need to click the Browse button to locate and select the
text files. 

· Use Field Containing File Path to load Text Files - Use this option if you want
Concordance Desktop to load the document level text from an OCR path referenced in
the DAT file. This new import option allows you to import document level text if
your DAT file references an OCR path. The OCR path needs to be edited to reflect
the directory where the text is located or edited to reflect a relative path. When
using the relative path in the DAT file, the edited copy of the DAT file must be in
the same directory as your text folders.

If the file path pointing to your text files is not accurate the text will not be imported.

12.  If you want Concordance Desktop to create optimized PDFs of the native files
during the import process, uncheck the Do not process to PDF check box.

By default, the check box is checked, which helps to reduce processing time.  When
checked, rendering of supported native file types is done on the fly as they are
viewed  in the viewer.  Unsupported file types however, cannot be viewed in the
viewer until they are optimized. For more information about optimizing, please see
the Optimizing documents to PDF topic.

13.  Click Import to start the import of the load files you have selected.

14.  If one or more files did not import properly, a dialog box displays telling you to see
the log file. Click OK.

15.  In the DAT Database dialog box:

· If all files imported properly (i.e., you did not see a dialog box stating one or more
files imported properly) , click the Open button to open the database in
Concordance Desktop.

· If any files did not import properly, click the View Log button to check the log for
any files that did not import properly.

The Concordance Desktop Image Base (.CIB) file for the Concordance Desktop viewer links
native documents and images with their corresponding records in Concordance Desktop.
An OPT file is used to import the document and image information into the CIB file. Once a
CIB file is created for a Concordance Desktop database, you can view the referenced
documents and images in the viewer.  

Typically, the vendor who processed your documents supplies you with a corresponding
load file (.opt, .log, or .txt) along with your documents and images. If you do not receive
this file, you can still load your documents and images into Concordance Desktop and
select to create an OPT file during the import. 
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Since your document and image files and image load file are typically provided by a vendor
on a CD or DVD, the path information listed could be written in the D:\ drive and will need
to be changed. You can provide the vendor with a specified directory path in advance if
you already have a designated location for your images. If not, you can change the
directory information yourself.  See Renaming file paths and folders.

Before you load any additional OPT files, make sure that you review the file to ensure it
meets the specifications for formatting. For more information, see Concordance Desktop
imagebase load file formatting.

The OPT file can contain both documents and images that are either single-page or
multiple-page files. Each file must contain a unique ID (media key).  Before loading an OPT
file, make sure that it provides an image media key, volume, file name with the path, and
page break. 

When importing a multi-page image file, make sure that the file is formatted as a .tif
file (.tif formatted files are the only image type file that recognizes document breaks).
All other image formatted files (.jpg, .bmp, .gif, etc.) can only be imported as a
single-page single image file. For example, a three page document for a single record
should be loaded as a .tif formatted file in order for the viewer to display all three
pages. If you load separate .jpg files for each page of the document, the viewer only
displays the first .jpg file, as only one .jpg file can be associated with a record.

Before you can drop a file onto a database, you must open that database in
Concordance Desktop, and ensure that the database is open in either Browse or Table
mode on the Concordance Desktop workspace. Whatever database is currently open
and has focus is the database to which the file will be appended. If no database is
open, the drag and drop action will fail. 

To add an extra .opt file:

1. Open Windows Explorer and navigate to the folder where the opt file you need to
add (load) is located.

2. Review the OPT file to make sure that the data contains a valid media (image) alias
and file path for each document or image. 

Do not close Windows Explorer, as you will need to have access to the OPT file for
step 5.

3. In Concordance Desktop, open the database to which you need to add the OPT
file. 

4. Click on the Browse view button to open the database in browser view. 

5. Drag the OPT file in the Windows Explorer window onto the database in the
Concordance Desktop window. 
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If you closed the Windows Explorer window you had opened in step 2, open it again
and navigate to the folder where the opt file is located, then drag and drop the OPT
file onto the database open in the Concordance Desktop window. 

A dialog box opens asking if you are sure you want to add files to the current
database.

6. If you are sure you want to add files to the current database, click Yes. 

The files are imported and an optimized PDF is created for each native file. 

7. When finished, locate the first document associated with the OPT file you dropped
on the database.

8.  On the Dynamic toolbar, click the View Image (Camera) button to open the
document in the viewer.

If the document is a supported file type, the viewer opens and displays the
document.

If the document is not a supported file type, the viewer opens and displays a page
stating that the document cannot be viewed in the viewer. You can view the
document in its originating software by clicking on the document link in the record
displayed in Concordance Desktop, providing you have the originating software
application installed on your computer.

You may receive new image load files and images to replace existing images after creating your
database.  The overlay option loads images into the existing imagebase without adding
additional images.  Verify the filename and path information in the image load file is correct
before performing this task.

File paths, folders and imagekeys are case-sensitive.  Make sure the new image path
and filename case match to ensure that the paths are replaced.

Use caution when overlaying images paths as there is no undo function and changes are
permanent. We recommend backing up the database files before performing this process
or other imagebase management tasks.
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To overlay image files:

1.  From the File menu, click Administration, Image Base Management and then
Overlay/Append OPT.

2.  Click the Browse button, locate and open the .OPT file you want to load.

3.  Click Overlay.  A prompt will appear to confirm overlay:

All existing markups, including redactions, will not be transferred to replacement

images.  If the image file wasn't there previously then it will be appended to the

database.

 

In load file databases, the imagekey field was selected during the initial import
when the database was created.  The imagekey values in your load file must match
the values in this field in the database.

4. Click Yes to continue. 

If any errors occur, a log file will be saved in the Logs folder where the database is
saved in Windows.

5.   In Concordance Desktop, open a record to view your image files.

Adding Files to Migrated Concordance 10.x DBs

Concordance Desktop is able to import a variety of electronic documents (eDocuments),
including text, Adobe Acrobat PDF, Microsoft Word, PowerPoint, Excel, and Outlook or
Outlook Express message files into an existing eDocuments database.  



Administration 243

Electronic documents require that source file software, like Microsoft Office and Adobe
Acrobat, are pre-installed on your network in order to extract the data from the file and
import it into your Concordance Desktop database.

Concordance Desktop, however, does not allow importing of data from any zipped,
encrypted, .exe, or system files. The files are imported but not the data contained with
the file.  You’ll need to adhere to any forensic data processes as outlined by your
organization or recommended for e-discovery processing.

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop.  For more information,
please see the Microsoft website.

When using the Record Divider option, imported Microsoft Excel files that contain more
than one sheet and viewed in Concordance Desktop Viewer will display only the first
sheet for the database record.  No view is available for the other sheets associated
with the record.

Adding documents to an existing E-Documents database is made easy using a simple file
drag-and-drop operation. Concordance Desktop automatically processing the documents,
assigning document IDs, reading document metadata, extracting text, and appending the
records to the database. 

Any file or electronic document format not supported will be added to the database as an
excluded file, but the contents will not be imported.  You’ll need to adhere to any forensic
data processes as outlined by your organization or recommended for e-discovery
processing.

Some earlier versions of Microsoft Excel files are no longer supported through
Microsoft and cannot be opened from Concordance Desktop. For more information,
please see the Microsoft website.

Supported e-document file types

Concordance Desktop supports the following e-document file types for creating and
adding documents to an e-documents database:

File Type Description

*.tif, *.tiff Tagged Image File

*.jpg, *.jpeg Joint Photographic Experts Group

*.gif Graphic Image File

*.bmp Bitmap

*.asc ASCII text



Concordance Desktop 244

*.pcx PC Paintbrush bitmap

*.csv Comma-Separated Values

*.cal, *.cals Facsimile

*.pdf Adobe Portable Document Format

*.doc, *.dot, *.docx Microsoft Word 

*.ppt, *.pps, *.pptx, *.pptm Microsoft PowerPoint®

*.xls, *.xlsx, *.xlw, *.xlt Microsoft Excel®

*.msg Microsoft Outlook 2010 or later Message File

*.eml Microsoft Outlook Express

*.txt ASCII Text

*.rtf Rich Text Format

*.html, *.htm Web/HTML

*.pab Microsoft Outlook Personal Address Book

*.wps Microsoft Works

When importing records using a DAT file, ensure that the carriage return delimiter is
set to something other than "new line" (value 013). If the new line (value 013)
delimiter is set, change the delimiter in the DAT file before attempting to import the
file. 

To add extra documents to an existing Concordance 10.x database:

1. In Concordance Desktop, click Documents, click Import, then click e-documents.

2. Select whether to import by file type(s) or by specific files. 

3. Select how you want to import the files. 

To import by file type:

a. Select the Import by file type option, then click Next.

b. Select the file extensions you want to import. 

Import all extensions (*.*) indicates that all files, regardless of the
extension, are to be imported. If you select this option, you can still exclude
some of the files by clicking the Exclude button.
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Import selected extensions allows you to select only specific file types to
import. If your file type is not listed (for example, docx), you can add it by
clicking the Add custom button.  

c. When finished selecting the file types, click Next. 

d. Go to the folder where the files are located.

e. Click Add to add the folder to the Directory pane.

To select another folder, repeat the step above.

f. (Optional) To import files from sub-folders in the folder you have selected,
check the Import files from subdirectories button.

g. Click Next.

To Import specific files:

a. Select the Import specific files option, then click Next.

b. Go to the folder where the files are located and select the files. 

To select multiple files, use SHIFT+click or CNTRL+click.

c. Click Add.

d. Click Next.

e. Continue on with step 4. 

4. Select the field mappings for your database, and click Next. For fields that do not
match, leave them set to <none>.

5. Select the appropriate options for the files you are importing.

6. Match metadata field names

7. Store file name without full path

8. Create hyperlinks to original document

9. View e-Docs in Concordance Desktop Viewer

10. Auto-number documents with a DOCID (document ID)

11. If you select to auto-number DOCID, you need can setup a Prefix to precede the number,
and the number to begin with. Ensure that you precede the starting number with zeros. 

12. (Optional) To create a plain text file for messages produced during the import, click
Browse to setup a log file name and location to capture the messages. 
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13. (Optional) If importing plain text files, enter the Record divider. If the record
divider is anchored, also check the Divider is anchored check box.

14. Click Next. 

15. Click Import.

16. When the import finishes, click Done.

When adding additional e-mails and attachments to a Concordance 10.x database that
has been migrated to Concordance Desktop, it is best to if the database you are adding
them to is a Concordance 10.x migrated E-mail database, they contain unique internet
account type coding for the author and recipients, include a parent and child structure
that needs to be preserved, and attachments that need to be retained. All of these
components are critical metadata that can easily be altered, spoiling original records and
damaging critical information regarding who knew what and when. Once damaged, this
information is nearly impossible to restore and is irretrievable after the documents have
been added to the database.

Concordance Desktop provides an E-mail database wizard, which includes typical
metadata fields from Outlook and takes care of the field mapping for you. The import
wizard automatically establishes parent-child relationships with the e-mail messages and
their attachments. This provides efficient and comprehensive searching and saves time in
document loading. The wizard also lets you create and modify fields as needed. 

When adding e-mail and attachment files to a Concordance 10.x migrated
concatenated database, the e-mails are appended to the last database in the
concatenated set. When adding a whole e-mail .pst file, a new e-mail database is
created from the .pst file and the databases are automatically concatenated (CAT).
The database into which you are importing the .pst file becomes the primary database
in the CAT set.

If you need to export your e-mail from Concordance Desktop back to a .pst file, then
consider using Discover the Wave’s Trident Pro software.

To add e-mail and attachments to a Concordance 10.x migrated e-mail database:

The third step in importing e-mail and attachments is to import the e-mail and
attachment files into your e-mail database. E-mail is imported into Concordance using
the Import e-mail wizard. The Import e-mail wizard automatically establishes parent-
child relationships with the e-mail messages and their attachments. This provides
efficient and comprehensive searching and saves time in document loading.

When importing e-mails into a concatenated database, e-mails are updated when
the fields of an imported e-mail match an existing email. When the fields do not
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match, the imported email is appended to the last database in the concatenated
set.

1. In Concordance, open the E-mail database into which you want to import additional
documents.  

2. On the Documents menu, click Import, and then click E-mail and Attachments.

3. In the Choose Profile dialog box, from the Profile Name list, select the name of
the e-mail profile you created, and click OK.

4. In the Import e-mail - Folder dialog box, click the .pst folder associated with the
e-mail profile you created. 

To import the entire .pst file, be sure to click the .pst file's top-level folder. If you
select a folder that does not contain e-mail messages, such as the Microsoft
Outlook calendar or contacts, the folder can be imported, but the records created
will not be complete because the Import e-mail wizard only imports information
related to e-mail messages.
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5. To include the folder's subdirectories, make sure that the Import subdirectories
check box is selected.

6. Click Next.

7. In the Import e-mail - Attachments dialog box, specify any of the following:



Administration 249

· To extract attachments, make sure that the Extract .MSG files and
attachments with e-mail check box is selected, and browse to the directory
where you want to store the extracted email files and attachments.

E-mail .msg files and attachments can be extracted and saved to a specific
directory.

By default, the Extract .MSG files and attachments with e-mail and Create
subdirectories for attachments check boxes are selected. The Attachment
directory field defaults to the e-mail database's directory, the Subdirectory prefix
field defaults to ATTACH, and the Max files field defaults to 500. 

It is best practice to store attachments in subdirectories, especially when you are
managing large numbers of attachments.

· To store email .msg files and attachments in subdirectories of the directory
displayed in the Attachment directory field, make sure that the Create
subdirectories for attachments check box is selected.  In the Subdirectory
prefix field, type the prefix you want to use for the subdirectory folder names,
and in the Max files field, type or scroll to the maximum number of files allowed in
each subdirectory. 

Subdirectories are named using a prefix and a number. For example, if you specify
the prefix ATTACH and the maximum files to store as 500, the first subdirectory
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created will be ATTACH0000. After that directory is filled with 500 files, the import
creates the ATTACH0001 directory, and proceeds to store attachments in the
ATTACH0001 directory until it reaches 500 files. This process continues until all
the attachments are extracted.

· To display e-mails in the viewer for review, select the View e-mails in
Concordance Desktop Viewer  check box.

Selecting this option creates the Concordance Imagebase (CIB) file that is needed
to link the view of the e-mail files with the corresponding record in Concordance. 
You must modify the database and make DOCID the image key field.  To modify
the database fields, see

6. When finished, click Next.

7. In the Import e-mail - Date range dialog box, specify any of the following:

· To import all e-mail messages in the selected .pst folder, select the Import all e-
mails option.

· To import only the e-mail messages for a specific data range in the selected .pst
folder, select the Import e-mails from a specific date range option and then
specify the Begin Date and End Date.

8. When finished, click Next.
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9. In the Import e-mail - Fields dialog box, specify any of the following:

You can map specific e-mail fields, such as the sender and recipient, to
Concordance database fields. Using the E-mail and Attachments template to create
your e-mail database ensures all fields exist for accurate mapping between e-mail
messages and the Concordance fields. The E-mail and Attachments database
template has all the fields necessary to import and store e-mail messages.

The left column displays the e-mail message fields, and the right column displays
the database fields.

If your e-mail database was created from the E-mail and Attachments template, the
database fields are automatically mapped to the correct e-mail message fields.

If your e-mail database was not created from the E-mail and Attachments template,
select the database fields you want to map to the e-mail message fields.

10. When finished, click Next.

11. In the Import e-mail - Options dialog box, specify any of the following:
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· To auto number the imported e-mail messages, select the Auto-number
documents with a DOCID (documentID) check box, and then enter the Prefix
and Starting number (zero-filled).

Auto-numbering your documents when importing e-mail messages provides a prefix
and starting number for each e-mail message and any attachments, while also
tracking family groups in a DOCID and PARENT_DOCID field. If the option is
selected and the Prefix and Starting number are not specified, Concordance will
automatically create one for each document.

The Auto Number documents with DOCID option must be selected to
successfully view the documents in Concordance Desktop Viewer.

· Select the Display full path of attachments check box to display the full path
to attachments.

By default, only the file name is displayed.

· Select the Do not allow duplicate e-mails check box if you do not want to
import duplicate e-mails. 

Most e-mails have a unique message identifier called the message-id. This entry is
stored in the MESSAGEID field. Before importing a message, the Import e-mail
wizard checks to see if any previously imported e-mails have the same message-
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id. If the wizard finds another record with this message-id, it does not import the
message.

· Select the Import HTML formatted e-mail text as check box to import the body
of HTML formatted e-mail messages as RTF/Plain text or Native Format formatting,
and then select the text format to use to convert the format.

· Select the Create log file for attachment import errors check box if you want
the import to create an import error log.

12. When finished, click Next.

13. In the Import e-mail - Finish Import dialog box, click the Import button to start
the import.

14. When the import is completed, click the Done button.

To verify the imported files:

Once you have imported your e-mail messages, it is best practice to verify that the
files imported correctly. After verification, you need to reindex or index the database.
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1. In Concordance Desktop, open the Browse view.

2. In the Browse view, verify that the e-mail messages you imported display properly.

3. If you have already indexed the database, reindex the database. Otherwise, run a
full index.

For more information about indexing and reindexing databases, see Indexing and
reindexing updates.

If you receive the following message, Dictionary file exists, overwrite?, click Yes.

Due to a database formatting difference between Concordance 10.x DAT databases and
Concordance Desktop DAT databases, there is no method available for updating or
appending records to a Concordance 10.x DAT database that has been migrated to
Concordance Desktop. Therefore, if additional records need to be added to a migrated
Concordance 10.x DAT database, you must do so by creating a new DAT database with
the new/updated data, and then concatenate that new DAT database with the migrated
Concordance 10.x DAT database.

For information on creating a DAT database, refer to the Creating a new database from
load files topic.

For information on concatenating databases, refer to the Joining multiple databases
(concatenating databases) topic. 

Setting data validation

Once you have created your database, you can define the data validation attributes for
your database fields in the Data Entry Attributes dialog box. Data validation attributes are
settings that define how data is entered in fields within the Edit view. 

For example, you can define a field that only allows upper case letters for field values or
you can make a field read only. You can also define the parameters for authority lists,
which are field value lists. Your  data validation selections are stored in the database's
[database name].ini file. 

For more information about authority lists, see Creating word lists. 
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Updating existing database records

In Concordance Desktop, you can drag and drop a DAT update file onto a Concordance Desktop
Load File (DAT) database, an e-Document database, or an e-mail and attachments database to
add information to existing records. To use the drag and drop functionality, you must either log
onto the Concordance Desktop server/computer where the database you want to add to
resides, or use Windows Remote Desktop to log onto that server/computer. 

When importing records using a DAT file, ensure that the carriage return delimiter is
set to something other than "new line" (value 013). If the new line (value 013)
delimiter is set, change the delimiter in the DAT file before attempting to import the
file. 

Prior to dropping a DAT file onto a database, ensure that the document file path
listed in the DAT file is the same as the document file path in the database, as
document file paths do not update. If the file paths are different, when you click on a
document link it will open the old document in the database as opposed to the
updated document. 

To update existing database records:

1. In Concordance Desktop, open the database in which you need to update records.

2. In Windows Explorer, open folder containing the updated DAT file.

3. Drag the updated DAT file onto the database in the Concordance Desktop workspace.

A DAT File Drop Operation box opens.

4. Click the Overlay button. 



Concordance Desktop 256

If the database is part of a concatenated set of databases, a Databases for overlay box
opens. If not, skip to step 6. 

5. Select the database to update, and click OK. 

An Overlay Database box opens.
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The import process attempts to determine which field to use as the indicator that a
record has an update, and then preselects that field in the Key Field box. 

If the delimiters in the update DAT file match those in the database, all fields currently
containing information in the database are selected (checked) for updating. System
fields, and any fields in the DAT file that do not have a corresponding field in the
database, are grayed out. 

If the delimiters in the update DAT file do not match those in the database, no fields
are checked in the box. Please see the 'Using the Customize Load File Preview' section
below if no fields are checked. Once you are done in the customize window, you can
continue on with step 6 below. 

6. If the preselected field in the Key Field box is not correct, click the down-arrow and
select the appropriate field.

7. Do one of the following to select the fields you want the import process to update, if
you do not want all fields to be updated.

· To deselect only a few fields: Remove the check mark from each field you do not
want to update. 

· To select only a few fields: Click the None button to remove the check mark from
all fields, and then check only those fields you want to update. 

If you click the None button in error, click the All button to re-check all the fields. 

8. Click Start.

The updated information from the fields in the updated DAT file replace the information in the
fields in existing matching records.

Using the Customize Load File Preview

If your update DAT file field delimiters do not match those in the database, you can change
the delimiters in the load file to match those in the database by using the Customize
button. 

1. After the Overlay Database box opens, click the Customize button.

A Load File Preview box opens displaying the first three lines of the DAT file. Within
those lines, only fields that can be found, based on the delimiters being used, are
displayed. If no fields are displayed, it indicates that the fields cannot be found
because the delimiters are not matching those found in the database. If this
happens, you need to correct each delimiter until all fields are displayed in the view.
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2. Click the Format down-arrow and select the format of your update DAT file.

If all fields appear, you are finished – go to the last step. 

If only some of the fields appear, please continue with the next step. 

3. Click on the down-arrow of the delimiter that appears to be causing the issue, and
select the appropriate code. 

4. Repeat step 3 until all fields appear in the display area. 

5. Click OK. 

You are returned to the Overlay Database box where you can continue one with
step 6 (in the section above) to complete the import of the overlay files. 

Creating a database template

Database templates are stored in the Concordance Desktop Templates folder and its
subfolders: C:\ProgramData\CloudNine\Concordance Desktop\Templates.

All templates in the Templates folder and the Templates folder's subfolders are displayed in
the Create database from template dialog box. With the exception of the General tab, the
Templates folder subfolders are displayed as tabs in the dialog box. The General tab
contains all database templates in the main Templates folder.

You can save your database templates in one of the existing Templates folders or create
your own Templates subfolder. Concordance Desktop comes with some pre-defined
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templates and template subfolders. You can modify or delete the pre-defined templates
and subfolders if they do not meet your organization's needs.

When you create a database, a temporary subfolder is added to the database folder
structure. This folder is only temporary and will be removed when the database is
closed.

Predefined Database Templates

Predefined Database Templates

Folder
Name

Template Name

Templates* Blank

Generic 20 Field

Research Bibliography

*The Templates folder is displayed as the General tab in the
Create database from template dialog box.

E-DOCS E-Documents 

E-mail And Attachments

LEGAL Litigation Document Production

Transcripts

Creating a database template is great for building future Concordance Desktop databases.
Database templates are created by exporting an existing database's structure. When you
export a database template, the template includes fields, data types, properties,
punctuation, stopwords, field data validation settings, and .ini file settings like alias groups
and tags. The database structure is stored in a database.dcb file. User Management
settings are not included in the template.

To create a database template:

1. In Concordance Desktop, open the database from which you want to create a database
template.

2. From the Documents menu, click Export, and then Structure.

Clicking Structure opens the Copy Structure dialog box.

3. Navigate to the Templates folder or one of its subfolders, type the name of the

database file in the File name field, and click Save.
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If you want to create a new subfolder, navigate to the Templates folder, create the
subfolder, type the name of the database file in the File name field, and click Save. 

Moving a registered database

If you need to move the location of a database that has already been registered in
Concordance Desktop, you need to complete several steps. 

To move a registered database:

1. Unregister the database in Concordance Desktop. See Registering/unregistering a
database

2. Move the database folder (including the natives folder) to the new location.

3. Open the Concordance Desktop Admin Console. See Opening the Admin Console

4. Register the database. See Registering/unregistering a database

5. Close the Admin Console. 

6. Open the database in Concordance Desktop. See Opening a database

7. Update the path to the Native files. See Renaming file paths and folders

8. Reindex the database. See Indexing and reindexing updates (This step may not be
necessary, but suggested)

9. Run the CreateHyperlinks CPL. See CreateHyperlinks

10. Test the path in Concordance Desktop. Open the database again and test a few of the
hyperlinks.

Indexing Databases

A Concordance Desktop database must be indexed prior to searching. When an index is
run during the creation of a new database, it is actually creating and populating the
Concordance Desktop dictionary and index files for the first time. How your database
records are indexed ultimately affects how reviewers search for information:

· Full-text searching works only on indexed fields

· Relational searching is for non-indexed fields or keyed fields

· Paragraph fields are indexed by default

You can, however, index just about anything in your database depending on how you
create the database structure. When you are building your database, you want to plan
which fields to include in the dictionary and index. The smaller the dictionary and index,
the faster your searching and indexing speeds will be.
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Indexing versus Reindexing:

· Indexing is performed when the initial database is built, and needs to be performed
after every database modification, including changes in fields, punctuation or the
stopwords list. Indexing is an exclusive process.

· Reindexing is performed when new records are added to the database or when there
are new annotations and modifications to record content. Reindexing appends new
information to both the index and dictionary files.

Indexing considerations

Indexing and reindexing databases is integral in keeping your database updated with
current review information, free of unnecessary and obsolete files, and processing
efficiently for full-text searches by the review team. Indexing large datasets is time
consuming, but is a standard process and part of your database maintenance schedule.

When Concordance Desktop databases are built, the index and dictionary are generated
from the document contents. The dictionary contains a list of every word or string of
characters in the database's record collection. The index contains directions to every
word or string of characters in the database.

Example: airforce1 or ABC00001

Both airforce1 and ABC000001 qualify as index entries and are searchable. Concordance
Desktop considers both examples, including both the letters and numbers, to be a word,
because there is no space between the characters. Spaces between characters would
disqualify them as words; a space between airforce and 1 would be read as two words.

Please consider the following before you create a database or index it and create
the dictionary:

· Avoid indexing serial and Bates numbers (unique value fields)

· Punctuation needs to be set only once and only pertains to indexed fields

· Punctuation is indexed only if embedded between alphanumeric characters. All
leading and trailing punctuation is trimmed.

· Update the database's stopwords list to exclude additional words that you want
ignored during indexing and searching

· A well-defined stopwords list keeps your dictionary and index lean

If indexing or reindexing processing speeds seem slow, you may want to increase
your Concordance Desktop server's RAM and check your Indexing cache settings
on the Settings tab in the Admin Console.

Index files
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Indexing scans the database and notes where each word occurs. These occurrences
are stored in two files created during the indexing process, the dictionary file (.dct) and
the inverted text file (.ivt). When you perform a search, Concordance Desktop looks in
these two files for your words, not in the actual text of the database. Due to the
structure of these files, the search is performed very rapidly, much faster than
searching each document one-by-one for every word.

The dictionary file is stored in the database directory folder. The .dct file contains all
dictionary words and their hit and document counts.

The inverted text file is accessed along with the .dct file when reviewers perform
searches. The .ivt file contains a path to all words, along with the applicable number for
each record, field, line, and word for each word in the .dct file.

Both the .dct and .ivt files contain a B-tree data structure, and the size of each file is
important. When full-text searches are performed, this process only accesses these
two files.

Building the initial index for these records can take many hours. Reindexing a day’s
worth of new documents could take a few hours, so it is better to reindex after
entering a few records in order to have that content searchable in a timely
manner.

Indexing Process

Concordance Desktop follows several rules when indexing the database. Words must
begin with an alphabetic or numeric character. Once the beginning of a word is found,
Concordance Desktop scans until it finds the first non-alphanumeric character. This
character is compared against the list of embedded punctuation characters. If the
character, such as a decimal point, is found in the list and the following character is
alphanumeric, then that punctuation is included in the word. Otherwise, the first non-
alphanumeric character will mark the end of the word.

Embedded Punctuation

User definable embedded punctuation is provided so that hyphenated words, dates,
decimal numbers, and contractions are not split into two or more words. By default
Concordance Desktop uses ‘ . , / characters for embedded punctuation. Note that
the hyphen is not included in the default set. You may want to include them, but it
is recommended that you leave them out. Proper names, such as Mary Smith-Jones,
would only be searchable under the Smith prefix if hyphens were used as embedded
punctuation. Use the Punctuation field in the Modify dialog box to change the default
characters.

Case Sensitivity
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Concordance Desktop is not case sensitive. All words are converted to upper case
letters when placed into the dictionary. All searches are likewise converted to upper
case before being processed. This upper case conversion does not affect the original
text that exists in your documents.

Word Length

A word can be any length of characters, but only the first 64 are considered
significant. Longer words are truncated to 64 characters when they are stored in the
dictionary. When you search for a word longer than 64 characters, your search word
is truncated before being looked up in the dictionary. The source text is not
affected.

Stopwords

Words that occur frequently, such as the, and, and or, have little search value.
Such words are commonly referred to as noise words. Concordance Desktop stores
these types words in a stopword list. Words that occur in the stop list are not stored
in the dictionary. Excluding them from the dictionary saves time in the indexing
process and significant disk space on your computer without impairing the database's
ability to retrieve data. The list of stopwords is user defined and can be printed or
changed in the Stopwords dialog box. If you have not specified any stopwords for
your database, Concordance Desktop uses the default list in the
concordance_[version #].stp stopwords file.

The stopword dictionary is used during the indexing process. Adding or deleting
words from the stopword dictionary does not affect the existing database dictionary.
Editing the stopword dictionary requires a complete index of the database for the
changes to take effect.

For more information about stopwords, see Updating the stopwords list.

Indexing and reindexing updates

Actively used databases need frequent updating to keep the index and dictionary entries
current. In Concordance Desktop, we refer to creating the database index as a full index,
and refer to an index update as a reindex, which simply updates the database dictionary
and its corresponding index. 

During the creation of a load file database, you can select the option to run the index
automatically after the import process. However, if that option is not selected, have an
option to have the database automatically indexed during the 
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Reviewers are typically not given indexing or reindexing privileges because of the
sensitivity involved in running these processes. Concordance Desktop administrators must
ensure that all data is reviewed and proper back-ups are made before indexing or
reindexing the database with updates.

For information about indexing and reindexing concatenated databases, see Indexing and
reindexing concatenated databases.

Indexing databases

Running a full index is necessary after you create a new database, if the database
status in the Admin Console displays that the database has not been indexed. However,
there will also be times when you need to perform full index updates to include
modifications to the dictionary, stopwords list, and punctuation settings. Running a full
index is an exclusive process and only the administrator can access the database at
that time. 

When performing a full index, please consider the following:

· Perform a full index when all reviewers are logged out of Concordance Desktop,
processing can take hours and impacts access to the system and work activity

· When possible, plan to perform full indexes when it doesn’t impact regular work
hours

· Alert all reviewers of when indexing will occur and the timeframe for when the
system may be available again

· Verify that all reviewers are logged out of the system before you run this process

You may find it useful to maintain an email distribution list for the review team for
times when you need to ask everyone to exit a database.

On the File menu, Concordance Desktop adds a check mark next to the Index
command:
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In the Databases task pane, Needs Reindexing is displayed in the Current Databases
panel:
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In the Admin Console, under the Management tab when you click on the Databases
folder:
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In the Indexed column in the table on the right, Yes indicates that the database has
been indexed, while No indicates that it needs to be. 

In the Admin Console, under the Management tab, when you click on the Databases
folder, and then click on a database name.
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Under the Database heading in the pane on the right, there is a row for Indexing
Needed. A Yes in this column indicates that the database needs to be indexed, while a
No indicates that the database has already been indexed. 

To index a database:

On the File menu, click Index.

Reindexing Databases

You can determine whether a database needs reindexing on the File menu and the
Databases task pane, or in the Admin Console when you have the Management tab
open and you click on the Databases folder. A database needs reindexing whenever the
database dictionary is not current with the additions or changes that have been made
to the database since the database was last indexed or reindexed. 

On the File menu, Concordance Desktop adds a check mark next to the Reindex
command:
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In the Databases task pane, Needs Reindexing is displayed in the Current Databases
panel:
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When performing a reindex, please consider the following:

· Run a query on edited records or those marked for deletion. To do this, on the
Search menu, click Search for edited documents.
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To reindex a database:

On the File menu, click Reindex.

Finding the database indexing time

Knowing the indexing time for databases can help you plan your indexing schedules. Once
you have built your databases, you can find out how long it takes to index each database
by checking the Concordance Server.log file. The Concordance Server.log file is stored in
the Working Path directory usually found at  C:\ProgramData\LexisNexis\Concordance
Desktop\Working Path.

To find a database's indexing time:

1. Navigate to the Concordance Desktop Server Working Path folder containing the
Concordance Server.log file.

The default directory is C:\ProgramData\LexisNexis\Concordance Desktop\Working
Path.

2. Right-click the Concordance Server.log file, click Open With, and then Notepad
or another text editor program to open the .log file.

3. Locate the database name and indexing time. 
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The indexing time is listed after the database name. The .log file also displays the
amount of cache used during processing, the number of database records, and the
user who performed the index.

The example of the .log file shows indexing in seconds, but realistically, your
database is probably going to index in hours, not seconds.

Updating the stopwords list

Stopwords are the most common words in the English language (and, the, but, etc.).
Stopwords are not words that are generally searched for by reviewers. Eliminating
stopwords from the index ensures that searches run much faster and efficiently.
Stopwords are stored in the [database name].STP file. Concordance Desktop
automatically creates a list of 141 stopwords in .STP file.

You may receive requests from reviewers to add a specific word that is common to the
case review documentation and needs to be avoided during searches. Administrators can
modify the Stopwords list for your review team when necessary.

Editing the Stopword list requires a full index of the database for the changes to take
effect.

The Stopword list is only used during the indexing process. Adding or deleting words from
the Stopword list does not affect the existing database dictionary until the database is
indexed.

To update the stopwords list:

1. On the File menu, click Dictionaries, and then Stopword list.

Clicking Stopword list opens the Stopwords dialog box.
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2. To add a word to the Stopword list, type the word you want to add in the field
below the Stopword list, and click the Add button. 

Wildcards can be used with stopwords to eliminate large groups of words. For
example, adding 9* to the stopwords list eliminates every word or number beginning
with the character 9 from the database dictionary.

For searching purposes, it is recommended that only Latin based characters are
used in the Stopword list.

3. To search for a stopword, type all or part of the word in the field below the
Stopword list. 

As you type, the list scrolls to the word closest to the word you are typing. You
can also use the scroll bar and buttons to find a word in the list. 

4. To delete a word from the Stopword list, click the word in the list, and click the
Delete button.

5. To print the Stopword list, click the Print button.

6. Click OK to save your changes.

7. Index the database to update your database. 

Stopword list changes will not apply to searches until a full index is run. 

Adjusting punctuation settings

For full-text searching, punctuation is not indexed. Concordance Desktop treats
punctuation as spaces. All punctuation is ignored, such as periods or quotations, as well
as currency and percentage symbols.



Concordance Desktop 274

There are two exceptions to this rule, and both exceptions must be true:

· Punctuation is listed in the Punctuation field on the New or Modify dialog box to be
indexed

· Punctuation is embedded in a string of characters

You can find what punctuation is full-text searchable in a database, when it’s embedded
in a string of characters, by checking the Punctuation field in the database properties
dialog box. By default, Concordance Desktop includes the apostrophe, period, comma, and
forward slash. You may want to add symbols like the ampersand and the at sign for e-mail
databases.

Examples: Embedded Punctuation

· AOL.com and NETSCAPE/AOL – Allows you to search on these terms because the
entries relate to a case regarding Internet browsers.

· D’Arcangelo – The apostrophe is embedded because of the surname spelling. People
mentioned in case records may have possessive apostrophes embedded in their
names and may be added to the list because the name is searched often.

· john.smith@organization.com – The period and at sign are both examples of
embedded punctuation within an e-mail address.
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To adjust punctuation settings:

1. On the File menu, click Modify to open the Modify dialog box.

2. In the Punctuation field, add or delete the applicable punctuation.

3. Click OK to save your changes.

4. Run a full index to update the database dictionary with the punctuation changes.

Reviewing the dictionary

In Concordance Desktop, a word is any string of characters. A word can be a series of
numbers or a combination of letters, numbers and even punctuation or symbols. Familiarize
yourself with your database dictionary by reviewing or printing the entries.

The maximum length of a dictionary word is 64 characters. When a word exceeds 64
characters, only the first 64 characters of the word are included in the dictionary.
Since the full word is not listed in the dictionary, the word may not be found in the
database. 

For example, creating a word that includes the file name and path can create a word
longer than 64 characters that is not found in the database.



Concordance Desktop 276

You can review dictionary entries in three areas:

· The database properties dialog box displays the number of words included in your
dictionary and the punctuation that is indexed.

· The Dictionary dialog box accessed from the File menu provides a complete listing of all
the words included in the dictionary, the number of documents each word appears in,
and how many word hits there are for each word in the dictionary.

To search for a word in the dictionary, type all or part of the word in the field below
the word list.
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To print the words in the dictionary:

1. On the File menu, click Dictionaries, and then Database dictionary.

2. To print a range of words, in the From field, type the first word in the range, in
the To field, type the last word in the range, and click the Print button.

To print all words in the dictionary, leave the From and To fields blank, and click
the Print button.

To print the dictionary words to a .txt text file, select the Print to file check box
before clicking the Print button.

· The Dictionary dialog box accessed from the Search pane allows reviewers to select
words from the dictionary and add them directly into search logic in the Advanced
Search panel.

Creating and Managing Tags

Typically a Concordance Desktop Administrator or Litigation Support Manager works with a
lead attorney to build a set of tags for case review that include standard naming
conventions and that adhere to internal guidelines for a case review. These tags are often
organized into folder structures that indicate phases of review, case topics, or are
designated by reviewer. Once tagging conventions are determined, as the administrator
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you will most likely be setting up these tags and folders after you build the database so
the review team can be begin searching and tagging immediately.

If you are working with a team of administrators, we recommend that only one or two
people be in charge of tag management, especially when making new ones and
deleting unnecessary tags. This prevents duplication of efforts and helps tag trees
remain uncluttered for all reviewers working in the database.

Managing tags in Concordance Desktop requires the following:

· Creating and applying tags to documents and queries

· Removing, renaming, and deleting tags and folders

· Importing and Exporting tags

· Querying tags and folders

· Tracking tag activity in the Tags task pane and .TRK file

· Backing up the tag file

For more information about basic and advanced tagging and tagging strategies, see the
topics in the Basic Tagging and Advanced Tagging books under the Using Concordance
Desktop book.

Creating tags

Tags can be used to categorize documents for any purpose. Use tags to mark documents
for status, witnesses, issues, exhibits, keywords, reviewer assignments, or anything else
you want to mark. You can group similar tags or issues by creating a folder and adding
tags or issues to that folder. Multiple levels of folders can be created to simplify document
reviews. You can also create personal folders and sub-folders to help organize your
personal tags and issues.

Both reviewers and administrators are able to create and apply tags to documents, but
administrators have the ability to do this in four locations so they can track and manage
tagging activity.

Tags and tag folders do not support Unicode characters.  Only ASCII (values 032-
126) characters are allowed. If a tag name or tag folder name contain an invalid
character, you are prompted to rename the tag or tag folder.

There are six ways you can create tags:

· In the Tags task pane

· On the Add/Delete tab in the Tag and Issue Management dialog box

· By writing tags directly in the TRK file
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· By writing tags directly in the INI file

· Writing tags from field data

· Importing Tags

Reviewers can apply tags and create tags in the Tags task pane. Administrators usually
create and manage the tags available to all users in the database on the Add/Delete tab
in the Tag and Issue Management dialog box. 

For a tag folder to exist in Concordance Desktop, it must have at least one tag
created in it. There is no known maximum limit on the number of tags you can create
and apply in Concordance Desktop.

To create a folder for administrative tags, name it zAdmin so it displays at the end of
the tag/folder tree and does not distract reviewers.

A tag name cannot contain more than 199 characters.
When creating tags and folders, the folder and tag string cannot exceed 199
characters. 
Example: 
The following folder/tag combination would be translated as a total of 45 characters.
001_Reviewer_Assignment
 9 Proposal
     9 Cary_Grant
001_Reviewer_Assignment>>Proposal>>Cary_Grant = 45 characters 

To create tags and tag folders in the Tags task pane:

1. Open the Tags task pane.

2. To create a new tag folder, right-click the Tags task pane, point to New, and and
then do one of the following:

· To create a new folder, click Folder.

· To create a subfolder, right-click to select the parent folder, point to New, and
click Folder.

3. Type the name of the new folder and press Enter.

When you are creating a folder, you must add at least one tag to the folder, or the
folder will not be saved when you end your Concordance Desktop session. You
cannot create empty folders.

Personal folders are pink and can only be viewed by the user who created the folder
and the administrator. All public folders are yellow.
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For more information about creating personal folders and tags, see Organizing tags.

4. To create a new tag, do one of the following:

· To create a tag in a folder, right-click to select the folder, point to New, and
then click Tag.

· To create a tag outside of a folder, without selecting a folder, right-click in the
Tags task pane, point to New, and click Tag.

5. Type the name of the new tag and then press Enter.

To create tags and tag folders in the Tag and Issue Management dialog box:

1. On the Tools menu, click Manage Tags/Issues.

2. In the Tag and Issue Management dialog box, to create a tag folder, do one of
the following:

· To create a tags folder, click the arrow next to the Add button, and click Folder.

· To create a tags subfolder, click the parent folder, then click the arrow next to
the Add button, and click Folder.

3. Type the name of the new folder and press Enter.
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When you are creating a folder, you must add at least one tag to the folder, or the
folder will not be saved. You cannot create empty folders.

4. In the Tag and Issue Management dialog box, to create a tag, do one of the
following:

· To create a tag in a folder, click the folder, click the arrow next to the Add
button, and click Tag.

· To create a tag outside of a folder, without selecting a folder, click the arrow
next to the Add button, and click Tag.

5. Type the name of the new tag and press Enter.

6. When you are finished adding the tags and/or folders, click Done . 

Your new folders and/or tags are displayed in the Tags panel in the Tags task pane.

To delete tags and folders:

Selected tags and issues can be deleted from the database. This permanently removes
them from the database and cannot be undone. Folders are automatically deleted after
all of the tags and issues in the folder are deleted. You cannot manually delete a folder.

Tags added to the database using the .ini file need to be removed from the .ini file
first, and then deleted from the Add/Delete tab. Tags not removed from the .ini file
remain in the database even after deleting them from the Add/Delete tab.

1. On the Tools menu, click Manage Tags/Issues.

2. In the Tag and Issue Management dialog box, click Add/Delete, select the tag
you want to delete, and then click Delete.

3. When prompted, verify whether or not you want to delete the tag.

5. When finished, click Done.  

The deleted tags are removed from the database and the Tags panel in the Tags task
pane.

Organizing tags

Folders are used to organize similar types of tags, allowing you to easily focus on the tags
that matter to you at that moment. Once a review has begun, you can review tag history
and statistics to see what tags are applied to a document, who applied the tags and
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when. You can also perform queries on multiple tags or folders, allowing you to use a
document’s tag status as part of a complex search.

Creating folders

When you create a folder you must add at least one tag to the folder, or the folder will
not be saved. You cannot create empty folders.

To create a folder:

1. Open the Tags task pane.

2. In the Tags task pane right-click, point to New, and then click Folder.

3. Type the name of the new folder and then press Enter.

4. Right-click the new folder, point to New, and then click Tag to create a tag
within the folder.

5. Type the name of the new tag and then press Enter.
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When you are creating a folder, you must add at least one tag to the folder.

To create a folder and set of tags for your individual review of documents, you can
easily do so. For more information, see Creating Personal Folders and Tags.

If you need to remove a folder or tag, contact your Concordance Desktop
administrator.

Creating Personal folders and tags

To keep the tag panel uncluttered for all users, you can create a personal folder and
custom tags specific to your own review needs. When you create personal folders, they
are not visible in the Tags panel for other users. 

1. Open the Tags task pane.

2. In the Tags task pane right-click, point to New, and then click Folder.

3. Type the name of the new folder, and then press Enter.

Personal folders are pink and can only be viewed by the user who created the folder
and the administrator. All public folders are yellow.

4. Right-click your personal folder, point to New, and then click Tag to create a tag
within the folder.

5. Type the name of the new tag, and then press Enter.

When you are creating a folder, you must add at least one tag to the folder, or the
folder will not be saved when you end your Concordance Desktop session. You
cannot create empty folders.

If you need to remove a folder or tag, contact your Concordance Desktop
administrator.

Reorganizing tags and tag folders

1. Open the Tags task pane.

2. In the Tags task pane, do any of the following:

· To move a single tag from one folder to another folder, select the tag and drag to
the new folder.

· To move multiple tags, press CTRL and click the tags to move, and then drag the
tags to the new folder.
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· To move a folder and all the tags in the folder, click the folder and drag to the
new location.

· To move multiple folders, press CTRL and click the folder to move, and then drag
the folders to the new location.

For a tag folder to exist in Concordance Desktop, it must have at least one tag in
it.  If you move all the tags out of a folder, the folder will be deleted.

Importing and Exporting Tags

The Import Tags and Export Tags commands in the Tag and Issue Management dialog box
provide the necessary tools to quickly copy tag structures between databases without
having to create them manually.  You can create a text file from scratch that contains a
list of tags and folders similar in format to adding tags using the .INI file.  The » ASCII
character » (ASCII 187) is used to identify the folder structure for the tags. 

Tags and tag folders do not support Unicode characters or high-end ASCII
characters.  Only ASCII (values 032-126) characters are allowed. If a tag name or
tag folder name contains an invalid character, you are prompted to make corrections.

When creating a tag file, each line represents a tag and every folder must have a tag. 
The text file format should be written as follows:

Type Structure Example

Single Tag Tag Junk

Tag with Folder Folder»Tag Status»Reviewed

Nested Folders Folder»Folder»Tag Production»Production001»To
_Produce
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Example Tags .txt file for importing tag lists

If you have an existing tag list setup in a Concordance Desktop database, you can export
the tags and then import the file into any new or existing database.  Only public folders
and tags are exported, no personal folders and tags.

To import tags from a text file:

1. Make sure that the text file you want to import is formatted correctly.

2. On the Tools menu, click Manage Tags/Issues.

3. In the Tag and Issue Management dialog box, click Import Tags.

4. Click the Browse button, locate and select the text (.txt) file for the tags you
want to import, and then click Open.

5. (Optional) Click the Prescan button to scan the file for unsupported characters,
tag names that are longer than 199 characters, and any delimiter issues.  

6. When the Prescan is complete, do one of the following:

· If no errors are found, click Done to close the Prescan dialog box.
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· If errors are displayed in the dialog box, click the Export button to export the list
to a comma separated (.csv) formatted file, find and fix any errors, and then
rerun the Prescan to ensure all the errors have been resolved.

8. Click the Import button.

9. When finished, click Done and then verify that the Tags pane contains the tags
imported from the text file. 

To export tags to a text file:

1. On the Tools menu, click Manage Tags/Issues.

Issue tags cannot be exported unless the tag is applied to a Concordance Desktop
record.

2. In the Tag and Issue Management dialog box, click the Export Tags button.

3. Click the Browse button, navigate to the location where you want to save the tags
text (.txt) file, and then then click Open.

4. Click the Export button.
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5. When finished, click Done, and then open the exported text file, and review the
exported folders and tags.

Writing tags in the TRK file

In addition to creating tags in the Tags task pane and the Tag and Issue Management
dialog box, you can write tags directly into the .trk file. This is useful if you want to
transfer many tags from one database to another database.

You can manually add individual tags to a database's .trk file, or can copy the tags from
one database's .trk file to another database's .trk file.

To manually add a tag to a .trk file:

1. In Concordance Desktop, open the database you want to add a tag.

2. On the Tools menu, click Manage List Files to open the List File Management
dialog box.

3. On the Lists tab, click the Open button.

4. In the Open dialog box, locate and open the database's .trk file.
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The selected .trk file's data is loaded into the List File Management dialog box.

5. Click the Edit tab to view all of the records in the database's .trk file.

6. In the Key field, replace the existing text in the field with the new tag name, make
sure that the tag name begins with the $ symbol. 

To add the tag to an existing tag folder or create the tag in a new folder, add the
folder name before the tag name and separate the folder name and tag name with
the » ASCII character 187. The character is used to identify the folder structure of
the tag.

For more information about delimiter characters, see About delimiter characters.

Examples:

To add a tag, type $Tag Name.

To add a tag to an existing or new tag folder, type $Folder Name»Tag Name.

7. If this is a new tag that has not been applied to any documents in the database,
type a zero in the Data value field.

8. Click the Add button.

Clicking the Add button adds the tag to the database's .trk file, and the record list
on the Edit tab.

9. Click the Done button to close the List File Management dialog box.

10. Open the Tags task pane or Tag and Issue Management dialog box to verify that
the new tag and tag folder are now displayed. 

If the Tags task pane was open while you added the tag, the newly added tag and
folder will not be displayed until you leave and reopen the Tags task pane. For
example, open the Databases task pane and then reopen the Tags task pane.

To copy tags from one database to another:

To copy tags from one database to another, you first need to export the tags and then
import the tags into the other database.

To export tags from a database:

1. In Concordance Desktop, open the database you want to copy tags from.

2. On the Tools menu, click Manage List Files.
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Clicking Manage List Files opens the Lists tab in the List File Management dialog
box.

3. Click the Open button.

4. Locate and open the database's .trk file.

Clicking Open loads the selected .trk file's data into the List File Management
dialog box.

5. Click the Import/Export tab.

6. Select the Export option in the Import/Export section. 

By default, in the Data value delimiter section, the Include data values check box
is selected, the Comma delimiter option is selected. 

List files exported or imported with both the key value and the data value must
use a delimiter to separate them. The key entry is always first, followed by a
delimiter, and then the numeric data value.

7. To export the database's tags, leave the Include data values check box
selected, and select the applicable delimiter. 

If the delimiter is not a comma or tab, click the Other option and select the
applicable delimiter from the delimiter list.

The delimiters available from the delimiter list may appear as square symbols or
may not be displayed. How this list is displayed depends on the computer's
language environment. The delimiters listed in the About delimiter characters topic
use the Tahoma font, which displays the characters regardless of the language
environment. All of the characters listed in the delimiter character list can be
selected as the delimiter, even if the symbols they represent do not appear in the
delimiter list.

To see the list of available delimiter characters, see About delimiter characters.

8. In the Range section, select one of the following:

· All entries – All entries in the database's .trk file are exported

· Range – Only the range defined in the From and To fields is exported from the
database's .trk file. If you select Range, in the From field type the first entry
in the range, and in the To field, type the last entry in the range.

9. Click the Export button.

Clicking the Export button opens the Save As dialog box.

10. Browse to where you want to save the .txt file generated by the export, type
the .txt file name in the File name field, and click Save.
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Clicking Save saves the .txt file in the directory you selected and closes the
Save As dialog box.

11. Click the Done button to close the List File Management dialog box.

12. In any text editor program, navigate to and open the exported .txt file.

Delimited text files can be opened with any text editor program, such as Notepad.
We recommend using an advanced text editor program like TextPad or UltraEdit.

 

All Concordance Desktop database tag and tag folder entries in the exported .txt
file begin with a $ symbol.

13. Select all records in the .txt file that do not begin with the $ symbol, and delete
them.

There should now only be tag and tag folder records in the .txt file.

14. Save the modified .txt file and close the file.

If you do not want to overwrite the originally exported .txt file, be sure to save
the modified .txt file with a different file name.

 

To import tags from another database:

1. In Concordance Desktop, open the database you want to copy the tags from.

2. On the Tools menu, click Manage List Files.

Clicking Manage List Files opens the Lists tab in the List File Management dialog
box.

3. Click the Open button.
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4. Locate and open the database's .trk file.

Clicking open loads the selected .trk file's data into the List File Management
dialog box.

5. Click the Import/Export tab.

6. In the Import/Export section, select the Import option.

By default, in the Data value delimiter section, the Include data values check box
is selected, the Comma delimiter option is selected. 

List files exported or imported with both the key value and the data value must
use a delimiter to separate them. The key entry is always first, followed by a
delimiter, and then the numeric data value.

7. To import the tags .txt file from the other database, leave the Include data
values check box selected, and select the applicable delimiter option. 

If the delimiter is not a comma or tab, click the Other option and select the
applicable delimiter from the delimiter list.

The delimiters available from the delimiter list may appear as square symbols or
may not be displayed. How this list is displayed depends on the computer's
language environment. The delimiters listed in the About delimiter characters topic
use the Tahoma font, which displays the characters regardless of the language
environment. All of the characters listed in the delimiter character list can be
selected as the delimiter, even if the symbols they represent do not appear in the
delimiter list.

To see the list of available delimiter characters, see About delimiter characters.

The options in the Range section are not used during the import.

8. Click the Import button.

Clicking the Import button opens the Open dialog box.

9. Browse to where you saved the modified tags .txt file, click the file name, and
click Open. 

Clicking Open imports the tags and tag folders in the modified tags .txt file into
the database. 

10. Click the Done button to close the List File Management dialog box. 

11. Open the Tags task pane or Tag and Issue Management dialog box to verify
that the imported tags and tag  folders are now displayed. 
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If the Tags task pane was open while you imported the tags, the imported tags
will not be displayed until you leave and reopen the Tags task pane. For example,
open the Databases task pane and then reopen the Tags task pane.

Writing tags in the INI file

One method of creating a permanent tag structure is to write tags directly into an INI file.
A database's INI file stores various database configuration settings. Tags created in this
file cannot be deleted in the Tag and Issue Management box.

When tags are created in Concordance Desktop or in the TRK file, the tags are not
automatically written to the .ini file. To add tags to the .ini file, you need to manually
write them into the file. Once tags are written in the .ini file and available in the Tags task
pane.  Once a tag is applied, the tags are automatically written to the .trk file.

The » ASCII character is used to identify the folder structure of the tag. The ASCII
character for this symbol is 187. You can  create a shortcut for the symbol in Microsoft
Word on the Symbols tab in the Symbol dialog box. For example, you can create a
shortcut of F10+K for this character.

For more information about delimiter characters, see About delimiter characters.

Once you have written tags to an .ini file, you can save time creating tags for another
database's .ini file by copying and pasting the entries from one database .ini file to
another.

If you are renaming tag or tag folder names in the .ini file, the Tags pane displays
both the original and renamed tags.  Renaming tags does not affect *.ini file tags.

To write tags in the .ini file:

1. Navigate to the database's .ini file.

The .ini file is stored in the same directory as the database .dcb file.

2. Open the .ini file in any text editor program.

INI files can be opened with any text editor program, such as Notepad. We
recommend using an advanced text editor program like TextPad or NotePad ++.
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In the .INI file, the different database configuration settings are designated by the
[] symbols around the configuration category. For example, field groups are listed
under [FieldGroups], and added menu items are listed under [AddedMenuItems].

Tags are added after the [Tags] category, and each tag has a separate line in the
.ini file. 

3. If the .ini files does not have a tags list, type [Tags] in a new line to create the
tags list.

4. Add the tags below the [Tags] line using the following format:

· To add a tag outside of a folder, type: Tag#=Tag_Name

· To add a tag within a folder, type: Tag#=Folder_Name»Tag_Name

· To add a personal folder and tag, type:
Tag#=»UserID»Personal_Folder_Name»Tag_Name

Use underscore characters to indicate spaces in a tag or folder name.  

To enter the ASCII character, », press ALT+0187 on the number pad.  If you are
using a laptop, press ALT+FN+0187 (blue numbered keys - UILKJ and M).

In the image above, one tag, Sample tag, was created outside of a folder. There
are five tags, Privileged, Production, Redacted, Responsive, and Sample Tag in
Folder, created in the Status Folder, there are two tags, Hauser and Weller, created
in the Witness Kits folder, and a personal folder and tag.

5. Save and close the modified .ini file.

6. Open the database in Concordance Desktop.

7. Open the Tags task pane to verify that the tags and folders you added are
displayed. 



Concordance Desktop 294

If the Tags task pane was open while you wrote tags to the database's .ini file, the
tags you added will not be displayed until you leave and reopen the Tags task pane.
For example, open the Databases task pane and then reopen the Tags task pane.

Creating tags from data

The Field To Tag feature copies the contents within a selected field to a create tags in the
Tags pane.

When selecting a field to create a tag from, ensure that you select a field that is
listed before your OCR numbered fields. 
Example:

 In this example, we are selecting the ADMIN field, which appears before the OCR1
field.

Tags and tag folders do not support Unicode characters.  Only ASCII (values 032-
126) characters are allowed. If a tag name or tag folder name contains an invalid
character, you are prompted to make corrections.  The Prescan option scans the field
data for any invalid tag names.  

Creating tags from data within a specified field

1. On the Tools menu, click Manage Tags/Issues.

2. In the Tag and Issue Management dialog box, click the Field To Tag button.
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3. From the Select Field list, select the field for the values you want to convert to
tags.

4. From the Select Delimiter list, select the delimiter to use to separate the tags in
the field.

5. (Optional) Click the Prescan button to scan the data in the specified field for
unsupported characters, tag name size (limited to 199 characters) and delimiter
issues.  

Any resulting errors are displayed in the Prescan dialog box.

6. When the Prescan is complete, do one of the following:

· If no errors are found, click Done to close the Prescan dialog box.

· If errors are found, click the Export button to export the list to a comma
separated (.csv) formatted file, find and fix any  errors, and then rerun the
Prescan to ensure all the errors have been resolved.

7. Click the Start button.

8. When finished, click Done, and then verify that the Tags pane contains the tags
that match the values in the specified field.  For every value in the field, you should
have a matching tag.
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Applying tags to queries

As an administrator, you may find that searching for a batch of documents first and then
applying a tag to the query is more efficient than tagging individual records one at a time.
This tactic may be useful if you are pre-categorizing tagged documents into folders for
the review team or gathering documents for witness kits.

To apply tags to queried documents:

You can apply tags to queried documents from the Tags task pane and the Tag and
Issue Management dialog box. For more information about adding or removing tags from
queries in the Tags task pane, see Tagging records.

1. Run a search for the documents you want to locate and tag.

For more information about searching, see Available search tools. 

2. On the Tools menu, click Manage Tags/Issues.

Clicking Manage Tags/Issues opens the Add/Delete tab in the Tag and Issue
Management dialog box.

3. Click the Tag Query tab.
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4. Click the tags you want to apply to the documents in the query you ran.

To select multiple tags, use CTRL+click or SHIFT+click.

5. Click the Apply to Query button.

The number of tags applied displays in the bottom right corner of the dialog box.

To remove tags from the current query, select the tags on the Tag Query tab and
click the Remove from Query button.

Querying tags and folders

Running a query from a tag is a simple way to locate all records that have a particular tag
applied to them. You can also query a tag folder to locate all tagged documents within a
folder.

To query tags and folders:
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You can query tags and folders from the Tags task pane and the Tag and Issue
Management dialog box. For more information about querying tags and folders in the
Tags task pane, see Creating queries from tags.

1. On the Tools menu, click Manage Tags/Issues.

Clicking Manage Tags/Issues opens the Add/Delete tab in the Tag and Issue
Management dialog box.

2. Click the Tag Query tab.

3. Click the tags and/or folders you want to create a query.

To select multiple tags and folders, use CTRL+click or SHIFT+click.

4. Click the Create Query button.

Clicking the Create Query button generates the query for the selected tags and/or
folders. The number of documents found in the query is displayed in the bottom
right corner of the Tag and Issue Management dialog box.

Concordance Desktop stores all searches from a current session in the Review view.
Your new query is listed in the query list in the Review view.



Administration 299

Managing tags and folders

On occasion you may need to add/remove, reorganize, or rename a tag or tag folder due
to a misspelling or shift in document categorization during case review phases. This
process is not the same as renaming a folder or tag in a Microsoft Word or Outlook menu
tree. In Concordance Desktop the process should be controlled by administrators to
ensure that ample backups and tag history is captured before the tag and folder structure
is altered.

For more information about reviewing and capturing tag history, see Storing tag history.

For more information about backing up tags, see Backing up tags.

Using the Tag and Issue Management dialog box, you can add/remove, reorganize, and
rename tags and tag folders in the current database. Concordance Desktop verifies that
only one named tag or folder is present within the same hierarchy. If tag or folder with
the same name already exists, Concordance Desktop prompts you to rename the tag or
folder. Concordance Desktop then automatically updates all records with the new tag
name.

Before renaming a tag or tag folder, it is best practice to run the
TagHistoryandStoreIt.cpl to capture a current query of all tag history before
transferring documents to a new tag.

The maximum length for tag names is 199 characters.

Reorganizing tags and tag folders:

1. On the Tools menu, click Manage Tags/Issues:

2. In the Tag and Issue Management dialog box, on the Add/Delete/Rename tab, do
any of the following:

· To move a single tag from one folder to another folder, select the tag and drag to
the new folder.

· To move multiple tags, press CTRL and click the tags to move, and then drag the
tags to the new folder.

· To move a folder and all the tags in the folder, click the folder and drag to the
new location.

· To move multiple folders, press CTRL and click the folder to move, and then drag
the folders to the new location.

For a tag folder to exist in Concordance Desktop, it must have at least one tag in
it.  If you move all the tags out of a folder, the folder will be deleted.

To rename tags and tag folders:
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1. Run the TagHistoryandStoreIt.cpl to capture a current query of all tag history
before transferring documents to a new tag.

The default directory for the CPL folder installed with Concordance Desktop is C:
\Documents and Settings\All Users\Application Data\LexisNexis\Concordance
Desktop\CPL (Windows XP) or C:\ProgramData\LexisNexis\Concordance Desktop\CPL
(Windows 7). For more information about CPLs, see About the Concordance Desktop
Programming Language Reference and TagHistoryAndStoreIt. 

2. On the Tools menu, click Manage Tags/Issues.

3. In the Tag and Issue Management dialog box, click the tag or folder you want to
rename, and then click Rename.

4. Enter the new tag or folder name.

The Manage Tags/Issues dialog box does not allow non-ASCII characters for tag or
tag folder names.  You can add non-ASCII character tag and tag folder names
using CPLs or INI files.

5. Repeat steps three and four for each tag or folder you want to change.

6. When finished, click Done.  

Concordance Desktop automatically updates all tagged records with the new tag
name. 

7. Review the queried records to ensure the tag or folder name is updated.

Viewing tag history

The Tag history panel displays two types of information:

· Added Tags - tags that exist on the current document record, including who applied
the tag and when it was applied.

· Deleted Tags - tags that previously existed on the current document record, but are
now removed, including who deleted the tag and when.

As you navigate records, your tag history changes to reflect the history of each selected
document.
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To review tag history:

1. Select a document record that has been tagged.

2. Open the Tags task pane and select the Tag history panel.

3. Scroll to view all tags that are applied and removed from the current document.

4. Click the plus or minus sign next to the tag status to view or hide a category
listing. 

Storing tag history

The TagHistoryAndStoreIt.cpl allows you to take the information from the Tag history
panel in the Tags task pane and place it into a field for the purpose of searching, backups
or storing historical information.



Concordance Desktop 302

Storing a database's tag history can help you track tagging issues, such as a user
accidentally bulk un-tagging a group of documents. The information captured by the
TagHistoryAndStoreIt.cpl allows you to run relational searches on specific tags, users, and
the date that an event occurred.

Tag history will also need to be stored when using the Export as a Concordance Desktop
Database feature because the export includes a database's current tagging information, 
but does not include the tag history.

For more information about the exporting Concordance Desktop databases, see backing up
databases and Exporting databases. 

By default, the CPL places all of the tag history for a query of documents into the
TAGINFO field. If you want to store the tag history in different field in your database, you
need to replace the TAGINFO field name with the other field name in the
TagHistoryAndStoreIt.cpl file before running the CPL.

If your database has an existing field named TAGINFO, then you do not need to modify
the CPL before running the CPL.

To change the tag history field in the CPL:

1. Open the CPL using a text editor.

To open the CPL, right-click the TagHistoryAndStoreIt.cpl file, point to Open,
and click Notepad or any other text editor program you have.

Delimited text files can be opened with any text editor program, such as Notepad.
We recommend using an advanced text editor program like TextPad or UltraEdit.

2. Search and replace all references to the TAGINFO field with the name of the field
you want to use to store your tag history. If you have an existing field named
TAGINFO, then you will not need to modify the cpl.
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3. Save your changes and close the TagHistoryAndStoreIt.cpl file.

To store tag history:

1. In Concordance Desktop, on the Standard toolbar, click the All button to query all
records in your database.

2. On the File menu, click Begin program.

3. Navigate to the CPL directory installed with Concordance Desktop, and click the
TagHistoryAndStoreIt.cpl file.

The default directory for the CPL folder installed with Concordance Desktop is C:
\ProgramData\LexisNexis\Concordance Desktop\CPL (Windows 7). For more
information about CPLs, see About CPLs and TagHistoryAndStoreIt.

4. Click Open.

After clicking Open, the CPL automatically extracts your tag history from each
database record and adds the tag history to the TAGINFO field, or its equivalent,
for each record. 

5. Open the Browse view and locate the field where you placed the tag history. 

The tag history lists the tags that were added to and removed from the record,
when the tags were added or removed, and by whom. 
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Viewing tag statistics

The Tag statistics panel allows you to monitor the tags applied, in categories by tag or
reviewer, for a certain time frame. This feature is useful when monitoring an individual’s
review progress.
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To review tag statistics:

1. Open the Tags task pane and select the Tag statistics panel.

2. In the From and To fields, select the date range you want to review.

3. Click the Refresh button to display the tag statistics.

4. Scroll to view all tags and users listed.

The Tags list displays the name of the reviewers who applied the tag, and how
many records the tag was applied to by the user. 

The Users list displays the tags applied by each reviewer, and how many times the
user applied each tag. 

5. Click the plus or minus sign next to the users and tags to view or hide the
statistics. 

Tracking tags in the TRK file

To track and manage your tags, you can review the .trk file that references all tags set in
the system at a given time. All tag information is stored in the .trk file, which includes
three sections:

· Index Section - Review the index to see how many tags a document has applied to it.
For example, if there are 10 documents in a database with three tags applied to each
document, then there would be 30 records in this section. Every record in the index
begins with a hash mark (#).

· Tag List - Review this list to locate tag names in your database. One record exists for
each unique tag name in the database. So if there were three tags in the database,
there would be three records in the tag list. Each record stored in this list begins with
a dollar sign ($).

· Tag History - Review these items for added and deleted tags. Every record in this
section begins with a plus or minus sign (+ or -).

In the .TRK file, personal folders and the tags in the folder are preceded by the »
character and the user's Windows login or security user ID. 

· Personal folders are displayed in the following format: 

»UserName»Personal Folder Name»Tag Name

· Public folders are displayed in the following format: 

Folder Name»Tag Name
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To review the .TRK file:

1. On the Tools menu, click Manage List Files.

Clicking Manage List Files opens the Lists tab in the List File Management dialog box.

2. Click the Open button to open the Open dialog box.

3. Browse to and click the database's .trk file, and click Open.

Clicking Open loads the selected .trk file's data into the List File Management dialog
box.

4. Click the Edit tab.

All of the records in the database's .trk file are listed on the Edit tab.

5. Review the tag information in the .trk file.

6. When finished, click Done to close the List File Management dialog box.

Scheduling tag backups

It is recommended that you make regular backup files of your tags. An exported copy of a
database does not retain tag history. Utilizing Windows Services, the Backup and Restore
Tag Utility backs up a single database or directory of databases and provides tools to
restore any damaged or lost files to an earlier point in time. 

The Backup and Restore Utility searches the specified directory and when changes are
made to a database's TRK file, the utility backs up the file at the scheduled backup
interval, and saves it to the specified directory.  Email notification can be set up to alert
you when a TRK file is identified as damaged or the storage capacity of the backup file
location. The backup files are located in the same location as the associated database. 

Multiple backup services can be configured for different directories where Concordance
Desktop databases are stored.  A log file is created for each directory with the backup
information, including when a backup was skipped because the previous backup took too
long.  The log file is stored in the Concordance Desktop 10 Logs folder in the Program data
path.

Keep the following in mind when scheduling the TRK backup:

· Schedule the Backup and Restore Tag Utility to run when all databases are closed to
ensure the process is not interrupted.

· The utility does not create a backup for the Notes.TRK or the Redlines.TRK.

· A backup will not be created if the directory path, including the TRK filename, exceeds
251 characters.
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Make sure that you have administrator-level permissions for the computer you want
to run the Backup and Restore Tag Utility.  For more information, see Windows Help
and Support.

When scheduling the backup of large TRK files that may require more than an hour to
run, make sure you allow enough time between backups to ensure one process
completes before the next one begins.

To setup a tag backup schedule:

1. From the Tools menu, click Backup and Restore Tag Utility.

2. To setup a backup folder to store the files:

a. Click the Add button.

b. In the Configure Backup Directory dialog box, click the Browse button.

c. In the Browse for Folder dialog box, locate and select the directory or folder
that contains the database(s) you want to backup tags, and then click OK.

The path for the directory or folder is displayed in the Backup Root Directory field.

The path for the directory or folder should not exceed 251 characters in length.

d. From the Frequency list, select how ofter to run the backup utility.

e. In the Start Time box, specify the start time for the backup utility.

f. In the Maximum # of backup files per DB field, type the maximum number of
backup files to store in the folder for the database. 

When the backup folder reaches the maximum limit, the oldest backup file is
replaced with the latest version.

g. When finished, click Apply.

3. To setup the email notifications:

a. In the Notification section, select any of the following:

· Select the Send Notification when TRK file stops responding check box to receive
an email for non-functioning TRK files.

· Select the Send backup summary email after each run to receive an email
outlining the latest backup processes.

b. Click the Configure button.
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c. In the SMTP Server field, type the e-mail server to send e-mail notifications.

d. In the SMTP Server Port field, type the port number to use for outgoing mail
transport.

e. In the Username field, type the name you want to appear as the author of the
e-mail.

f. In the Email Address field, type the email address for the author.

g. In the Recipient field, type the email address for the individual who will receive
the email notification.

h. To verify the email address is valid, click the Test button.  

If the email is valid, a message is displayed stating the test was successful and the
recipient will receive a test email .

i. When finished, click Apply.

4. When finished, click Enable Tag Backups.

5. In the Backup Service Login dialog box, do one of the following, and then click OK:

· Select Local System Account to run the service from the local system account.

· Select This Account, and then type the domain name and username in the Username
field, and the password in the Password field.

6. When finished, click OK to exit the utility.

To view the backup summary report:

1. From the Tools menu, click Backup and Restore Tag Utility.

2. Click the Last Backup Summary button.

3. Review the summary report, and then do one of the following:

· Click OK to close the Backup Summary Report.

· Click Print to print a copy of the report.

4. When finished, click OK to exit the utility.

To change a tag backup schedule:

1. From the Tools menu, click Backup and Restore Tag Utility.

2. In the Backup Folder section, select the folder path you want to modify.

3. Click the Modify button.
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4. In the Configure Backup Folder dialog box, make any necessary changes, and
then click Apply.

5. To make changes to the email notification, click the Configure button, make any
necessary changes, and then click Apply.

6. When finished, click Enable Tag Backup.

7. In the Backup Service Login dialog box, do one of the following, and then click OK:

· Select Local System Account to run the service from the local system account.

· Select This Account, type the Username and Password in the corresponding fields.

8. When finished, click OK to exit the utility.

To delete a scheduled backup folder:

1. From the Tools menu, click Backup and Restore Tag Utility.

2. In the Backup Folder section, select the folder path you want to modify.

3. Click the Delete button.

4. When prompted, click Yes to confirm the deletion.

5. When finished, click OK to exit the utility.

Restoring tags from a backup

The Backup and Restore Tag Utility can be used to set up a list of databases to be
monitored for tag integrity.  When a TRK file becomes damaged or is no longer functioning,
the affected database is listed on the Restore tab with a list of backups allowing you to
restore the TRK file to an earlier point in time. 

To restore a damaged TRK file:

1. From the Tools menu, click Backup and Restore Tag Utility.

2. In the Backup and Restore Tag Utility dialog box, click the Restore tab.

3. In the Damaged TRK file(s) section, select the TRK file to restore.

4. From the Restore Tags From list, select the date and time to restore the TRK file.

5. Click the Restore button.

6. When finished, click OK.
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Additional tag backup tools

The following tools are available for backing up tags:

· Tag To Field command

· TagSaver CPL

Running the Tag To Field command

The Tag To Field command in the Tag and Issues Management dialog box writes the tag
names to a specified field in the database separating the tag name with the selected
delimiter.  To restore tags stored in a field, see the Creating tags from data within a
specified field procedure in Creating and applying tags.

To write tag names to a field:

1. On the Tools menu, click Manage Tags/Issues.

2. In the Tag and Issue Management dialog box, click the Tag to Field button.

3. From the Select Field list, select the field you want to copy the tag names.

4. From the Select Delimiter list, select the delimiter to separate the tag names in
the field.
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5. Click the Start button.

6. When prompted, do one of the following:

· Click Yes to confirm that you want to write the tag names in the selected
field.

· Click No to append the tag names to the existing field contents.

· Click Cancel to abandon the changes.

7. When finished, click Done, and verify that the selected field displays the tag
names separated by the selected delimiter.

Running the TagSaver CPL

You can create a backup file of your tags or restore the backed up tags into another
database using the TagSaver.cpl. We recommend running this CPL script once or twice
daily, depending on how much active reviewing is occurring. The tag back-up is stored
in a database's .GAT file and the tag data is retrievable, when needed.

TagSaver CPL benefits:

· You can move tag application information to different databases

· You can restore backup files (.gat) to other databases to move tag structure

When restoring tags from a .gat file, the maximum number of characters allowed in
a tag name is 199.

To backup tags in a database:

1. In Concordance Desktop, click the All button on the Standard toolbar to query
all records in your database.

2. On the File menu, click Begin program.

3. Navigate to the CPL directory installed with Concordance Desktop, and click the
TagSaver.cpl file.

The default directory for the CPL folder installed with Concordance Desktop is C:
\ProgramData\LexisNexis\Concordance Desktop 10\CPL (Windows 7). For more
information about CPLs, see and the TAGSAVER.cpl.

4. Click Open to open the Tag Saver Options list.
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5. Click Save tags or press Enter.

Clicking Save tags or pressing Enter opens the field list. Use the arrow keys on
your keyboard to scroll through the field list.

6. Click or press Enter on the field you want to associate with the tags. 

You need a common field with a unique value, such as the Begno (Bates number)
field. Do not use the Access ID field when exporting tag history.

After you select the field, the CPL creates the [database name].GAT file in the
same directory as the database's .dcb file. The [database name].gat file contains
your tag backup.

After the CPL process is finished, the Tag Saver Options list is displayed.

7. Click Quit to return to Concordance Desktop.

The database's .gat file is not automatically updated when you add or modify
tags in the database. It is best practice to run the TagSaver.cpl periodically to
ensure your tag backup is current.

To restore tags from a .GAT file to a database:
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1. Copy the .GAT file containing the tags you want to add to your database, and
paste the file into the database directory for the database you want to add the
tags.

2. Rename the .GAT file you copied to the database directory using the same name
as the database's .dcb file. 

For example if the database's .dcb file is Cowco.dcb, the .gat file needs to be
named Cowco.gat.

3. In Concordance Desktop, open the database you want to add the tags.

4. On the Standard toolbar, click the All button to query all records in your
database.

5. On the File menu, click Begin program.

6. Navigate to the CPL directory installed with Concordance Desktop, and click the
TagSaver.cpl file.

The default directory for the CPL folder installed with Concordance Desktop is C:
\ProgramData\LexisNexis\Concordance Desktop\CPL (Windows 7).  For more
information about CPLs, see Concordance Desktop Scripts  and the TAGSAVER.

7. Click Open to open the Tag Saver Options list.

8. Click Retrieve tags.

When you click Retrieve tags, the CPL adds the tags for all the records that were
tagged in the .gat file to the database. 

After the CPL process is finished, the Tag Saver Options list is displayed.

9. Click Quit to return to Concordance Desktop.

10. Open the Tags task pane to verify the tags were added and applied correctly to
the database.
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Setting Preferences

Preferences for reviewers and administrators involve three main topics:

· Preferences – various settings that affect all users using Concordance Desktop.

· Table Layout – custom setting options available and accessible by all users to create
both private and public table layouts.

· Custom Menus – custom menus added by administrators so tools are accessible from
the Menu bar, such as CPL scripts or query files.

Defining preferences

The Preferences dialog box contains settings used by both the administrator and
reviewers. You can choose to prevent certain users from accessing the Preferences dialog
box by applying security to this menu item. Most of the preferences are Microsoft
Windows registry settings, but there are several options that allow you to apply selections
to all databases.

Setting some of your viewing parameters helps ease browsing by offering more record
detail onscreen, and changing the red highlight color for keywords.

The Preferences dialog box contains seven tabs:

· General - settings used when starting and closing Concordance Desktop,
enable/disable Workspace options, and assigning fields for attachments.

· Searching - settings for the default search behavior and search engine.

· Browsing - settings for the title bar field, default query field, and tag and issue
options.

· Import - import settings related to numbering and indexing. 

· CPL - settings for CPLs, such as the CPL font selection.

Any setting changes made in the Preferences dialog box require you to close
Concordance Desktop and restart the application before the changes take effect.

To set General preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

Clicking Preferences opens the General tab in the Preferences dialog box. 
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The Startup section defines the startup view when opening Concordance Desktop
and databases.

For more information about customizing the start-up view in Concordance Desktop,
see Customizing the start-up view.

The Initial Browse Path field is used to determine the initial folder that opens when
you browse for a file or open a new database. For example, entering C:
\CloudNine\MyDatabases opens the MyDatabases folder when selecting Open
database from the Databases task pane. During each Concordance Desktop session,
the browse path is a dynamic setting and remembers the last folder opened. The
next time you browse for a file or select Open database, the previous folder location
opens. Each time you close and restart Concordance Desktop, Concordance
Desktop resets the browse path to the original Initial Browse Path field setting.

You need to restart Concordance Desktop for this change to take affect.
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2. To define the initial browse path, click the ellipses (...) button next to the Initial
Browse Path field, to open the Browse For Folder dialog box.

3. Navigate to and click the folder you want to open when you browse for a file or
open a new database, and click OK.

Clicking OK adds the folder path to the Initial Browse Path field. 

4. To ensure all workstations installs open the path in the Initial Browse Path field,
select the Always Map Initial Browse Path option.

The Default view field determines whether the Browse or Table view automatically
opens when you open a database in Concordance Desktop.  

5. To define the default view, in the Default view field, click Browse or Table from
the view list.

The Number of MRU items field determines the number of database files listed in the
most recently used (MRU) file list. The MRU file list is displayed on the File menu and
the Recent panel in the Databases task pane. The Number of MRU items field
defaults to 6. You can display up to nine files in the list. 

If a user's Recent panel or Recent Files list is blank, your company may have a
policy preventing the user's computer from writing to the MRU registry key.

You need to restart Concordance Desktop for this change to take affect.

6. To modify the number of database files listed, in the Number of MRU items field,
type or scroll to the number of files to list in the most recently used (MRU) file list. 

The Exit section defines what happens when you close Concordance Desktop. 

The Exit application field allows you to set up an application to automatically launch
after Concordance Desktop is closed, like a reviewer time card application.
Concordance Desktop launches the application when it terminates normally. Any
additional parameters for the application file are entered in the Parameters field. 

7. To launch an application after Concordance Desktop closes, click the ellipses (...)
button next to the Exit application field, to open the Open dialog box.

8. Browse to and click the application executable file, and click Open.

Clicking Open adds the application's file path to the Exit application field.

9. In the Parameters field, type any additional parameters for the application.

The Workspace section controls the Workspace tab settings in Concordance
Desktop.

By default, the Workspace tab is displayed and contains links to the CloudNine Web
site. You can customize your Workspace tab to display internal or external Web
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pages simply by adding a link to an external HTML web page or to a locally stored
.HTM or .HTML file with information you’d like to publish for user reference.

10. In the Workspace section of the General tab, the Enable workspace check box
is selected by default. To continue displaying the Workspace tab in Concordance
Desktop, leave the Enable workspace check box selected. If you do not want to
display the Workspace tab, clear the check box.

11. To add a link to an external HTML Web page, in the URL field, enter the Web site
URL. Be sure to include http:// or https:// in the URL. For example:
http://www.google.com.

To add a link to an internal internal .HTM file located on your server, in the URL
field, enter the full UNC path. For example: J:\CloudNine\Internal_Links.htm or \
\MyServer\MyFolder\myhtm.htm.

12. In the Attachments section, if the attachment fields were not set up during the
database creation process, to specify the fields to use with the Find Attachments
feature, do one of the following:

· To set a field to a range of attachments, select the Attach Range option, and
then select the field that contains the attachment range data. 

· To set up the beginning and ending attachment fields, select the Fields option,
and then from the Beg Attach and End Attach list select the fields that contain
the attachment data for the beginning attachment number and ending attachment
number.

When using the Find Attachments feature, it is best practice to setup the fields
as paragraph type fields to increase the performance and make sure to
index/reindex the database. For more information about the Find Attachments
feature, see Finding attachments.

13. Click OK to save your changes. 

To set Searching preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Searching tab.

The settings on the Searching tab define settings for your search query results.
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The Default search term section determines which search operator is used when
two search terms are entered without an intervening search operator, and the
number of words within the search. The search operator selected in the Default
search term field is automatically inserted when Concordance Desktop encounters
this scenario. The Default search term field defaults to the adjacent (ADJ) search
operator.

For example, searching for Anza Borrego is interpreted as Anza ADJ Borrego.

3. To change the default search operator, in the Default search term field, select
the default search operator you want to use.

4. To expand the number of words included in the search results, in the Within words
field, type the number of words to include within the search. 

For example, if ADJ is selected in the Default search term field and you enter 3 in
the Within words field, Concordance Desktop searches for Borrego within 3 words of
Anza.
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The Wildcard character field determines the wildcard character for searches. The
wildcard character is used as a prefix or suffix mask when running a search. The
Wildcard character field defaults to an asterisk (*). You can change this character
to any non-alphanumeric character.

5. To modify the wildcard search character, in the Wildcard character field, type the
non-alphanumeric character you want to use.

Quote characters are used when your search query includes numbers or special
characters, such as periods (.), asterisks (*), and spaces. The quotation character
can be redefined as any non-alphanumeric character, such as the apostrophe. The
quotation character is not included in the dictionary unless it occurs as embedded
punctuation. To search for the quote, use this option to change the character
recognized as the quote, then do the search.

The Quotation character field defaults to the quotation mark (") character. It is
best practice to leave the quotation mark character in the Quotation character
field, which is necessary for locating punctuation in relational searches.

For more information about quotes in searches, see Running relational searches.

On occasion you may need to search for a quote. To do so, you must first change
this setting to a non-alphanumeric character, like an apostrophe, so that the
quotation mark is searchable. To search for the word “and”, you need to use
quotes in your query “AND”, otherwise it is read as a search operator by
Concordance Desktop.

6. To change the quotation character, in the Quotation character field, type the
non-alphanumeric character you want to use. 

The Highlight color field determines the color used to display search hits from
searches performed using the Quick, Simple, Form, and Advanced Search features. 
The Persistent color highlights the terms found in the record from the list of terms in
the <databasename>_Persistent.txt file when the Persistent Search feature is
enabled.  It is best practice to choose a color that stands out against the Browse
view background and is different than the data or field font color. The Highlight
color field defaults to red.  The Persistent color defaults to blue.

7. To change the hit color, do any of the following:  

· For search hits using Quick, Simple, Form or Advanced searching, click the Highlight
color list, in the color selection box, click the color you want to use. 

· For Persistent Search hits, click the Persistent color list, in the color selection box, click
the color you want to use.

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

8. Click OK.

To set Browsing preferences:
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1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Browsing tab.

The settings on the Browsing tab define the browse settings by database and field
data parameters.

The Local settings section determines where the browse settings are applied. The
browse settings can be applied to any database in a group of concatenated
databases. 

3. In the Apply settings to field, select the database you want to apply the settings.

In the Select the field to display in the title bar while browsing field, you can select
a field to display on the Title bar for the current document. The field is displayed on
the Title bar in the Browse, Table, and Edit views.
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Having a field's content displayed on the Title bar can help when viewing long
documents, such as depositions, where you may be deep within the document and
forget the deponent's name or the document's title. It can also help you see
relevant document information when scrolling through records in the Table view.

For transcript databases, Concordance Desktop automatically displays the name,
date and volume of the current document in the Title bar.

Use the Select the field to display in the title bar while browsing field to select a
field for other non-transcript databases.

For concatenated databases, you can choose a different Title bar field for each
database.

In the Select the field to sort default query by field, you can modify the default field
sort order of a database when the database is opened and before running a search.
This is called the "default query." The database is sorted in ascending order by the
field selected in the Select the field to sort default query by field. The field can be
any field designated as a key field on the New or Modify dialog box. For more
information about key fields, see Creating databases. 

Selecting <none> sorts the database by the document number.

4. To adjust the default sort order of a database, in the Select the field to sort
default query by field, click the field you want to use for the default sort order. 

In the Select the default action of double-clicking a tag field, you can determine
whether double-clicking a tag applies the tag to or removes the tag from a
document or whether double-clicking a tag opens the tagging options menu. The
Select the default action of double-clicking a tag field defaults to Apply tag
(Default). 

Regardless of the Select the default action of double-clicking a tag field's setting,
clicking directly on the tag’s check box will apply or remove the tag as usual, and
you can always access the tagging options menu in Concordance Desktop by right-
clicking a tag. 

5. To modify tagging actions, in the Select the default action of double-clicking a
tag field, click Apply tag (Default) to apply a tag when you double-click a tag or
click Displays menu to open the tagging options menu when you double-click a
tag.

Double-clicking a tag applies the tag to a document or removes it from the
document if it's already selected. You can change this action to display the tagging
options menu, which is usually displayed by right clicking a tag.

The Issue coding section determines how issues are applied in Concordance
Desktop. By default, issues are are applied to highlighted text in a  document using
SHIFT+left-click. You can change the setting to apply issues using only left-click. 
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6. To modify the issue coding setting, in the Issue coding section, click the Use
shift-left-click for issue coding or Use left-click for issue coding (original
method) option.

If you change the issue coding setting, the change will not take effect until you
close and reopen Concordance Desktop.

In the Sticky camera section, you can determine whether the View Image (camera)
button on the Dynamic toolbar automatically stays selected, also known as "sticky,"
for continuous image viewing in the Browse, Table, and/or Edit views. 

When a "Sticky" [view name] button check box is selected, the View Image button
is automatically selected in the view. When the check box is cleared, users manually
have to click the View Image button to view the images associated with the
documents in the viewer. 

By default, the Sticky browse button, Sticky table button, and Sticky edit button
check boxes are selected.

7. To turn off "Sticky" [view name] button function for a view, clear the check box
for the view.

8. Click OK to save your changes.

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

9. Click OK. 

To set Import preferences:

1. Do one of the following: 

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the Import tab.
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The settings on the Import tab allow you to define import settings related to
numbering and indexing. 

3. In the Prefix field, type the prefix you want to precede the production number. 

The prefix can be any combination of letters, numbers, or punctuation that are valid
folder or file names. You can use up to 57 characters.

4. In the Starting Number field, type the number you want to use to start numbering
the production files. 

Zero fill your starting number to determine the desired number width. You can use
up to 9 digits. 

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

5. Click OK.
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To set CPL preferences:

1. Do one of the following:

· On the Tools menu, click Preferences.

· On the Standard toolbar, click the Tools button, and then click Preferences.

2. Click the CPL tab.

The CPL tab determines the font and tab size settings used when running
Concordance Desktop Programming Language (CPL) programs. 

The CPL font field defaults to Courier New 9pt and the Tab size field defaults to 3
spaces. 

3. To change the CPL font, click the CPL font button.  The Font dialog displays.

4. Modify the settings and click OK.
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Clicking OK closes the Font dialog box, and adds the font settings to the CPL font
field.

5. To change the tab size, in the Tab size field type the number of spaces you want a
tab to contain.

6. Click OK to save your changes. 

Clicking OK opens the Changes may not be reflected until Concordance Desktop is
restarted message.

7. Click OK.

Using table layouts

The Table view uses table layouts to determine the fields and order of the fields displayed
within the view. Table layouts can be used to customize viewing preferences or to support
sort methods specific to a review.

Table view layouts are created and maintained on the Table Layout dialog box. For each
database, each user has one private layout, that is accessible only to the user. Any
additional layouts created for a database are public and accessible to everyone using the
same database. A database's public layouts can be created, edited, or deleted by anyone
in the database.

Be selective when creating table layouts for a database. Too many table layouts in a
database can slow down the database's processing speed.
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If you have a table layout design that works well in other databases, you can copy and
paste the .layout file into other database directories, and then rename the file with the
new database name. 

If you are using Table View to display long documents, such as depositions or
resumes, you can get much faster performance if you do not display full text
Paragraph fields. If necessary, add fixed length fields to your database, which have
identifying information, such as a name, date and serial or volume number. Then use
those fields for Table View. By selecting only fixed length text, date or numeric fields,
large full text portions are not loaded. This improves performance for long document
types.

It is recommended that the .layout file not be marked as Read-Only as this will
prevent users from creating or switching layout views.

To create a table layout:

You can only make new layouts for the database currently selected. Any layouts
created in addition to your private table layout are accessible to all reviewers, and can
be altered or deleted by them as well.

1. On the Standard toolbar, click the Table button arrow, and then click Table
layout to open the Table Layout dialog box.

In the Table Layout dialog box, the green box with your Windows User ID is your
private table layout that is customizable and viewable only by you.

Users are permitted one private table layout per database.

2. In the Layouts tree, click the New button to create a new layout .

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list do any of the following:

· Drag a field to the new layout.

· Double-click a field to add the field to the new layout. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

The order the fields are listed in the Layouts tree is the order in which the fields
appear in the Browse and Edit views.

5. To change the order of the fields in the layout, click a field in the layout and drag it to the
desired position in the Layouts tree.

6. When finished, click OK.
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7. To view a saved layout, on the Standard toolbar, click the arrow next to the Table
button, and then click the layout name. 

The Table view layout is not persisted if a sorting layout is applied to the view. 
Creating a sorting layout will automatically apply a Zero query, returning all
documents and sorting the records based on the specified sorting layout.

To modify a table layout:

1. On the Standard toolbar, click the Table button arrow and click Table layout to
open the Table Layout dialog box.

2. To change the order of a field in a table layout, click a field in the layout and drag it
to the desired place in the Layouts tree.

3. To remove a field in a table layout, right-click a field in the layout and click Delete.

You can also double-click a field in the layout to remove the field.

4. Click OK to close the Table Layout dialog box and apply your changes to the Table
view. 

To view other table layouts:

In the Table view you can switch between the different table layouts created for the
selected database.

On the Standard toolbar, click the arrow to the right of the Table button then click
the layout name for the layout you want to view in the Table view. 

The check mark next to a layout indicates the layout currently displayed in the
Table view. 

To delete a table layout:

Only public table layouts can be deleted in Concordance Desktop. When you delete a
table layout, it is deleted for all users using the same database.

You cannot delete your private table layout or the table layout currently displayed in
the Table view. The Delete command in the Table Layout dialog box is unavailable for
private table layouts and the table layout currently displayed in the Table view.

To delete the public table layout currently displayed in the Table view, you first need to
display a different layout in the Table view.

1. On the Standard toolbar, click the Table button arrow, and click Table layout to
open the Table Layout dialog box.
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2. Right-click the layout you want to delete in the Layouts tree and then click
Delete.

Using sorting layouts

The Sorting feature in Concordance Desktop determines the order records are displayed in
the Browse view. The fields selected in the Sorting Layout dialog box define the order the
records are returned for viewing.  For example, if you select to sort the records by the
fields:  BEGNO, DOCDATE, and AUTHOR, then the records are first sorted by the records
BEGNO number, then the document date and then by the document's author.  You can
also choose whether the field is to sort in Ascending or Descending order.  

Sorting layouts are created and maintained in the Sorting Layout dialog box and saved as
a .Sortlayout file on your local machine in the same directory as the database. There are
no limits to the number of sort layouts that can be created and saved; however, sort
layouts are specific to the database for which they were created.  

Sorting layouts are specific to a database and user.  Therefore, if you are working in a
database and using a sorting layout that you created, and another user accesses the
same database, the sorting layout you are using is not affected by the other user or their
sorting layout.  

Sorting layouts are compatible with concatenated databases.  The fields available in the
Sorting Layout dialog box are those fields associated with the primary database.  

When creating sorting layouts for concatenated databases, keep the following in
mind:

· All databases in a concatenated set are sorted according to the sorting layouts for the
primary database when accessed from the concatenated set.

· Database fields in a concatenated set other than the primary will not appear in the
Sorting Layout dialog box unless they are opened separately.

· If the field structures for the primary database do not completely match the field
structure of concatenated databases, the sorting layout may not sort the
concatenated databases as expected.

· In order for field structures of concatenated databases to match, they must have
identical field names and field types and be listed in the same order.

· Each sorting layout is limited to four fields.

It is recommended that the .Sortinglayout file not be marked as Read-Only as this will
prevent the ability to create or switch layout views.
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Sorting layout dialog box

Icon Description

Single Database and Compatible Concatenated Databases

Primary database

Available sort layout

Field sort order - Descending

Field sort order - Ascending

Incompatible Concatenated Databases

Available sort layout containing fields that are not
compatible with the concatenated set of databases

Field sort order - Descending (inconsistent layouts may
appear for each concatenated database)

Field sort order - Ascending (inconsistent layouts may
appear for each concatenated database)

To create a sort layout:
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1. On the Standard toolbar, click the Sorting button.

2. In the Layouts tree, click the New button.

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list, do one of the following:

· Drag a field to the new layout.

· Double-click a field. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

5. To change the order of the fields sort the database in the layout, in the Layouts tree,
drag a field to the desired position.

6. To set sort order for the field data, right-click the field, and then click either Ascending or
Descending.

7. When finished, click OK.

To modify a sort layout:

1. On the Standard toolbar, click the arrow next to the Sorting menu, and then click Sort
layout to open the Sorting Layout dialog box.

2. To change the field order, drag a field in the Layout tree to the desired location.

3. To remove a field, in the Layout tree, do any of the following:

· Right-click a field, and then click Delete.

· Double-click a field.

4. When finished, click OK to apply your changes.

 

To view a sort layout:

Do one of the following:

· From the View menu, click Sorting, and then click the layout name.

· On the Standard toolbar, click the arrow next to the Sorting menu, and then click
the layout name. 

To delete a sort layout:

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open

the Sorting Layout dialog box.
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2. Right-click the layout you want to delete in the Layouts tree and then click Delete.

To rename a sort layout:

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open

the Sorting Layout dialog box.

2. Click the layout name to change, and then type a new sort layout name.

The default user sort layout is automatically created when the database is opened.
 This sort layout cannot be renamed.

Creating edit layouts

To make editing easier, Concordance Desktop provides the ability to select specific fields
and change the order they are displayed in the Edit view.  Changing field display settings
only affects your view of the fields, it does not affect field display for other users. These
field settings apply to all records within the database.

Concordance Desktop uses edit layouts to determine the fields and order of the fields
displayed within the view. Edit layouts are created and maintained on the Edit Layout
dialog box and stored in the <databasename>.Editlayout file. An edit layout can be
created or edited by anyone in the database.  However, only the Concordance Desktop
Administrator or person who created the layout have permissions to delete it.
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When creating an Edit Layout for a concatenated set, only the fields of the primary
database are displayed in the Available Fields list for non-identical concatenated
databases.

The .Editlayout file should never be marked as Read-Only, as this will prevent users
from creating or switching layout views.

To create an edit layout:

You can only make new layouts for the database currently selected. All edit layouts are
accessible to all reviewers and can be altered by them as well.

1. Do one of the following:

· On the View menu, click Edit View, and then Edit Layout.

· On the Standard toolbar, click the Edit button arrow, and then click Edit layout.

· On the Standard toolbar, click the Edit button, right-click within a field, point to Layout
and then click Edit Layout.

2. In the Edit Layout dialog box, click the New button to create a new layout .

3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list do any of the following:

· Drag a field to the new layout.

· Double-click a field to add the field to the new layout. 

· Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields
to the new layout.

The order the fields are listed in the Layouts tree is the order the fields appear in
the Edit view.

5. To change the order of the fields in the layout, in the Layouts tree, click a field and drag
it to the desired position.

6. When finished, click OK.

The new layout view is displayed in the Edit view.

To modify an edit layout:

1. Do one of the following:

· On the View menu, click Edit View, and then Edit Layout.

· On the Standard toolbar, click the Edit button arrow, and then click Edit layout.

· On the Standard toolbar, click the Edit button, right-click in a field, point to Layout and
then click Edit Layout.
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2. In the Edit Layout dialog box, from the Layouts tree, select the layout you want to edit.

3. Do any of the following:

· To change the field order, click a field and drag it to the desired location in the
Layouts tree.

· To remove a field, right-click a field in the Layouts list, and then click Delete.

You can also double-click a field in the layout to remove the field.

4. When finished, click OK. 

If all the fields are removed from a layout, then the layout itself is removed.  The
active layout cannot be deleted.

To view saved edit layouts:

In the Edit view you can switch between the different edit layouts created for the
selected database.

Do any of the following:

· On the View menu, click Edit View, and then click the layout name to view.

· On the Standard toolbar, click the Edit button arrow, and then click the layout name to
apply.. 

· On the Standard toolbar, click the Edit button, right-click in a field, point to Layout and
then click the layout name to view.

The check mark next to a layout indicates the edit layout currently displayed in the
Edit view. 
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Adding custom menus

Adding custom menus and custom menu commands to Concordance Desktop is one of the
many features you have available to make your administration job much easier. Having CPL
scripts and databases accessible as a shortcut in a menu provides instant access to the
tools you need to use frequently. You can apply these menus and menu commands to the
current database or all databases. You can add custom menu commands to existing or
custom Concordance Desktop menus. By default, all users will be able to use and access
the custom menu and menu command. To restrict custom menus and menu commands to
a specific user, you need to add the user and the custom menu command for the user in
the Added Menu Items dialog box. 

If you are familiar with programming and took a Concordance Desktop CPL class, you can
add your own CPL scripts to a custom menu, which  launches these programs without
having to navigate to their directory folder.

Custom menu commands are not listed in the Security dialog box for enabling and
disabling menu access. If you need to restrict access to custom menus and menu
commands, be sure to add the custom menu command to specific users in the Added
Menu Items dialog box.

The following file types can be opened from Concordance Desktop custom menus:

· Database file (.dcb, .fyi)

· CPL file (.cpt, .cpt)

· Report file (.arp)

· Print file (.fmt)

· Concatenation file (.cat)

· Snapshot file (.snp)

· Query file (.qry)

· PDF file (.pdf)
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To add a custom menu and menu command:

1. In Concordance Desktop, open the database you want to add a custom menu and
custom menu command.

2. On the File menu, click Administration, and then Added menu items.

The User field comes with a pre-defined Default user ID.

The Default user ID works on databases that do not have security enabled or and
databases with a default user ID defined in the Security dialog box.

Creating a custom menu and/or menu command for the Default user ID allows all
users to view and access the menu and menu command.

To restrict access to the custom menu and/or menu command, you need to add
each of the users you want to have access to the menu and/or menu command to
the User field, and create the custom menu and/or menu command for each of the
users you created. The users you create must already be added to the database,
and the user IDs you create in the User field must match the users' database user
IDs in the Security dialog box. 
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When a user is added as a database user and then added to the User field in the
Added Menu Items dialog box, the custom menu commands assigned to the Default
user ID in the Added Menu Items dialog box will not be available to this user. You
will have to assign the same custom menu commands to the individual user in order
for the user to access these menu commands.

 

3. To add a user to the User field, select all the text in the user list, and type the
new user name, and click the Add button.

Adding a user to the User field in the Added Menu Items dialog box does not add
the user to the database. To add a user to the database, see Adding/modifying
users.

To add a custom menu and/or menu command for an existing user ID in the User
field, in the User field, click the applicable user ID.

In the Database field, located in the Added menu items section, the current
database name is displayed. The custom menu and/or menu command will be
created in the current database unless you want to add the custom menu and/or
menu command to all databases. If the current database is part of a concatenated
database group, you can also add the custom menu and/or menu command to any
database in the concatenated group.  

4. To add the custom menu and/or custom menu command to all databases, in the
Database field, click All databases.

To add the custom menu and/or custom menu command to database in a
concatenated database group, in the Database field, click the applicable database.

5. In the Menu item section, click the New button to create the custom menu and/or
menu command.

6. Click the File button to open the Open dialog box.

7. Browse to and click the file you want to launch from the custom menu command,
and click the Open button.

Clicking the Open button, adds the file name and path to the File field.

Concordance Desktop custom menus can open the following file types:

· Database file (.dcb, .fyi)

· CPL file (.cpl, .cpt)

· Report file (.arp)

· Print file (.fmt)

· Concatenation file (.cat)

· Snapshot file (.snp)

· Query file (.qry)

· PDF file (.pdf)
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The Added Menu Items feature only works with specific IPRO CPL scripts. Be
certain to verify the supported IPRO scripts before loading them into a database.

You can add a custom menu command to a custom menu or an existing
Concordance Desktop menu.

8. To add the custom menu command to an existing Concordance Desktop menu, in
the Menu field, click the menu you want to add the custom menu command.

To add the custom menu command to a custom menu, in the Menu field, type the
name of the custom menu you want to create. The menu name you type in the
Menu field is the menu name that will be displayed on the Concordance Desktop
Menu bar.

For custom menus, the Position field determines where the menu is displayed on the
Menu bar.

For custom menu commands in an existing Concordance Desktop menu, the Position
field determines where the custom menu commands is displayed in the menu. 

The Position field defaults to -1.

9. In the Position field, type the position number you want the custom menu and/or
custom menu command to be displayed. 

When you are creating a custom menu, zero is the first position on the left on the
Menu bar. For example, if you typed 0 in the Position field, the custom menu will be
displayed to the left of the File menu. Positive position numbers will move the
custom menu the number of places to the right. For example, if you type +3 in the
Position field, the custom menu will be displayed 3 places to the right. Typing -1
places the custom menu to the right of the Help menu.

Negative position values start at the right and work their way left on the Menu bar.
Positive position values start at the left and work  their way right on the Menu bar.

When you are creating a custom menu command, zero is the first position at the
top of the menu. Positive position numbers will move the custom menu command the
number of places down from the top of the menu. For example if you add a custom
menu command to the File menu and type 3 in the Position field, the custom menu
command will be displayed between the Snapshot and Close commands on the File
menu. Typing -1 places the custom menu command at the bottom of the menu. 

Negative position values start at the bottom and work their way up the menu.
Positive position values start at the top and work their way down the menu.

10. In the Display name field, type the custom menu command name as you want it to
appear in the menu.

If the custom menu command opens a CPL program file, you can have Concordance
Desktop run a specific function within the program file by adding the function value
to the Function field. This should be a complete and valid CPL function call, such as
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main() or myfunction( "Hello", 1, 2, 3). This allows you to create a single CPL file
with a complete set of functions to handle different menu items.

Display names that contain the ampersand "&" or parenthesis "()" characters will
not display correctly.  Spell out the word "and" to include it in the display name.

11. To run a specific function within the CPL program file selected for the custom menu,
in the Function field, type the full CPL function call.

For all other custom menu commands, leave the Function field blank.

Once you have finished adding a custom menu and/or custom menu command, it is
listed in the Added menu items section. If you are creating multiple custom menus
and/or custom menu commands, you can organize the display order of the custom
menus, and the custom menu commands within the same menu by clicking the Move
up and Move down buttons.

When determining the display position of custom menus and/or custom menu
commands in relation to each other, sometimes it is easier to leave the Position field
set to -1 for each menu and menu commands, and just use the Move up and Move
down buttons to position them. 

The custom menu and menu command list in the Added menu items section has a
shortcut menu to make menu customization easier.  The shortcut menu allows you
to cut, copy, paste, and select all custom menu items.  To open the shortcut
menu, right-click one or more of the menus and/or menu commands in the list. You
can select multiple menus and menu commands using SHIFT+click or CTRL +click. 

With the cut, copy, and paste features you can create a set of menu items, copy
them, and paste them into other user’s profiles or other database profiles. This is
the easiest way to replicate menus in the Added Menu Items dialog box.

12. Click OK to save your custom menu and/or custom menu command.

You may need to close out of Concordance Desktop and log back in to activate the
new menu settings.

Managing Databases

Ongoing maintenance of your Concordance Desktop databases is standard practice as an
administrator. Refer to this module to review database management guidelines and tips,
and for general maintenance processes.



Administration 339

Database management includes the following procedures for quality control and
maintenance:

· Assigning database administrators

· Taking databases offline

· Synchronizing databases

· Backing Up and Archiving Databases

· Subsequent loads

· Performing data entry and editing

· Creating Authority word lists

· Performing global replacements

· Checking for duplicate records

· Packing the dictionary

· Packing databases

· Zapping databases

· Modifying database field structure

Exclusive Administrator Processes

Some database management tasks require that all other users are logged out of the
database when they are performed. The administrator is the only user allowed in the
database when the following processes are occurring:

· Index

· Pack

· Zap

· Security

· Modify

· Replication/Synchronization

· Converting or upgrading to a current version

To verify whether any users are currently logged on to Concordance Desktop, you
need to log into the Concordance Desktop server computer.

· To see users currently logged in, Open the Admin Console, and click the
Connections tab. The Server tab displays all users who are access what
databases on the server. 

· To disconnect users: Call them and ask them to save their work and close the
database(s) they have open. If it is an emergency and you need to take the
database offline immediately, you can disconnect users from the Connections tab
by highlighting their name and clicking the large red X in the Active Connections
toolbar. Note that when you do this, the users will lose any of the work they
have done in the database if they haven't saved it. 
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Assigning database administrators

The easiest method for assigning administrators to a specific database is to use the Admin
Console to setup a matter and assign  the database to that matter. Then setup a user
group, assign the administrator users to that group, and then assign that user group to
the same matter. You can also quickly assign users as administrators for all databases
using the Admin Console. While the Admin Console works well for these types of scenarios,
it can be cumbersome if you just need to setup one user as an  administrator on one
database. For setting up administrators on a one user to one database basis, the easiest
method is to select the database, and then use the User Management feature to assign
that specific user as the administrator for that specific database. You can setup multiple
administrators using this same method, however it may become time consuming if you
have several users to assign as administrators to several databases, as assignments must
be applied on a per user per database basis. Which tool you use depends on how many
administrators you need to setup, on how many databases. The default, when adding
users to a Concordance Desktop server in the Admin Console, is set to allow all users
"Supervisor" privileges across all Concordance Desktop databases on the server. If
however users are added to the server when a database has been migrated to
Concordance Desktop

When you assign database administrators, take into account each of their roles and
schedules for managing database processes and ongoing database maintenance tasks. 

To assign database administrators using the Admin Console

This method is usually used to assign a user as an administrator across several, or all
the databases on this Concordance Desktop server. This is the default for all users
when you add them to the server, unless you change their License Type, Field Rights
and/or Menu Types.  

1. Click on the Workspace tab. 

2. On the File Menu, click Administration and then Admin Console. 

3. Click the Management tab, to open the Management pane. 

4. Click the Users folder to display the list of all users. 

5. Locate and click on the user you want to assign as an administrator.

6. Click the License Type down-arrow, and select Administrator.

7. Change the Field Rights setting only if you need to restrict the user's Write access
to the database. Otherwise, leave the default of Read and Write. 

8. Click the Menu Type down-arrow and select either Supervisor or Administrator,
depending on the menus you want the user to have access to as the administrator
of the database. 
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Supervisor - Access to all menus and menu commands. A supervisor can add users
in the Admin Console and then restrict field-specific rights and limit their menu
access on a database by database basis from the User Management screen. 

Administrator - Access to all menus and menu commands except the Modify, User
Management, and Zap menu commands.

9. If you want to assign this user as an administrator across all databases on this
Concordance Desktop server, click the Assign settings for this user to all DB's
button. 

10. Click the Synchronize now button to save and synchronize the changes. 

 To assign database administrators using the User Management feature

This method is usually used to assign one administrator to a single database. Though it
can also be used to assign multiple administrators to a single database.

1. Open the database to which you need to assign an administrator user, by using one
of the following methods. 

· Select the database from the Databases Recent list

· Select the database from the Databases Current Database list.  

· From the File menu, click Open (if the database is not listed in the Recent or
Current Database lists).

2. On the File Menu, click Administration and then User Management. 

3. Type your own administrator User name and Password, and then click OK, to gain
access to the User Management screen for the selected database.

4. Click the Menu access tab.

5. Click on the login ID of the user you want to assign as an administrator of the
database.

6. Under the Presets section, click on either Supervisor or Administrator, depending
on the menus you want the user to have access to, as the administrator of the
database. 

7. To further define the menu access for this administrative user, click on the check
box next to a menu option to add or remove a check mark. A check mark indicates
that the user has access to that menu, while no check mark indicates they do not
have access. 

To set restrictions on sub-menus, click on the main menu option's plus sign to box
to display the list of sub-menus, and then add and remove check marks as
necessary. 

8. Do one of the following:
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· Click Apply to apply the setting to the selected user. You'll want to use Apply if
you need to add more administrators. 

· Click OK to apply the setting to the selected user and close the User Management
screen. If adding multiple administrator users, click OK only after the very last
user assignment. 

9. Repeat all the steps for each user you want to assign as an administrator of the
database.

Taking a database offline

When you perform processes such as indexing and packing a database in Concordance
Desktop, you should always take the database offline prior to starting the process. Failure
to do so could cause corruption of the database if users have the database open and are
working with it.

For more information about indexing and Concordance Desktop server, see Indexing and
reindexing considerations.

Databases can be taken offline from the Management tab in the Admin Console.

To take a database offline

1. In Concordance Desktop, click on the Workspace tab. 

2. On the File Menu, click Administration and then Admin Console. 

3. Click the Management tab, to open the Management pane. 

4. On the Management tab, click the Databases folder, to display the list of
databases registered on the server.

5. Click on the database you want to take offline.

6. Click in the Status field on the right.
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7. Click the Status field down-arrow and select Offline.

To put the database back online, follow the same steps, but select Online in step 7
above. 

Reloading databases

The Refresh button saves any changes made in the Admin Console, and also refreshes the
tree view on the Management tab with any synchronized updates.

When you are working on the Management tab in the Admin Console it is recommended
that you refresh the view so you can see your change. If you do not have Auto refresh
turned on, make sure that you click the Refresh button before leaving the tab so that all
changes are saved.

Registering/unregistering a database

In Concordance Desktop, a database must be registered with the server before it can be
opened or worked with. When you create a new Concordance Desktop database, the
database is automatically registered with the server during the import process. Databases
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created in Concordance 10.21 are also automatically registered with the server during the
import process. However, if you have converted Concordance 10.20 or older version 10.x
databases to Concordance Desktop databases, those databases are not automatically
registered. In order to register the converted databases, some interaction on your part is
necessary. To register a Concordance 10.20 or older version 10.x converted database,
you can need to use the manual method described under To manually register a database.
 

If you have unregistered a database and now need to access that database again
through Concordance Desktop, you need to manually register the database again with
the Concordance Desktop server.

When you are moving a database to archive, assigning it to another server for access, or if a
mobile license has taken control of the database for private/single user review, you can
unregister the database on its current server so that the database does not appear in the list
of available databases on that server. When you unregister a database, the database is not
physically removed from the server, it's name is simply removed from the Database List on
the current server. 

After converting a Concordance 10.21 database to a Concordance Desktop database,
you can automatically register the converted database by placing it in the DB Smart
Path folder/directory. 

To manually register a database

Before you can register a database on a Concordance Desktop server, you must
physically move (or copy) the database onto that server's local hard-drive. 

1. On the File menu, click Administration and then Admin Console.

2. Log onto the server where you want to register the database. 

You must be a Concordance Desktop administrator on the selected server in order to
register a database.

3. Click on the Management tab.

4. Right-click on the Databases folder, and then click Register database.

5. In the field that appears, type a name for the database you want to register, and
press Enter. 

An Open Database window opens.

6. Locate and open the folder where the database is located.

7. Click on the database to select it. 

8. Click OK.
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If the selected database is a Concordance 10.x database, you are asked if you are
ready to migrate it. If you have done a backup and are ready, Click OK, otherwise just
close the dialog box. After the migration and registration processes are finished, the
Databases pane opens on the right. At the bottom of the list you should see the name
of the database you just registered. The database can be found at the bottom of the
list.

If the selected database is a Concordance Desktop database, after the registration
process is finished, then the Databases pane opens on the right. The database can be
found at the bottom of the list. 

The Status column indicates whether or not registration (migration for Concordance
10.x database) was successful. If successful, the Status column displays "Online", of
not successful, it displays "Conversion failed" or "Registration failed." More information
about failures can be found in the server log file. 

If Auto refresh is turned on (Auto refresh on), the database name appears under the
Databases folder, after auto refresh runs. 

To un-register a database

1. On the File menu, click Administration and then Admin Console.

2. Log onto the server where you want to register the database. 

You must be a Concordance Desktop administrator on the selected server in order
to unregister a database.

3. Click on the Management tab.

4. Double-click on the Databases folder to open it. 

5. Right-click on the database you want to un-register, and then click Unregister
database.

6. You are asked to confirm that you want to un-regisrter the database, click Yes. 

The database is un-registered from the Concordance Desktop server. The database
remains on the server in the same location, unless you physically remove it, or move it
to another location. However, it cannot be accessed through Concordance Desktop
unless you manually register the database. 
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Synchronizing databases

The 'Synchronize now' button on the Management tab in the Admin Console automatically
synchronizes changes to users, user groups, and matters with the associated registered
databases on the Concordance Desktop server. 

To synchronize changes that you have made in the Admin console that affect databases on
the Concordance Desktop server:

1. Click on the Admin Console Management tab, if not already opened. 

2. Click the Synchronize now button at the top of the Management tab pane. 

About editing records

Concordance Desktop is fully equipped to handle a rolling production environment with
features that allow editing records as needed. Attorneys find the editing tool useful for
adding comments directly to a document record during the case review. Administrators
can add an Attorney Notes field to the database for this purpose.

The editing tool is also useful when there is limited information in the database to search.
Sometimes a paralegal or staff member may be assigned to add missing information, such
as the dates, authors, and recipients, to every document in a database to help locate
documents authored by a particular individual to another individual within a specific time
frame during searches.

When the Edit view is opened, record data is displayed for editing in the Workspace pane
and the Edit toolbar opens at the bottom of the Workspace.  By default the Edit view
includes all fields to which you have access. Edit Layout can be used to customize the
view to display only those fields you want to edit and in the order you want to see them.
Only those fields to which you have full rights can be edited. Read-only fields are
displayed in grey and cannot be edited.

The customization of the Edit view is not available for the Append and Ditto features.
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Edit View

Edit tools

When you click the Edit button on the Standard toolbar, the four Edit view tools on
Dynamic toolbar are displayed:

· Fields - accesses a field listing to insert data from another field

· Ditto - allows you to copy field data from another record Note that Ditto can on be
used on migrated 10.x DAT, E-mail and Attachment, or Transcript databases. Ditto
cannot be used for Concordance 10.21 E-document databases, and all databases
created in Concordance Desktop. 

· Delete - mark or unmark document for deletion

· Undo - allows you to undo or abandon edits

Rich Text toolbar
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When you click the Edit button on the Standard toolbar, the Rich Text toolbar displays
under the Standard toolbar. On the Rich Text toolbar you can adjust the font size,
color, and spacing in edit form fields.

Edit Mode options

When opening up a record in edit mode in the Edit view, Concordance Desktop has
formatting options that can be applied to data within a specific field. These formatting
options include: Upper case, Lower case, Capitalize, and Reset field formatting. 

To change the format of existing data within a field:

1. In the Edit view, select the word or blocks of text that you want to format. 

2. Right-click the text and click the applicable formatting option.

Your changes are saved when you navigate to another record or view in
Concordance Desktop.

Editing records

Editing existing records is done most often when records are added to Concordance
Desktop but are missing information that needs to be captured in the system to identify it,
such as the document title, author, and date it was created. 

If you are an attorney entering summary notes or a paralegal adding missing data to
records, you are only able to access fields that you have permission to edit. Fields that
can’t be edited display in gray. Other data entry restrictions may be placed on fields by
your Concordance Desktop administrator.

Each time you edit a record, any changes are saved when you navigate to another record
or change your view in Concordance Desktop.  New information is not full-text searchable
until the database is reindexed to refresh the dictionary.

If you try to edit a record that someone else has open for editing, the record will be
locked and displays as read-only with gray fields and a LCK notification displays in the
Status bar.

For more information about field lists containing word selections that reduce data entry
time, see Using Word Lists.

Editing = coding. Use caution when working in the Edit view. You can spoliate
documents if you are not careful, damaging the integrity of your original database
records and impacting the search results of others.
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To edit an existing record:

1. In the Browse or Table view, select the record .

2. On the Standard toolbar, click the Edit button to activate edit mode for the record.

By default, all the fields are displayed in the Edit view.  Some fields may be gray
because you don’t have permission to edit these fields.

3. To apply an edit layout, do one of the following:

· On the View menu, click Edit View, and then click the layout name to apply.

· On the Standard toolbar, click the Edit button arrow, and then click the layout
name to apply.

· In the Edit view, right-click within a field, point to Layout and then click the
layout name to apply.

For more information about Edit Layouts, see Creating edit layouts.

4. To resize a field in the Edit view, select the bottom border box of the field and drag
it down the page to expand the field size. The fields are distinguishable by having a
raised border and can be resized during data entry to make editing easier.

5. Make your edits.
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Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

6. To reindex the database, on the File menu, click Reindex.

Using Word lists

In most document databases, some data entry work is unique, like attorney review
comments, but much of it is repetitive. For example, if you are cataloging
correspondence between the principal players in a case, the same names are repeated
again and again.

Having these names or other repetitive words available in word lists allows you to insert
them in respective database fields reducing the amount of typing necessary. This
feature also minimizes data entry errors. For example, you can pick Wocjieweiski from a
list instead of having to remember how to spell it each time you need to enter the name
into a field.

Word lists can be used for any repetitive data entry fields, such as document type
(letters, memos, reports, etc.), privilege (attorney client privilege, trade secret, etc.),
or any field where the same set of terms is used over again.

Word lists are set up by your Concordance Desktop administrator. If you want a word
list added to a particular field, contact your Concordance Desktop administrator.

There are numerous ways to open a word list in Concordance Desktop. You can only
open a word list when you are in the Edit view.

To open a word list:

For fields associated with a word list, the first time you click in the field, the
associated word list automatically opens. To open the word list if the word list does
not automatically open, begin typing the value or right-click in the field to open the
associated word list. 

For fields not associated with a word list, do one of the following: 

· Press CTRL + L, select the word list, and click Open.
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· Right-click in the field and click Word Lists or the associated field list. If you
select Word Lists, navigate to and open the word list file.

· On the Edit menu, click Lists, then Word Lists, and then navigate to and open
the word list file. 

To populate a field using a word list:

1. In the Browse or Table view, select the record.

2. On the Standard toolbar, click the Edit button to open the Edit view and
activate edit mode for the record.

By default, all the fields are displayed in the Edit view. Some fields may be gray
because you don’t have permission to edit these fields.

3. To apply an edit layout, do one of the following:

· On the View menu, click Edit View, and then click the layout name to apply.

· On the Standard toolbar, click the Edit button arrow, and then click the layout
name to apply.

· In the Edit view, right-click within a field, point to Layout and then click the
layout name to apply.

For more information about Edit Layouts, see Creating edit layouts.

4. For fields associated with a word list, the first time you click in the field, the
associated word list automatically opens in the Word List dialog box. To open
the word list if the word list does not automatically open, begin typing the value
or right-click in the field to open the associated word list. 

For fields associated with a word list, you can also populate the field with a value
from a different word list. To use a value from a different word list, click the field.
 From the Edit menu, point to Lists, and click Word Lists.  Navigate to and open
the word list file.

For fields not associated with a word list, click field you want to populate and
open a word list. To open a word list do one of the following:

· Press CTRL + L, click the word list, and then click Open.

· Right-click in the field and select Word Lists or the associated field list. If you
click Word Lists, navigate to and open the word list file.

· On the Edit menu, click Lists, then Word Lists, and then navigate to and open
the word list file.

5. Select a value from the word list and click the Add button.

For long word lists, you can quickly locate the value you are looking for by typing
the first couple letters or characters of the value in the field below the word list.
For example, typing S takes you to the values beginning with the letter S.
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The Add button adds the selected value to the field and closes the Word List
dialog box. 

Concordance Desktop automatically saves your edits as soon as you navigate to
another record or change your view in Concordance Desktop.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

6. To reindex the database, on the File menu, click Reindex.

To add a new entry to a word list:

1. Open a word list.

2. Type the value you want to add to the list in the field below the word list.

3. Click the Insert button.

To delete a value from a word list:

1. Open a word list.

2. Select the value you want to delete from the word list.

3. Click the Delete button.

Removing rich text from multiple records

If rich text formatting has been applied to field data, you may need to change the rich
text formatting in a field to plain text to save space or remove certain text formatting
that affects the precision of hit highlighting when searching in Concordance Desktop.

If you need to remove rich text formatting from a field in multiple records in the database,
administrators can use the Bulk Field Format Reset feature. When you use the Bulk Field
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Format Reset feature, Concordance Desktop removes all rich text formatting in the
selected field and changes the text in the field to plain text in all records in the database.

If you only need to remove rich text formatting from a field in individual records, you can
use the Reset Field Formatting function in the Edit view. For more information about
removing rich text formatting in the Edit view, see Formatting field text.  

When using the Bulk Field Format Reset, make sure that no other users are in the
database at the time.

To reset the rich text format to plain text for multiple records:

1. On the File menu, click Administration, then Bulk Field Format Reset.

The Bulk Field Reset Format dialog box opens. 

2. Select one of the following options:

Check for RTF Data (Recommended):  If you select this option, the process checks the
specified field in each record for Rich Text formatted data, and resets the data in only
those records in with there is RTF formatted data. If no RTF data is found in the specified
field in a record, the data is not reset. 

Reset Field Format:  If you select this option, the process does not check for Rich Text
formatted data prior to resetting the data. Instead, it resets the data for the specified
field in every record. This process actually takes longer, as it has to reset the data in the
field on every record, not just those records that contain RTF data.  through every record
in the database and resets the data in the specified field, whether or not it needed to be
reset. 

3. Click OK. 

The Bulk Reset Format dialog box opens.
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4. In the field list, click the field containing the rich text formatting that you want to change
to plain text. 

5. Click Next.  A confirmation message displays regarding the field you selected.

6. Click OK.

If rich text formatting in found in the field, the process removes the rich text formatting
and replaces it with plain text in all records in the database. When it finishes, click
Cancel in the Bulk Reset Format dialog box to close it.

If the process does not find any rich text formatting in the field in any of the
records, when the process finishes, a Selected field does not contain RTF text
message displays. Click OK to close the message, and then click Cancel in the Bulk
Reset Format dialog box to close it.

After running Bulk Field Format Reset, the changes are immediately viewable in
Concordance Desktop and all single byte and Unicode character sets are retained;
however you need to reindex your database to see the red search hit highlighting
again during searches.

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

7. Reindex the database, (From the File menu click Reindex.)
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Using Ditto to copy field data from record to record

IMPORTANT NOTE: Ditto cannot be used on databases created in Concordance Desktop,
or on Concordance 10.21 E-document databases that have been migrated to Concordance
Desktop. The information below is provided only for the use of Ditto on other Concordance
10.x databases that have been migrated to Concordance Desktop. 

Ditto is a tool that can be used for repetitive data entry. When using Ditto, it opens a Duplicate
dialog box that allows you to copy fields of data from one record to another, minimizing data
entry errors. The Ditto feature is only available in the Edit view. 

Ditto offers the following options through the Duplicate dialog box:

· Copy previous - copies data from a previous document into a new or edited document

· Copy from another - copies data from another document into a new or edited document

If you are copying field data from a document to a field containing data in the current
document, when you select Copy previous or Copy from another, the data for the selected
fields in the current document is overwritten by the data from the other document.

For concatenated databases, only documents in the primary (first) database can be used
for copying data.

To copy field data from one record to other records:

1. In the Browse or Table view, select the record containing the fields you want to
populate from another record.

2. On the Standard toolbar, click the Edit button to open the Edit view.

3. To open the Duplicate dialog box, do one of the following:

4. From the Field list, select the fields containing the data you want to copy to the record. 
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· On the Edit menu, click Ditto (Edit View). 

· On the Dynamic toolbar click the Ditto button.

5. From the Field list, select the fields containing the data you want to copy to the
record.

You can select multiple fields by pressing the SHIFT or CTRL key while selecting multiple
fields.

DO NOT select the DOCID field, as this field is used by Concordance Desktop as
the unique record identifier. Selecting to duplicate (copy) this field will corrupt
your database. 

6. Do one of the following:

· To copy the data from the previous record, click Copy previous.

· To copy the data from another record, click Copy from another and type this
document's current record number.

7. Click OK.

Clicking OK copies the data from the selected fields in the other document to the fields in
the current document.

8. Repeat steps 1 through 7 for each record you want to populate with field data from
another record. 

9. On the Standard toolbar, click the Edit button to turn off edit mode and save your
record.

Concordance Desktop automatically saves the new record as soon as you close the Edit
view or navigate to another record.

Changes are immediately viewable. However, in order to run full-text searches on the
edits in the record, the database needs to be reindexed. Once this action is performed
all reviewers can search the updates. 

To ensure that your new records are searchable in a timely manner, coordinate with
your Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays on the File menu next to
Reindex.

It is best practice to close out of the Edit view by clicking the Edit button after
you are done adding or editing records – and before you exit Concordance Desktop
– to ensure that all new records have been saved. If you do not close the Edit
view before exiting, you may lose your work.

9. To reindex the database, on the File menu, click Reindex.
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Searching for edited records

To query the database for any documents that have been edited use the Search for
edited documents command. When you select Search for edited documents, all documents
that have been edited since the last database reindex or index are displayed in Browse or
Table view.

Adding field groups to the .INI file

You or reviewers may want to search across multiple data fields at the same time without
having to construct a long search query.

Writing field groups directly to an .ini file allows you to use an alias name to search across
multiple fields at the same time without having to construct a long search query.

Example: Aliasname = fieldname1, fieldname2

ALLDATES = DATE, DOCDATE

By creating an alias field named ALLDATES and associating it with all various date fields
from a concatenated database set, users can search all date fields without having to
modify date field names in each database. You can also create a field group for data fields
in a non-concatenated database.

The CREATEDATE and CREATIONDATE fields, or their equivalents, cannot be included
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in a field group because of the validation settings applied to them.

Field groups written directly into an .ini file will also save into a Concordance Desktop
database template.

To add a field group to the .ini file:

1. In Microsoft Windows Explorer, navigate to the database .ini file you want to add a
field group. 

The .ini file is stored in the same directory as the database's .dcb file. 

2. Right-click and open the .ini file in any text editor program.

3. Scroll to the bottom of the file.

4. In the next line after the last record, type [FieldGroups] and press Enter.

5. Type the Aliasname = fieldname1, fieldname2, fieldname3.

For example: Date = DOCDATE,DATE,GMT_DATE,MODDATE,PRINTDATE

You can add as many fields as you need to the field group.

6. Save the .ini file.

7. To test the field group you created, in Concordance Desktop, run a search for the
field group alias you created.

For example: Date = ??/??/1982, ??/??/2000.

Your search results should include the applicable data from the fields within the field
group you created. 

To use a field group for concatenated databases, add the same field group to the
other databases in the concatenated database set. When you search the
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concatenated database set, Concordance Desktop searches the all the fields in the
field group in each of the databases in the concatenated set.

Creating authority word lists

Authority word lists are lists of words and phrases that open in the Edit view when you
place your cursor in a field associated with a word list or right-click a field and click the
list in the shortcut menu. Typing text automatically scrolls the list to the word or phrase
nearest in spelling. Most words and phrases are retrieved with just a few keystrokes.
Authority list entries are always inserted at the current cursor location in the Edit view. 

An authority list can contain anything, including zip codes, author's names, and complex
chemical names. Any data entry task that is repetitive and prone to errors is a good
candidate for an authority list. Selecting entries from the list lowers the number of errors
introduced through data entry, and the number of keystrokes — thus saving labor and
expense while improving accuracy. 

Authority lists are special files, similar to the database dictionary, which provide fast
retrieval and maintenance of alphabetized entries. The authority lists used in Edit view
have the .lst file extension.  

Authority lists are created in the List File Management dialog box. Once an authority list is
created, the list is assigned to a field or fields in the Data Entry Attributes dialog box.

 You can create authority list values in three ways:

· Manually create list values

· Import existing values from a database field 

· Import values from an ASCII file

To manually create an authority list:

1. On the Tools menu, click Manage List Files.

2. In the List File Management dialog box, click the Lists tab, click the New button.

Clicking the New button opens the Allow duplicates in new list file? message.

3. To allow duplicate values in the authority list, click Yes.

If you do not want to allow duplicate values, click No.

Clicking Yes or No opens the Create a case sensitive list file? message.

4. To set the authority list to be case sensitive, click Yes.

If you want the authority list to not be case sensitive, click No.
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Clicking Yes or No opens the Save As dialog box.

5. Navigate to the directory where you want to store the authority list's .lst file, type
the name of the authority list file in the File name field, and click Save.

Clicking Save opens the new authority list in the List File Managment dialog box.

6. Click the Edit tab.

7. In the Key field, type the first list value.

The Key field is case sensitive and allows up to 240 alpha-numeric characters.

The Data value field is not used when creating an authority list. Leave the default 0
value in the Data value field.

8. Click the Add button to add the new list value.

9. Repeat steps 7 and 8 for each list value.

10. When you have finished creating the authority list, click the Done button to save
your new list. 

To create an authority list from field data:

1. On the Tools menu, click Manage List Files.

Clicking Manage List Files opens the Lists tab in the List File Management dialog
box. 

2. On the Lists tab, click the New button.

Clicking the New button opens the Allow duplicates in new list file? message.

3. To allow duplicate values in the authority list, click Yes.

If you do not want to allow duplicate values, click No.

Clicking Yes or No opens the Create a case sensitive list file? message.

4. To set the authority list to be case sensitive, click Yes.

If you want the authority list to not be case sensitive, click No.

Clicking Yes or No opens the Save As dialog box.

5. Navigate to the directory where you want to store the authority list's .lst file, type
the name of the authority list file in the File name field, and click Save.

Clicking Save opens the new authority list in the List File Management dialog box.

6. Click the Authority List tab.
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7. In the Field list, click the fields containing the values you want to use for your
authority list. 

To select multiple fields, use SHIFT+click or CTRL+click.

The Delimiter section determines which delimiter is used to separate the list values
from each other in the authority list's .LST file. The Delimiter section defaults to
Comma. If each value needs to be on a new line by itself, select the Newline option.

For more information about delimiters, see About delimiter characters.

8. In the Delimiter section, select the delimiter option you want to use in the .lst file.

The Case conversion section determines whether or not Concordance Desktop
converts the text of the value selected in the authority list to all upper case or
lower case characters in the Concordance Desktop field. The Case conversion
section defaults to No conversion.

9. In the Case conversion section, select the conversion option you want to use.

The Documents section determines whether the authority list values are created
from the field values in the current query or the entire database. 

10. In the Documents section, select the Current query or Entire database option.

11. Click the Load button to add the field values to the authority list. 

12. To view, add, or delete the new list values, click the Edit tab and do any of the
following:

· To add a new value, in the Key field, type the new value and click the Add
button.

· To delete a value, click the value in the value list and click the Delete button.

13. When you have finished creating the authority list, click the Done button to save
your new list.

To create an authority list from an ASCII file:

If you have an ASCII file with listed or delimited data you can save time by importing it
into an authority word list.

1. On the Tools menu, click Manage List Files.

Clicking Manage List Files opens the Lists tab in the List File Management dialog
box. 

2. On the Lists tab, click the New button.

Clicking the New button opens the Allow duplicates in new list file? message.

3. To allow duplicate values in the authority list, click Yes.
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If you do not want to allow duplicate values, click No.

Clicking Yes or No opens the Create a case sensitive list file? message.

4. To set the authority list to be case sensitive, click Yes.

If you want the authority list to not be case sensitive, click No.

Clicking Yes or No opens the Save As dialog box.

5. Navigate to the directory where you want to store the authority list's .lst file, type
the name of the authority list file in the File name field, and click Save.

Clicking Save opens the new authority list in the List File Management dialog box.

6. Click the Import/Export tab.

7. In the Import/Export section, click the Import option.

The Data value delimiter section determines which delimiter is used to separate the
list values from each other in the authority list's .lst file. By default, the Include
data values check box and Comma option are selected in the Data value delimiter
section. 

For more information about delimiters, see About delimiter characters.

Data values are not used by the authority list. For the authority list, it does not
matter whether the Include data values check box is selected. If it is selected, the
import populates the Data value field on the Edit tab in the List File Management
dialog box with any data values in the ASCII file. 

8. In the Data value delimiter section, select the delimiter option you want to use in
the .lst file.

9. Click the Import button.

Clicking the Import button opens the Open dialog box.

10. Navigate to and open the ASCII .txt file you want to use for the authority list.

The values in the .txt file are added to the authority list.

11. To view, add, or delete the new list values, click the Edit tab and do any of the
following:

· To add a new value, in the Key field, type the new value and click the Add
button.

· To delete a value, click the value in the value list and click the Delete button.

12. When you have finished creating the authority list, click the Done button to save
your new list.
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To associate an authority list with a field:

Once you have created an authority list in Concordance Desktop, you need to
associate the word list to a field so it can be used for data entry in the Edit view.

1. On the Edit menu, click Validation.

Clicking Validation opens the Data Entry Attributes dialog box.

2. In the Field Name list, click the field you want to add the authority list.

3. In the Authority lists section, click the File button.

Clicking the File button opens the Open dialog box. 

The Data validation and Authority lists sections in the Data Entry Attributes dialog
box are independent sections. For example, assigning an authority list with words
to a field selected as Numeric only does not cause an error. The data from the
authority list overwrites the Numeric only setting.

4. Navigate to and open the authority list file, .lst.

5. Select the check boxes that apply to the authority list in the field. 

Authority lists check box definitions

· Required for data entry - When the user's cursor is placed in the empty
field, the authority list automatically opens. If the field is already populated,
the authority list opens when a user clicks the right mouse button or
attempts to type in the field. When the Required for data entry check box is
selected, users can only choose a field value from the list or cut, copy or
paste the text in the field.

· Single entry field- The field only allows one field value from the list to
populate the field. If a user clicks another field value from the list, the original
value is replaced by the newly selected value. You can select both the Single
entry check box and the Required for data entry check box to ensure users
only populates the field with one field value from the authority list.

· List updateable by user- Users can add and delete field values from the
authority list assigned to the field. If you do not want users to modify the
authority list, be sure the List updateable by user check box is not selected.
When the List updateable by user check box is selected, the Insert and
Delete buttons are displayed at the bottom of the authority list dialog box.

· Upper case conversion- Concordance Desktop automatically converts all
text to upper case before text is copied to the field or the text is added to
the authority list. Do not select the Upper case conversion check box if you
are using an existing authority list containing lower case field values. If the
check box is selected in this scenario, when a user selects a lower case field
value from the list, the value will not be added to the field.
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6. The Delimiter field defaults to the comma character. To change the field delimiter,
type a different character in the Delimiter field. 

The character in the Delimiter field is used to separate field values that were added
to the field from an authority list. Delimiters are also used by exploded sort reports
and the tally function to determine where one entry ends and another begins.

7. Click OK to save your changes.

For more information about the Data Entry Attributes dialog box, see Setting data
validation.

To test an authority list:

After associating an authority list with a field, you can test to make sure that the
authority list opens for the field in the Edit view.

1. In the Browse or Table view, select a record.

2. On the Standard toolbar, click the Edit button to open the record in the Edit view
in edit mode.

3. Click the field you associated with the authority list.

If the Required for data entry check box is selected for the authority list in the Data
Entry Attributes dialog box, the authority list automatically opens when you click in
the field if the field is empty. If the field is already populated, the authority list
opens when a user clicks the right mouse button or attempts to type in the field. 

When the Required for data entry check box is selected, users can only choose a
field value from the list or cut, copy or paste the text in the field.

If the Required for data entry check box is not selected for the authority list in the
Data Entry Attributes dialog box, users can right-click in the field to open the
shortcut menu, and click the authority list file name to open the authority list
associated with the field.

Making global replacements

Global replacements allows you to search and replace words, phrases, dates, or carriage
returns in specific fields throughout your entire record database. The Global Replace dialog
box is used to run global replacements. You can search and replace populated or empty
fields, with or without case sensitivity. Global replacements only work on the current
query.
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Global edits are immediately saved and committed to a database. There is no undo
option. We recommend that you always back up the database before making any
global replacements.

If you have moved your native documents or attachments from one drive to another,
you need to globally replace the drive letter in the NOTEATTACHED field of the
Notes.dcb. If your attachment includes the full directory file path in the main
database, you also need to replace the drive letter in the FILEPATH field.

To make global replacements:

1. Back up your database before running the global replacement.

For more information see backing up databases. 

2. Run a search query to located the records that need a global edit.

For more information about searching, see Available search tools.

3. On the Edit menu, click Global Replace.

Clicking Global Replace opens the Global Replace dialog box.
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4. In the Field list, click the fields containing the text you want to replace.

To select multiple fields, use SHIFT+click or CTRL+click.

During a global replacement, Concordance Desktop will only search the fields
currently selected in the Field list.

5. In the Target field, type the text you want to replace.

6. In the Replacement field, type the text you want to add to the field.

To search or replace empty fields:

To replace empty fields in the database with the text in the Replacement field,
leave the Target field blank.

To remove the text in the Target field from the selected fields in the database,
leave the Replacement field blank.
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An empty target will replace all fields selected with the replacement text, if
the field is empty. Since all fields are automatically selected by default in the
Field list, it is important to only select the fields you want to replace in the
Field list.

To search or replace hard carriage returns:

To search or replace hard carriage returns in you data, type \n in the Target or
Replacement field to represent a hard carriage return. If you need to search or
replace the actual \n character combination in your data, instead of a hard
carriage return, then type  \\n in the Target or Replacement field. Typing \\n lets
Concordance Desktop know that you are searching for the\n character
combination and not a hard carriage return.

To search or replace dates:

To search or replace dates in date fields, the format of the dates entered in the
Target and Replacement fields must match the date format set up for the
selected date fields.

A date field’s date format is set in the Type field in the New dialog box when
creating a database or in the Modify dialog box when modifying databases. 

For example, if you are performing a global replacement for the DOCDATE field
and the Type field for the DOCDATE field is set to DateMMDDYYYY in the New or
Modify dialog box, the dates entered in the Target and Replacement fields in the
Global Replace dialog box must use the same MMDDYYYY format. 

Dates should be zero filled. For example, if the date format is MMDDYYYY, July
17, 1960 is entered as 07171960. It is also valid to use partial dates as targets
and replacements, such as 1013 for October 13, but do not use a partial date to
replace a complete target. This will result in invalid date field entries.

In the Document range section you can specify a document range within the
current query to have Concordance Desktop search and replace text only within this
range. The First field defaults to the first document in the current query and the
Last field defaults to the last document in the current query. 

7. In the First field, type the first document in the current query to search for the
global replacement.

8. In the Last field, type the last document in the current query to search for the
global replacement.

By default, the Ignore case check box is not selected. When the Ignore case check
box is not selected, field text must exactly match the text in the Target field,
including capitalization, before Concordance Desktop will attempt a replacement. 

9. To enforce case sensitivity during global replacements, leave the Ignore case
check box blank.
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To ignore upper and lower case lettering during global replacements, select the
Ignore case check box. 

By default, the Confirm before replace check box is not selected. When the Confirm
before replace check box is not selected, Concordance Desktop automatically
searches and replaces the text in the documents in the current query without
asking for confirmation before each replacement.

10. To make the global replacements with out confirmation, leave the Confirm before
replace check box blank.

To request confirmation before replacing text, select the Confirm before replace
check box.

11. Click OK to make the global replacements.

If the Confirm before replace check box is selected in the Global Replace dialog box,
each time Concordance Desktop locates the text in the Target field during the
global replacement, Concordance Desktop displays the text found in the Text Found
dialog box. 

12. In the Text Found dialog box, do one of the following:

· Click Yes to replace the text.

· Click No to ignore the currently found text and continue the global replacement
process.

· Click All to replace all additional targets without confirmation.

· Click Cancel to cancel the global replacement process.

Once the global replacement process finishes, in the Status section, the Documents
field displays the number of documents searched and the Replacements field
displays the number of replacements made. The field below the Field list and Status
section displays the replaced text. 

13. Click the Done button to close the Global Replace dialog box.

Changes are immediately viewable. However, in order to run full-text searches on
the edits in the record, the database needs to be reindexed. Once this action is
performed all reviewers can search the updates. 

To ensure that your edits are searchable in a timely manner, coordinate with your
Concordance Desktop administrator regarding the reindexing schedule. If any edits
are made that require a reindex, a check mark displays in the File menu next to
Reindex.

14. To reindex the database, on the File menu, click Reindex.
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About attachments

When paper documents are scanned to TIFF formatted files, the documents are unitized
according to their physical or logical boundaries. When loaded into Concordance Desktop,
parent documents and their attachments may be broken out into separate records.  

If a document and its attachments were scanned as one entire document, there may be
only a Begin and End Bates number field for each record in the database that reflect whole
documents. If parent documents and attachments have been broken out into separate
records, there may be a Begin and End Bates number field, as well as a Begin and End
Attachment field or Attachment Range field in the database for each record.

When native e-mail files are processed, they may be converted to .tiff files, in which
case, they could be treated the same as paper documents .tiff files, in terms of the Begin
and End Bates number and Attachment number fields in the database. If they are not
converted to .tiff files and were reviewed in native format, document ID fields are used to
assign a unique identifier to each document and attachment. A document ID is a
document level identifier, rather than a page level identifier.

The Find Attachment command gathers related parent and attachment documents in a
database based on the fields containing the attachment information for an active query.
The Find Attachments command looks for attachments where the attachment ranges are
stored in a single field or two separate fields. The Find Attachments can be set up when
creating a database using the New Database Creation Wizard, or using the preferences
For more information about setting up the fields for the Find Attachment command for the
database, see Defining preferences.

When using the Find Attachments feature, it is best practice to setup the fields as
paragraph type fields to increase the performance and make sure to index/reindex the
database. For more information about the Find Attachments command, see Finding
attachments.

Document and attachment field examples:

The following examples show some possible document and field scenarios in a
Concordance Desktop database:

Example 1 - Parent Document with Two Attachments

1st Record (Parent Document)

BEGDOC:  DSC0000001

ENDDOC:  DSC0000001

BEGATTACH:  DSC0000001

ENDATTACH:  DSC0000010
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Example 1 - Parent Document with Two Attachments

2nd Record (First Attachment)

BEGDOC:  DSC0000002

ENDDOC:  DSC0000004

BEGATTACH:  DSC0000001

ENDATTACH:  DSC0000010

3rd Record (Second Attachment)

BEGDOC:  DSC0000005

ENDDOC:  DSC00000010

BEGATTACH:  DSC0000001

ENDATTACH:  DSC0000010

Notice that in each example above, the BEGDOC and ENDDOC fields reflect the Bates
number range of the parent document and each attachment document. The
BEGATTACH and ENDATTACH fields reflect the Bates range of the entire document
(parent and all attachments).

Example 2 - Parent Document with One Attachment using
Attachment Range Field

1st Record (Parent Document)

BEGDOC:  DSC0000001

ENDDOC:  DSC0000002

ATTACHRANGE:  DSC0000001- DSC0000010

2nd Record (First Attachment)

BEGDOC:  DSC0000003

ENDDOC:  DSC00000010

ATTACHRANGE:  DSC0000001- DSC0000010
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Example 3 - Doc IDs with a Parent Document and One
Attachment

1st Record (Parent Document)

DOCID:  DSC00000001

PARENTDOCID:  DSC0000001

2nd Record (First Attachment)

DOCID:  DSC0000002

PARENTDOCID:  DSC0000001

In this scenario, the PARENTDOCID field establishes the parent to attachment
relationship for this document. Notice there are many field naming conventions and
other possible styles for Parent and Attachment fields in a Concordance Desktop
database.

To locate documents and related attachments:

1. Run the appropriate search to locate the documents for review.

The search results are returned.

2. On the Search menu, click Find Attachments.

3. When finished, press Enter.

To run a query and include all documents and attachments:

1. In the Search field, type the query to locate the documents and attachments.

2. In the Navigation pane, click the Search tab.

3. In the Options section, click the Include Attachments check box.

4. On the Search toolbar, click the Go button .
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Updating hyperlinks file path

Hyperlinks often require updating or replacement if you move the database or the native
files to another network directory. Hyperlinks are stored in the [database name]-
Notes.dcb file for each database. For example, if you move your native documents or
attachments from one drive to another, you need to globally replace the drive letter in the
NOTEATTACHED field of the Notes.dcb. If your attachment includes the full directory file
path in the main database, you also need to replace the drive letter in the FILEPATH
field. 

If you have moved your database and can no longer launch the native files from the links
in the database records, first update the native file path so that it points to the new
location of the Native files, and then re-create the hyperlinks in the records so they point
to the new location.

To update the native file path:

1. Make a backup copy of your database. See backing up databases for instructions.

2. Open the database in Concordance Desktop, if not already open.

3. From the menu, click Edit and then Global Replace.

The Global Replace dialog opens.
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4. In the Field list, locate and select the field that contains the hyperlink. 

The field name is FILEPATH for databases created in Concordance Desktop, but may
be named NOTEATTACHED or something else in Concordance 10.x databases that
have been migrated to Concordance Desktop.

5. In the Target box, type the file path to the original location of the Native files
folder.

The Native files folder is named Natives for databases created in Concordance
Desktop, but may be named something else for databases that were migrated from
Concordance 10.x.

6. In the Replacement box, type the file path to the new location of the Native files
folder. 

For databases created in Concordance Desktop, the 'Natives' folder usually resides
in the same folder as the database (.DCB), unless the Native files have been
previously  
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7.  Ensure that the file paths are correct before proceeding, as the update is
immediately committed to the database once you click OK.

8. Click OK.

The update process begins. When the status shows that all documents have been
updated, the updates are complete.

9. Click Done.

You are ready to run the CreateHyperlinks CPL to regenerate the updated links in the
database records.

Checking for duplicate records

After importing records, you may want to check for duplicates in Concordance Desktop.
Duplicates are identified by comparing the content in selected fields. When Concordance
Desktop finds duplicate records, Concordance Desktop tags each of the duplicate records.
Give some forethought to what fields you want to use to check for duplicates. Before
checking for duplicate records, make sure that there are not any records that were
tagged in a previous duplicate check before you start the process again.

It is best practice to remove access to the Check for Duplicates menu command on the
Tools menu from most users, except your advanced users. 

When Concordance Desktop checks for duplicate records, Concordance Desktop only
checks the records in the current query. If you want Concordance Desktop to check for
duplicates in the entire database, be sure to run the Zero Query before checking for
duplicates.

The duplication detection categorizes documents in three ways:

· When a record is unique, no tag is assigned to the record

· The first time a duplicate record appears, the Original tag, or its equivalent, is assigned
to the record

· The subsequent times the duplicate record appears, the Duplicate tag, or its
equivalent, is assigned to the records

To check for duplicate records:

1. Run a search query to locate the records you want to search for duplicate records.

For more information about searching, see Available search tools.

When Concordance Desktop checks for duplicate records, Concordance Desktop
only checks the records in the current query. If you want Concordance Desktop to
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check for duplicates in the entire database, be sure to run the Zero Query before
checking for duplicates.

For more information about the Zero Query, see Reviewing search queries.

2. On the Tools menu, click Check for duplicates.

Clicking Check for duplicates opens the Duplicate Detection dialog box.

3. In the field list, click the fields you want Concordance Desktop to compare to
identify duplicate records in the database's current query.

To select multiple fields, use SHIFT+click or CTRL+click.

You can select as many fields as you want, but there is a limit of 245 characters
that can be compared. Paragraph fields count as sixty characters.

When you first open the Duplicate Detection dialog box, the Original field defaults to
Original and the Duplicate field defaults to Duplicate. The Original field determines
the name of the tag applied to the first record encountered in a duplicate record
set, and the Duplicate field determines the name of the tag applied to the second
record in a duplicate record set. You can modify the tags names in the Original and
Duplicate fields to any tag name you want Concordance Desktop to use for
duplicate records.

4. Before checking for duplicate records in the database, make sure that the database
does not have any records that were already tagged with these tag names from a
previous check for duplicate records.

5. If you selected a paragraph field in the field list, it is best practice to select the
Only use the first line of each field check box.

If you do not want Concordance Desktop to compare all of the text in a field, up to
the 245 character limit, clear the Only use the first line of each field check box.

6. Click OK to check for duplicate records.
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The Duplicate count field displays the number of duplicate records found during the
duplicate record check. Any duplicate records are tagged.

7. Click the Done button to close the Duplicate Detection dialog box.

8. To view the duplicate records, query the Original and Duplicate field tags.

For more information about querying tags, see Creating queries from tags.

Tallying duplicates:

You can also use the Tally feature in the Tally task pane to help identify duplicate
records in the database. The Tally feature creates an itemized list of data values within
a field, including the number of occurrences of each data value in the field.

For more information about the Tally feature, see Searching by tally. 

About deleting records

You may need to delete records if there are duplicate records or opposing counsel
unintentionally produced privileged documents. Deleting records is a two-step process:
mark for deletion, then pack the database to permanently remove the records. Reviewers
can flag records for deletion, but they are not permanently removed from the database
until the database is packed. Packing a database permanently deletes the records from
the database, and there is no undo function for this process, therefore the Pack Database
menu command should only be available to administrators.

Once records are flagged for deletion, you can run a query to review those flagged
documents. This is your only fail-proof means of restoring a record after it is removed from
the database. If you find that you later need to restore the deleted records, the only way
to restore a record permanently deleted from a database is to import the deleted records
back into the database.

Deleting Records Overview:

· Deleting is a three-step process: mark for deletion, remove tags from the records
marked for deletion, and then pack the database

· Make a back-up copy of records marked for deletion by exporting those records to
another Concordance Desktop database

· Packing is permanent; there is no Undo button

· Packing the database is an exclusive process
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Deleting records in Concordance

Deleting records is a two-step process: records are marked for deletion, then the
database is packed to permanently remove the records. Packing a database permanently
deletes the records from the database, and there is no undo function for this process.

Before permanently deleting any records, you first need to run a query for all records
marked for deletion to review the documents.  It is recommended that you remove any
tags applied to the deleted records. For more information, see About deleting records.

You can also permanently delete all records in the current database using the Zap menu
command on the Administration menu. When you zap a database, all documents and
search files are erased and free space is returned to Concordance Desktop.  

To mark records for deletion:

For step-by-step instructions to mark individual and multiple records for deletion, see
Deleting records in the Using Concordance Desktop module.

To search for deleted records:

1. On the Search menu, click Search for documents marked for deletion.

2. Clicking Search for documents marked for deletion creates a query of the
records currently marked for deletion in the database.

When a record is marked for deletion, DEL is displayed on the Status bar. 

3. In the Browse or Table view, review the records in the query to determine whether
the records should be permanently removed from the database. 

4. If any records in the query should not be permanently deleted, remove the delete
status from the applicable records.

To remove the delete status from a record, see To unmark individual records for
deletion in the Deleting records topic.

5. If you removed the delete status from any records in the query, click Search for
documents marked for deletion on the Search menu again to update the query
to only include the records you want to permanently delete.

To export the records marked for deletion:

After reviewing the records marked for deletion and updating the query to only include
the records that will be permanently deleted, it is best practice to export these records
to another database.
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Always export your deleted records before you pack the database, just in case
you need to retrieve them later. Once you pack a database, any records marked
for deletion are permanently removed. There is no undo function for this process.

Use the Export As a Concordance Desktop database menu command to export the
records marked for deletion. When you use the Export As a Concordance Desktop
database menu command, Concordance Desktop exports all the records in the current
query to a new database. For more information and step-by-step instructions, see
Exporting databases.

To pack the database:

After backing up the records marked for deletion, you are ready to permanently remove
the records from the database.

Remember, there is no undo function for this process. Records are immediately and
permanently removed from the database, unless you export a copy of your deleted
records.

You cannot pack a concatenated set of databases remotely, you must perform
packing from the Concordance Desktop server machine. 

1. On the File menu, click Administration, then Pack, and then Database.

2. Clicking Database opens the Administration dialog box.

3. In the User field, type the administrator's user ID.

4. In the Password field, type the administrator's password.

5. Click OK.

Clicking OK opens the Pack dialog box and starts the pack process.

When Concordance Desktop finishes permanently deleting the records marked for
deletion, the Pack dialog box closes. 

6. Verify that the records were deleted. 

To verify the records were deleted, open the Table view and scan your record
listing. The records marked for deletion should no longer be listed.

If you have an ACCESSID field in your database, you will notice that the accession
number does not readjust for deleted records. This allows you to view gaps in your
database records.
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It is best practice to pack the dictionary after packing the database. For more
information, see Packing the dictionary.

To zap a database:

Zapping a database permanently deletes every record in the active database. All
documents and search files are erased and free space is returned to Concordance
Desktop. If databases are concatenated, only the documents and search files in the
primary database are erased when you zap a database in a set of concatenated
databases.

It is best practice to not give users access to the Zap menu command due to the
risks involved in deleting all records in a database. There is no undo function for
this process.

1. On the File menu, click Administration, and then Zap.

Clicking Zap opens the Administration dialog box.

3. In the User field, type the administrator's user ID.

4. In the Password field, type the administrator's password.

5. Click OK.  A confirmation dialog displays.

6. Click Yes to zap the database. 

Click No to cancel the zap process. 

After the zap process completes, No documents in query is displayed on the Status
bar. 

Packing the dictionary

Packing the dictionary is similar to defragmenting your hard drive; it gets rid of
unnecessary entries to keep your system running faster and smarter. Good routine
maintenance is to pack the dictionary after you pack the database and also each time you
reindex.

Packing the database regularly:

· Increases database processing and search speed

· Increases reindex speed by up to 6X

· Optimizes the dictionary file and makes it smaller
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For more information about packing databases, see Deleting records in Concordance
Desktop. 

To pack the dictionary:

1. On the File menu, click Administration, then Pack, and then Dictionary.

2. Clicking Dictionary opens the Administration dialog box.

3. In the User field, type the administrator's user ID.

4. In the Password field, type the administrator's password.

5. Click OK.

Clicking OK opens the pack status dialog box and starts the pack process.

When Concordance Desktop finishes packing the dictionary, the status dialog box
closes. 

About modifying databases

When you make a modification to a database, it usually means that you are modifying
fields in the database. When you modify a database, you need to be careful. Concordance
Desktop has no restrictions for database modifications, but we do offer recommendations
on what you should and should not do so you are less likely to corrupt your database.

Modifications made to a database is a common reason for corruption. Please use
caution when making changes and always back up your database files before doing
so. Also it is a good practice to close other databases while making database
modifications.

If you are modifying the database structure and using an active sorting layout or
table layout, you must delete .Sortinglayout and .layout files and the files will be
rebuilt to accommodate the new database structure the next time you open the
database.

Always back up a database's files before you make any changes to the database. Some
modifications are more dangerous than others, and database modifications always require
a full index update immediately after. Most modify functions rebuild the database and
erase the dictionary, requiring you to index the database from scratch. We recommend
that you plan ahead to allocate time for database modification since it requires exclusive
access to the database and time to run a full index.
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Certain changes that do not require a database rebuild:

· Changing a date field’s display type

· Changing only one field’s name

· Adding or deleting key fields

If you have applied security, you must also give users access to any new or renamed
fields before they are visible in the database. New and renamed fields are not visible in the
Table view until they are added to the layout structure.

If you are renaming a field and moving or changing the field's type, it is best not to
rename it at the same time. Instead, change a field name in one step. Then come
back and modify the field type or location in another step.

Remember the 3 Change Rule for databases: We recommend that you not make more
than three changes to a database before indexing. After making three changes in the
Modify dialog box, click OK to save your changes, and then index the database. For
more information about indexing databases, see Indexing and reindexing updates.

If Concordance Desktop security is enabled, the Modify dialog box can only be
accessed by a user that has full read/write access to all fields.

Database modification guidelines

Database Modification Guidelines

Risk Activity

Less
Dangero
us

Adding/removing punctuation

Changing a field’s length

Changing field properties (index or key)

Changing data types (text to paragraph)

Adding a new field at the end of the list

Inserting a new field in the middle of the list

Renaming a field – A common cause of database corruption!

Delete or insert a field elsewhere – common cause of database corruption.



Concordance Desktop 382

Database Modification Guidelines

Risk Activity

More
Dangero
us

Making more than one change to the same field, at the same time

If you need to change a field name, make a new field first and run the
AppendOneFieldToAnother.cpl, then hide the other field from users in the Security
dialog box. Do not delete it!

How to modify a database:

1. Make a back-up copy of the database you are modifying. Do not proceed to step 2
until you have completed this procedure.

Do not perform live backups if you are using backup software that locks files, even
briefly. This has been known to cause read/write functions to the database files to
fail, and can cause file synchronization or corruption issues. Check with your IT
group and/or backup solution provider to verify that no file locking occurs before
scheduling any backups on Concordance Desktop, Concordance Desktop Image,
and FYI files that are in use.

Be aware that anti-virus, firewall, and backup software can often interfere with
network traffic and the locking of files, and in effect, could cause Concordance
Desktop software to crash.

For more information see backing up databases.

2. Once your database backup copy is secure, open the database you want to modify
and close all other databases.

3. On the File menu, click Modify.

The Modify dialog box opens.
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4. Make the necessary changes.

For more information about database fields, see About fields.

For more information about filling out the Modify dialog box, see the Basic database
fields topic.

If you are renaming a field and moving or changing the field's type, it is best not to
rename it at the same time. Instead, change a field name in one step. Then come
back and modify the field type or location in another step.

Remember the 3 Change Rule for databases: We recommend that you not make
more than three changes to a database before indexing. After making three
changes in the Modify dialog box, click OK to save your changes, and then index
the database. For more information about indexing databases, see Indexing and
reindexing updates.

5. Click OK to save your changes and close the Modify dialog box.

6. Run a full index.

For more information about indexing databases, see Indexing and reindexing
updates.

Whenever you add or rename a field in the database, it is added to the database
with full field access rights. If you need to restrict one or more user's field rights to
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the database, you will need to set the field privileges for the new or renamed field
for users already added to the Concordance Desktop server.

For more information about field access rights, see Restricting user access on
databases. 

Managing Persistent Search

One method for storing search terms is to write the terms directly to a text file that is
stored with the database. The Persistent Search feature searches for the terms included
in the <databasename>_Persistent.txt file and highlights term(s) in each record where
they are found.  

Persistent Search, when enabled, remains active even after the results are returned.
When new records are added to a database and the Persistent Search feature is enabled,
simply reindex the database and then the new records are automatically included in the
search results if the records meet the criteria.  

If a query is run in conjunction with the Persistent Search enabled, the search results are
returned for both the query and the persistent search,  and the terms are highlighted in
the Browse view. The search query results are displayed in a different color than those
found from the Persistent Search.  The color settings are defined on the Searching tab of
the Preferences dialog box, see Defining preferences.

The Persistent Search feature may be run in conjunction with the Quick, Simple,
Form, and Advanced Search queries to refine the search results even further. 
However, when combining search queries a maximum number of 255 characters is
allowed.  If a search is performed and then Persistent Search is activated make sure
that the total number of characters does not exceed 255 to ensure the correct
results are returned. 

To add search terms to the Persistent Search file:

1. Navigate to the database's Persistent.txt file.

The .txt file is stored in the same directory as the database .dcb file.

2. Open the Persistent.txt file in any text editor program.

Persistent.txt files can be opened with any text editor program, such as Notepad. 

 

3. In the Persistent.txt file, type a search term, and then press Enter.
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The maximum number of characters per search term is 64.

4. Repeat step three for each term you want to include in the text file.

5. When finished, save the file and close the text editor.

Publishing Databases Using Shortcut (.fyi) Files

Working with Concordance Desktop shortcut (.fyi) files

In the Concordance Desktop Admin Console, you can create shortcut (.fyi) files that allow
users to launch Concordance Desktop and open remote databases through the
Concordance Desktop Server.

Concordance Desktop needs to be installed on the client's computer and Internet access
needs to be available. Users can access PDF copies of native documents and/or images if
a Full Reviewer license is added to the server and they are provided with the log in
credentials for that server. 

Concordance Desktop shortcut (ifyi) users have full functionality, with the exception of
modifying the database structure, providing an account has been setup for them on the
server. Concordance Desktop shortcut (.fyi) users cannot access the Modify command on
the File menu.

The shortcut (.fyi) file, which can be opened in any text editor, contains the connection
information needed to address the Concordance Desktop server and request the database.
It includes the server/host name and port number, the database name and description,
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and a specific serial number. Users receive access when you email them the shortcut (.fyi)
file pointing to the database, along with their Concordance Desktop user name.

For more information about the Concordance Desktop shortcut (.fyi) file, see Working with
shortcut (.fyi) files and Distributing the shortcut (.fyi) file to users.

Supporting Concordance Desktop shortcut (.fyi) files

Once databases have been registered and published from the Admin Console, there are
some steps you will need to take to ensure that your users have the necessary
information they need to get started with the Concordance Desktop shortcut (.FYI)  files. 

For more information about distributing shortcut (.FYI) files, see Distributing the shortcut
(.fyi) file to users.

For more information about supporting reviewers, see Supporting reviewers.

Concordance Desktop server system requirements for shortcut (.fyi) files

The minimum system requirements include:

· Internet access

· Must have client port open to inbound and outbound traffic on the server/computer
(port 443 by default)

Creating shortcut (.fyi) files

In the Concordance Desktop Admin Console, you can create shortcut (.fyi) files that allow
users to open remote databases in Concordance Desktop.

Concordance Desktop needs to be installed on the user's computer and Internet access
needs to be available. 

The shortcut (.fyi) file contains the connection information needed to address the
Concordance Desktop server and request the database. The shortcut (.fyi) file includes
the server/host name and port number, which can be viewed in a text editor program.
Users can access the shortcut (.fyi) file when you e-mail them the file pointing to the
database, along with their Concordance Desktop user name.

When working with shortcut (.fyi) files, consider the following:

· Shortcut (.fyi) files can be viewed in a text editor program where you can manually
change the server/host name, port listing and database description.

· Do not modify the serial number contained in the Shortcut .fyi file as this invalidates
the file.
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· There is no limit to the number of shortcut (.fyi) files that can be generated.

· When distributing shortcut (.fyi) files from a concatenated set, only the primary
database needs to be published to a Shortcut (.fyi) file, as long as the other joined
databases are registered on the same Concordance Desktop server.

A new shortcut (.fyi) file is needed when the following occurs:

· The port address changes

· A database is unregistered or registered

· The server's name (computer name) changes

To create a shortcut (.fyi) file

1. Log onto the Admin Console of the Concordance Desktop server where the
database is registered.

2. Click the Management tab. 

3. Double-click on the Databases folder to open the database list. 

4. Right-click on the database for which you need to create a new shortcut (.fyi) file,
and select Create Database Shortcut file. 

A Save .FYI [database name] dialog box opens.

5. Select the appropriate Server Address.

6. Click Next. 

7. Click the ellipses button to select the folder and file name for the new shortcut
(.fyi) file.

8. Click Finish. 

The shortcut (.fyi) file is saved under the file name and location you entered.  

Distributing the shortcut (.fyi) file to users

Users cannot access remote Concordance Desktop databases without having the .fyi file
distributed to them. You must also ensure that the port setting is entered in the Admin
Console and is open for inbound and outbound traffic. The shortcut (.fyi) file does not
need to be redistributed to users unless the serial number or port address changes.

Concordance Desktop shortcut (.fyi) distribution checklist
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Checklist: Concordance Desktop Shortcut (.fyi) Distribution

E-mail Template

Prepare an e-mail template for distributing the Concordance Desktop shortcut (.fyi)
file to users to ensure that this process is fast and easy the next time a user
needs access.

Include the sohrtcut (.fyi) file in the e-mail and instruct users to save the file to
their computer desktop.

Logons and Passwords

Include the user’s logon, as well as the server or host name and port (usually
443),  they need when opening the shortcut (.fyi) file on their compute desktop.

Launching Concordance Desktop

After users have saved the shortcut (.fyi) file to their desktop, they can double-click
the file to launch the Concordance Desktop application.

Once users have entered their logon and password, and entered the server/host
name and port, the database opens in Concordance Desktop.

*If a user receives an error message stating that the server is unreachable or
other message or pop-up, instruct them to contact you. The error is probably due
to an incorrect server address and you will need to verify whether the port setting
is correct and open.

User Session Timeout Allotments

Inform users of the user session time allotment you have designated for them.
Users should know that when their user session timeout period is nearly finished,
they will receive an announcement indicating that they should save their work. If a
user is logged on, but not actively working, the Concordance Desktop application
on the server will then disconnect them from the database and Concordance
Desktop, and they risk losing data. To re-open a user session, a user should save
their work, exit Concordance Desktop and re-launch the application, thereby
opening a new user session period.

About snapshots

Snapshots are a point-in-time picture of a user’s work history and helps them track and
preserve both search history and search results. Saved snapshots can easily be restored
to see what the contents of a database were on a particular day and what search results
were found at that moment in time. Snapshots only store historical data, such as
searches, the last record selection, and the last sort performed during a user’s
Concordance Desktop session.
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When a saved snapshot file is restored, Concordance Desktop automatically opens the
databases associated with the file, with all queries and sorts preserved. These snapshots
can only be restored in the original database they were created in.

Users may also choose to have the Auto-restore feature turned on which is a similar
feature to saving a snapshot. This snapshot file contains that last record selection and
last record viewed at the end of a Concordance Desktop session, so when users next
access Concordance Desktop they can resume. The Auto-restore feature is enabled by
default. The Auto-restore setting can be found under File > Snapshot in Concordance
Desktop.

Managing Imagebases

The Concordance Desktop Image Base (CIB) database is a SQLite database that stores
information on all native documents and image files in a Concordance Desktop database.
The .cib file stores information such as folder path location, markup history, and
preferences settings for the viewer. 

As a best practice, make sure that all users are logged out of the database prior to using
the Image Base Management tools.

Do not delete the .CIB file. Doing so can corrupt the database. The .CIB file
contains vital information that the database requires in order to allow the database
to be opened and its records to be accessed. 

Managing the Concordance Desktop Image Base includes the following:

· Renaming/deleting media paths and folders

· Renaming/deleting media keys (aliases)

· Exporting the imagebase database to an OPT file

· Calculating or updating document page count

· Converting Concordance Desktop Viewer Imagebases to Concordance Viewer

If you are on the Concordance Desktop server machine, and the Image Base
Management tools are not available from the File > Administration menu, then you
have not been given access privileges.  If you need access, please contact your
Concordance Desktop Administrator.
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Renaming file paths and folders

After registering your media, if you receive an error message stating that the viewer is
unable to open the corresponding document, you need to edit your folder paths. The
folder path listed in the message box is the path stored in the Concordance Desktop
Image Base that points to where your files are located so the viewer can open and display
the documents. You need to change the path to the directory location where your
documents actually reside.

Use caution when resetting folder paths as there is no undo function and changes
are permanent. We recommend backing up the .cib file before performing this process
or other imagebase management tasks.

To rename media paths and folders:

1. Open the database you want to change the media path or folder.

2. From the File menu, click Administration, Image Base Management, and then
CIB Management.

3. Click the Browse button to locate and open the .CIB file for which you need to
rename paths and folder. 

4. In the Image Base Management dialog box, click the Rename Media Paths and
Folders button.
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The current file paths are listed at the top of the Rename Media Paths and Folders
dialog box.

5. To specify a Target path, do one of the following:

· From the Root Paths list, select an existing file path.

· Enter a partial path in the Target field.

6. To set the Replace with path folder, do one of the following:

· Click the Select Folder button and select a new root path folder.

· In the Replace With field, enter the new root path. 

File paths and folder are case-sensitive. Make sure the target and replace case
matches the actual locations, to ensure they are properly replaced.  

7. When finished, click Replace.

8. In the New Root Paths dialog box, do one of the following:

· Click Confirm if the new path is correct.

· Click Cancel to return to the Rename Media Paths and Folders dialog box and
make any necessary corrections.

The New Root Path dialog box displays the new path. If the path is displayed with
red text, this indicates that the folder does not currently exist. It is recommended
that you cancel the rename and choose an existing folder or create one prior to
renaming the path.
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8. When finished click OK.

Editing media keys

Your load file's alias format for should match the media (image) key information in the
corresponding Concordance Desktop database. Concordance Desktop stores this key in
order to reference the image for viewing in the viewer. For more information about the
Image (Media) check box, see About fields.

You can use the Image Base Management feature to make changes to the media (image)
aliases as needed.

Make sure that when you rename or delete any media keys, you rename or delete the
media key in the Concordance Desktop database.

Unicode characters are not supported for media (image) key field names/

To edit media keys:

1. Open the database for which you need to change the media keys.

2. From the File menu, click Administration, Image Base Management, and then
CIB Management.
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3. Click the Browse button to locate and open the .CIB file for which you need to
edit media keys. 

4. Click the Rename or Delete Media Keys button.

5. Do any of the following:

· Locate and click the media key from the media keys listed.

· Enter the media key alias and then click Search.

6. In the New Alias field, enter the new media key.

7. Click Save Alias.

8. Repeat steps 5 through 7 for each media key you want to edit.

9. When finished, click OK.

To delete media keys:

1. Open the database for which you need to change the media keys.

2. From the File menu, click Administration, Image Base Management, and then
CIB Management.
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3. Click the Browse button and then locate and open the .CIB file for which you need
to delete media keys.

4. Click the Rename or Delete Media Keys button.

5. Do any of the following:

· Locate and click the media key from the media keys listed.

· Enter the media key alias and then click Search.

5. Click Delete.

6. Repeat steps four and five for each media key you want to delete.

7. When finished, click OK.

Exporting a CIB file to OPT format

To make a backup of a Concordance Desktop database imagebase you can export the
database's .cib file to an .opt formatted file. The OPT file is a text file that contains the
contents of the imagebase at the time of the export.  
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If you plan to export the imagebase database more than once, make sure that you
delete or rename the existing .opt file(s) prior to exporting as Concordance Desktop
will not overwrite the file(s). The exported .opt file does not include markup history. 

To export a .cib file to an .opt file:

1. From the File menu, click Administration, Image Base Management, and then
CIB Management.

2. Click the Browse button to locate and open the .CIB file that you need to export.

3. Click the Export CIB to OPT Format.

4. Click Add, and then locate and open the .cib file you want to export.

5. In the Output Folder field, click Browse.

6. Locate and select the folder where you want to export the OPT file.

7. Click Export.

8. When finished, click OK.
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To export multiple .cib files to an .opt file:

1. From the File menu, click Administration, Image Base Management, and then
CIB Management.

2. Click the Browse button to locate and open the .CIB file that you need to export.

3. Click the Export CIB to OPT Format button.

4. For each CIB file you want to export, click Add, and then locate and open the .CIB
files you want to export.

5. In the Output Folder field, click Browse.

3. Locate and select the folder where you want to export the OPT files.

4. Click Export.

5. When finished, click OK.

Each CIB file is exported to a separate OPT formatted file, and placed in the
designated folder.
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Converting existing CI imagebases

If you need to convert Concordance Image imagebase files to Concordance Desktop,
please contact Support. 

Converting Concordance Desktop Viewer Imagebases to Concordance Viewer

Concordance Desktop provides a feature to convert an imagebase from the original
Concordance Desktop Viewer to the new Concordance Viewer.  This feature is only
available for databases that are linked to the Concordance Desktop Viewer and contain
supported filetypes for the new viewer.

It is not recommended to convert the imagebase to the new viewer if any of the following
are true:

· The imagebase contains file types that are not supported in the new viewer.

· Markups include text-based underlines, highlights and strikethroughs.  These markups
are not converted in the process.

· Markups include stamps. While stamps do convert, they may appear distorted in the new
viewer.

· The database is part of a concatenated set in which other databases cannot be
converted to the new viewer.

· The database review is in progress and changing to a new viewer, as well as new
production and printing processes would be disruptive and result in possibly inconsistent
output.

Document redactions and markups placed in the original viewer are stored in .xrl files
located in the same Windows folder as the image, near-native or native file to which
it applies.  Markup history is stored in the .cib file located in the database folder.  The
conversion process will make a copy of the .cib file and rename the .xrl files in their
locations.

 

To convert an imagebase from Concordance Desktop Viewer to Concordance
Viewer:
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1. Verify that no other users are logged into the database.  You may take the database off-
line in the Admin Console to ensure that users will not access the database during the
conversion process.

2. From the File menu, click Administration, Image Base Management, and then
Convert to new viewer.

3. An informational message box is displayed with details about the conversion process. 
Select OK in the dialog to continue the conversion process.

4. Upon completion, the Concordance Desktop Redaction Converter window is displayed. 
This window displays details about what was converted.
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4. The window displays details about what was converted.  Use the scrollbar on the right
to review the details.

5. Click View Log to display the redaction conversion log in a separate text editor
window.

6. Click View Report to display a comma separated log of markups that were converted
in a separate window.  Each record in this report includes CNDCN, Page, Type, Reason
for Redaction, and Status.

7. Click Done when you are ready to start working with your converted imagebase and
the new Concordance viewer.  The new viewer will automatically launch when users
click on the camera button.  New printing and production wizards associated with the
new viewer will also launch when these menu options are selected.

Should they be needed later, both the conversion .log and .csv report are saved in the
Logs folder where the database files are stored.

The Convert to new viewer menu option will only be available for databases that are
associated with the Concordance Desktop Viewer.

Concatenating Databases

Concatenation is the joining together of two or more Concordance Desktop databases,
allowing users to view multiple databases as if they were one database in Concordance
Desktop. 
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There are three main reasons for joining databases:

· Very large record collections are often broken into smaller databases for administrative
maintenance needs and need to be joined for the review team to access all case
documents

· Databases that are separated based on record and/or file type, still make up the
case’s record collection and need to be searched together during particular review
projects

· Attorneys may request that records are separated by category, yet still need to
combine the databases during case review

Separate databases are also created based on type; emails, transcripts, and non-
transcript records, so joining them for search purposes is ideal during review projects.
Sometimes attorneys may want subsets of records broken by category, such as all
pleading documents and correspondence documents separated by database, and again
having the benefit of concatenating them for specific review projects.

Members of the review team, must ensure that every pertinent record has been reviewed,
sorted and tagged appropriately regardless of the database location. The way to do this
efficiently is by having concatenated databases in which they can save appropriate
search queries during the discovery process. Every tag and issue, entered by all users will
be viewable, and listed alphabetically.

Concatenating databases is a powerful feature that includes:

· Searching up to 128 databases simultaneously and treating them as a single large file,
depending on network set up

· Opening transcript and non-transcript databases together

· Using drop-down database lists on field’s with selection functions

Databases that have been converted from Concordance 10.x cannot be
concatenated with new databases created in Concordance Desktop. In addition, you
cannot drag and drop a migrated database onto a new database created in
Concordance Desktop, or vice versus. 

With database concatenation users can:

· Search up to 128 databases simultaneously. Concordance Desktop treats them as a
single large file (not including Notes and Redlines databases).

· Open transcript and non-transcript databases together

· Use drop-down database lists on fields with selection functions

· Save indexing time when new records need to be imported into Concordance
Desktop, by having a secondary database created and joined with the primary
database

· Save maintenance time when indexing databases. With concatenation, you can
index multiple databases at the same time.

· Automatically display tags from all databases



Administration 401

· Create field groups in INI files so reviewers can search multiple fields under one alias
(copy into each .ini file for joined databases)

Benefits of concatenated databases

· Large record collections can be broken into smaller databases that can then be
concatenated for review.

· You can organize a record collection for review by creating databases based on
document type, custodian, etc.

· Users can share tags across all the databases in the concatenated set.

· Users can search across all the databases in the concatenated set.

Things to know about manually concatenated databases:

· Concatenation is not a structural change, records in each database remain the
same.

· Concatenation does not have to be permanent. Databases can be removed from the
concatenated set, or the concatenation itself can be removed.

· Concatenated databases do not have to have any fields in common, unless you
need to create a production from the set. For productions, the field names must be
common across all the concatenated databases. 

· The .cat file is saved in the same folder as the primary database's .dcb file. When
the pimary database is launched, all other databases in the concatenated set are
opened. 

· Packing, database modifications, indexing and reindexing are done in the primary
database only, all others are automatically updated.

· You must be on the Concordance Desktop server machine in order to pack a
concatenated set of databases.

· You should never delete the CAT file itself. Instead you should clear the
concatenation through Concordance Desktop. 

· Searches search each dictionary file one by one. 

Things to know about automatically concatenated databases:

· Concatenation is not a structural change, records in each database remain the
same.

· Concatenated databases do not have to have any fields in common, unless you
need to create a production from the set. For productions, the field names must be
common across all the concatenated databases. 

· The .cat file is saved in the same folder as the primary database's .dcb file. When
the pimary database is launched, all other databases in the concatenated set are
opened. 
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· Packing, database modifications, indexing and reindexing are done in the primary
database only, all others are automatically updated.

· You must be on the Concordance Desktop server machine in order to pack a
concatenated set of databases.

· You should never delete the CAT file itself. Instead you should clear the
concatenation through Concordance Desktop

· When you create a new database based on multiple record sets, the import process
creates a new database for each record set and then concatenates the databases
so they appear as one database. 

· You should never delete the .CAT file of a concatenated database set. If you need
to remove a database from the set, or remove concatenation, you need to do so
through Concordance Desktop. 

· Automatically concatenated databases do not have to have any fields in common

· Automatically concatenated databases are saved in a single folder so that all
databases open when the primary database is opened in Concordance Desktop.
Packing, database modifications, indexing and reindexing are done in the primary
database and automatically performed on the rest of the databases in the
concatenated file set.

· Searches search each dictionary file one by one.

How to recognize a concatenated database set

   

A concatenated set in the Admin Console 

A concatenated set in Windows Explorer

The image on the left shows how a concatenated database set is displayed in the
Admin Console under the Management tab. The plus sign (+) indicates that a database
is the primary of a concatenated set. Secondary databases are indicated by a 'C' and
are indented directly below the primary database.

The image on the right shows how a concatenated database set is saved and displayed
in Windows Explorer. Note how a folder is created for the secondary database, labeled
the same name as the primary, with an extension beginning with 001. If you look at the
database in the folder, it too will be named the same as the primary, with a dash and
then sequential number, beginning with 001. 



Administration 403

Designing concatenated databases

When large databases are split into multiple databases and then concatenated for ease of
maintenance, all databases can be created with the same structure. The following
Concatenated Database Sample table illustrates how this architecture is created.

As the administrator, this database design serves both you and the reviewer. The generic
naming of the primary database prevents confusion for the reviewers because they can
simply launch the primary database (Columbia.dcb) without having to be concerned about
multiple databases. The design also benefits you because databases are similarly named
and the structure allows for ease of maintenance when indexing or reindexing is needed.

Organizing document types

There are various ways to organize the different types of documents imported into
databases. Transcripts must be organized in a separate database because of the template
structure required to import these files. In order to search a paper document database
with transcript content, the two databases must be concatenated.

When various database types are concatenated, all databases in the set automatically
launch when the primary database is accessed in Concordance Desktop.

Managing concatenated databases

When managing concatenated databases, be aware of the following:

· Index and reindexing need only be done on the Primary database; all others are
automatically indexed/reindexed.

· Pack need only be done on the primary database; all others are automatically packed.

· File updates and data imports, either from drag and drop or the Import feature, append
to the very last database in the file set.

· DCB, DAT, and PST files that are dragged and dropped onto the primary database are
automatically added to the concatenated file set.

· Exports only use a selected database’s field structure from a concatenated set.

· Each users' field rights and menu access settings need to be the same for every
database in the concatenated file set.

· Productions can be run for a concatenated file set by running them on the Primary
database only; all other database in the file set are automatically included
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You can export from a concatenated set of databases as long as the field names are
the same; however, the field type is inherited from only one selected database, so
data may be truncated if the field size and data size of one of the concatenated
databases exceeds the field size of the selected database structure.

Limitations for concatenated databases

Using concatenated databases includes the following limitations:

· You can join databases with differing structures and they can be edited, sorted,
and printed. However, the structures must be identical to use certain options such
as Overlay and Export.

· When exporting concatenated databases, only the data in fields that are identically
named and formatted in the concatenated set will be exported.

· When importing records into a concatenated database, records are updated when
the fields of an imported record match an existing record. When the fields do not
match, the imported record is appended to the main database, which is the first
database in the concatenated set. However, when using the Overlay option,
importing records with mismatched fields can cause a loss of data.

· Only the "Primary" database of a concatenated file set can be opened. If a user
attempts to open a database that is part of a concatenated file set, they receive a
message stating that they cannot open a "non-primary" database.

User Management guidelines for concatenated databases

Setting up user management for concatenated databases includes the following
guidelines:

· Each users' user name and password must be the same for all databases in the
concatenated set.

· When the user name and password in the primary database does not exist in a
secondary database, the concatenated database will not open. The user receives a
message that they do not have access rights to the specific database.

Automatically launching concatenated databases

The concatenated text file (.CAT file) is used to keep track of concatenated
databases. The file contains the list of database names and their file paths for the
databases in the concatenated database. If you attempt to open a database and
Concordance Desktop finds a database .cat file by the same name in the same
directory as the .dcb file, the databases in the list are automatically opened and
concatenated. Since the Reindex function updates all actively concatenated
databases, you can search, edit, and use the group as if they were one.
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Indexing and reindexing concatenated databases

Edits and changes on various databases are occurring simultaneously by all users who are
adding tags and comments, and editing records. Make sure that team members are
updating the dictionary for searches by regularly reindexing all the databases in
concatenated database sets.

When you Index a concatenated set of databases, Concordance Desktop indexes each
database in the set. When you Reindex a concatenated set of databases, each database
in the concatenated set is reindexed, updating the whole concatenated database
collection.

If a check mark is displayed next to Reindex on the File menu, the databases need
updating. The check mark disappears from this setting after the process is completed.
Collaborate with the review team lead to ensure that reindexing schedules coordinate with
case review objectives.

Joining multiple databases (concatenating databases)

Administrators on the Concordance Desktop server can concatenate databases using
either Concatenate Database function in the Databases task pane, selecting the
Concatenate option from the File menu, or by dragging and dropping a DCB, DAT or PST
onto an existing database. Please note that only those who are assigned as administrators
on the Concordance Desktop server where the concatenation needs to be performed,
have the ability to concatenate databases.

When reviewing a concatenated dataset, all tags in all databases display in the Tags
panel. If you apply a tag from one database to a record in another database,
Concordance Desktop automatically writes that tag into the record’s corresponding
database.

Databases that have been converted from Concordance 10.x cannot be
concatenated with new databases created in Concordance Desktop. In addition, you
cannot drag and drop a migrated database onto a new database created in
Concordance Desktop, or vice versus. 

To concatenate databases:

You can only concatenate databases if you are a Concordance Desktop Administrator
on the server where the databases reside. 

1. Do one of the following:



Concordance Desktop 406

· On the File menu, click Administration, then Concatenate, and then Edit
concatenation. 

· Drag and drop a DCB, DAT, or PST file onto an existing database

The Concatenated Databases dialog box opens. 

If the database you have open is already the primary database in a concatenated
file set, the list displays all the database files in the set. 

If the database you have open is not in a concatenated file set, this list shows only
that database.

2. Click the Add button.

3. Locate and Select the database file you want to join with your current database.

 The file path is added to the Concatenated Databases box.

The Current Database panel in the Databases task pane displays all the
concatenated databases, the total number of documents in the concatenated set,
and whether the databases need reindexing.

Joined databases in a Concatenated database set only remain concatenated for the
current session unless you save the concatenated database set. Once you close
out of the database, the concatenation is removed from each of the databases in
the set.

To remove the database concatenation, on the File menu, click Administration,
then Concatenate, and then Clear Concatenation. You can only use this method
if you are a Concordance Desktop Administrator on the server where the databases
reside. 

The Table view layout corresponds to the active database you are reviewing. If
you view a record from a concatenated database, your Table view layout changes
to display the fields and sort order for that database. Remember to reference the
Concordance Desktop Title bar to see what database you are viewing for a
particular record.

If you are reviewing multiple joined databases at a time, it may be helpful to
change the font color or size in each database to help you differentiate between
the databases at a glance.

Opening a concatenated file set

When you open the primary database file of a concatenated file set, Concordance Desktop
automatically opens each of the databases joined together in the file, and lets you search
and review the set of databases as if they were all one database.
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To open a concatenated file set:

· In Concordance Desktop, open the "Primary" database of the concatenated file set
or from the File menu, click Connect and then select the primary database. 

The "Primary" database is the database that was opened first and to which the
other databases were joined. 

Deleting a concatenated file set

If users no longer need databases to be joined in a concatenated file or they no longer
need them to automatically launch each time the primary database is launched, you can
remove the concatenated file set from within Concordance Desktop. In order to delete a
concatenated file set, you must be an administrator on the Concordance Desktop server
where the databases of the concatenated file set are registered.

To remove a concatenated file set

1. In Concordance Desktop, open the "Primary" database of the concatenated file set. 

The "Primary" database is the database that was opened first and to which the
other databases were joined.

2. From the File menu, click Administration, then Concatenate, and then Clear
Concatenation.

Note that you must be an administrator user in order to delete a concatenated file
set. 

3. You are asked to confirm the action, click Yes.

Removing a database from a conatenated file set

You can only remove a database from concatenated set, or delete a concatenated file set
if you are a Concordance Desktop administrator on the Concordance Desktop server where
the concatenated databases are registered. When you delete a concatenated file set, it
removes the concatenation only. The databases still remain on the server and become
individually accessible.  
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When you remove a database from an automatically concatenated set of databases,
record numbering across the remaining databases will no longer be sequential. This is
due to the removal of numbered records in the database that was removed, thus
causing a break in the sequential order of the numbering. 

To remove a database from a concatenated file set:

1. In Concordance Desktop, open the "Primary" database of the concatenated file set. 

The "Primary" database is the database that to which all the other databases were
joined. 

2. On the File menu, click Administration, then Concatenate, and then Edit
concatenation. 

The Concatenated Databases dialog box opens.

3. Click on the database you want to remove from the concatenated file set. 

4. Click the Delete button.

5. Repeat steps 3 and 4 for each database you want to remove from the
concatenated set. 

Reviewing concatenated databases

When reviewing concatenated databases, it can sometimes be difficult to distinguish data
from each database at-a-glance in the Table view. In the Table view, you can change the
text font and color for each database and use table layouts to help you review
concatenated databases.

Applying tags to concatenated databases is as simple as applying tags to individual
databases. You can even add tags from one database to another database in a
concatenated set.

Reviewing concatenated databases in the Table view

When you are viewing a concatenated database set, you can change the font color or
size in the Table view for individual databases to help you differentiate between the
databases at a glance.
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You can identify a database in a concatenated set in the following ways:

· Reference the Concordance Desktop title bar for an individual record’s database and
document name

· Reference field names for each database displayed in the Table view

· Change the font color and size for each database in the Table view

When you are searching data on multiple databases, the query results from a same
name field intermingle in the Table view. The easiest way to distinguish between
database information in the Table view is by font color and size.

Example: If each database has a same name DATE field, you can run a search on this
field to gather subsets of documents by date.

date = 10/??/1983,10/??/1998,02/??/2003

This query located all documents within three different databases with a date of
October 1983, October 1998, and February 2003. As shown in the example above, the
Table view listings the black query results are from a paper database, the purple results
are from a transcripts database, and the blue results are from an e-mail database.

Reviewing concatenated databases using Table Layouts

You can also adjust your Table view layouts if field names are similar to sort across the
joined databases. Each concatenated database will be listed in the Table Layout dialog
box with private and any public layouts that have been created. You will need to
manually rearrange fields to have them display in the same columns for sorting
purposes.

Copy the .LAYOUT file from one database to other concatenated databases to use
the same table layouts in the Table view.

Tagging and concatenated databases
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When databases are concatenated, all tags from both databases are displayed in the
Tags task pane. If a reviewer applies a tag from one database to a document residing
in another database, the tag is then added to the database where it never existed
before.

Saving searches in concatenated databases

When searching concatenated databases, Concordance Desktop searches across all
concatenated databases but because it searches each dictionary file one by one,
searches may take a bit longer.

Saving queries executed on concatenated databases is the same process as saving them
when reviewing one database at a time. All searches from all databases in the
concatenated set are saved. Query files are stored in a .qry file, and can be restored on a
concatenated set as you would a single database. You just need the databases to be
joined when you save the query and when you re-run the query. Re-running the queries
on a concatenated database set gathers any updates made since the last time any
database was reindexed.

Adding field groups to the INI file

You or reviewers may want to search across multiple data fields at the same time without
having to construct a long search query.

Writing field groups directly to an .ini file allows you to use an alias name to search across
multiple fields at the same time without having to construct a long search query.

Example: Aliasname = fieldname1, fieldname2

ALLDATES = DATE, DOCDATE

By creating an alias field named ALLDATES and associating it with all various date fields
from a concatenated database set, users can search all date fields without having to
modify date field names in each database. You can also create a field group for data fields
in a non-concatenated database.

The CREATEDATE and CREATIONDATE fields, or their equivalents, cannot be included
in a field group because of the validation settings applied to them.

Field groups written directly into an .ini file will also save into a Concordance Desktop
database template.

To add a field group to the .ini file:
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1. In Microsoft Windows Explorer, navigate to the database .ini file you want to add a
field group. 

The .ini file is stored in the same directory as the database's .dcb file. 

2. Right-click and open the .ini file in any text editor program.

3. Scroll to the bottom of the file.

4. In the next line after the last record, type [FieldGroups] and press Enter.

5. Type the Aliasname = fieldname1, fieldname2, fieldname3.

For example: Date = DOCDATE,DATE,GMT_DATE,MODDATE,PRINTDATE

You can add as many fields as you need to the field group.

6. Save the .ini file.

7. To test the field group you created, in Concordance Desktop, run a search for the
field group alias you created.

For example: Date = ??/??/1982, ??/??/2000.

Your search results should include the applicable data from the fields within the field
group you created. 

To use a field group for concatenated databases, add the same field group to the
other databases in the concatenated database set. When you search the
concatenated database set, Concordance Desktop searches the all the fields in the
field group in each of the databases in the concatenated set.

Printing from concatenated databases

When printing from a concatenated database set, you have the option to show or hide
certain fields.
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If you are printing a standard report in Concordance Desktop, you need to designate the
database you are printing from, on the Fields tab in the Print documents dialog box. 

To open the Print documents dialog box:

1. From the standard toolbar, click the Print button.

2. Optional: From the Field tab, select the fields you want to print and/or arrange the
field order for printing.

For more information about printing standard reports, see Printing standard reports.

Backing Up and Archiving Databases

There are a couple of options for backing up your Concordance Desktop databases. Before
backing up your Concordance Desktop database, you need to determine how long the
backup process may take, given the size of the database files. The backup process could
take many hours, so having a solid estimate helps you plan backup maintenance
schedules.

Research the network’s automatic server backups and how it may impact Concordance
Desktop database files. Database files automatically backed up in this manner often take
longer to restore, therefore, they are probably not a practical method to rely on as your
sole source for database copies. 

Do not perform live backups if you are using backup software that locks files, even
briefly. This has been known to cause read/write functions to the database files to
fail, and can cause file synchronization or corruption issues. Check with your IT group
and/or backup solution provider to verify that no file locking occurs before scheduling
any backups on Concordance Desktop files that are in use.

Be aware that anti-virus, firewall, and backup software can often interfere with
network traffic and the locking of files, and in effect, could cause Concordance
Desktop, Concordance Desktop Image, and Concordance Desktop server software to
crash.

It is best practice to use the following methods for routine backup procedures:

· Verify that you are not backing up your databases while they are in use either by tape
or by manually making a copy. Any locking of files while users are updating those same
files can produce erroneous results. Using snapshots on your data storage devices can
reduce these effects because they do not lock the files.

· To create a backup of a Concordance Desktop database, use the Export Wizard
provided in Concordance Desktop. Exported databases do not include tag history, 
redlines, or the imagebase. To retain this data in your back up, you should replicate
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the database. To include tag history, run the TagSaver.cpl and
TagHistoryandStoreIt.cpl. Either way, you are storing a backup of your database files
in the event they need to be restored later. To save your redlines and imagebase,
backup the .CIB file separately. In lieu of using the wizard, you can backup the whole
database folder by copying and pasting the whole folder to another location.

When backing up databases, you should also consider the following:

· If user management  is applied at the database level, back up the .sec files

· Back up tags using the TagSaver.cpl and TagHistoryandStoreIt.cpl

· Back up redlines and imagebase by using another backup method to backup the .CIB
file.

· Do not forget to copy over your list files, queries, exported user management, and .gat
files, etc.

· Verify that your anti-virus does not scan any of the following file
types: .trk, .key, .dct, .dir, .fzy, .layout, .sec, .cib

Backing up tags may take days for some databases, and loss of tagging information
can jeopardize a case review. Please make time to research and test this process so
you understand how to best schedule this task regularly.

About Concordance Desktop database files

When you create a database, you import the initial load files to populate the database
with records. These initial files can be either PST files, electronic documents, or delimited
text files prepared by a vendor (or other party), and can be imported as you create the
new Concordance Desktop database. Concordance Desktop provides a Creation Wizard to
help you create and import the documents all together. 

· You can import the following types of files:

· Delimited text file

· Native files

· Electronic documents

· E-mails and attachments

· Transcripts

· Concordance Desktop databases

Each Concordance Desktop database uses several files during operation. Only four are
absolutely required to open and use a database. The four mandatory files are the
database control block (.dcb), the numeric, date, and text file (.ndx), the text file (.txt),
and the user management file (.sec). All of the other files can be recreated without
damaging the integrity of the data. At a minimum, these four files should be backed up for
archival purposes.

For more information see backing up databases. 
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A B-tree file uses a tree data structure to provide fast search results. The tree data
structure minimizes the number of times the database is accessed when searching for
a record, resulting in faster searches.

The .TRK file in Concordance Desktop uses SQLite. SQLite is an embedded relational
database engine, which brings more stability to the functions of the .TRK file.
Because SQLite is an embedded database, SQLite does not increase the required
maintenance and administration of Concordance Desktop.

Concordance database files

Concordance Desktop Database Files

Name  File Description Usage File Type

.cat Concatenation Stores a list of concatenated databases Text file

.cib Imagebase Stores association between media keys
and native and image files including
markup history 

SQLite file

.cpl CPL script Store Concordance Desktop
Programming Language (CPL) scripts

Script file

.cpt CPL script Stores compiled versions of CPL script Script file

.csv User management Stores field and menu access for all users
(when exported by user)

Text file

.dat Delimited text Contains metadata and sometimes OCR
for document records

Text file

.dcb Data control block Database definition, including fields,
document count, and other settings

.dct Dictionary All unique words in the database, in
alphabetical order 

This is not a plain text file, it cannot be
read or edited by a text editor or word
processor

B-tree file

.fmt Print settings Saves print settings for reports
generated using the standard print
feature

User generated file
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Concordance Desktop Database Files

Name  File Description Usage File Type

.fyi Concordance
Desktop
Concordance
Desktop server
database

A link file that opens a database on a
remote Concordance Desktop server

Text file

.fzy Fuzzy search
dictionary

The fuzzy search dictionary contains
homonyms for words in the search
dictionary

This file is created and updated by
indexing and reindexing

B-tree file

.gat Back Up A tag backup file that stores tagging
information. Generated by running the
TagSaver.cpl

.ini Configuration
settings

Stores various configuration settings Text file

.ivt Inverted text Used with the dictionary during searches

.key Key fields Field storage for fast relational searching B-tree file

.layout Table layout Stores the defined table layouts B-tree file

.sortlayo
ut

Sorting layout Stores the defined sorting layouts for the
current database

.editlayo
ut

Editing layout Stores the defined editing layouts for the
current database

.lst Word lists Contains predefined values that can be
selected from a list when editing fields

When a list is assigned to a specific field,
it's called an Authority List

B-tree file

.ndx Numeric, date, and
text fields

Stores data for the fixed length field
types: Numeric, Date, and Text

.opf Print settings A Concordance Desktop Image print file
that stores print settings for print jobs
generated by Concordance Desktop
Image (Opticon)

User generated
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Concordance Desktop Database Files

Name  File Description Usage File Type

.qry Query Stores search query strings

.sec User management
control

Stores user management settings B-tree file

.snp Snapshot Stores search history and auto-restore
settings

.stp Stopwords Contains the noise words that are
ignored during database indexing

B-tree file

.syn Synonyms Stores the user defined synonyms B-tree file

.tex Text Full text paragraph field storage Text file

.trk Transaction tracking Relational SQLite file structure that
stores tags and tag histories, security
(field and menu access for all users) and
replication data

SQLite file

.xrl Markup Stores the current state of markups and
placeholders

Temporary files

Concordance Desktop creates and uses temporary files, which are automatically erased
when you leave the program. However, temporary files are not erased if there is a
power outage or other problem which causes an irregular program termination.
Concordance Desktop places the files in the system's temporary directory as defined by
the Windows TEMP environment variable. The two most common functions that create
temporary files are indexing and reindexing.

When indexing a database, two temporary files are saved in the local computer's temp
directory. Both files begin with the prefix C- and end with the .tmp extension. These
files represent the temporary .dct and .ivt files. They are not initially saved on the
network server since network latency would severely decrease performance. When
indexing is complete, the resulting .dct and .ivt files are copied to the Concordance
Desktop server.

When reindexing a database, the same temporary files are saved in the local computer's
temp directory. In addition, a temporary dictionary file with a .dcb file extension is
saved in the local computer's database directory. This file contains information from the
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newly created records. Near the end of the reindexing process, this dictionary file is
merged with the main dictionary file on the network server.

For more information about indexing and reindexing, see Indexing Databases. 

About archiving databases

Archiving of databases is standard practice for corporate environments, and you will want
to adhere to those guidelines with Concordance Desktop databases. You may want to
make additional archives for maintenance reasons too, ensuring that you have adequate
archive files for case history and research. Reviewers are known to come back, even
years later, and want to research a case history if they are working on a similar one. Many
vendors offer vault storage and web repository environments for data retrieval in the
event of a disaster, or merely to restore data from an archive library.

Another consideration for you is to think about creating a database archive using
Concordance Desktop. Because the storage capacity for records is vast, an archive library
may work well for your organization in researching old records and case history data.

Minimum Required Files for Archiving

Task File Type Use

.dcb Database Primary database control block.

.ndx Index Fixed field and document status storage.

.tex Text Full-text paragraph field storage.

Archiving Guidelines:

· Run the Tag To Field command in the Tag and Issue Management dialog box, and the
TagHistoryandStoreIt.cpl to track and manage tags in a field.

· There are three minimum files needed to archive a database: .dcb, .ndx, .tex.

· Export to a delimited text file because it is a universal archive format that is retrievable
in years to come.

· Ask yourself whether you really need to archive images; these files are huge and
require adequate media storage.

· Move files to a long-term, archive-quality media.

· Schedule data destruction per corporate policies; determine how long do you need to
keep the copies.

· Keep an updated list of archive files for you or another administrator to reference.
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Exporting Data

Concordance Desktop offers a variety of options for exporting data in order to back up
databases or save data into a format that can be imported into another database. Data
exports are often required when there is a need to share data with other parties or for
document production.

In Concordance Desktop you can export:

· As a Concordance Desktop database

· To an OPT file for use with Concordance Desktop Viewer

· To a delimited text file

· To a database structure for creating a database template

· Database transcripts into .PCF or delimited text files

Exporting data covers two scenarios:

· Exporting data for backup files and internal case review

· Producing images and information for third parties or opposing counsel

Exporting databases

When you export a Concordance Desktop database, you have the option to export to an
existing database or to create a new database. The export includes every record in the
current query, in the sort order they are listed. By default, all fields, data, and tags, are
also exported, but you also have the option to select only specific fields for export. 

Security and tag history are not included in the export when you export a database. You
can export a database's security settings from the Security dialog box. For more
information about exporting security settings, see Setting up security.

Before exporting a database, you can store the database's tag history in one of the
database's fields using TagHistoryAndStoreIt_v10.00.

When exporting to an existing database, fields are only copied if they exist in both
databases.

To export a Concordance Desktop database:

1. Run a search query to locate the records you want to include in the export.

For more information about searching, see Available search tools.
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When Concordance Desktop exports a database, Concordance Desktop can export
just the records in the current query or can export all the records in the database.
If you want to export all the records, you can run the Zero Query.

For more information about the Zero Query, see Reviewing search queries.

2. On the Documents menu, point to Export, and click As a Concordance Desktop
database.

Clicking As a Concordance Desktop database opens the Export Wizard - Database
dialog box.

3. Click the Browse button to open the Select database to merge dialog box.

4. If you are exporting to an existing database, navigate to and open the .dcb or .fyi
file for the database you are exporting to.

If you are exporting to a new database, navigate to where you want to store the
database, type the database name in the File name field, and click Open.

Clicking Open adds the database file name and directory to the Database field in the
Export Wizard - Database dialog box.

5. Click Next to open the Export Wizard - Fields dialog box.

The database list defaults to the database currently opened and all the database's
fields are selected in the field list.

When exporting to an existing database, fields are only exported if the fields match
the fields in the existing database. 
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If the database is a concatenated database, the other databases in the
concatenated set are also available for selection in the database list. 

When exporting concatenated databases, only the data in fields that are identically
named and formatted in the concatenated set will be exported.

6. To include only some of the database fields in the export, in the fields list, click the
fields you want to export.

To select multiple fields, use SHIFT+click or CTRL+click.

7. Click Next to open the Append/Replace dialog box.

The Append/Replace dialog box allows you to control how documents are exported. 

8. Choose one of the following options:

· Append all records - When you select this option, if you are exporting to a new
database, the export adds all records in the query to the new database. If you
are exporting to an existing database, the export appends all records in the query
after the last record in the existing database. 

· Replace matching records and append new records - When you select this
option, the export searches for a matching record and replace it. If the export
does not find a match, it appends the record.

The Delete and replace existing annotations and tags check box is only available
when you select the Replace matching records and append new records option. The
Delete and replace existing annotations and tags check box determines how
annotations are copied when an existing record is updated. By default, the check
box is not selected. 

9. To have the export remove all existing tags and annotations for a record in the
existing database when the export finds a matching record, select the Delete and
replace existing annotations and tags check box. 

When the check box is selected, any annotations from the matching exported
record are added to the record.

To have the export ignore any existing tags and annotations for a record in the
current database when the export finds a matching record, make sure that the
Delete and replace existing annotations and tags check box is cleared.

The export uses the fields selected in the Locate matching records by comparing
field to determine exact record matches between the two databases. The Locate
matching records by comparing field is only available when you select the Replace
matching records and append new records option. Only key fields are listed in the
Locate matching records by comparing field. 

Key fields are defined in the Modify dialog box. For more information about key
fields, see Creating databases. 
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10. In the Locate matching records by comparing field, select the fields you want
the export to use to determine record matches.

To select multiple fields, use SHIFT+click or CTRL+click.

Full-text paragraph fields are considered a match if the first sixty characters or the
first line, whichever is less, match, regardless of the remaining contents of the
field. 

11. To copy a record's attachments with notes during the export, select the Copy
attachments with notes check box.

When the Copy attachments with notes check box is selected, the export
automatically creates sequentially numbered attachment folders in the same
directory as the Concordance Desktop database, and copies attachments into the
subfolders. Folders are named in the format ATTACH-000000 and increment by one
if the initial folder exceeds maximum capacity. 

To exclude a record's attachments with notes from the export, clear the Copy
attachments with notes check box.

12. Click Next to open the Export Wizard - Export dialog box.

The First and Last fields default to the first and last record in the current query. 

13. To modify the range of the records to be exported, in the First field, type the
record number for the first record in the range you want to export, and in the Last
field, type the record number for the last record in the range you want to export.

14. Click the Export button.

If you are exporting to a new database clicking the Export button opens the
following message:

15. Click Yes to start the export and have the export create the new database.

If you are exporting to an existing database, clicking the Export button starts the
export.

You can click the Cancel button at any time to cancel the process.
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When the export finishes, the Export Wizard - Export dialog box automatically
closes.

Exporting delimited text files

In Concordance Desktop you can export data directly to another Concordance Desktop
database or save the records as delimited text files.

The benefit of exporting to delimited ASCII files is that this format is universal and works
in other database management systems. Some forethought in planning the export of these
files includes understanding that there are certain features in Concordance Desktop that
have no parallel in other database managers such as Microsoft SQL Server and Microsoft
Access. These features include record tags, issue coding, annotations, attachments, and
hypertext links. Exporting in Concordance Desktop delimited text files does not preserve
record mark-ups.

When you export database records to a delimited text file, the export includes every
record in the current query, in the sort order they are listed. If you want to export the
entire database, run the Zero Query. For more information about the Zero Query, see
Reviewing search queries.

when you export records to a delimited text file you can export the records using the
Export Wizard to guide you through the export process or you can manually export the
records using the Export Delimited ASCII dialog box.

When exporting records to a DAT file that will be imported into another Concordance
Desktop database, do not use the "new line" (code 013) as the carriage return
delimiter. Use the standard Concordance Desktop newline delimiter (code 174).

When exporting concatenated databases, only the data in fields that are identically
named and formatted in the concatenated set will be exported.

To export to a delimited text file using the Export Wizard:

1. Run a search query to locate the records you want to include in the export.

For more information about searching, see Available search tools.

When exporting from Concordance Desktop, Concordance Desktop can export just
the records in the current query or can export all the records in the database. If
you want to export all the records, you can run the Zero Query.
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For more information about the Zero Query, see Reviewing search queries.

2. On the Documents menu, click Export, and then To a delimited text file.

Clicking the option To a delimited text file opens the Export dialog box.

3. Click the Export Wizard option and click OK.

The Export Wizard - Documents dialog box opens.

The First and Last fields default to the first and last record in the current query. 
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4. To modify the range of the records in the query to be exported, in the First field,
type the record number for the first record in the range you want to export, and in
the Last field, type the record number for the last record in the range you want to
export.

5. Click the Next button to open the Export Wizard - Format dialog box.

Concordance Desktop is a full-text database manager. Its documents are likely to
contain text delimiters — commas, quotes, and carriage returns — that may confuse
other programs, or Concordance Desktop itself, when reading the delimited text file.

To avoid this problem, Concordance Desktop allows you to specify the characters
recognized as the comma, quote, and newline delimiters in delimited text files.

The Format field defaults to Concordance Desktop default.

If you are exporting and importing documents within the Concordance Desktop
system, then you won't need to change these default values. Change them only if
you are using these characters in the text of your documents.

Default Delimiters for Concordance
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The default delimiter characters used by Concordance Desktop are listed below.
To the right of each delimiter character is the delimiter's numeric value. 

Concordance Desktop Default Delimiters

Delimiter Character Function Numeric Value

Comma The field delimiter separates one field
from the other.

20

Quote The text qualifier encloses text to
differentiate it from field delimiters
which may appear in the data.

254

Newline Substitute carriage return. Some
programs use this character to
designate multi-level fields or fields-
within-fields. Concordance Desktop
replaces all carriage returns or
carriage return linefeed combinations
with the newline code within the
data of a field. The record itself is
still terminated with a real carriage
return and a line feed.

174

The delimiters available from the Comma, Quote, and Newline fields may appear as
square symbols or may not be displayed. How the lists are displayed depends on
the computer's language environment. The delimiters listed in the About delimiter
characters topic use the Tahoma font, which displays the characters regardless of
the language environment. All of the characters listed in the delimiter character list
can be selected as the delimiter, even if the symbols they represent do not appear
in the Comma, Quote, and Newline fields.

To see the list of available delimiter characters, see About delimiter characters.

6. Click Next to open the Export Wizard - Date format dialog box.
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7. Click the date format you want to use in the delimited text file. 

The dates exported from the database to the delimited text file will be exported using
the date format you select in the Export Wizard - Date format dialog box.

8. Click Next to open the Export Wizard - Fields dialog box.
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By default, all of the database fields are added to the Selected fields list for the
export. 

9. To only select some of the fields for the export, click the double arrow (<<) button
to move all the fields to the Available fields list.

10. In the Available fields list, select the fields you want to include in the export, and
click the right arrow (>) button to add the fields to the Selected fields list. 

11. To change the order of the fields in the export, in the Selected fields list, click the
field you want to move  and click the Up or Down button to move the field.

The field order in the Selected fields list will be the field order in the delimited text
file.

12. To display hidden system fields in the Export Wizard - Fields dialog box, select the
Show system fields check box.

System fields are fields used by Concordance Desktop to administer database
functions, such as replication. They are generally not visible, but you can display
and export them if you select the Show system fields check box.
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13. To include field names in the export, select the Export field names check box.

If the Export field names check box is selected, field names are exported as the first
record, with each field name taking the place of its field's data for that record.
Exporting field names can help manage data if the data is imported into another
program.

14. To export Concordance Desktop data with rich text, select the Export rich text
check box.

Full text paragraph fields in Concordance Desktop can contain rich text. Rich text
contains font changes, bullet lists, and other word processor commands that other
database programs cannot handle. You can export with rich text if the data is
destined for another Concordance Desktop database. Do not export rich text if the
data is destined for another program. 

If the Export rich text check box is not selected, all text formatting is stripped from
the exported data during the export.

15. Click Next to open the Export Wizard - Save dialog box.

16. Click the Browse button to open the Save As dialog box.
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17. Navigate to where you want to save the delimited text file, in the File name field,
type the file name, in the Save as type field, select the type of text file you want
to create, and click Save.

Clicking Save adds the delimited text file name and directory to the Database field in
the Export Wizard - Database dialog box.

18. To export the data in ANSI (American National Standards Institute) format, select the
Export in ANSI format check box.

You will want to select the Export in ANSI format check box if you will be importing the
delimited text file into an application that does not support the Unicode Standard, such
as importing into Concordance version 2007 or earlier.

For more information about the Unicode Standard and Concordance Desktop, see About
the Unicode Standard.

When exporting to ANSI or ASCII format, characters that cannot be represented
as a single-byte character will be lost in the export. For an example, see the
"Export Issues and Tips" section in the About the Unicode Standard topic.

19. Click Next to open the Export Wizard - Finish dialog box.
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20. Click the Finish button to export to the delimited ASCII file.

The Export Wizard - Finish dialog box automatically closes when the export
finishes.  

To export to a delimited text file using the Export Delimited ASCII dialog box:

1. Run a search query to locate the records you want to include in the export.

For more information about searching, see Available search tools.

When Concordance Desktop exports a database, Concordance Desktop can export
just the records in the current query or can export all the records in the database.
If you want to export all the records, you can run the Zero Query.

For more information about the Zero Query, see Reviewing search queries.

2. On the File menu, click Export, and then To a delimited text file.
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Clicking To a delimited text file opens the Export dialog box.

3. Click the Export dialog box option and click OK.

Clicking OK opens the Export Delimited ASCII dialog box.

By default, all of the database fields are added to the Selected fields list for the
export. 

4. To only select some of the fields for the export, click the Remove all button to
move all the fields to the Available fields list.
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5. In the Available fields list, select the fields you want to include in the export, and
click the Select button to add the fields to the Selected fields list. 

To change the order of the fields in the export, click the Remove all button to add
all the fields to the Available fields list and then add each field to the Selected fields
list in the order you want the fields to be listed. The field order in the Selected
fields list will be the field order in the delimited text file.

6. To include field names in the export, select the Export field names as first record
check box.

If the Export field names as first record check box is selected, field names are
exported as the first record, with each field name taking the place of its field's data
for that record. Exporting field names can help manage data if the data is imported
into another program.

7. To export Concordance Desktop data with rich text, select the Export rich text
check box.

Full text paragraph fields in Concordance Desktop can contain rich text. Rich text
contains font changes, bullet lists, and other word processor commands that other
database programs cannot handle. You can export with rich text if the data is
destined for another Concordance Desktop database. Do not export rich text if the
data is destined for another program. 

If the Export rich text check box is not selected, all text formatting is stripped from
the exported data during the export.

8. To export the data in ANSI (American National Standards Institute) format, select the
Export ANSI check box.

You will want to select the Export ANSI check box if you will be importing the delimited
text file into an application that does not support the Unicode Standard, such as
importing into Concordance Desktop version 2007 or earlier.

For more information see About the Unicode Standard.

When exporting to ANSI or ASCII format, characters that cannot be represented
as a single-byte character will be lost in the export. For an example, see the
"Export Issues and Tips" section in the About the Unicode Standard topic.

The First and Last fields in the Range section default to the first and last record in
the current query. 

9. To modify the range of the records in the query to be exported, in the First field,
type the record number for the first record in the range you want to export, and in
the Last field, type the record number for the last record in the range you want to
export.

Concordance Desktop is a full-text database manager. Its documents are likely to
contain text delimiters — commas, quotes, and carriage returns — that may confuse
other programs, or Concordance Desktop itself, when reading the delimited text file.
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To avoid this problem, Concordance Desktop allows you to specify the characters
recognized as the comma, quote, and newline delimiters in delimited text files.

The Comma, Quote, and Newline fields default to the default delimiters for
Concordance Desktop.

If you are exporting and importing documents within the Concordance Desktop
system, then you won't need to change these default values. Change them only if
you are using these characters in the text of your documents.

Default Delimiters for Concordance

The default delimiter characters used by Concordance Desktop are listed below.
To the right of each delimiter character is the delimiter's numeric value. 

Concordance Desktop Default Delimiters

Delimiter Character Function Numeric Value

Comma The field delimiter separates one field
from the other.

20

Quote The text qualifier encloses text to
differentiate it from field delimiters
which may appear in the data.

254

Newline Substitute carriage return. Some
programs use this character to
designate multi-level fields or fields-
within-fields. Concordance Desktop
replaces all carriage returns or
carriage return linefeed combinations
with the newline code within the
data of a field. The record itself is
still terminated with a real carriage
return and a line feed.

174

The delimiters available from the Comma, Quote, and Newline fields may appear as
square symbols or may not be displayed. How the lists are displayed depends on
the computer's language environment. The delimiters listed in the About delimiter
characters topic use the Tahoma font, which displays the characters regardless of
the language environment. All of the characters listed in the delimiter character list
can be selected as the delimiter, even if the symbols they represent do not appear
in the Comma, Quote, and Newline fields.

To see the list of available delimiter characters, see About delimiter characters.

10. In the Date format field, click the date format you want to use in the delimited text file. 
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The dates exported from the database to the delimited text file will be exported using
the date format you select in the Date format field.

11. Click the OK to open the Unload delimited file dialog box.

12. Navigate to where you want to save the delimited text file, in the File name field,
type the file name, in the File of type field, select the type of text file you want to
create, and click Open.

Clicking Open initiates the export to the delimited ASCII file. 

The Export Delimited ASCII dialog box automatically closes when the export finishes.

Exporting database structures

You can export a copy of the database structure to create a duplicate database or to
create a new database template based off a current database. The structure is stored in
a .dcb file and contains the original field names and their types. Data exported from a
database can be loaded into another database that has been exported.

Before exporting a database structure, you can save the structure to a .txt file that you
can print for your reference. The text file contains a list of all the database's fields and
field types. 

 Keep the following in mind when exporting concatenated databases:

· Concordance Desktop exports data from all databases within a concatenated set only
when the concatenated databases have identical database structures.

· When exporting from a concatenated set with different database structures, the
contents from the secondary database gets exported only for the fields that match the
primary database. The remaining field contents will not be exported.

To export a database structure to create a template, see Using a database template. 

To populate a database with data from another database, see About importing files.

To save a database structure to a .TXT file:

1. In Concordance Desktop, open the database with the database structure you want
to save.

2. On the File menu, click Modify.

Clicking Modify opens the Modify dialog box.
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3. Click the Save to File button to open the Save Field Definitions dialog box.

4. Navigate to where you want to save the file, in the File name field, type the file
name, and click Save.

To export a database structure:

1. In Concordance Desktop, open the database with the database structure you want
to export.

2. On the Documents menu, point to Export, and click Structure.

Clicking Structure opens the Copy Structure dialog box.

3. Navigate to where you want to save the database structure .dcb file, type the
name of the database file in the File name field, and click Save to export the
database structure.

Exporting transcripts

Administrators are not typically involved in the general printing of transcripts, but may be
asked to export transcript files from Concordance Desktop into another application such as
West LiveNote.

Transcripts can be exported to the West LiveNote standard Portable Case Format (.pcf)
file structure or to a delimited text file. This allows you to export several transcripts to a
single file, keeping annotations, quick marks, notes, and issue codes intact. Hyperlinks are
also transferred, but any external files they link to are not transferred and must be copied
manually.

Transcripts can also be exported to delimited text files. For more information about
exporting to delimited text files, see Exporting delimited text files.

When exporting concatenated databases, only the data in fields that are identically
named and formatted in the concatenated set will be exported.

To export transcripts to a .pcf file:

1. In Concordance Desktop, open the database containing the transcripts you want to
export.

2. Run a search query to locate the transcripts you want to include in the export.
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For more information about searching, see Available search tools.

When exporting from Concordance Desktop, Concordance Desktop can export just
the records in the current query or can export all the records in the database. If
you want to export all the records, run the Zero Query.

For more information about the Zero Query, see Reviewing search queries.

3. On the Documents menu, click Export, and then Database transcripts.

Clicking Database transcripts opens the Export Transcripts dialog box.

4. To export only the current transcript, select the Export current transcript option.

5. To export multiple transcripts, select the Export transcripts option.

When you select the Export transcripts option, the First transcript and Last
transcript fields become available. The First transcript and Last transcript fields
default to the first and last record in the current query. 

To modify the range of the transcripts in the query to be exported, in the First
transcript field, type the record number for the first transcript in the range you
want to export, and in the Last transcript field, type the record number for the last
transcript in the range you want to export.

6. To export the data in ANSI (American National Standards Institute) format, select the
Export in ANSI format check box.

You will want to select the Export in ANSI format check box if you will be importing the
delimited text file into an application that does not support the Unicode Standard, such
as importing into Concordance version 2007 or earlier.

For more information see About the Unicode Standard.

When exporting to ANSI or ASCII format, characters that cannot be represented
as a single-byte character will be lost in the export. For an example, see the
"Export Issues and Tips" section in the About the Unicode Standard topic.



Administration 437

7. Click the Export button to open the Save As dialog box.

8. Navigate to where you want to save the transcript .pcf file, type the name of the
transcript file in the File name field, and click Save to export the transcripts.

Once the transcript .pcf file is created, the file can be imported in to West
LiveNote. For more information about importing .pcf files into LiveNote, see the
West LiveNote documentation.

Exporting to Concordance Desktop Viewer

Concordance Desktop load file formatting

A load file (.opt, .log, .txt) format is a delimited ASCII file containing all information
necessary to insert links into the imagebase. The load file consists of seven delimited
entries. Reference the following table and examples when formatting images.

Image Load Files

Format Description

ALIAS Should match your media (image) key from the Concordance
Desktop database. Concordance Desktop stores this key in order
to reference the image.

VOLUME Name of the volume where the documents and images reside,
typically the volume name of a CD or DVD server.

PATH Full path and file name (and extension) of the image.

DOC_BREAK Enter a Y to denote whether this image marks the beginning of a
document.

PAGES Number of pages associated with the image

Character Description

Y First page of a document

Comma (,) Indicates a page break or pages

Example: Concordance Desktop viewer format for single-page TIFF files
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00010002,NROTEK001,NROTEK001\001\00010002.tif,Y,,,1

00010003,NROTEK001,NROTEK001\001\00010003.tif,Y,,,1

00010004,NROTEK001,NROTEK001\001\00010004.tif,Y,,,3

00010005,NROTEK001,NROTEK001\001\00010005.tif,,,,

00010006,NROTEK001,NROTEK001\001\00010006.tif,,,,

Example: Concordance Desktop viewer format for Multiple-Page PDF files

00010036,NROTEK001,NROTEK001\001\00010036.pdf,Y,,,29

00010065,NROTEK001,NROTEK001\001\00010065.pdf,Y,,,2

00010067,NROTEK001,NROTEK001\001\00010067.pdf,Y,,,3

00010070,NROTEK001,NROTEK001\001\00010070.pdf,Y,,,1

00010071,NROTEK001,NROTEK001\001\00010071.pdf,Y,,,1

A load file does not necessarily need the volume name, but still needs the
parameter for the volume name (the commas).  Example format: 
Imagekey/Alias,Volume Name,Pathname,Doc Break,Folder Break, Box Break, Page
Count - without the VOL name would look like this:  0000001,,D:
\VOLO001\001\0000001.tif,Y,,,1

A document or image file path cannot contain a comma (,) when exporting to
Concordance Desktop Viewer. The comma is used as a delimiter in the exported
OPT file.

Unique identifier (Media Key)

Your load file format’s alias (media key) should match your image key from the
Concordance Desktop database. Concordance Desktop stores this key in order to
reference the image.

The alias in your load file matches the database field that has the Image check box
selected on the Modify dialog box for the database in Concordance Desktop. For
more information about the Image check box, see About fields.

The Concordance Desktop viewer will not load documents and images if the media
(image) key contains over 1000 characters or a comma (,).
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To export native files for use in the viewer:

1. Create the database you want to export. For information on creating a database,
see Creating a new e-documents database.

2. Import the data into the database. 

3. Verify that each record has a unique identifier in the field that you marked as the
media (image) key field and the file path field displays the path to the native
document.

4. From the Documents menu, click Export, and then As a Concordance Desktop
database.

5. In the Export to Concordance Desktop, select the database field where the file
path is stored. 

Note the output file path. This is where the .opt file will be exported for importing in
Concordance Desktop.

Each time you perform an export, a unique OPT filename is generated with the date and
time the file is created, DBNAME_YYYYMMDDhhmmssfff (i.e.
NATIVE_20150517105932021.opt).

6. When finished, click the Camera button to view the documents and images in the
viewer.

7. In the Exported Load File section of the Imagebase Conversion Source
Selection dialog box, select the OPT file you exported, and then click Convert.

The viewer opens and displays the documents and images.

Preparing Productions

Once a document collection review is completed, documents typically need to be
produced to opposing parties, this is known as a production. Database administrators
prepare the electronic production using Concordance Desktop, based on queries or tagged
sets of documents that are identified for production during the review phase. 

Concordance Desktop provides two production options:

· Standard production - produces a set of TIF or PDF files, .opt and a .dat load file.

· Native production - copies original native files out to a production destination directory
and the files can be renamed with the production numbers. No redactions or other
production type operations happen, simply a copy and rename. for more information
about Native File production, see Running a native file production.
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It is recommended that a production run, executed from Concordance Desktop, be
performed on a machine that is not currently running any other applications. This is
due to the integration of a 3rd-party tool with Concordance Desktop that currently
switches the input focus while the production process is running. 

Before running a production, make sure that all users are logged out of the database.

Managing rolling productions

Due to the ever-increasing size of electronic productions, litigation support staff are
often faced with the task of handling and tracking large volumes of data that are
incoming and outgoing during the life cycle of an e-discovery project. As a best
practice, we recommend establishing an organized tracking method to ensure that all
data is properly handled and nothing is missed.

Examples of data types handled during E-Discovery

Here are some examples of data that can be handled during a large e-discovery: 

· Data coming from clients that needs to be processed. This could include paper
documents, electronic files, e-mail files, images, metadata load files, transcripts,
graphics, and audio/video files.

· Data being produced from opposing parties to be loaded into a review tool, such
as Concordance Desktop, for review by attorneys, paralegals, experts or
investigators.

· Data going out to vendors for processing, scanning, coding, or printing.

· Data to be processed in-house using an e-discovery processing software, such

as CloudNine™ LAW.

· Data such as exhibits, graphics, and presentations being prepared for trial to be
loaded into trial presentation software.

· Transcripts and audio/video files from court reporters to be loaded into a
transcript database for review and analysis.

· Data being copied or produced to other parties for review such as co-counsel and
experts.

· Data being produced to opposing parties.

· Data that is to be archived from the network to disk or hard drive storage.

· Data that requires special handling, such as compliance with destruction or
preservation orders.

When handling forensically collected data, be sure to follow appropriate legal
procedures for preservation, handling, and chain of custody to avoid spoliation
issues.
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Tracking data

There are many ways that data can be tracked using database software tools
specifically designed to help facilitate data tracking for e-discovery, such as
Concordance Desktop, Microsoft Access, or Microsoft Excel.

CDs, DVDs, and external hard drives are typically labeled using some sort of uniform
numbering system so that it is possible to track all incoming and outgoing volumes.
Production volumes are also usually numbered in a series for record-keeping
purposes. It is also important to keep track of production Bates number series to
avoid accidental production of documents with overlapping Bates numbers.

Archiving data

Production elements

Numbering documents

As part of the production process, a new set of files are generated for documents
that need to be produced. A Bates number series is then applied to all pages of all
documents included in the production, with the option of burning or fusing the
numbers to the image during the process. This number series usually differs from that
of your internal collection. You can then track what has actually been produced and
your Bates number series for the production is sequential with no gaps in the
numbering.

Burning annotations

Redactions or other redlines can be burned to the images during production so that
they cannot be altered. Confidentiality headers or footers can also be burned to the
images during production. Production numbers are usually cross-referenced to those
in the original review collection.

If the Concordance Desktop administrator included fields for production numbers in
your database, these numbers are then written to the production number fields
during the production process. Later when you look at your internal document
collection, you are able to see the production number for any documents that were
produced.

For multiple or rolling productions, tags or sequentially numbered production fields are
tracked for which production series a document was produced under. For example,
fields named BEGPRODNO1/ENDPRODNO1, BEGPRODNO2, ENDPRODNO2, etc.
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Production output

The output generated by a production run in Concordance Desktop is a set of TIF
images or PDF files and a load file. Both the production set and the load file are
typically burned onto CDs or DVDs (or for very large collections, an external hard drive).
Output volumes, such as CDs or DVDs, are labeled to track the production series.

Native files

For native productions, the set of documents to be produced is typically converted
to image or PDF files prior to production. Organizations need to adhere to proper
forensic procedures for handling native files. 

Generating load files and images

The output from a production is a set of images and an image load file. The output
generated depends on production requirements agreed upon with opposing counsel.
A best practice is to know in advance what the recipient needs for output format.

Production load files enable recipients to import images into their own viewer
software. Images and load files are generated for either single or multi-page, TIFF or
PDF format.

Administrators can also export specific field data to a delimited file, .dat, .csv, etc.,
to accompany the produced OPT and images.  If new production numbers are
created as part of the production, be sure to write the beginning and ending
numbers back to fields in the database so they are available for export and also
cross reference with any original document numbers.

Concordance Desktop export processes work well with most of the review tools on
the market, or Concordance Desktop data can be converted to something that will
work. 

Productions and concatenated databases

· When running productions on a set of concatenated databases for native files, all
the databases in concatenated set must have identical database structures and
have matching Media (Image) key field names across the concatenated set.

· Native file productions will only be performed on the primary database when differing
database structures (any one of the field names is different between the primary
and secondary databases or any additional fields exist in any one of the databases)
are included in a concatenated set.

· Productions for differing database structures should be run separately for each
database.

· Productions should be run on the machine without any other applications running.
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Creating a production

Concordance Desktop provides the tools you need to permanently burn headers, footers,
and annotations onto the new .tif or .pdf files. This ensures that your files are branded
properly and that opposing counsel and any internal review staff do not receive original
copies or view privileged content.

When creating productions, close any other database tabs so Concordance Desktop
does not synchronize with a different database incorrectly. We recommend having no
more than three tabs or databases open during this process. Do not attempt to open
the Admin Console while running a production.

When exporting a concatenated set for productions, you can only export fields from
one selected database structure.

Do not open the Admin Console while running a Production.

Production process overview

1. Generate new production numbers and cross-reference them back to the
Concordance Desktop database.

2. Create new files.

3. Burn in redactions and other selected annotations.

4. Create CD/DVD productions.

5. Create subsets of imagebases.

6. Create load files.

Each time you produce a batch of records, a new set of production files are created. This
ensures that original records are never changed, and that there is always a backup copy
of document changes.

When creating productions, close any other database tabs so Concordance Desktop
does not synchronize with a different database incorrectly. We recommend having no
more than three tabs or databases open during this process.

When exporting a concatenated set for productions, you can only export fields from
one selected database structure.
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Selecting image file files

Reference the Supported Image File Types table when making adjustments as needed
to match the images you are producing for image type, compression, and number of
colors.

Supported Image
Types

Compression Colors

TIFF None

1-bit

4-bit

8-bit

24-bit

Black & White

16 colors

256 colors

16.7 million colors

Pack Bits

1-bit

4-bit

8-bit

24-bit

Black & White

16 colors

256 colors

16.7 million colors

LZW

1-bit

4-bit

8-bit

24-bit

Black & White

16 colors

256 colors

16.7 million colors

PDF

Black & White

Color

Production checklist

Refer to the Pre-Production Checklist to ensure all steps are completed before running a
production.
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Pre-Production Checklist

File Numbering

Have you determined a file numbering and naming convention for
your images?

Delivery  Media

Do you have the proper production request file formats and
media delivery types from opposing counsel or other third
parties?

Tagging

Have you reviewed documents categorized for production for
possible tagging inconsistencies by reviewers?

Did you run the Tag To Field command, Tools > Manage
Tags/Issues, on production documents to capture tag activity at
the time of production? Tag names can be placed into a field
called PRODTAGS1.

Back-ups and File Storage

Did you save a backup copy of your media files before
production?

Did you back up your imagebase files?

Did you a create sub-directory folders for your new files?

Production training

Anyone tasked with preparing productions should receive Concordance Desktop
Administration training before attempting to produce documents from a live database. The
litigation industry guidelines regarding how discovery documents are handled, processed,
and shared between parties is a sensitive matter.

If you or anyone on your IT or Litigation Support Team are interested in learning more about
productions, please contact our Client Training Administrator at CloudNine Training for
additional information on Concordance Desktop certification courses, or email us at
training@cloudnine.com to register for Concordance Desktop courses.

Executing a production run

1. Locate the documents to produce

2. Marking up documents for production

3. Capture the tag activity
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4. Defining production parameters

5. Verify the produced images

6. Create a production database

Running a standard production

When using Concordance Desktop, you first need to identify and locate the documents
you want to produce.

To locate documents for a production:

1. In Concordance Desktop, open the database containing the documents you want to
produce.

2. Run a search query to locate the documents you want to produce.

For more information about searching, see Available search tools.

3. Create a tag specific to this production, such as PROD1, and apply the tag to the
applicable documents.

For more information about creating and applying tags, see Creating and applying tags.

Make sure that the proper annotations have been applied to the records you want to
include in a production. 

Annotations to consider adding to records for productions:

· Redactions to indicate and/or cover confidential or privileged information.

· White redaction to hide internal control numbers, vendor branding, and other
information you do not need to include in the production. 

In Concordance Viewer, all redactions are produced as black when Black & White is
selected in Image Settings for the production output.  Color redactions will appear as
set by the user when Color is selected for the production output.

Before running a production, you need to run the Tag To Field command, Tools > Manage

Tags/Issues. The Tag To Field command copies the contents in tags to a specific field in a
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database. Executing this command before creating the production captures tags that
were applied to each record just before the production was created. 

Running the Tag to Field command:

1. In Concordance Desktop, create a database field, such as PRODTAGS1, to store the
tag information.

2. For more information about database fields, see About fields and  Creating databases.

3. On the Tools menu, click Manage Tags/Issues.

4. In the Tag and Issue Management dialog box, click the Tag To Field button.

5. From the Select Field list, select the field you want to copy the tag names.

6. From the Select Delimiter list, select the delimiter to separate the tag names in the
field.

7. Click the Start button.

8. When prompted, do one of the following:

· Click Yes to confirm that you want to write the tag names in the selected field.

· Click No to append the tag names to the existing field contents.
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· Click Cancel to abandon the changes.

9. When finished, click Done, and verify that the selected field displays the tag names
separated by the selected delimiter.

When you run a production, you may choose to create production numbers and write the
numbers back to the database. The create production number option saves the new
production numbers to the new or appended .cib file and writes the beginning and ending
production numbers for each document back to the Concordance Desktop database to
cross-reference the information in the original record.

The Production Preferences options provide both whole number production numbers and
productions numbers that include a suffix.  

For example, the production has three documents (A, B, C) and document B contains four
pages.  The image below defines the production settings.
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The whole number production numbers are generated and written back to Concordance
Desktop as follows:
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Document Begin Production Number End Production Number

A DAT000001 DAT000001

B DAT000002 DAT000005

C DAT000006 DAT000006

Productions with the suffix added, are generated and written back to Concordance
Desktop as follows:

Document Begin Production Number End Production Number

A DAT000001.0001 DAT000001.0001

B DAT000002.0001 DAT000002.0004

C DAT000003.0001 DAT000005.0001

Each document is produced with the corresponding production and page number. 
Therefore, in the above example, each page of document B is produced with one of the
following production numbers:  DAT000002.0001, DAT000002.0002, DAT000002.0003,
DAT000002.0004.

Production is the generation of a sub-set of document TIFF or PDF files, some of which
have been redacted.  Similar to other batch processes in Concordance Desktop,
Concordance Desktop production parameter settings can be saved and used each time
you create a production.  

Before starting a production run, you need to run a query to locate all the documents for
the production, then define the production run parameters or load a saved parameter set.

If your current database is using the Concordance Desktop Viewer, follow the information
below.  Otherwise if you are using the Concordance Viewer, see Production with
Concordance Viewer.

Markups including redactions and header/footer/margin information may fail to be
included in the produced or printed output when these processes are started from a
Windows 10 workstation that is set to sleep. Windows 10 workstation used for
production or print jobs should set the workstation to never sleep. The monitor may
go into screensaver mode without issue but the workstation needs to maintain
contact with the server in order to properly complete the production or print job.

To run a production:

1. If you have not done so already, run a search query to locate the documents you
want to produce. See, Locating documents to produce.
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2. Create a directory folder to store the production files.

3. From the Tools menu click Production, and then Production.

4. If a dialog appears stating that remote databases could run slow, click Yes if you
want to continue. Click No only if you do not want to run the production at this
time. 

The Production Run Parameters dialog opens.
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5. Specify the following production parameters:

To set production run parameters:

a. From the Production Run Parameters section, in the Document Range list, click
one of the following:

· To include all the documents in the query, click All.

· To include a selected set of documents from the query, select Range, and
then specify the range of documents you want to produce. The default
range is the complete range of documents in the current Concordance
Desktop query.

b. To create production numbers, do the following:

· In the Create Production Numbers field, click Yes.

· In the Create Production Numbers from Existing Field, select the Concordance
Desktop database field name from which you want the Production numbers to
be created.

· In the Prefix field, type the prefix you want to precede the production
number. The prefix can be any combination of letters, numbers, or
punctuation that are valid folder or file names. There is a limit of 57
characters.

· In the Starting Number field, type the number you want to use to start
numbering the production files.  Zero fill your starting number to determine
the desired number width. There is a limit of 9 digits.

The Starting Number field accepts a zero-filled number up to 10 digits in
length (maximum number of two billion).

· In the Add a Numeric Suffix field, click Yes or No to add an incrementing
numeric value to a production number for each page in a document.

When adding a numeric suffix, the pages within document will be produced with a
beginning .0001 suffix and incremented accordingly. Therefore, if a single
document within the production set contains more than 10000 pages, page 9999
will contain the suffix .9999 and page 10000 will contain the suffix .10000.  This
may cause sorting issues for other applications used to view documents/images if
not loaded into the application with a corresponding OPT file.

· In the Use Production Numbers for File Names, click Yes or No to
replace the current file name with the generated production number.  

· In the Use Production Numbers for New Media Keys, click Yes or No to
replace the current media key with the generated production number in the
.cib file you specified.

· In the Copy Production Numbers to Production Fields, select either
Append Production Numbers to Field Data or Overwrite Field Data
with Production Numbers.
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· In the Beginning Production Number list, click the field you want to use
to store the beginning production number in the corresponding Concordance
Desktop database.

· In the Ending Production Number list, click the field you want to use to
store the ending production number in the corresponding Concordance
Desktop database.

When producing single-page .tiff formatted files, the Use Production Numbers
for File Names and Use Production Numbers for New Media Keys options must
be set to Yes.

The BEGPRODNO and ENDPRODNO fields are included in the standard database

template as production fields to ensure that the numbers do not append to a field

with existing data.  If the production number appends to an existing field, the

numbers may truncate if the content exceeds the field length.  

c. To create a Placeholder for unsupported or missing files, Click Yes.

· The produced image for the unsupported or missing file will appear as this:
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The placeholder pdf and tiff images are stored in the installation Program Data
folder and can be replaced with a custom image of your choosing.

To set the output location parameters:

a. In the Output Location Run Parameters section, in the CIB Database Output
Mode list,  do one of the following:

· To add the documents to an existing CIB database, click Append.

· To create a new CIB database, click Create.
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b. To generate the CIB database file to store references to the production files, in
the CIB File field, do one of the following:

· To append a current CIB database, click Browse , and then navigate to
and select the CIB file you want to append.

· To create a new CIB database, click Browse , navigate to where you
want to store the file, and then enter a new .cib file name and click Open.

c. To specify location where the output files are to be stored, in the Root
Destination Folder field, click Browse , and then navigate to and select the
folder.  

The Root Destination Folder path including the folder name should not exceed 250
characters as this may cause the application to close unexpectedly.

d. To create volume folders for the production files, in the Create Volume Folders
list, click Yes, and then do the following:

· In the Prefix field, type the prefix you want to use to precede the volume
number. The prefix can be any combination of letters, numbers, or
punctuation; however, the characters must be valid folder and file name
characters.

· In the Starting Number field, type the number, you want to use for the
starting number for the volume folders.

· In the Max Volume list, click the maximum size for the folders or create a
custom size.

The contents of the volume directories can be copied to a CD or DVD for
distribution.  If you plan to copy the production files to a CD or DVD, make
sure that you know the recording capacity of the CD or DVD prior to setting
the Max Volume value.  This ensures that the entire contents of the volume
can be copied without running out  of disk space. 

After a volume fills to the maximum size, a new volume folder is created and, if
requested, will continue sequentially. Production files will not be split across
volumes.

e. To organize the production files within the volume folder, in the Create File
folders list, click Yes, and then do any of the following:

· In the Prefix field, type the prefix you want to use to precede the file
folder number. The prefix can be any combination of letters, numbers, or
punctuation.

· In the Starting Number field, enter the number, you want to use as the
starting number for the file folders. Zero fill your starting number to
determine the desired number width. 

· In the Maximum Record Count field, type the maximum number of records
to include in each folder.

· To use the first file name in each folder as the folder name, click Yes.
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f. To specify the output type and image compression, in the Production Output File
Type list, do one of the following:

· Click PDF Single Page to convert the documents to single-page .pdf
formatted files that can be loaded into a new or existing Concordance
Desktop Viewer imagebase.

· Click PDF Multi Page to convert the documents to multi-page .pdf
formatted files that can be loaded into a new or existing Concordance
Desktop Viewer imagebase.

· Click TIFF Multi Page (Color) to convert the documents to multi-page
LZW compressed .tif formatted files that can be loaded into a new or
existing Concordance Desktop Viewer imagebase. 

· Click TIFF Single Page (Color) to convert the documents to single-page
LZW compressed .tif formatted files that can be loaded into a new or
existing Concordance Desktop Viewer imagebase.

· Click TIFF Multi Page (Black & White) to convert the documents to multi-
page CCITT Group-4 compressed .tif formatted files that can be loaded into
a new or existing Concordance Image imagebase.

· Click TIFF Single Page (Black & White) to convert the documents to
single-page CCITT Group-4 compressed .tif formatted files that can be
loaded into a new or existing Concordance Image imagebase.

LZW compression produces a small file size image, which cannot be used with
Concordance Image.

g. To specify the output color settings, from the Color Settings list, select one of the
following:

· To convert the documents to shades of gray, click Grayscale.

· To produce the files with original colors, click Color.

h. From the Fit Image Inside Headers/Footers list, click Yes.  

This option reduces the size of the produced document or image to accommodate
the space needed for the number of lines of text and font size for the specified
headers and footers.  

i. To generate a .opt file for the production files, do the following:

· In the Create OPT file, click Yes.

· Click the Output path for OPT file field, click Browse , and then navigate
to and enter a name for the .opt file.

It is recommended that you create an OPT file when using the Numeric Suffix
option to ensure the produced documents/images can be loaded properly in
Concordance Desktop viewer and Concordance Image, as well as other viewer
applications.

To specify markup types to include in the production:
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In the Markup Types section, do any of the following:

· To include all markups, from the Select All list, click Yes.

· To exclude all markups, from the Select All list, click No.

· To include some of the markups, from the Select All list, click No and then
for each mark up you want to include click Yes from the corresponding
markup list.

Due to how the markups are rendered during production, if you want to
include any applied crossout, strikeout, highlight, or underline markup in a
production, please note that all four markups are treated as one and all four if
applied will be included in the produced file.  For example, if a crossout and
highlight markup are applied to a document, if the crossout markup is selected
in the Production parameters, both the crossout and the highlight markup are
produced.

To edit a header, footer or watermark:

Headers and footers are a string of text assigned to a specific location within a
document. Headers and footers contain information such as date, time, page
number, user name, etc. For productions and printing, the text is not restricted
to just the top and bottom of a document, you can also place them in the right
and left the margins of a document. Each margin may be 10 lines deep giving you
120 individual strings of text.

A watermark is a semi-transparent string of text that appears behind the existing
document content. A watermark appears across each produced file from bottom
left to top right and has a transparency setting of 20%.

Similar to markups and redactions, headers, footers, and watermarks are
integrated into a production file as a fixed element that cannot be moved,
changed, or deleted.  

1. In Concordance Desktop, from the Tools menu, click Production.

2. In the Production Parameters dialog box, select the Include Hdr/Fts
Spec check box.

3. Click the Edit Headers/Footers and Watermarks button.

4. Click the (+) sign next to the Header/Footer folders or the watermark folder
you want to edit.

5. For each header, footer, or watermark, do one of the following:

· Type the text you want to be displayed.

· Type % to display the available macros list, and then select the macro(s)
you want to add.
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Available macros

Keep the following in mind when adding macros to headers/footers, and
watermarks:

· Each line of header or footer can use multiple macros.  For example,
you can add %Date %Time to the Top Left header.  This prints the
date and time in the location you specified on each page of the
production.

· All macro values are case insensitive, except for the %FIELD_ macro,
this must remain all uppercase.

When producing Concordance Desktop viewer documents/images in
Concordance Desktop, do not modify the %BatePgNo() macro as this
will cause the creation of new production numbers to fail.

Macro Description

%FIELD_ Inserts database field data up to 60 characters for a each
specified field.  For example, %FIELD_OCR1 %FIELD_OCR2,
would produce the first 60 characters of the OCR1 field and
the first 60 characters of OCR2 field.  If security is enabled,
only those fields with a minimum of "Read" access are
displayed.

%Date Inserts the current date

%
SysDatePlusDay
s(0)

Inserts a date the specified number of days after the
system date.  Replace the 0 a number to indicated the
number of days.

%Time Inserts the current time the production is executed based
on a 12-hour clock

%MilTime Inserts the current time the production is executed based
on a 24-hour clock

%Title Inserts the current title of the document

%Page Inserts the page number

%TotalPages Inserts the total number of pages

%BatesPgNo() Indicates the starting number for each page within a
document.  The generated number is appended to the
production number creating a unique document ID for each
page of a document stored in the corresponding
Concordance Desktop database.  For example, a
production run  of three single page documents are
generated as ABC00001, ABC00002, ABC00003. 

%Login, %User Inserts the user name of the person who executed the
production
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%Hostname Inserts the hostname of the machine where the production
was executed from

%IPAddress Inserts the IP address of the machine where the
production was executed from

%% Inserts a single % character

© Inserts a copyright symbol

® Inserts a registered trademark

6. To edit the font for the all the text, click the Font button, and then in the
Font dialog box, specify the font name, style, and size.

Overlapping of text in headers and footers may occur if the specified font size
is too large.

7. Click List to review the applied header/footer and watermark text and macros
set for the production.

8. Click Edit to make any changes.

9. When finished, OK.

Production and Printing headers/footers and watermark settings are separate
entities.  Parameters you set in the Production dialog box are only available
for production.

6. After all production parameters have been specified, click Start.

7. Verify the header/footer and watermark settings, and then click Ok.

The Production Control dialog box opens.  For more information about the
Production Control dialog box, see Monitoring the production run.

8. When the production is finished, in the Production Control dialog box, click Close.

Concordance Desktop provides the tools you need to permanently burn headers, footers,
and annotations onto the new .tif or .pdf files. This ensures that your files are branded
properly and that opposing counsel and any internal review staff do not receive original
copies or view privileged content.



Concordance Desktop 460

When creating productions, close all other database tabs and the Admin Console.

Do not open the Admin Console while running a Production.

Each time you produce a batch of records, a new set of production files are created. This
ensures that the original records are never changed, and that there is always a backup
copy of document changes.

If your current database is using the Concordance Viewer, follow the information below. 
Otherwise if you are using the Concordance Desktop Viewer, see Production with
Concordance Desktop Viewer.

Locate documents for a production:

When using Concordance Desktop, you first need to identify and locate the documents
you want to produce.

1. In Concordance Desktop, open the database containing the documents you want to
produce.

2. Run a search query to locate the documents you want to produce.

For more information about searching, see Available search tools.

3. Create a tag specific to this production, such as PROD1, and apply the tag to the
applicable documents.

For more information about creating and applying tags, see Creating and applying
tags.

Annotating documents for production

Make sure that the proper annotations have been applied to the records you want to
include in a production. 

Annotations to consider adding to records for productions:

· Redactions to indicate and/or cover confidential or privileged information.

· White redaction to hide internal control numbers, vendor branding, and other
information you do not need to include in the production. 

See Adding markups in Concordance Viewer for additional information.

Capturing tag activity for the production

Before running a production, consider running the Tag To Field command, Tools > Manage

Tags/Issues. The Tag To Field command copies the contents in tags to a specific field
in a database. Executing this command before creating the production captures tags
that were applied to each record just before the production was created. 
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Running the Tag To Field command:

1. In Concordance Desktop, create a database field, such as PRODTAGS1, to store the
tag information.

2. For more information about database fields, see About fields and  Creating
databases.

3. On the Tools menu, click Manage Tags/Issues.

4. In the Tag and Issue Management dialog box, click the Tag To Field button.

5. From the Select Field list, select the field you want to copy the tag names.

6. From the Select Delimiter list, select the delimiter to separate the tag names in
the field.

7. Click the Start button.

8. When prompted, do one of the following:

· Click Yes to confirm that you want to write the tag names in the selected field.

· Click No to append the tag names to the existing field contents.

· Click Cancel to abandon the changes.

9. When finished, click Done, and verify that the selected field displays the tag names
separated by the selected delimiter.
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To run a production:
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1. From the Tools menu click Production, and then Production.

2. The Concordance Production dialog opens.

3. Specify the desired production parameters needed.  See details for the various
production parameters in the sections below.

4. Before you Start production or Cancel, it is recommended to review your
production settings and save them to a template if desired.  If you need to cancel
the production it is easier to resume your production from a template of your
settings. 

5. If your settings are correct then click Start production to process your images.

After running a production, it is best practice to verify the produced images and
production data, such as carefully reviewing the production log in the database logs
folder; checking redacted documents; and confirming page numbers and page counts
match expected output.  If an OPT load file was created as part of the production,
consider editing it to reflect a relative path to the images rather than a full path before
sharing the file outside your organization.

Creating Production Numbers

1. Select the check box  for Create production numbers to expand the numbering
options.

2. Choose to create New production numbers or use numbers From existing field in
the drop-down list box.

To create New production numbers, do the following:

· In the Prefix field, type the prefix you want to precede the production number. The
prefix can be any combination of letters, numbers, or punctuation that are valid
folder or file names. There is a limit of 57 characters.

· In the Starting number field, type the number you want to use to start numbering
the production files.  Zero fill your starting number to determine the desired number
width. There is a limit of 9 digits.

The Starting Number field accepts a zero-filled number up to 10 digits in length
(maximum number of two billion).

· Select the Add a numeric suffix check box  to add an incrementing numeric value to a
production number for each page in a document.

When adding a numeric suffix, the pages within document will be produced with a
beginning .0001 suffix and incremented accordingly. Therefore, if a single document
within the production set contains more than 10000 pages, page 9999 will contain
the suffix .9999 and page 10000 will contain the suffix .10000.  This may cause



Administration 465

sorting issues for other applications used to view documents/images if not loaded
into the application with a corresponding OPT file.

· In the Begin production number field, select from the drop-down list the field you
want to use to store the beginning production number in the corresponding
Concordance Desktop database.

· In the End production number field, select from the drop-down list the field you
want to use to store the ending production number in the corresponding
Concordance Desktop database.

· In the Copy production numbers to field, select either Append or Overwrite.

Depending on your selection, any existing field data will have the production numbers
appended to the data or overwritten completely.

To create production numbers From existing field, do the following:

· In the Production number field select drop-down arrow  to choose the field in
that Concordance Desktop database from which you want the Production numbers
to be created.

· In the Begin production number field, select from the drop-down list the field you
want to use to store the beginning production number in the corresponding
Concordance Desktop database.

· In the End production number field, select from the drop-down list the field you
want to use to store the ending production number in the corresponding
Concordance Desktop database.

· In the Copy production numbers to field, select either Append or Overwrite.

Depending on your selection, any existing field data will have the production numbers
appended to the data or overwritten completely.

The BEGPRODNO and ENDPRODNO fields are included in the standard database
template as production fields.  If the production number appends to an existing field,
the numbers may truncate if the content exceeds the field length.  

Output Settings

In the Output Settings section of the Concordance Production window, select the check box

 for any or all of the desired options:

· Use production numbers for media keys, to use the new production numbers as
media (image) keys in the produced .opt file.

· Use production numbers for file names,  to replace the current file name with
the generated production number when naming the new production files. 
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If Create production numbers is not enabled in the Concordance Production
settings then Use production numbers for media keys and Use production
numbers for file names will not be displayed. 

· If Create place holders for unsupported/missing files is selected, the produced
image for the unsupported or missing file will appear with the text "Image not
available".

· Select Volume folders to create volume folders for the production files.  After
selecting:

o In the  Prefix field, type the prefix you want to use to precede the volume number.

The prefix can be any combination of letters, numbers, or punctuation; however, the
characters must be valid folder and file name characters.

o In the Starting Number field, type the number you want to use for the starting
number for the volume folders.

o In the Max Volume Size, enter the value for the maximum size for each volume.

The contents of the volume directories can be copied to an external
storage for distribution.  If you plan to copy the production files to an
external storage medium, make sure that you know the available space
prior to setting the Max Volume value.  This ensures that the entire
contents of the volume can be copied without running out of space.
After a volume fills to the maximum size, a new volume folder is created
and, if requested, will continue sequentially. Production files will not be
split across volumes.

· Select File folders to organize the production files within the volume folder.  After
selecting:

o In the Prefix field, type the prefix you want to use to precede the file folder number.
The prefix can be any combination of letters, numbers, or punctuation; however, the
characters must be valid folder and file name characters.

o In the Starting Number field, enter the number, you want to use as the starting
number for the file folders. Zero fill your starting number to determine the desired
number width.

o In the Maximum Record Count field, type the maximum number of records to include in
each folder.

· Click Browse next to the Production path to specify the folder location where the
output files are to be stored.

The Production path including the file name should not exceed 250 characters as
this may cause the application to close unexpectedly.

· Select Create OPT to generate an .opt file for the production files.  Click the
Browse button, navigate to the location for the .opt file, enter a filename to use,
and click Open.



Administration 467

It is recommended that you create an OPT file when using the Numeric Suffix option
to ensure the produced documents/images can be loaded properly in Concordance
Desktop viewer and Concordance Image, as well as other viewer applications.

Image Settings

Image Settings allow you to configure output files as TIFF or PDF, single-page or multi-
page, black and white (greyscale) or color in any combination of these three settings.

LZW color compression produces a small file size image, which cannot be used with
Concordance Image.

The available image settings are:

· File Type - select from the drop down list either TIFF or PDF for the image output
type.

· Page Settings - select either Multi-Page or Single-page.

· Color Settings - select either Black and white CCITTFAX4 compression or
Color LZW compression.

· Select the Fit image inside header/footer checkbox to reduce the size of the
produced document or image to accommodate the space needed for the number of
lines of text and font size for the specified headers and footers.

All redactions are produced as black when Black & White is selected for the production
output.  Color redactions will appear as selected when Color is selected for the
production output.

Markups

To specify markup types to include in the production click the check box next to the
desired markups to be included.

To include all markups click the check box next to Select All.

Be sure to include Redaction in your produced output if reviewers used the redaction
markup to hide any protected or privileged information.

Headers and Footers
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Click Include Headers and Footers to enable settings for Headers, Footers, Margins,
and Watermarks. The headers, footers, and watermarks are integrated into a production
file as a fixed element that cannot be moved, changed, or deleted. 

Printing and Production headers/footers and watermark settings are separate entities.
 Parameters you set in the CDV Printing dialog box are only available for printing, and
parameters you set in the Concordance Production dialog box are only available for
production.

Font

Clicking Font opens a new Select Font window where you can change the font
settings for all text in headers, footers, margins, and watermarks.

· Select the Font Family you want from the list box.

· Select the Font Size you want from the list box.

Overlapping text in headers and footers may occur if the specified font size is
too large.

· Select the Font Style options you want by selecting the corresponding check
boxes for Bold and/or Italic.

The Sample Text will show an example of text using the font options as you are
selecting them so you can see what it will look like.

Click OK to return to Concordance Production.

Headers and Footers

Headers and Footers are a string of text assigned to a specific location within the
top and bottom margins of the produced image.  Headers and footers contain
information such as production page number, date, time, field content, etc.

Free text can be typed in each section or you can select from the drop-down list of
variables and fields.  If you specified to create new production numbers, you may
select Page ID to endorse the image with the new production page number.

Margins

For productions the text is not restricted to just the top and bottom of a document, you
can also place them in the right and left the margins of a document.

The text can be typed in to the field or selected from the drop-down list of variables and
fields.  

Watermark
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A watermark is a semi-transparent string of text that appears behind the existing
document content. A watermark appears across each produced file from bottom left
to top right and has a transparency setting of 20%.

Similar to markups and redactions, headers and footers, watermarks are integrated
into a production file as a fixed element that cannot be moved, changed, or
deleted.  

Production setting templates

In order to save time for production runs that are similar in nature, you can save your
production settings to a template file for future use. If you save your settings as the
default settings, the next time you run a production all the settings will be predefined
accordingly when you open the Concordance Production dialog box.

To name a template

1. From the Tools menu click Production, and then Production.

2. The Concordance Production dialog opens.  Any available saved settings
templates will be shown in the Settings drop down.  The first time a production is
started from a station or with a new login, the Settings drop down will be blank.

3. Make sure that whatever settings you want saved as a template have been
selected in the Concordance Production window.

4. Type the desired name of the template in the Settings field.  

· Click Save to save the template with a specific name.

· Click Save as default to save the template as the default template to use
whenever a Production is started.

The templates are saved locally in C:\Users\(User name)
\AppData\Local\CloudNine\CVProductionSettings.conf.

To select a saved template

1. From the Tools menu click Production, and then Production.. 

2. The Concordance Production dialog opens.

3. The default template will be displayed in the Settings field.  

4. Expand the Settings drop down to see the full list of available templates.

5. Select the desired template and make changes as needed.
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6. If the changes should be saved to the template, then be sure to select Save
once the changes are complete.

To remove a saved template

1. From the Tools menu click Production, and then Production.

2. The Concordance Production dialog opens.

3. The default template will be displayed in the Settings field.  

4. Expand the Settings drop down to see the full list of available templates.

5. Select the template you want to delete and and click Remove.

6. The template is removed from the Settings list.

7. You can now select another template or create a new one.

When a production is executed, the Production Console is displayed. The production
control displays the progress of the files as they are converted, distributed to the
production volumes and file folders, creation of the CIB and OPT files, and production
information written back to the specified fields in Concordance Desktop.

Export to Log File:

1.  If you want any error messages encountered during the production to be written to
a log file, select the Export to Log File option.

2.  Navigate to where you want to save the log, in the File name field, type the log
name and click Save.

In order to save time for production runs that are similar in nature, you can save your
production parameters for future use. You can also save a parameter set as the default
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settings, so that the next time you want to run a production, all the parameters are
already predefined when you open the Production dialog box.

To save a production's parameters:

1. Specify all production parameters you want to save.  See, Setting production
parameters.

2. In the Parameter Set Selection section, in the Parameter Set Selected field,
enter a parameter set name.

3. Click Save User Parameter set.

To save defined production parameters as the default set:

1. Specify all production parameters you want to save.  See, Setting production
parameters.

2. When finished, click Save As Default Parameter Set.

To load a saved parameter set:

1. In Concordance Desktop, click Tools, and then click Production.

2. In the Concordance Desktop Production dialog box, from the Parameter Set
Selected list, click the parameter set you want to use for the production.

3. Click Load User Parameter Set.

To remove a saved parameter set:

1. In Concordance Desktop, click Tools, and then click Production.

2. In the Concordance Desktop Production dialog box, from the Parameter Set
Selected list, click the parameter set you want to remove.

3. Click Remove Current Parameter Set.

After running a production, it is best practice to verify the produced images and the
production data in Concordance Desktop.
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To verify produced images and production data:

1. In Windows Explorer, navigate to where you created the directory folder to store
the production files.

2. Review the produced images and corresponding files.

3. If the image load file is being produced to opposing counsel, you will want to
modify the directory path information before handing it over.

4. In Concordance Desktop, return to your document set and navigate to the next
record to refresh the database.

5. Scroll to the bottom of the produced records to view the production numbers for
the records and the tags applied to each record at the time of the production.

Running a native file production

A native file production produces copies of the original native files to a specified
production destination.  The native file production does not include any markups or other
production settings, Concordance Desktop simply copies the existing native files and
renames them according to the parameters you specify.  

Concordance Desktop renames the files using one of the following options:

· Native File Name - names the files based on the original native file name of each file.

· Image Key - names the files based on the corresponding image key

· Field - names the files based on the contents of a selected field

· Custom - names the files using a specified prefix and starting number 

A native file production can be executed for all the documents in the database, for a
specific set of documents from a query, or documents that have been tagged with a
specific tag.

Make sure that the original native file name does not contain any Unicode characters
as this may result in the production of a blank text file.

To run a native production:

1. In Concordance Desktop, open the database containing the documents you want to
produce.



Administration 473

2. Do any of the following:

  To produce all the documents in the database

Click All   to make sure that all the documents are available.  From the Tools
menu, click Production, and then Native File Production.

  To produce a specific set of documents

Run a search query to locate the documents you want to produce and from the
Tools menu, click Production, and then Native File Production.

  To produce based on tagged documents

1. Create a tag specific to this production, such as PROD1, and apply the tag to the
applicable documents.

For more information about creating and applying tags, see Creating and applying
tags.

2. Right click on the tag and select Create query from tag(s).

3. In the Tags task pane, right-click the tag, and select Native File Production.

3. The Native File Production dialog opens.
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4.  In the Native File Production dialog box, click the Browse button to navigate to
the folder location where you want to store the produced files.

In version 1.07+

5.  Do any of the following:
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· To create a new folder, select New Folder in the Folder field type the folder
name, and click Select Folder.

· To use an existing folder, select the folder, and click Select Folder.

The production folder must be empty.

Microsoft Windows imposes a limit on the number of characters that can be used for file
path names. Therefore, the folder path, including the folder and production file name,
should not exceed the 260 characters, as doing so may cause the application to close
unexpectedly.

6.  In the File Naming Scheme section, do one of the following:

· To name the produced files using the original native file name, select Native File
Name.

· To name the produced files using the current Image Key. Select Image Key.

· To name the produced files using the contents of a selected field, click Field and
select the field from the list.

· To name the produced files using a specific prefix and numbering scheme, click
Custom.

1. In the first field type the prefix you want to precede the production
number.  

2. In the second field type the number to use as the starting number for the
production files.

A maximum number of digits allowed for the starting number field is nine.
The produced native file names are automatically incremented from the
starting number.

Selecting the box  Write Production number to the database field writes
the production number for each produced file back to the database.  If the box
is selected, you must select the field to update with the produced file name
value.  You must also select either to Overwrite or Append to any existing
data in the selected field.

· Overwrite will remove the current value in the field and replace it with the
custom production number.

· Append will add the custom production number after the current field value
for example: WIN00123; ABC000001.
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If creating a native file production from a concatenated set of databases, do not
select 'Image Key' as the Production Type. If Image Key is selected, you may
receive an "Image key duplication..." error message when the process attempts to
produce native files starting with the second database in the concatenated set. 
Image keys must be unique across the production run however, concatenated
databases may duplicate the image key across the concatenated set.

Do not open the Admin Console while running a Production.

7.  (Optional) To exclude specific files from the production and insert a placeholder (empty
text file), click the Exclusion List button, do any of the following:

To add a file, in the small field type the file type extension, and then click Add.

To remove a file type from the exclusion list, click the file type, and then click
Remove.

When finished, click OK.

8.  In the Source Type section, select one of the following:

· CIB (Imagebase) to produce files as they are currently linked in the
Concordance Viewer.

· Field to copy files from a path and filename in a field in the data such as the
FILEPATH field.  Select the field from the drop-down menu.

Filetypes that are unsupported by the viewer cannot be produced using the
CIB as the source type. It is recommended that a field such as FILEPATH be
used for native file productions that include unsupported file types. If the CIB
is selected, be sure to review the produced output for any 0-byte .txt files
where the filename is the CNDCN. The presence of these .txt files indicates
the native file was not produced.
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9.  Write the output production path back to the database field, select the check

box  and select the field to update with the produced path information.

The production path is a full path with file name for the produced files.  You may
use the Global Edit option to modify the path to a relative path if needed prior to
export.

10.  To run the production, click Start.  The production status bar will display the native
file production status.

In prior versions to 1.07

5.  Do any of the following:

· To create a new folder, click the Make New Folder.  In the Folder field type the
folder name and click OK.

· To use an existing folder, select the folder, and click OK.

The production folder must be empty.

Microsoft Windows imposes a limit on the number of characters that can be used for
file path names. Therefore, the folder path, including the folder and production file
name, should not exceed the 260 characters, as doing so may cause the application
to close unexpectedly.

6.  In the Production Type section, do one of the following:

· To name the produced files using the original native file name, select Native File
Name.

· To name the produced files using the current Image Key.  Select Image Key.

· To name the produced files using the contents of a selected field, click Field and
select the field from the list.

· To name the produced files using a specific prefix and numbering scheme, click
Custom.  In the first field type the prefix you want to precede the production
number.  In the second field type the number to use as the starting number for
the production files.

A maximum number of digits allowed for the starting number field is nine. The
produced native file names are automatically incremented from the starting
number.

If creating a native file production from a concatenated set of databases, do not select
'Image Key' as the Production Type. If Image Key is selected, you may receive an
"Image key duplication..." error message when the process attempts to produce native
files starting with the second database in the concatenated set.  Image keys must be
unique across the production run however, concatenated databases may duplicate the
image key across the concatenated set.
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Do not open the Admin Console while running a Production.

7.  (Optional) To exclude specific files from the production and insert a placeholder (empty
text file), click the Exclusion List button, do any of the following:

To add a file, in the small field type the file type extension, and then click Add.

To remove a file type from the exclusion list, click the file type, and then click
Remove.

When finished, click OK.

8.  To run the production, click Start.

Generating a production attachment range

After running a production in a database that contains emails and attachments, a
production attachment range can be generated to reflect the new production numbers
assigned to the family of documents.

An attachment field must be added to the database prior to generating the attachment
range. For more information on adding fields, see About Modifying Databases.

To generate a production attachment range:

1. From the Tools menu, click Production, and then Production Attachment Range. The
Production Attachment Range dialog opens
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2. In the Existing Attach Range Fields section, select one of the following to specify the
field(s) which contain the attachment data:

· Select the Attach Range option if a field in the database contains an attachment range,
and then select the field that contains the attachment range data. 

· Select the Fields option if there are beginning attachment number and ending
attachment number fields in the database, and then from the Beg Attach and End Attach
list select the fields that contain the attachment data for the beginning attachment
number and ending attachment number.

3. In the Existing Production Number Fields section, select the fields that contain the

beginning production number values and ending production number values in the database.

4. In the Production Attach Range Field section, select the field you want to use to store the

production attachment range.

5. Click Start.
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Creating a production database

After running a production and verifying the produced images, it is best practice to create
a database for the production.

For more information about exporting databases, see Exporting databases.

To create a production database:

1. In Concordance Desktop, make sure that the same production query is still active in
the database or rerun the same production query in the database.

2. From the Documents menu, click Export, and then As a Concordance Desktop
database.

Clicking As a Concordance Desktop database opens the Export Wizard - Database
dialog box.

3. Click the Browse button to open the Select database to merge dialog box.

4. Navigate to the directory where the production imagebase is stored, type the
database name, using the same name as the production imagebase, in the File
name field, and click Open.

When creating your production database, the database needs to be created in the
same directory with the same name as the imagebase that was created in the
production wizard. This will ensure that the production imagebase will link to the
corresponding database.

5. Click Next to open the Export Wizard - Fields dialog box.
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The database list defaults to the database currently opened, and all the database's
fields are selected in the field list.

When exporting to an existing database, fields are only exported if the fields match
the fields in the existing database. 

6. To only include some of the database fields in the export, in the fields list, click the
fields you want to export.

To select multiple fields, use SHIFT+click or CTRL+click.

7. Click Next to open the Append/Replace dialog box.

The Append/Replace dialog box allows you to control how documents are exported. 

8. Select the Append all records option.

When you are exporting to a new database, if the Append all records option is
selected, the export adds all records in the query to the database. If you are
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exporting to an existing database, the export appends all records in the query after
the last record in the existing database. 

9. To copy a record's attachments with notes during the export, select the Copy
attachments with notes check box.

When the Copy attachments with notes check box is selected, the export
automatically creates sequentially numbered attachment folders in the same
directory as the Concordance Desktop database, and copies attachments into the
subfolders. Folders are named in the format ATTACH-000000 and increment by one
if the initial folder exceeds maximum capacity. 

To exclude a record's attachments with notes from the export, clear the Copy
attachments with notes check box.

10. Click Next to open the Export Wizard - Export dialog box.

The First and Last fields default to the first and last record in the current query. 

11. To modify the range of the records to be exported, in the First field, type the
record number for the first record in the range you want to export, and in the Last
field, type the record number for the last record in the range you want to export.

12. Click the Export button.

If you are exporting to a new database clicking the Export button opens the
following message:

13. Click Yes to start the export and have the export create the new database.

If you are exporting to an existing database, clicking the Export button starts the
export.

You can click the Cancel button at any time to cancel the process.

When the export finishes, the Export Wizard - Export dialog box automatically
closes.

14. On the File menu, click Open to open the Open dialog box.
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15. Navigate to and open the production database you created,  to open the database in
Concordance Desktop.

16. On the File menu, click Reindex to index the database.

17. On the Dynamic toolbar, click the View image (camera) button to open the
Concordance Desktop viewer and the produced images linked to the production
database you created.

Creating Reports

Concordance Desktop provides several tools for printing document records and transcripts,
and can be used to create and print a variety of customized reports based on search
results, field content, tagged document sets, and transcript annotations. Printing options
are available within Concordance Desktop from either the Browse or Table view, and the
output looks similar to the onscreen display, depending on which view you choose to print
from. Document images can also be printed from Concordance Desktop Image, based on
search results in Concordance Desktop.

While Concordance Desktop offers the basic options for printing, such as page numbers
and dates, Concordance Desktop also offers selections for printing highlighted
annotations, underlined hits, field labels, and more. This is especially useful for printing
sets of records for full-text review or printing annotations from transcripts.

You can also print a spreadsheet report of queries displayed in Table view, with field text
in the sort order selected. This option is useful when a summary listing is appropriate.

You can create reports in Concordance Desktop using the following methods:

· Exporting Concordance Desktop Table Data

You can export Concordance Desktop record content to CaseMap, a case tracking
tool, or export record content to spreadsheets in Microsoft Excel.

For more information about exporting table data, see Exporting Concordance Desktop
data.

· Printing with the standard print options

Concordance Desktop offers many standard printing options and report tools to assist
reviewers during case review.

For more information about using the standard print options in Concordance Desktop,
see Printing standard reports.

· Printing with the Annotation Report Writer Wizard

Use the Annotation Report Writer Wizard to create custom reports from your transcript
files. The custom reports can include transcript notes, highlights, and attachments.

For more information about creating custom reports using the Annotation Report Writer
Wizard, see Printing transcript annotations.

· Printing with the Report Writer
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Use the Report Writer to create custom reports from the Table view, based on a sort
query. You can also use the Report Writer in conjunction with a CPL (Concordance
Desktop Programming Language) script to create custom exploded sort reports.

For more information about creating custom reports using the Report Writer, see
Printing with Report Writer.

Exporting Concordance data

In Concordance Desktop, you can export record data from the Table view to Microsoft
Excel and CaseMap. The export feature is a great tool for making custom reports, as well
as contact and mailing lists. In order to export to Microsoft Excel or CaseMap, the
software you are exporting to must be installed on your computer.

If you want to export data to Microsoft Word, you can simply copy and paste data
from Concordance Desktop to Microsoft Word. 

Exporting to Microsoft Excel

When you export data from the Table view to Microsoft Excel, Concordance Desktop
exports data from the records you select in the Table view. The fields and field order
currently displayed in the Table view determine which field data is exported for the
selected records and the order of the fields exported to Microsoft Excel. Before
exporting, you can run a search to display the records you want to export in the Table
view, and modify the table layout to define the fields and field order you want to
include in the export. 

Microsoft Excel has capacity limitations. If you are primarily exporting your data to
Microsoft Excel 2003 , you need to be aware that this version of Excel is limited to
printing a maximum of 65,000 rows, and also has limitations for the number of
characters per cell.

To export table data to Microsoft Excel:

1. Run a search to locate the records you want to include in the export to Microsoft
Excel.

For more information about searching, see Available search tools. 

2. In the Table view, adjust your table layout to include the fields and field order
you want to export to Microsoft Excel.

For more information about adjusting a table layout, see Using table layouts.
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3. In the Table view, select the records you want to export.

You can export multiple adjacent records and non-adjacent records.

· Adjacent records: SHIFT + Click to select a block of consecutive records.

· Non-adjacent records: CTRL + Click to select random records from the list.

· All records: CTRL + A to select all records in the list.

If you have Microsoft Excel 2013 installed, open a blank Excel spreadsheet prior
to completing step 4 below. 

4. Right-click in the Table View, point to Send To, and then click Excel.

Microsoft Excel automatically launches and displays your exported Concordance
Desktop data in the field order you selected. If the data does not display, try the
export again. 

Exporting to CaseMap

When you export table data to CaseMap from the Table view, all of the records listed in
the Table view are exported to CaseMap. Before exporting data to CaseMap, run a
search to capture only the records you want to include in the export.

To export table data to CaseMap:

1. In Concordance Desktop, run a search to locate the records you want to include
in the export to CaseMap.

For more information about searching, see Available search tools. 

2. In the Table view, right-click the records, point to Send To, point to CaseMap,
and then click Send all documents in query.
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Selecting Send all documents in query opens the following message: CaseMap
does not support Unicode and we will only send single-byte (Ascii) text to them.
Press OK if you want to continue.

3. Click OK to continue.

Clicking OK opens the Completed gathering the document data message dialog
box.

4. Click the Continue button.

Clicking the Continue button opens the Bulk Send to CaseMap wizard in CaseMap.

For more information about exporting Concordance Desktop data to CaseMap and
using CaseMap's Bulk Send to CaseMap wizard, see the CaseMap documentation.

Exporting numerical data to Microsoft Excel

When you export numerical data from Concordance Desktop to Microsoft Excel, if the
field value begins with leading zeros, the leading zeros are trimmed from the field value.
For example, if you are exporting the BEGNO field value 00020177, the value is exported
to Excel as 20177. To keep record numbering consistent with Concordance Desktop
data, you need to add the leading zeros back onto the applicable field data in Microsoft
Excel.  See, Microsoft Excel documentation.

Numerical field values starting with alphabetical prefixes are not affected when
exporting to Microsoft Excel.

Only the field data that is displayed in the Table view is exported. Field data is exported
in the order that is displayed in the Table view, based on the selected table layout. You
can use custom table layouts to determine the field data and order of field data
exported to another application.

Printing transcript annotations

Because your transcripts are unique documents with added notes, highlights and
attachments, Concordance Desktop offers an Annotation Report Writer tool for
customizing reports from your transcript database.

Depending on your needs, each annotated report created in the wizard may include
several types of annotations and the text included in the annotations. 
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To print annotations using the Annotation Report Writer wizard:

1. In Concordance Desktop, open your transcripts database.

2. On the Standard toolbar, click the arrow next to the Report button and select
Annotation report writer.

3. In the Annotation Report dialog box, select Annotation Report Wizard and click
OK.

4. In the Report dialog box, select the type of annotated report you want to print and
click Next. 

· Issue report - prints an issues report
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· Attachment report - prints a report of annotations containing attachments

· Note report - prints a report of annotations containing notes

· Quick mark report - prints a report of all transcript line number highlights  

5. If you are printing an issue report, select the Print all issues option or select the
Print selected issues option and select the issues you want to include on the
report, and then click Next on the Issues dialog box.

To select individual issues in the list, use CTRL+click. To select a block of issues in
the list, use SHIFT+click.

If you are printing an attachment, note, or quick mark report, just click Next on the
Issues dialog box.

6. In the Annotations field, select the one of the note printing options and select
whether you want to print the quick marks, attachments, and/or issue list.

7. In the Select the user(s) to print annotations field, select the users for which
you want to print annotations and click Next.  

To select individual users in the list, use CTRL+click. To select a block of users in
the list, use SHIFT+click.
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8. Select the transcript context you want to include when printing the notes and
issues in the Context dialog box and click Next. 

9. To add a custom header and/or footer to the report, fill out the fields in the
Formatting dialog box and click Next.
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You can include an annotation header, page numbers, the print date, and the print
time on the report. You can also select whether to print a page border and multiple
pages per sheet of paper in the Compressed print field.

10. Define your final print options in the Print dialog box, like customizing the font and
page layout, and whether to print a hard copy or save to a file.

To preview or edit your report, click the Click this button to preview your report
button.

We recommend that you always preview the report before printing a hard copy or
saving multiple files of it on your hard drive or server. This also allows you to edit
the font, headers, footers, or other print options before you process the report.
Click the Close button in Print Preview if you need to return to the Annotation
Report dialog box to make any additional changes to the report.

11. Click the Print button to print the report.
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Printing with the Report Writer

With the Report Writer, you can create simple reports, exploded sort reports, complex
reports from concatenated databases, or reports where you need to print tens of
thousands of records. The reports are based on a sort query. 

You can select the fields to use, column widths, and page and individual column formats
and alignment. The report columns can contain stacked fields, truncated fields, calculated
data, and combined data and quoted text with tab alignment. The Report Writer supports
date and math calculations, and advanced if-then-else logic. While many of these
features are powerful, the report writer was designed to be easy and flexible.

In Concordance Desktop, the Report Writer is only available in the Table view, but you can
also use the Report Writer in conjunction with CPL (Concordance Desktop Programming
Language) scripts. 

If you are primarily exporting your data to Microsoft Excel 2003, you need to be
aware that this version has limitations for a maximum number of rows and characters
per cell.

Understanding the Report Writer
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Editable Areas

The Report Writer screen is divided into four horizontal edit areas:

· Page Header

The top edit box is the page header. It is printed at the top of every page. Any
text can be typed into the page header. The header can be pulled down to give
you more room for a large header or font. There is no limit to the number of lines
in the header. If you do not want a page header, just pull it up until it
disappears.

· Column Headers

The next row of the report contains the column headers. These are printed at
the top of every page, above the data columns. As with the page header, the
column headers are resized by grabbing the window borders and pulling them up
or down. There is no limitation on the number of lines of text they can hold. Make
them as large or small as you need. Resizing one column header will resize all
column headers, they are always uniform in height.

· Data Columns

The next row contains the data columns. These contain the actual data printed
in your reports. The data columns are interpreted; if you place a field's name--it
must be in upper case--in the column, then that field's data ends up in the
report. If you place something like, "Data: " + SUMMARY into the column, then
the word "Data: " precedes the text from the field named SUMMARY. Any text or
function or mathematic operator defined in the programming language can be
used in a data column. This allows you to do things like convert data to upper or
lower case, print only the first 100 characters, or calculate dates and other
values in your reports.

· Page Footer

The bottom edit box is the page footer. The page footer is printed at the bottom
of every page. Any text can be typed into the footer. The footer can be pulled
up or down to give you more or less room for text or type size. Make the footer's
window smaller if too much room appears between the footer and the page
numbers or dates.

Adding Field Titles and Data

There are two drop-down lists on the Report Writer toolbar. The first list contains a
list of every field in the database. The second list contains a list of useful CPL
functions and operators. When adding fields to a report, you should always select
fields from the list box. It will automatically include necessary conversions for you,
such as converting dates to text so that they can be printed. For instance, selecting
the date field DATE will actually place dtoc(DATE) into the report column. This uses
the date-to-character function to convert a numeric date into text. To add a field,
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function, or operator to a report, click on the report where you want to add a field,
function, or operator and make a selection from the field or function list. 

If you need to type field names manually, make sure that you use upper case
letters. The report writer will not recognize field names unless they are in upper
case.

Stacked Fields and Other Useful Tricks

The Report Writer is very powerful and flexible. It can use any of the CPL
(Concordance Desktop Programming Language) Operators and Functions. With the
Report Writer, you can create some wonderful and complex reports. There are
however, just a handful of functions and operators, like the plus sign, which you will
use most of the time. This section describes the most useful functions and how to
use them.

The first thing you may want to do is to combine some text with a field or two. The
following example does just that. It stacks two fields in one column with titles for
data:

"Date  "+dtoc(DATE)+newline()+

"Customer "+CUSTOMER

Enclose any static text in quotes. Combine quoted text and other data with the plus
sign. The newline() function forces anything that follows it onto the next available
line. Also included in the example, but not shown, are tabs. The quoted text includes
a tab character to align the two data fields--there are no spaces in the line.

Always remember to use plus signs to combine everything with everything else.
Leaving one out, or putting two plus signs in a row, are the two most common report
errors.

Sometimes you may have a very large field which would use a lot of paper if it were
printed. The next example uses the substr() function to print the first 200 characters
of the summary field, it sub-strings it.

substr(DIGEST,1,200)

The example about uses the substr() function to grab 200 characters, starting with
the first character. For this scenario, it would be really useful if we could check first
to see if the brief field was actually more than 200 characters long. Then we could
append ellipses (…) to show that we truncated the entry, if we need to truncate it
at all.

(len(DIGEST)>200?substr(DIGEST,1,200)+"…": DIGEST)
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This example uses two new features: the len() function and the conditional operator.
The len() function determines the length of the text in any field. The conditional
operator allows us to embed if-then-else logic into a report column. The conditional
operator has the following format: (statement?true-response:false-response). The
Report Writer tests the statement. If it is true, the true-response is the result,
otherwise the false-response is the result. In our example the Report Writer
determines if the length of the digest field is greater than 200 characters. If it is, the
true-response returns the first 200 characters of the field with ellipses appended to
show that it was truncated. If the statement is false, the entire field is printed. The
parentheses around the conditional operator are required.

Report Writer Guidelines

· Use if-then-else syntax is (:?) and put literal text within quotes

If a date = 00/00/0000, then you can place quotes around “no date available”

· Stack fields with newline()

“Beg Bates : ”+BEGNO+newline()+“End Bates : ”+ENDNO

Report Writer Toolbar

Once you have generated a report using the Report Writer, the report and the Report
Writer toolbar are displayed in Concordance Desktop. You can use the Report Writer
toolbar to open, save, and insert files, select print options and font settings, and more.
You can also select fields and codes to customize your report options.

Button Definitions

Report Writer Toolbar Buttons

Butto
n

Name Description

Open Opens the Open dialog box. Click the Open button to open an
existing .arp report file in the Report Writer.

Save Saves your latest report changes to the .arp file currently
opened.

Save as Opens the Save As dialog box.

Insert Inserts a column to the left of a selected column. Click a column
in the report and click the Insert button to open the  Report
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Report Writer Toolbar Buttons

Butto
n

Name Description

Columns dialog box. Type the number of columns to insert and
click OK to insert the new columns.

Delete Deletes a selected column.  Click a column in the report and click
the Delete button to open the Report Columns dialog box. Type
the number of columns to delete and click OK to delete the
selected column, and if you entered more than one column, the
remaining number of columns you entered to the right of the
selected column.

Options Opens the Report Options dialog box. In the Report Options
dialog box, you can edit the report's current settings.

Page Setup Opens the Page Setup dialog box. In the Page Setup dialog
box, you can edit the report's page setup settings,including the
paper size, source, orientation, the page margins, and printer.

Justify Opens the Justify dialog box. Select the check box that applies
to the text you want to format, click OK to open the Text
Alignment dialog box, click the alignment option you want to
use, and click OK.

Font Opens the Font dialog box. Select the check box that applies to
the text you want to format, click OK, modify the font, and click
OK again.  

Print Preview Opens the report in the print preview screen. The print preview
screen allows you to browse through up to 100 pages of your
report before printing the report.

Print Opens the Print dialog box. Select you printer settings and click
OK to print the report.

Exit Closes the Report Writer in Concordance Desktop. You will be
prompted to save the report if any changes were made.

Field List Contains a list of the database fields you can add to the report.

Function List Contains a list of available CPL functions and operators you can
add to the report.

You can create reports in the Report Writer using the wizard or manually create reports in
the Report Writer's Report Options dialog box. You can also edit existing reports in the
Report Options dialog box.  

To generate reports using the Report Writer Wizard:
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1. Run a search query to locate the documents you want to include in the report.

For more information about searching, see Available search tools.

2. In the Table view, use a table layout to organize the columns and column order you
want to include in the report.

For more information about custom layouts see, Using table layouts.

3. With the Table view still open, on the Standard toolbar, click the down arrow next
to the Report button and click Report writer.

Clicking Report writer opens the Report Writer dialog box.

4. Select the Report Writer Wizard option and click OK.

Clicking OK opens the Report Wizard - Documents dialog box.

5. In the Report Wizard - Documents dialog box, define the report's document range
settings.

To define the settings in the Report Wizard - Documents dialog box:
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In the Report Wizard - Documents dialog box, the First and Last fields default to
the first and last record in the current Concordance Desktop query. 

1. To modify the range of the records to be printed, in the First field, type the
record number for the first record in the range you want to print, and in the
Last field, type the record number for the last record in the range you want
to print.

2. Click Next to open the Report Wizard - Page numbering and dates dialog
box.

6. In the Report Wizard - Page numbering and dates dialog box, define the report's page
numbering and date stamp settings.

To define the settings in the Report Wizard - Page numbering and dates dialog box:
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In the Report Wizard - Page numbering and dates dialog box, the page number,
date, and time stamp options all default to No. If you choose to print page
numbers and/or date and time stamps,  they will be printed at the bottom of
each page in the report footer.

1. To print page numbers, in the Do you want to print page numbers field,
select the Yes option.

Page numbers are printed in the lower-right corner of the report.

2. To print the current date, in the Do you want to print dates field, select the
Yes option.

The date is printed in the lower-left corner of the report.

3. To print the current time, in the Do you want to print the time field, select
the Yes option.

The time is printed in the lower-left corner of the report.

The default font for page numbers and date and time stamps is Arial 9pt. The
report uses the same font settings for page numbers and date and time
stamps on the report.

4. To modify the font settings, click the Font button.

Clicking the Font button opens the Font dialog box.
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5. Specify the font settings and click OK to save your changes. 

The font changes apply to all the page numbers and date and time stamps on
the report.

6. Click Next to open the Report Wizard - Header/Footer dialog box.

7. In the Report Wizard - Header/Footer dialog box, define the report header and footer
settings .

To define the settings in the Report Wizard - Header/Footer dialog box:

In the Report Wizard - Header/Footer dialog box, you can preset the header and
footer text for all of the fields default to No, except for the Do you want a blank
line between records field. 

1. To print a report header, in the Enter the report header field, type the
header text you want to print.

2. To print a report footer, in the Enter the report footer field, type the footer
text you want to print. 

3. Click Next to open the Report Wizard - Options dialog box.

8. In the Report Wizard - Options dialog box, define the report's record break, column
border, and field printing settings.
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To define the settings in the Report Wizard - Options dialog box:

In the Report Wizard - Options dialog box, all of the fields default to No, except
for the Do you want a blank line between records field. 

1. To print each record on a separate page, in the Do you want a new page to
start with each record field, select the Yes option.

2. To disallow a blank line between each record on the report, in the Do you
want a blank line between records field, select the No option. 

3. To add a horizontal line between each record on the report, in the Do you
want horizontal lines between records field, select the Yes option.

The Do you want horizontal lines between records field is only available if you
are also adding blank lines between each record.

4. To add vertical lines between each report column, in the Do you want
vertical lines separating columns field, select the Yes option.

5. To print only the first line from each field in the report, in the Do you want
to print just the first line of every field (summary report) field, select the
Yes option.

If you choose to only print the first line of each field, Concordance Desktop
prints a summary report with one line per record.

6. Click Next to open the Report Wizard - Margins dialog box.
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9. In the Report Wizard - Margins dialog box, define the report's page margins and
intercolumnar spacing setting.

To define the settings in the Report Wizard - Margins dialog box:

In the Report Wizard - Margins dialog box, all page margins default to .50 inches
from the edge of the page, and the Intercolumnar (1/10th") field defaults to 2
tenths. 

1. To edit the print margins, type or select the margin sizes in inches, that you
want to print on the report. 

Some printers have an unprintable reserved area and the margins cannot be
set below this limit.

2. To edit the intercolumnar spacing, in the Intercolumnar (1/10th") field,
type or select the spacing, in tenths of an inch, that you want to print on
the report. 

The intercolumnar spacing determines the distance between columns in your
report.

3. Click Next to open the Report Wizard - Printer dialog box.

10. In the Report Wizard - Printer dialog box, define additional report page settings
including page breaks and orientation.

To define the settings in the Report Wizard - Printer dialog box:
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1. To change the paper size or source, page orientation or margins, or default
printer, click the Printer button.

2. Clicking the Printer button opens the Page Setup dialog box.
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3. Make the applicable edits.  

To change the default printer for the report, click the Printer button, make
the applicable edits, and click OK to save your changes.

4. In the Page Setup dialog box, click OK to save your changes and return to
the Report Wizard - Printer dialog box. 

In the Report Wizard - Printer dialog box, the Widows field controls the
minimum number of lines Concordance Desktop will allow to remain at the
bottom of a page. If the number of lines to print at the bottom of the page is
less than the value in the Widows field, then the document is moved to the
top of the next page.

The Orphans field controls the minimum number of lines Concordance Desktop
prints at the top of a page when splitting a document between pages. If the
lines left to print are less than the value in the Orphans field, then lines are
borrowed from the previous page until the orphan minimum is met. This may
cause the preceding page to go below the Widows threshold, causing the
entire column to print at the top of the next page.

The Widows field defaults to 4 lines and the Orphans field defaults to 3 lines.
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5. To change the widows value, in the Widows field, type or select the number
of lines you want the report to use for page widows.

6. To change the orphans value, in the Orphans field, type or select the
number of lines you want the report to use for page orphans.   

7. Click Next to open the Report Wizard - Exploded Sort dialog box.

11. In the Report Wizard - Exploded Sort dialog box, define the report's exploded sort
settings.

To define the settings in the Report Wizard - Exploded Sort dialog box:

An exploded sort is a report where each entry in a multiple entry field is sorted in
alphabetical order and given its own line in the report as if it were a separate
record. Concordance Desktop determines each sub-entry in a field by grabbing
the data between delimiters such as a comma. Any punctuation character can be
used as the delimiter as long as it is used consistently.

Exploded Sort Example

An attorney has placed bibliographic entries for all of the documents needed in
a case into Concordance Desktop. The counselor then searched for financial
reports, and wanted to print a report showing each author alphabetically for
an upcoming deposition. With a typical report, the attorney would get a
printout sorted by the first author’s name appearing in the author field. Finding
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a specific author’s name would require looking through each multi-author entry
in the report. Using an exploded sort places each author in alphabetical order
in the first column, repeating the data in the other columns for each entry.
Now the attorney can find the authors quickly and easily, during the
deposition.

1. To create an exploded sort report, in the Do you want an exploded report
field, select the Yes option.

If you do not want to create an exploded sort report, select the No option
and click Next to open the Report Wizard - Fields dialog box.

2. In the Select the field you want to explode sort field, click the field you
want to use for the exploded sort.

The field selected in the Select the field you want to explode sort field will
always be the first column in your exploded sort report.

Records should be sorted by the field used in the report's second column
before entering the Report Writer. That way duplicate records are sorted by
the second column’s contents.

The Set a delimiter to base the exploded sort field defaults to a comma.

3. To change the delimiter used for the exploded sort, in the Set a delimiter to
base the exploded sort field, type the delimiter you want to use.    

4. Click Next to open the Report Wizard - Fields dialog box.

12. In the Report Wizard - Fields dialog box, define the fields that print in the report
columns.

To define the settings in the Report Wizard - Fields dialog box:



Concordance Desktop 506

The order the fields are listed in the Column list is the order the fields will be
displayed in the report columns. If you are creating an exploded sort report, the
field you selected on the Report Wizard - Fields dialog box is automatically added
to the first column in the report, and cannot be moved from the first column. The
wizard automatically sets the number of columns in the report to the number of
fields selected in the Report Wizard - Fields dialog box.

1. To add a field to the Column list, click the field in the Field list, and click the
right arrow, >, button.

2. To remove a field from the Column list, click the field in the Column list, and
click the left arrow, <, button.

3. To change the column order of a field, click the field in the Column list, and
click the Move up or Move down button to move the field to the applicable
column.

When you move a field in the Column list, the wizard automatically updates
the column order number for the field.

4. Click Next to open the Report Wizard - Field Options dialog box.

13. In the Report Wizard - Field Options dialog box, define the individual report field
settings.

To define the settings in the Report Wizard - Field Options dialog box:
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In the Report Wizard - Field Options dialog box you can define settings for the
individual fields in the report including totalling and defining how the Report Writer
handles the data in the field, such as underlining search hits.

1. In the Column list, click the field you want add report settings for.

2. To print a grand total of the field data in the selected column, select the
Total check box, in the Width field, type the total field size in number of
characters, and in the Decimals field, type the number of decimal points you
want to use in the grand total. 

The Width and Decimals fields are only available when the Total check box is
selected. The grand total is printed at the end of the report.

3. To print subtotals, select the Subtotal check box and in the Break column
field, type the number of the column to break on for the subtotals. 

A break column can be any other column in the report. The report should be
sorted by the break column. For example, if the subtotal column contains the
PRICE field and the break column contains the PART_NUMBER. The PRICE
column prints a subtotal whenever the PART_NUMBER changes, and it will
print a grand total when the report is complete.

The Break column field is only available when the Subtotal check box is
selected. Every time the column in the Break column field changes contents,
Concordance Desktop will subtotal the field data.
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4. To print each record on a separate page whenever the column's contents
change between one record and the next, select the New page on new
entry check box.

The database should be sorted by the selected field in the report column.

5. To suppress all repetitive entries in the selected field on the report, select
the Suppress repetitive entries check box.

When the Suppress repetitive entries check box is selected, only the first
instance of duplicate entries will be printed on the report. The report should
be sorted by the selected field in the report column. 

6. If you want all search hits in the selected field to be underlined on the report,
select the Underline hits check box.

7. Click Next to open the Report Wizard - Finish dialog box.

14. In the Report Wizard - Finish dialog box, click the Finish button to create the
report template.

Clicking the Finish button opens the report template within the Report Writer in
Concordance Desktop, and the Report Writer toolbar is now displayed in
Concordance Desktop below the Standard toolbar. 

15. In the Report Writer, you can further customize the report, including adjusting the
column widths, adding and removing columns, adjusting report settings, and
adjusting text properties.

For more information about working in the Report Writer, see the Concordance
Desktop Report Writer User's Guide. 

16. Make the applicable edits to the report in the Report Writer.

17. Click the Print Preview button on the Report Writer toolbar to preview the report.

18. When you are ready to print the report, to send the report directory to the designated
printer, click the Print button in the print preview screen. 

To make any final print adjustments before printing, click the Print button on the Report
Writer toolbar to open the Print dialog box, edit the print settings, and click OK to print
the report from the designated printer.

19. To save your report settings, on the Report Writer toolbar, click the Save as button.

20. To close the report, on the Report Writer toolbar, click the Exit button.

To generate a report using the Report Options dialog box:

1. Run a search query to locate the documents you want to include in the report.
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For more information about searching, see Available search tools.

2. In the Table view, use a table layout to organize the columns and column order you
want to include in the report.

For more information about custom layouts see, Using table layouts.

3. With the Table view still open, on the Standard toolbar, click the down arrow next
to the Report button and click Report writer.

Clicking Report writer opens the Report Writer dialog box.

4. Select the Report Writer option and click OK.

Clicking OK opens the Report tab in the Report Options dialog box.

5. On the Report tab, define the report's document range, record break, field printing,

and column settings.

To define the settings on the Report tab:
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On the Report tab, the First and Last fields default to the first and last record in
the current Concordance Desktop query. 

1. To modify the range of the records to be printed, in the First field, type the
record number for the first record in the range you want to print, and in the
Last field, type the record number for the last record in the range you want
to print.

By default, only the Blank lines check box is selected in the Options section of
the Report tab.

2. To print each record on a separate page, select the New page check box. 

3. To disallow blank lines between each record on the report, clear the Blank
lines check box.

4. To add a horizontal line between each record on the report, select the
Horizontal Lines check box.

The Horizontal Lines check box is only available if you are also adding blank
lines between each record.

5. To add vertical lines between each report column, select the Vertical Lines
check box.

6. To print only the first line from each field in the report, select the Summary
report check box.
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If you choose to only print the first line of each field, Concordance Desktop
prints a summary report with one line per record.

7. In the Enter the number of columns for the report field, type the number
of columns you want to create in the report.

8. In the Enter the maximum characters in each column field, type the
maximum number of characters allowed in each column. The default is 4096
characters.

6. Click the Printer tab to define the report's page margin and intercolumnar spacing

settings, widow and orphan settings, additional page settings, and the default
printer settings. 

To define the settings on the Printer tab:

On the Printer tab, all page margins default to .50 inches from the edge of the
page, and the Intercolumnar (1/10th") field defaults to 2 tenths. 

1. To edit the print margins, type or select the margin sizes, in inches, that you
want to print on the report. 

Some printers have an unprintable reserved area and the margins cannot be
set below this limit.
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2. To edit the intercolumnar spacing, in the Intercolumnar (1/10th") field,
type or select the spacing, in tenths of an inch, that you want to print on
the report.

The intercolumnar spacing determines the distance between columns in your
report.

On the Printer tab, the Widows field controls the minimum number of lines
Concordance Desktop will allow to remain at the bottom of a page. If the
number of lines to print at the bottom of the page is less than the value in
the Widows field, then the document is moved to the top of the next page.

The Orphans field controls the minimum number of lines Concordance Desktop
will print at the top of a page when splitting a document between pages. If
the lines left to print are less than the value in the Orphans field, then lines
are borrowed from the previous page until the orphan minimum is met. This
may cause the preceding page to go below the Widows threshold, causing
the entire column to print at the top of the next page.

The Widows field defaults to 4 lines and the Orphans field defaults to 3 lines.

3. To change the widows value, in the Widows field, type the number of lines
you want the report to use for page widows.

4. To change the orphans value, in the Orphans field, type the number of lines
you want the report to use for page orphans. 

5. To change the paper size or source, page orientation or margins, or default
printer, click the Printer setup button.

6. Clicking the Printer setup button opens the Page Setup dialog box.

7. Make the applicable edits.  

To change the default printer for the report, click the Printer button, make
the applicable edits, and click OK to save your changes.

8. In the Page Setup dialog box, click OK to save your changes and return to
the Printer tab. 

7. Click the Footer tab to define the report's page number, date and time stamp, and
footer font settings. 

To define the settings on the Footer tab:
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On the Footer tab, by default the Print dates, Print time, and Page numbers
check boxes are not selected. If you choose to print page numbers and/or date
and time stamps, they will be printed at the bottom of each page in the footer.

1. To print the current date, select the Print dates check box.

The date is printed in the lower-left corner of the report.

2. To print the current time, select the Print time check box.

The time is printed in the lower-left corner of the report.

3. To print page numbers, select the Page numbers check box.

Page numbers are printed in the lower-right corner of the report. The default
font for footer text is Arial 9pt. 

4. To modify the font settings, click the Font button.

Clicking the Font button opens the Font dialog box.

5. Modify the font and click OK to save your changes. 

The font settings apply to all text in the report footer.

8. Click the Exploded sort tab to define the report's exploded sort settings. 

To define the settings on the Exploded sort tab:
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An exploded sort is a report where each entry in a multiple entry field is sorted in
alphabetical order and given its own line in the report as if it were a separate
record. Concordance Desktop determines each sub-entry in a field by grabbing
the data between delimiters such as a comma. Any punctuation character can be
used as the delimiter as long as it is used consistently.

Exploded Sort Example:

An attorney has placed bibliographic entries for all of the documents needed in
a case into Concordance Desktop. The counselor then searched for financial
reports, and wanted to print a report showing each author alphabetically for
an upcoming deposition. With a typical report, the attorney would get a
printout sorted by the first author’s name appearing in the author field. Finding
a specific author’s name would require looking through each multi-author entry
in the report. Using an exploded sort places each author in alphabetical order
in the first column, repeating the data in the other columns for each entry.
Now the attorney can find the authors quickly and easily, during the
deposition.

1. To create an exploded sort report, select the Explode check box.

If you do not want to create an exploded sort report, clear the Explode check
box.
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2. In the Select the field to perform an exploded sort on field, click the field
you want to use for the exploded sort.

The field selected in the Select the field to perform an exploded sort on field
will always be the first column in your exploded sort report.

Records should be sorted by the field used in the report's second column
before entering the Report Writer. That way duplicate records are sorted by
the second column’s contents.

The Select the delimiter to use for the exploded sort field defaults to a
comma.

3. To change the delimiter used for the exploded sort, in the Select the
delimiter to use for the exploded sort field, type the delimiter you want to
use.    

9. Click the Options tab to define the report's individual column settings. 

To define the settings on the Options tab:

On the Options tab, you can define settings for the individual columns in the
report including totalling and defining how the Report Writer handles the field
data in the column, such as underlining search hits.

1. In the Column list, click the column you want add report settings for.
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2. To print a grand total of the field data in the selected column, select the
Total check box, in the Width field, type the total field size in number of
characters, in the Decimals field, type the number of decimal points you
want to use in the grand total, and in the Style field, click numbering style
you want to use for the grand total. 

The Width, Decimals, and Style fields are only available when the Total or
Subtotal check box is selected. The grand total is printed at the end of the
report.

3. To print subtotals, select the Subtotal check box and then in the Break
column field, click the number of the column to break on for the subtotals. 

A break column can be any other column in the report. The report should be
sorted by the break column. For example, if the subtotal column contains the
PRICE field and the break column contains the PART_NUMBER. The PRICE
column prints a subtotal whenever the PART_NUMBER changes, and it will
print a grand total when the report is complete.

The Break column field is only available when the Subtotal check box is
selected. Every time the column in the Break column field changes contents,
Concordance Desktop will subtotal the field data.

4. To suppress all repetitive field data entries in the selected column on the
report, select the Suppress repetitive entries check box.

When the Suppress repetitive entries check box is selected, only the first
instance of duplicate entries will be printed on the report. The report should
be sorted by the selected field in the report column. 

5. To have the report print each record on a separate page whenever the
column's contents change between one record and the next, select the New
page on new entry check box.

The database should be sorted by the selected field in the report column.

10. Click OK to create the report template.

Clicking OK opens the report template within the Report Writer in Concordance
Desktop, and the Report Writer toolbar is now displayed in Concordance Desktop
below the Standard toolbar. 

11. In the Report Writer, you can further customize the report, including assigning fields
to columns, adding header and footer text, adjusting the column widths, adding and
removing columns, adjusting report settings, and adjusting text properties.

For more information about working in the Report Writer, see the Concordance
Desktop Report Writer User's Guide. 

12. Make the applicable edits to the report in the Report Writer.

13. Click the Print Preview button on the Report Writer toolbar to preview the report.
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14. When you are ready to print the report, to send the report directory to the
designated printer, click the Print button in the print preview screen. 

To make any final print adjustments before printing, click the Print button on the
Report Writer toolbar to open the Print dialog box, edit the print settings, and click
OK to print the report to the designated printer.

15. To save your report settings, on the Report Writer toolbar, click the Save as
button.

16. To close the report,  on the Report Writer toolbar, click the Exit button.

To edit an existing report in the Report Writer:

1. In the Table view, on the Standard toolbar, click the arrow next to the Report
button and click Report writer.

Clicking Report writer opens the Report Writer dialog box.

2. Select the Open existing report option and click OK.

Clicking OK opens the Open dialog box.

3. Navigate to and open the report .arp file you want to edit. 

The report opens in the Report Writer in Concordance Desktop.

4. Make the applicable edits to the report in the Report Writer.

For more information about working in the Report Writer, see the Concordance
Desktop Report Writer User's Guide. 

5. Click the Print Preview button on the Report Writer toolbar to preview the report.

6. When you are ready to print the report, to send the report directory to the designated
printer, click the Print button in the print preview screen. 

To make any final print adjustments before printing, click the Print button on the Report
Writer toolbar to open the Print dialog box, edit the print settings, and click OK to print
the report to the designated printer.

7. To save your report settings to the current .arp file, on the Report Writer toolbar, click
the Save button.

To save your report settings to a new .arp file, on the Report Writer toolbar, click the
Save as button.

8. To close the report, on the Report Writer toolbar, click the Exit button.



Concordance Desktop 518

For more information about using the Report Writer, including using the Report Writer with
CPL scripts, see the Concordance Desktop Report Writer User's Guide. You can request a
PDF file of the guide from Concordance Desktop Technical Support.

Troubleshooting

Isolating issues

Reference this section to review troubleshooting information and common issues that you
can resolve, perhaps avoiding a call to Concordance Desktop Technical Support or
isolating the issue so a support analyst can better assist you.

If you find yourself challenged with Concordance Desktop working properly, we've provided
you with a checklist to help you isolate where a problem resides: computer, network, or
application.

Once you've run through this checklist, you'll most likely discover where the issue lies and
can determine the course of action needed to resolve an issue. If you find you still have
difficulties after reviewing items on this checklist, you may want to enlist a Concordance
Desktop Technical Support analyst for research feedback.

Isolating Issues Checklist:

1. Is your problem happening to one person or all users?

If it’s one person, there’s potentially something wrong with the computer itself, such
as the user’s network privileges or another setting. Please check to ensure that the
user is granted full privileges.

2. Is the problem only with this computer?

If so, you may need to rebuild the system profile.

Test whether the user can log into a Concordance Desktop database from another
computer. If so, the problem is most likely the computer and not the application.

3. Is the issue occurring only in one database or all databases?

Determining this helps isolate whether it’s a database or system issue.

Depending on the setup, try moving a database to a location other than its current
placement.

Desktop to server or server to desktop.
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Resolving common database issues

Avoid time-consuming emails and calls to Concordance Desktop Technical Support by
resolving issues on your own. Here is a list of the most frequent issues that clients run
into while administrating Concordance Desktop and the steps you can take to fix them
yourself:

Full  Network rights given to users

If you find there are users having issues with accessing aspects of Concordance
Desktop or there are other problems occurring, you'll want to verify that all users have
full read/write privileges in the directory where each database resides.

File path problems

Whether you are trying to view images in Concordance Desktop or trying to launch a
hyperlink to a native document or email attachment, there are times when you may run
into the following issue:

Native files and attachments

When clicking on a native document or attachment hyperlink and nothing happens,
on the Start menu, click Run and type the listed path and click OK.

Windows may open a dialog box saying it can’t open the file. It will ask you what
program to use to launch the file. This occurs when Windows doesn’t recognize the
file extension. For example, if you just downloaded Adobe® Reader®, Windows may
not recognize the .PDF extension and which program to use to launch it.

Once you select the program from a list in the dialog box, ensure that the Always
use the selected program to open this kind of file is checked. In the future, the
document hyperlink in Concordance Desktop will correctly launch the native
document.

If Microsoft Windows can’t find the file, then there is a problem with the path listed
in Concordance Desktop.

For more information about updating hyperlinks, see Updating hyperlinks.

Overflow message during import

When importing data, you may receive various overflow messages in the Data Overflow
or Status box.

Here are some examples:
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If your message looks like this, then Concordance Desktop ran into an error on line 100
within the delimited text file you selected to import.

You'll want to open up the delimited text file, navigate to line 100 and verify that the
delimiters are correct and in place with the file containing a hard carriage return at the
end.

This message is listed with the first selected field (BEGNO) followed by an overflow in
every document. Most likely the problem is an incorrect import dialog selection for the
delimiters.

Verify what is used in the delimited text file and that your selection in the Import
Wizard matches. You will also want to verify your other delimiter selections as well.

For this type of error message, there are many possible reasons that an error occurred.
You will want to verify your delimiters, check your Modify dialog box to ensure that the
field type matches the type of data that is being imported in, and also verify that the
field order in the import selections matches the delimited text file.

Once you have modified your selections, be sure to save a new copy of your delimited
text file prior to import. Next delete any records loaded incorrectly or on the File menu,
point to Administration, and click Zap if it is your first import in the database.

Because mistakes can occur during an import, it is best practice to always import
additional delimited text files into a duplicate empty structure of your main database to
ensure that everything loads properly. Once everything looks correct, use the matching
import process to bring in the new records.

For more information about the matching import process, see Loading additional data
into databases.
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View Image (camera) button is not highlighted

If the View Image (camera) button is unavailable and grayed out when you are ready to
manage your imagebase, you most likely forgot to select a field in the database as the
Image key.

You will need to open the Modify dialog box and select the Image check box for a
unique field, typically your beginning Bates number. Once you have made your changes,
be sure to run a full index. After indexing the database, close Concordance Desktop and
re-launch your database. The View Image button should now be available.

Indexing takes too long

If your indexing speeds take too long, you'll want to check the following:

· Indexing Cache Preferences and Recommendations

First, review to the Cache Preferences and Indexing Speed Recommendations
sections in the Before installing Concordance Desktop topic.

The Cache Preferences section provides a formula for allocating RAM specifically for
the indexing process. For maximum speed, we recommend allocating 2 GB to your
machine.

· How many database indexes are you running?

Having indexes for each database run on individual machines greatly improves speed
since you’re able to allocate more memory to processing one database, rather than
having to share it across multiple databases at the same time.

· What is the size of your database?

Record sizes vary based on how many metadata fields there are and how large your
OCR text fields may be. The smaller the database: the faster your index processing.

If your databases are too large, one option is to separate them into smaller
databases and concatenate them for review.

For more information about concatenating databases, see Joining multiple
databases.

Offsetting hit highlights

If you search for terms using full-text search strings and the hit highlighting is not
working, here are steps to resolving the issue:

1. First, export one record that had hit highlighting issues to another Concordance
Desktop database. This way, you can test the issue without impacting your
reviewers.
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2. In the exported database, view this record in the Edit view. Right-click the field
where offset hit highlighting occurred, and click Reset field formatting on the
shortcut menu. 

3. Reindex the database and try searching on the same search term to see if the hit
highlighting issue is resolved in the record you just formatted.

If the problem is resolved, this was a rich text formatting issue. Sometimes, there
can be problems with HTML hexadecimal color codes and .rtf files. Once these files
have been imported into Concordance Desktop, the index may be offset in correctly
identifying your hit terms. You can reset the field formatting on each individual
record and reindex as listed above to resolve the issue.

If the issue has impacted a large number of records, there is a CPL script that can
reset the field formatting of all records in a query set.

4. If the problem persists, then there is an issue with the .ivt file. Take the entire
database offline and then run a full index.

Errors on dictionary and .ivt files

If you receive a message that your dictionary or inverted text (.ivt) files had errors or
were not found, then you'll want to rename the following files by adding OLD to the file
name, and then run a full index: .dct, .ivt, .fzy, .key.

Unable to read and/or write to fields

1. If you come across a field that is read-only in the Edit view that you intended to
have full access to, you may have applied security settings to the entire database.

First, check the Field rights tab in the Security dialog box to verify the given access
to each user. Second, check the specified field in the Data Entry Attributes dialog
box as it can override a field’s settings in the Security dialog box.

2. If you created a new field in the Modify dialog box and security is enabled, you
need to ensure that the new field has read/write access in the Security dialog box
for each individual user.

Be careful to check these settings prior to running productions. You may have
forgotten to create production fields in the database creation phase to store your
new beginning and ending production numbers.

Once you create these new fields, they are listed as options in the Production
Wizard to cross-reference your new production numbers. But if you did not adjust
security field rights for read/write access prior to initiating the production process,
the numbers will not be written to the production fields.
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Issue tags

In order to create an Issue Tag in Concordance Desktop, you must highlight the text,
hold down the Shift key and then select the tag. If you attempt or accidentally
highlight text and then select the tag without holding down the Shift key first, you
receive a message with instructions on using this method for issue tagging. This setting
can be changed back to the older method in the Issue Coding section on the Browsing
tab in the Preferences dialog box.

Production issues

Empty OPT and CIB file

If after creating a Production the OPT and CIB files appear empty, use the Image
Management utility to change the file path for the NearNative files. you will need to
remove the backslash (\) at the end of the folder path.  Use the Image base
Management feature, Rename Media Paths and Folders option to remove the back
slash. 

Unicode Support

About the Unicode standard

The Unicode Standard provides a consistent way to digitally represent the characters
used in the written languages of the world. As an accepted universal standard in the
computer industry, the Unicode Standard assigns each character a unique numeric value
and name. This encoding standard provides a uniform basis for processing, storing,
searching, and exchanging text data in any language.

In Concordance Desktop, the Unicode Standard is supported in Arabic, Chinese, English,
Hebrew, Japanese, Korean, Russian, and other languages.

Some Adobe PDF files with Arabic text do not display the Arabic text in the proper
right-to-left order in Concordance Desktop. These PDF files display the text in reverse
order (left-to-right) because the files report the language incorrectly or are not in the
standard format.

Installation and Database Compatibility

Supporting the Unicode Standard requires the following installation and database
changes:

Installing Language Packs
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To display characters in Unicode within Concordance Desktop, the appropriate
language packs need to be installed on the computer.

For more information, see Installing language packs.

Concordance Installation Changes

Concordance Desktop installs to a new default folder, …\CloudNine\Concordance
Desktop, and includes a new Add or Remove Programs dialog box entry and a new
registry key. This allows Concordance Desktop  and prior versions of Concordance to
exist on the same computer.

Database Compatibility

Due to the major database structure changes required by the Unicode Standard, all
databases need to be converted to Concordance version 10.x and then to
Concordance Desktop. Earlier database versions cannot be opened in Concordance
version 10.x or Concordance Desktop. Only Concordance database versions 7, 8, or 9
can be converted to Concordance version 10.x, and only Concordance 10.x
databases can be migrated to Concordance Desktop.

Since there is no backwards compatibility to older database versions in Concordance
Desktop or Concordance version 10.x, opening a database version 7, 8, or 9 in
Concordance 10.x prompts the user to convert the database to version 10. When
opening a Concordance version 10.x database in Concordance Desktop, the database
is automatically migrated to Concordance Desktop database format. 

All Concordance version 10.x databases in a selected folder and subfolders can be
converted to Concordance Desktop. For more information, see Migrating databases. 

Currently, the Unicode Standard is supported when importing, searching, printing, and
exporting documents in the languages listed above. However, certain issues and tips are
important to know when using these features with a non-English document. 

Import Issues and Tips

The Unicode Standard is supported when importing documents into Concordance
Desktop. 

The following issues and tips are important to know when importing non-English
documents:

Right-To-Left Documents

When importing documents with Right-To-Left (RTL) languages, such as Arabic, the
imported text may be incorrectly justified to the left side. To correct this and change
the justification to the right side, select the text and press the right [Ctrl] +right
[Shift] keys.
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Microsoft Excel Files

When importing Microsoft Excel files in Right-To-Left (RTL) languages, the
spreadsheet cells may be displayed Left-To Right instead of Right-To-Left.

File Names

Native and/or text file names containing Unicode characters are supported in
Concordance Desktop. However, Unicode characters are not supported for use in
user IDs, user groups, matters, clients, or database file names.

Delimiters

The delimiters available from the drop-down lists in the Import Wizard, Import
Delimited Text dialog box, and the Overlay Database dialog box may appear as
square symbols or may not be displayed. How the lists are displayed depends on the
computer's language environment.

The delimiters listed below use the Tahoma font, which displays the characters
regardless of the language environment. All of the characters listed below can be
selected as a delimiter, even if the symbols they represent do not appear in the
drop-down lists.

To see the list of available delimiter characters, see About delimiter characters.

Search Issues and Tips

The Unicode Standard is supported when searching documents in Concordance
Desktop. For more information about searching, see Available search tools.

The following issues and tips are important to know when searching non-English
documents:

Removing Kashida Characters

Kashida characters are used in Arabic text to lengthen a word by elongating
characters at certain points. The added Kashida characters change the word.

For example, the word for Term in Arabic is . When Kashida characters are

added, the word changes to .

Searching for the word Term with Kashida characters results in inaccurate search
results since it will not include the word  Term without Kashida characters.

To prevent inaccurate searches, the Concordance Desktop administrator can remove
the Kashida characters from the searchable text in the current database.
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To remove Kashida characters:

1. On the File menu, point to Administration, and then click Remove Kashida
characters.

2. Enter the administrator user name and password.

3. Click Yes to confirm.

The Kashida character removal is permanent and there is no process to convert
back to the earlier version. We recommend you make a backup copy of the
databases before performing this action.

Kashida characters are automatically removed from the current database. The
status is displayed in the Global Replace dialog box. When finished, the dialog
box closes.

4. Reindex the database after the Kashida characters have been removed to
update the database with these changes.

For more information about reindexing, see Indexing and reindexing updates.

Words that Sound Like the Selected Word

When doing an Advanced Search from the Search task pane, selecting Display a list
of words that sound like the selected word (also known as Fuzzy Search) only works
with English language words. Using this option with words in other languages will
display a list of words that do not sound like the selected word.

For more information about Fuzzy Search, see Using the Advanced Search panel.

Navigating Search Results for Ideographic Languages

A character in an ideographic language, like Chinese, can represent a word. When
navigating search results, each character is considered a separate hit. Clicking the
Next hit and Previous hit buttons jumps to the next character in the search results.

For example, if your search term is the Chinese word for Mandarin Language School
(    ) you will need to click Next hit four times for each word.

Search Examples
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Here are examples of searching Arabic and Japanese documents in Concordance
Desktop.

Simple Search in Arabic

You can use Simple Search to find non-English words in your documents. The

example below shows how Simple Search is used to find the word , which means
language in Arabic.

Some Adobe PDF files with Arabic text do not display the Arabic text in the proper
right-to-left order in Concordance Desktop. These PDF files display the text in
reverse order (left-to-right) because the files report the language incorrectly or
are not in the standard format.
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Advanced Search in Japanese

Advanced Search can also be used to find non-English words in your documents. The
example below shows an Advance Search for the word "  ", which means most
importantly in Japanese.

Edit Issues and Tips

The Unicode Standard is supported when using the Edit features in Concordance
Desktop. For more information editing in Concordance Desktop, see About editing
records.

The following issues and tips are important to know when using the Edit features with
non-English documents:

Data Validation Options

Database fields can be assigned data validation options from the Data Entry
Attributes dialog box. However, certain validation options are only supported with
English text. These include:

· Upper case

· Lower case

· Alphabetic only
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· Numeric only

For more information about data validation, see Creating databases.

Match Whole Word Only

When searching for text using the Find or Replace commands, the Match whole word
only check box does not work with ideographic languages such as Chinese. Clear the
Match whole word only check box before searching for text in these languages.

Print Issues and Tips

The Unicode Standard is supported when printing documents in Concordance Desktop.

The following issues and tips are important to know when printing non-English
documents:

Additional Options for Hit Highlighting

When printing documents with ideographic text, like Chinese, a character underlined
for hit highlighting can easily be confused with other characters.

To allow hit highlighting in these languages, additional options have been added to
the Formatting tab in the Print documents dialog box. Now you can use underline,
bold, italics, color formatting or a combination of these options to highlight the
search hits in your reports.

For more information about using the Formatting tab, see Printing standard reports.

Export Issues and Tips

The Unicode Standard is supported when exporting documents from Concordance
Desktop. For more information about exporting documents, see About exporting data.

The following issues and tips are important to know when exporting non-English
documents:

Exporting to ANSI or ASCII Format

You can export data from Concordance Desktop to ANSI or ASCII format. The file
can then be imported into an application that does not support the Unicode
Standard; for example, into Concordance 2007 or earlier versions.

This option is available for delimited text files in the Export Wizard dialog box and the
Export Delimited ASCII dialog box. It is also available when exporting database
transcripts.
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When exporting to ANSI or ASCII format, characters that cannot be represented
as a single-byte character will be lost in the export. So exporting documents with
double-byte characters, such as Chinese, to ANSI or ASCII format will result in
data loss. See the example below.

Example of exporting a document with Chinese characters to ANSI

Here is a document with Chinese characters in Concordance Desktop.

If you export this document to a delimited text file and select the Export ANSI
(Export Delimited ASCII dialog box) or Export in ANSI format (Export Wizard - Save
dialog box) check box, the Chinese characters will be lost. For example, when you
open the exported document in WordPad, the Chinese characters are displayed as
question marks (?).
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Delimiters

The delimiters available from the drop-down lists in the Export Wizard and the Export
Delimited ASCII dialog box may appear as square symbols or may not be displayed.
How the lists are displayed depends on the computer's language environment.

The delimiters listed below use the Tahoma font, which displays the characters
regardless of the language environment. All of the characters listed below can be
selected as a delimiter, even if the symbols they represent do not appear in the
drop-down lists.

To see the list of available delimiter characters, see About delimiter characters.

When sending data to a 3rd party software program using the Send To command,
only ANSI text is sent..

The Concordance Desktop server does not support user names, passwords, or
database names containing characters in Unicode, such as Chinese or Japanese
characters. Currently, the server only support user names, passwords, or database
names containing single-byte characters, such as English characters. 

Ensure that you only use single-byte characters when creating user names,
passwords, and database names in Concordance Desktop.
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Installing language packs

To display characters in Unicode within Concordance Desktop, the appropriate language
packs need to be installed on the computer. Please go to the Microsoft web site to find
out how to install language packs for your version of the Windows operating system. 

The Microsoft Windows Windows 7 operating system uses Language Interface Packs
(LIPs). These can be downloaded from the Windows Update Web site or the installation
media. Once you have installed at least one LIP, you can add or remove more LIPs from
the Control Panel.

To install language packs on a Windows 7 operating system:

1. In the Control Panel, click Change keyboards or other input methods.

2. Click the Keyboards and Languages tab.

3. Under Display Language, click Install/uninstall languages and follow the prompts.

For more information about installing LIPs, go to the Windows Help and How-to Web
page at: https://support.microsoft.com/en-us/help/14236/language-packs.
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Reference Information

Keyboard shortcuts

Use the following keyboard shortcuts to perform Concordance Desktop functions from a
specific view or task pane. The behavior of the keyboard shortcuts depends on the view
or task pane selected. Ensure that the view or task pane you want to work with is
selected before using the keyboard shortcuts.

Concordance Desktop

Browse and Table View

Keyboard Shortcuts: Browse and Table Views

Shortcut Keys Use

F1 Open Concordance Desktop Help.

F2 Open Search task pane.

F3 Open or close the Review View.

F4 Open the Query by Example dialog box to run a form search.

F5 Open or close the Table View in the Browse View.

F6 Open or close the Browse View in the Table View.

F8 Open the Sort task pane.

- Navigate to the previous document. 

+ Navigate to the next document.

C Open the Copy dialog box to copy document data. (Browse View
only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.

L Navigate to the last document.
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Keyboard Shortcuts: Browse and Table Views

Shortcut Keys Use

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

V Open the current document's corresponding image file in the
image viewer.

CTRL+N Open the New Database Creation Wizard for creating new
databases using load files, E-documents and E-mails.

CTRL+T Open the database templates for creating a new database using
a template.

CTRL+D Open the Dictionary dialog box when your cursor is in the
Advanced Search panel.

CTRL+F Open the Fields dialog box when your cursor is in the Advanced
Search panel.

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

Tags Task Pane

Keyboard Shortcuts: Tags Task Pane

Shortcut Keys Use

SPACEBAR Toggle selected tag.

C Open the Copy dialog box to copy document data. (Browse View
only)

D Open the Goto dialog box to navigate to a specific document.

F Navigate to the first document.

G Open the Goto dialog box to navigate to a specific document.
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Keyboard Shortcuts: Tags Task Pane

Shortcut Keys Use

L Navigate to the last document.

N Navigate to the next search hit.

O Open the Font dialog box to view or modify the font.

P Navigate to the previous search hit.

other letter keys Navigate to the tag starting with the same letter.

Review View

Keyboard Shortcuts: Review View

Shortcut Keys Use

F2 Open Search task pane.

F3 Open the Review View if it is not already opened.

F4 Open the Query by Example dialog box to run a form search.

ENTER Execute the selected search query.

CTRL+D Open the Dictionary dialog box when your cursor is in the
Advanced Search panel.

CTRL+F Open the Fields dialog box when your cursor is in the Advanced
Search panel.

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

ESC Cancel the current search that is in progress.

Edit View
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Keyboard Shortcuts: Edit View

Shortcut Keys Use

CTRL+PAGE UP Navigate to the previous document.

CTRL+PAGE DOWN Navigate to the next document.

TAB Navigate to the next field in the document.

SHIFT+TAB Navigate to the previous field in the document.

CTRL+TAB Navigate to the last database or Workspace tab you
opened.

CTRL+C Copy the selected text.

CTRL+D Open the Duplicate dialog box to copy field data to another
record.

CTRL+F Open the Find dialog box to find text in the current field.

CTRL+F Open the Fields dialog box when your cursor is in the
Advanced Search panel.

CTRL+SHIFT+F Find the next instance of the text entered in the Find dialog
box.

CTRL+H Open the Replace dialog box to find and replace text in the
current field.

CTRL+L Open the authority list associated with the current field. 

For fields not associated with an authority list, navigate to
and open a saved authority list. 

CTRL+S Open the Fuzzy Search dialog box when your cursor is in the
Advanced Search panel.

CTRL+V Paste the copied or cut text.

CTRL+X Cut the selected text

CTRL+Z Undo the last action
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Concordance Desktop Viewer

Keyboard Shortcuts: Concordance Desktop Viewer

Shortcut Keys Use

CTRL + C Copy the current selection

CTRL + X Cut the current selection

CTRL + V Paste the copied selection

CTRL + SHIFT + A Pan tool

CTRL + SHIFT + X Zoom tool

CTRL + SHIFT + Z Magnifier tool

CTRL + E Fit to Height

CTRL + W Fit to Width

CTRL + SPACEBAR Rotate clockwise 90 degrees

CTRL + SHIFT +
SPACEBAR

Rotate counter-clockwise 90 degrees

PAGE UP Navigate to the previous page

PAGE DOWN Navigate to the next page

CTRL + P Open Print dialog box

Concordance Viewer

Keyboard Shortcuts: Concordance Viewer

Shortcut Keys Use

PAGE UP Navigate to the previous page

PAGE DOWN Navigate to the next page

ARROW UP Navigate to the previous page
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Keyboard Shortcuts: Concordance Viewer

Shortcut Keys Use

ARROW DOWN Navigate to the next page

ARROW LEFT Navigate to the previous document

ARROW RIGHT Navigate to the next document

TAB Go to the next markup (if there are markups on the page)

Additional Resources

Sample Files

Sample Concordance Desktop databases

Two sets of sample files are included with the installation of Concordance Desktop;
one is a set of documents for creating a sample e-document database and the other is
a set of PST files for creating a sample e-mail database. The directory where these
files reside also includes instructions for creating both types of databases in
Concordance Desktop, along with an empty "Database"folder that you can use as the
location for your sample e-document and e-mail databases. 

The sample files folder and the instructions for creating the sample databases
can be found under:

C:\ProgramData\CloudNine\Concordance Desktop\Sample Database

The e-document files can be found under:

C:\ProgramData\CloudNine\Concordance Desktop\Sample Database\Sample files\Edoc

The e-mail PST files can be found under:

 C:\ProgramData\CloudNine\Concordance Desktop\Sample Database\Sample files\Email

In addition to the sample files included with the Concordance Desktop installation,
there are also some sample databases and some sample data files you can download
by clicking on the links below. 
 

When downloading the Sample E-Documents Database, ensure that you unzip
the files to C:\ProgramData\CloudNine\Concordance Desktop\Sample
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Database\Database, in order to view the documents in the Concordance

Desktop viewer. Unzipping to any other folder will result in the inability to view
the documents in the Concordance Desktop viewer.

· Sample E-Documents Database

· Sample E-Documents Data

· Transcript Sample Database (with Exhibits)

To download and extract the Unicode sample databases, you will need WinRAR by
RARLAB. WinZip® by WinZip Computing does not handle the foreign language
characters in the Unicode sample databases correctly, causing broken native file links
in the databases.

· Unicode Sample Database (1000 records)

· Unicode Sample Database (100 records)

For more information about Concordance Desktop and the Unicode Standard, see
About the Unicode Standard.

Copyright Information

© 2020 CloudNine™. All rights reserved.

No part of this work may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopying, recording, or by any information storage
or retrieval system, without permission.

While the information contained herein is believed to be accurate, this work is provided "as
is," without warranty of any kind. The information contained in this work does not
constitute, and is not intended as, legal advice.

Concordance is a registered trademark and FYI is a trademark of Cloud9 Discovery LLC dba
Cloudnine. Other products or services may be trademarks or registered trademarks of their

respective companies.

* Concordance Desktop Viewer incorporates software created by OpenText and its use is
limited to the terms of the licensing agreement.  

CloudNine™ Concordance® Desktop
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